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ZUSAMMENFASSUNG

Die Fluoreszenzmikroskopie ist seit Langem ein Standardverfahren,
welches verwendet wird, um biologische Systeme zu untersuchen. Mit
Hilfe der wegweisenden Entwicklung der Superauflösungsmikroskopie
ist es möglich, in den Nanometerbereich vorzudringen.

Die Erfolge der DNA-Nanotechnologie in den letzten Jahren haben
gezeigt, dass es gelingt, DNS als strukturelles Baumaterial zu verwen-
den. Ein bekanntes Beispiel ist DNA-Origami, mit dessen Hilfe man
Strukturen mit beliebigen Formen und Mustern mit Nanometerpräzi-
sion erzeugen kann.

Das Zusammenspiel von Fluoreszenzmikroskopie und DNA-
Nanotechnologie erzeugt eine effiziente Symbiose: Wissenschaftler
sind heute in der Lage, Modellsysteme aus DNS zu bauen, mit denen
Fluoreszenzmethoden mit bis jetzt noch nie dagewesener Genauigkeit
analysiert werden können. Damit ist es nicht nur möglich, die Flu-
oreszenzmethoden zu optimieren, sondern auch die Modellsysteme
selbst zu charakterisieren. Letztendlich können die optimierten Flu-
oreszenzmethoden dazu verwendet werden, biologische Systeme mit
bisher unerreichter Auflösung zu studieren.

In der vorliegenden Arbeit präsentiere ich Projekte, die an der
Schnittstelle von DNA-Nanotechnologie und Fluoreszenzmikroskopie
mit Schwerpunkt auf Superauflösungsmikroskopie angesiedelt sind.

Der erste Abschnitt befasst sich damit, wie DNA-Origami als Werkzeug
in der Fluoreszenzmikroskopie verwendet werden können. Hierfür
werden rechteckige, flache DNA-Origami-Strukturen mit Farbstoffen
versehen, um somit eine große Anzahl an unterschiedlichen Kon-
strukten zu erzeugen, die anhand ihrer Fluoreszenzsignatur eindeutig
zugeordnet werden können. Ferner verwende ich die Superauflösung-
stechnik DNA-PAINT dazu, DNA-Nanostrukturen zu analysieren. Dabei
wird die Einbauwahrscheinlichkeit und Verfügbarkeit der DNS-Stränge,
aus der eine DNA-Nanostruktur besteht, auf Einzelmolekülebene un-
tersucht.

Im zweiten Teil stelle ich ein Protokoll vor, anhand dessen die
Superauflösungstechnik DNA-PAINT durchgeführt werden kann. Dieses
beinhaltet alle notwendigen Schritte, von der Probenpräparation, der
Aufnahme von Superauflösungsbildern bis zur Datenauswertung und
basiert auf dem Computerprogramm Picasso, das eigens für diese An-
wendung geschrieben wurde. Als Nächstes diskutiere ich weiterführende
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Computertechniken wie die Simulation von Fluoreszenzexperimenten.

Zum Schluss präsentiere ich diverse Weiterentwicklungen von
DNA-PAINT, an denen ich gearbeitet habe. Diese zielen darauf ab,
die Anwendbarkeit von DNA-PAINT zum Studium von biologischen
Systemen zu erweitern. Als Erstes wird eine Methode vorgestellt, mit
deren Hilfe die Auflösung durch sequenzielle Bildaufnahme erhöht
werden kann. Als Zweites zeige ich einen Ansatz, mit dem absolute
Molekülzahlen bestimmt werden können. Als Drittes demonstriere
ich die Verwendung von SNAP-tag als Marker zur Bildgebung des
NUP107-Proteins der Kernpore mit Hilfe von DNA-PAINT.
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ABSTRACT

Fluorescence microscopy is a long established tool to investigate biolog-
ical systems, with recent groundbreaking technological advancements
of super-resolution microscopy it advances in nanometer length scales.

In recent years the advent of DNA nanotechnology has proven
the applicability of DNA as a structural building material. A prominent
example is DNA origami, which allows the creation of structures with
arbitrary shapes and patterns with nanometer precision.

The interplay of the achievements in DNA nanotechnology and
fluorescence microscopy creates a powerful symbiosis: Researches now
can build defined model systems made out of DNA that can be used to
benchmark fluorescence methods with unprecedented precision. Not
only can these be used to improve and systematically optimize the
techniques but also to characterize the model systems. Ultimately,
improved fluorescence methods can be used to study biological systems
with unprecedented detail.

This thesis contains projects at the intersection of DNA nanotechnol-
ogy and fluorescence microscopy with a focus on super-resolution.

In the first part, I show how DNA origami can be used as a tool
for fluorescence microscopy. For this, a rectangular flat DNA origami
structure is decorated with fluorophores to create a large variety
of molecular barcodes that can be distinguished by their unique
fluorescence signature. Additionally, I present how DNA-PAINT super-
resolution microscopy can be used to study DNA nanostructures. Here,
the incorporation and accessibility of DNA strands that compose a
DNA nanostructure are investigated on a single-molecule level.

In the second part, I present a protocol on how to perform the
super-resolution microscopy method DNA-PAINT. The protocol covers
all essential steps from sample preparation to image acquisition and
data processing, and introduces the software package Picasso that
was specifically written for this task. Moreover, I discuss advanced
computational techniques such as the simulation of fluorescence
experiments.

Lastly, I demonstrate technological advancements for DNA-PAINT
that I have been working on to improve its capability to study
biological systems. First, I present a method to enhance resolution
by sequential imaging. Second, I introduce an approach to perform
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absolute counting of molecules. Third, I demonstrate the usage of
a SNAP-tag label for DNA-PAINT experiments with super-resolution
imaging of the nuclear pore complex protein NUP107.
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1
INTRODUCTION

To study biological systems, it is imperative to gain knowledge of the in-
terplay of the tiniest objects that compose an organism. Even the larger
building blocks such as cells, which reach sizes of a few microns, require
the magnification of a microscope to be successfully visualized. Here,
the resolving power is dictated by the wave nature of light: Higher reso-
lution comes at a price of higher energy. This is disadvantageous when
ideally wanting to study the systems in physiological conditions, and
exploring of the domain of nanometers was long restricted to electron
microscopes. Another challenge arises in the staining of samples: Ideally
one only wants to visualize the molecules of interest and not all parts
of a cell. For this, fluorescence microscopy is a widely used tool. With
the recent advancement of super-resolution microscopy, researchers are
now able to investigate structures with nanometer resolution.
Another research area which experienced significant progress in recent
years is the field of DNA nanotechnology. The scientist of today is able
to create nanometer-sized objects with desired shapes and patterns.
For the symbiosis of fluorescence microscopy and DNA nanotechnology
this is is a stroke of luck: In order to optimize fluorescence methods,
one no longer needs to rely on known biological reference structures
which are subject to the intrinsic heterogeneity but now can create
defined synthetic reference structure. Complementary to that, fluores-
cence methods can be used to study DNA nanostructures with unprece-
dented precision.
In this chapter, I will present a brief introduction to the fundamen-
tals of fluorescence microscopy, super-resolution microscopy, and DNA
nanotechnology.

1.1 an introduction to fluorescence microscopy

Fluorescence microscopy has become a standard tool in biology. It al-
lows scientists to directly visualize target molecules by simply attach-
ing fluorescent entities to them and detecting the fluorescent emission.
This chapter will give a brief introduction on fluorescence microscopy;
its theoretical foundations, Förster resonance energy transfer (FRET),
the idea of total internal reflection fluorescence microscopy (TIRFM)
and present the components of a typical fluorescence microscope setup.
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2 introduction

1.1.1 Fluorescence

The foundation of fluorescence microscopy is the phenomenon of flu-
orescence. In general, the emission of light from any substance that
occurs from an electronically excited state is called luminescence. De-
pending on the underlying mechanism it can be divided into either to
fluorescence or phosphorescence. Fluorescence describes the rapid emis-
sion of a photon by depletion of an excited state to the ground state
with typical lifetimes of nanoseconds. Phosphorescence is the emission
from triplet excited states with lifetimes in the range of milliseconds to
seconds or longer [1].
An illustrative way of displaying the electronic states or energy levels
and their transitions is the Jablonski diagram, named after Aleksander
Jabłoński, a polish physicist. A sample Jablonski diagram is depicted
in Figure 1.
In essence, a fluorophore can exist in a singlet ground (S0), first (S1)
and second (S2) electronic state which each has a number of vibrational
energy levels (0,1,2). After light absorption, the fluorophore is excited
to a higher level S1 or S2. Usually, molecules relax to the lowest level of
S1 in a process called internal conversion. As this process occurs within
10−12 s and fluorescence lifetimes are 10−8 s the internal conversion
is usually complete before emission. An alternative pathway that is

Internal
Conversion

S2

S1

Absorption Fluorescence

Intersystem
Crossing

Phosphorescence

S0
0
1
2

T1

hνA hνA hνF

hνP

Figure 1: Jablonski diagram. A fluorophore can exist in a singlet ground (S0),
first (S1) and second (S2) electronic state that each have a number
of vibrational energy levels (0,1,2). After light absorption, the flu-
orophore is excited to a higher level S1 or S2. Usually, molecules
relax to the lowest level of S1 in a process called internal conversion.
As this process occurs within 10−12 s and fluorescence lifetimes are
10−8 s the internal conversion is usually complete before emission.
Also displayed is intersystem crossing, which is an alternate path-
way, that describes a spin conversion to the first triplet state T1.
Emission from T1 is called phosphorescence. Image adapted from
[1].
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depicted in the Jablonski diagram is the intersystem crossing, which
describes a spin conversion to the first triplet state T1. Emission from
T1 is called phosphorescence [1].
A key aspect of fluorescence, which is directly visible in the Jablonski
diagram, is that the energy of the emitted light is less than the energy
of the excitation light. In 1884 Sir George Gabriel Stokes reproduced
prior experiments of Sir John Herschel regarding this phenomenon and
noted:

After passing through this stratum, the incident light, though
not sensibly enfeebled nor coloured, has lost the power of pro-
ducing the same effect, and therefore may be considered as
in some way or other qualitatively different from the origi-
nal light [2].

What is being observed, the loss of power is termed Stokes Shift; the
emission wavelength is longer than the excitation wavelength, it is red-
shifted. Ultimately, this is the foundation for a fluorescence microscope
as excitation light can be separated from emission light. The magnitude
of the Stokes shift can be influenced by solvent effects, excited-state
reactions, complex formation, and/or energy transfer.

1.1.2 Förster resonance energy transfer

FRET describes the phenomenon that energy absorbed by a fluores-
cence molecule, termed donor dye, is transferred to another nearby
molecule, termed acceptor dye, by resonance energy transfer. This en-
ergy transfer happens through nonradiative dipole-dipole coupling and
is distance-dependent. By coupling a FRET donor-acceptor pair to two
molecules of interest and recording their fluorescence intensity, it can
be used to measure distances or observe changes in distance. A FRET
donor-acceptor pair can be characterized by their FRET-radius R0, the
distance at which the FRET efficiency E is 0.5. Typical FRET-radii are
in the range of 5 nm to 8 nm. The FRET efficiency varies as the inverse
6th power of the distance [1, 3]:

E =
1

1 + ( r
R0

)6 .

FRET can happen when the emission spectrum of a donor dye is overlap-
ping with the excitation spectrum of an acceptor dye, as it is illustrated
in Figure 2. In Chapter 2, FRET will be discussed as an effect that oc-
curs when placing spectrally different fluorophores on a DNA origami
nanostructure with neighboring distances as close as 5 nm, being in the
range of typical FRET-radii. Here, FRET distorts the excepted fluores-
cence signature and is successfully prevented by organizing fluorophores
in columns and separating spectrally different fluorophores.
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Figure 2: Requirement for FRET. FRET can happen, if the excitation spectrum
(Acceptor Absorption, green) of an acceptor dye is overlapping with
the emission spectrum of a donor dye (Donor Emission, blue). En-
ergy transfer happens through nonradiative dipole-dipole coupling
when the dye pair is in close proximity. Image adapted from [1].

1.1.3 The fluorescence microscope

As previously highlighted, the underlying principle of a fluorescence
microscope is the Stokes shift. It allows to separate the excitation light
from the emission light of the sample and thus allows efficient detection
of fluorescence.
The working principle of a fluorescence microscope can be readily com-
prehended when following the light path through the microscope as it
is displayed in Figure 3.
First, light is emitted from a light source, which can range from lamps
(e.g., mercury-arc or tungsten-halogen) that emit broad spectra to
light-emitting diodes with narrow spectra and lasers with defined wave-
lengths. The light travels through an excitation filter that only passes
the wavelengths desired for excitation and blocks all unwanted wave-
lengths. In order to achieve fluorescence, the excitation light must over-
lap with the excitation spectrum of the fluorophore. The filtered exci-
tation light passes a dichroic mirror that is reflective for the excitation
light and transparent for the emission light. The mirror is placed at
a 45-degree angle so that the emission light is reflected at a 90-degree
angle. The beam is then guided to an objective and ultimately to the
sample. Upon illuminating the sample, it exhibits fluorescence which
is captured by the objective. The resulting wavelength is red-shifted
for which the dichroic mirror is transparent. The emission light travels
through and additionally gets filtered by an emission filter. Typically,
excitation filter, dichroic mirror, and emission filter are assembled in
a so-called filter cube. Having several filter cubes allows fast switch-
ing of the filter sets for different excitation and emission wavelengths.
Ultimately, the emission light then is detected, e.g., by the eye or a
camera.
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Filter cube

Emission filter

Excitation filter
Dichroic mirror

Light source

Objective lens

to detector

Sample

Figure 3: Lightpath of a fluorescence microscope. Light travels from the light
source through the filter cube. It is filtered by an excitation filter, re-
flected by the dichroic mirror and directed to the sample plane by an
objective. The illumination of the sample with excitation light causes
fluorescence, that is guided through the objective, the dichroic and
emission filter and projected onto a detector.
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1.1.4 Total internal reflection

Depending on how the excitation beam passes through the sample,
different modes of illumination can be distinguished. This is illustrated
in Figure 4. Before entering the sample, the light path is parallel to
the optical axis of the objective. If the beam is coupled to the center of
the objective, it will illuminate a vertical column through the sample.
This illumination mode is termed EPI. Here, the deep penetration of
the sample will create a significant background signal. The light path
can be shifted parallel to the optical axis (∆x), causing the illumination
column to tilt. This allows to increase the signal-to-noise ratio (SNR),
the imaging at a steep angle is known as HILO [4]. Once a critical angle
is reached, the beam is reflected, which is known as TIR. The first case
to use TIR as a mode of illumination for fluorescence was demonstrated
in 1956 by E.J. Ambrose:

In order to study the contacts formed between cells and solid
surfaces, it is possible to make use of the slight penetration
of light waves into the less dense medium when totally in-
ternally reflected at a glass/water interface [5].

The nature of this slight penetration was described in more detail by
Daniel Axelrod in 1981, who extended this concept to the idea of TIRFM.
Specifically, this light is an electromagnetic field, named evanescent

EPITIR HILO TIR

BFP

Objective

Oil
Coverslip

Sample

Δx

TIRF

n = 1.33
n = 1.52

Evanescent wave
z

I
d

Figure 4: Modes of illumination and TIRF. Left: Depending on the orienta-
tion of the light path, different modes of illumination can be distin-
guished. If the beam is centered within the objective, it will illumi-
nate a vertical column through the sample. This illumination mode
is termed EPI. When shifting the beam path parallel to the optical
axis (∆x) the sample is illuminated at a steep angle. This mode is
known as HILO. Once a critical angle is reached, the beam is reflected,
and TIR is reached. Right: Illustration of total internal reflection flu-
orescence TIRF. When achieving total internal reflection, the sample
is illuminated by an evanescent wave that is exponentially decaying.
The evanescent wave can be described with a characteristic penetra-
tion depth d which is in the order of hundreds of nanometers. This
allows to illuminate a small area close to the surface and successfully
reducing background fluorescence. Image adapted from [4].
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wave that propagates parallel to the surface and experiences an expo-
nential decay and hence significantly decreases background fluorescence
[6]. The evanescent wave is depicted in Figure 4 and can be described
with the following equation:

I(z) = I0 · exp(
−z
d
).

With I0 being the Intensity at the surface, I(z) the intensity at the
position that is z away from the surface and d the characteristic pene-
tration depth.
Knowing the refraction indices n1 of the incident medium and n2 of
the sample as well as the incident angle, the penetration depth can be
calculated as follows [7]:

d =
λ

4π
1√

n12sin2(Θ)− n22
.

The incident angle can be readily calculated when considering Snells’
law:

sinΘ1
sinΘ2

=
n2
n1

.

For total internal reflection Θ2 = 90◦. Estimating for the glass (n1 =

1.52) and water (n2 = 1.33) intersection gives an incidence angle of:

Θ1 = arcsin(
n1
n2

) = arcsin(
1.33
1.52 ) = 61.04◦.

The range of angles at which an objective can accept or emit light is
typically characterized by its numerical aperture (NA) = n · sin(Θ).
This implies that total internal reflection can only be achieved for high
NA objectives that have NA > n2.
For a wavelength of λ = 561 nm the penetration depth can be readily
estimated to be:

d(65◦, 561 nm) =
λ

4π
1√

n12sin2(Θ)− n22
= 68.04 nm.

Therefore, the intensity at a distance of z = 100 nm is only approxi-
mately 23% of the intensity at the surface:
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I(z)

I0
= exp(

−z
d
) = exp(

−100 nm
68.04 nm ) ≈ 0.23.

This highlights the potential of this technique to perform studies close
at the glass surface with little background fluorescence.

1.2 super-resolution microscopy

In 1873, Ernst Abbe proposed that a microscope has, regardless of
its magnification, a fundamental limitation in its capability to resolve
structures.

.. so folgt, dass, wie auch das Mikroskop in Bezug auf
die förderliche Vergrösserung noch weiter vervollkomm-
net werden möchte, die Unterscheidungsgrenze für centrale
Beleuchtung doch niemals über den Betrag der ganzen, und
für äusserste schiefe Beleuchtung niemals über den der hal-
ben Wellenlänge des blauen Lichts um ein Nennswerthes
hinausgehen wird.

More specifically, he noted that:

.. die physikalische Unterscheidugnsgrenze dagegen hängt
allein vom Oeffnungswinkel ab und ist dem Sinus seines
halben Betrages proportional [8].

By extending this rule with the diffraction index of the sample n, Her-
mann von Helmholtz was able to condense this into the well-known
equation one year later [9]:

d =
λ

2n sinα =
λ

2NA .

With d being the smallest distance between two lines that can be re-
solved and α the maximal half-angle of the cone of light that can en-
ter or exit the lens. When illuminating a sample with a green laser
(i.e., 561 nm) and using an objective with a NA of 1.45 this would be
d = 561 nm

1.45 ≈ 387 nm. Note that this a sample calculation for con-
ventional microscopy which assumes that no excitation and emission
occurs and thus only considers one wavelength.
For fluorescence microscopy, where emission and excitation wavelength
are shifted, and the emission light originates from the dye, an intuitive
way to understand resolution is presented by the Rayleigh criterion,
which originates from astronomy. When an optical system images a
point-like emitter (in the case of fluorescence microscopy a fluorophore),
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it is not imaged as a point but as the diffraction pattern of the system’s
effective aperture. This pattern, also known as Airy-disc, is referred to
as the point spread function (PSF). When thinking about resolving of
two points in close vicinity, the Rayleigh criterion states that the two
points are resolved if the central maximum of the diffraction pattern
from the first point coincides with the first zero of the second point’s
diffraction pattern [10]. Mathematically it can be described as:

dR = 1.22 λ

2NA .

Other ways to asses resolution include Sparrow’s resolution limit and
full width at half maximum (FWHM) ≈ 2.3548σ.
With the advent of super-resolution microscopy techniques, researchers
are able to overcome these fundamental limitations. Breaking the
diffraction limit of light allows fluorescence microscopy to explore
cells with unprecedented resolution. The significance of this advance-
ment was highlighted when in 2014 the Nobel Prize in Chemistry was
awarded to Eric Betzig, Stefan W. Hell and William E. Moerner for
the development of super-resolved fluorescence microscopy.
In general, super-resolution methods can be divided into two groups,
depending on their underlying working principle: Methods that engi-
neer the illumination pattern (structured illumination microscopy (SIM)
and stimulated emission depletion (STED)) and those that are single-
molecule-localization-based (photo-activated localization microscopy
(PALM) and stochastic optical reconstruction microscopy (STORM)). In
the following sections, the techniques are briefly discussed.

1.2.1 Stimulated emission depletion

The idea behind STED is to increase resolution by inhibiting fluores-
cence in the outer regions of the PSF. For this, a scanning beam, as in
confocal microscopy, is used. The beam is overlayed by an additional
STED beam. It is meant to deplete the excited state of the fluorophore
by stimulated emission before fluorescence takes place [11].
The most common approach for depletion is making the STED beam
doughnut-shaped [12] by using a helical phase ramp. The achievable
resolution of STED is ultimately limited by the doughnut’s capability
of reducing the PSF and hence shows an inverse square-root proportion-
ality to its saturation intensity IS [13]. It can be approximated as an
extension of Abbe’s equation [9]:

d(I) =
λ

2NA ·
1√

1 + I
IS

.
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1.2.2 Single molecule localization microscopy

Another way to achieve super-resolution microscopy is by single-
molecule localization-based approaches, also known as single-molecule
localization microscopy (SMLM). Here, target molecules are stochasti-
cally changing between an ON- and OFF-state during continuous il-
lumination, which becomes apparent as blinking. This allows the ob-
servation of individual molecules one at a time. The PSF that arises
from a single molecule can be fitted to determine the center position of
the molecule with subdiffraction precision. The localization precision of
such a fit will strongly depend on the SNR of the image. Thompson et
al. laid the theoretical framework to estimate the localization precision
of such a fit [14]. Hence, the error in localization ∆x can be calculated
as follows:

〈(∆x)2〉 = s2 + a2/12
N

+
4
√
πs3b2

aN2 .

Here, the first expression is referring to the photon-counting and pixe-
lation noise (with s being the standard deviation of the PSF and a the
size of the pixel), and the second expression to the background noise b.
As for large photon numbers N , the first part dominates the equation.
Therefore the localization precision scales with the inverse square root
of the number of photons that are fitted: ∆x ≈ 1√

N
.

In PALM, the blinking behavior is created by attaching photoactivatable
fluorescent protein (PA-FP) molecules to the structure of interest and
stochastically activating them until depletion [15]. In the same year,
Hess et al. published the idea of fluorescence photoactivation localiza-
tion microscopy, FPALM, where PA-GFP molecules were used [16].
In contrast to PALM, STORM uses photoswitchable organic fluorophores
instead of fluorescence proteins [17].
A recent development that combines the doughnut-shaped STED beam
and single-molecule localization is called MINFLUX, minimal emission
fluxes, that achieved a localization precision of ≈ 1 nm [18].
Another way to achieve blinking behavior is point accumulation for
imaging in nanoscale topography (PAINT) [19]. Here, instead of hav-
ing fixed fluorophores at the target molecule, freely diffusing dyes or
dye-labeled ligands [20] are used. Each probe that hits the structure of
interest and becomes immobilized can be localized.

1.2.3 DNA-PAINT

A variation of the PAINT approach is called DNA-PAINT. Here, transient
DNA hybridization is used to create programmable blinking behavior. A
DNA-PAINT system consists of a docking strand and an imager strand,
both being short complementary single-stranded DNA oligomers. The



1.2 super-resolution microscopy 11

docking strand is attached to the target structure, while the imager
strand has a fluorophore coupled to it and diffuses freely through the
imaging solution, as it is depicted in Figure 5. In this state, the diffusing
imager strands are detected as background signal as they diffuse over
several pixels during the integration time of one frame, resulting in an
OFF-signal. Upon binding of an imager strand to a target strand, the
signal locally increases, and the binding event can be detected as an
ON-signal. This binding and unbinding of a DNA-PAINT system on the
surface can be roughly described as a pseudo-first-order reaction which
is characterized by an association (kON ) and dissociation rate (kOFF )
[21]:

A+B
kON


kOF F

C.

Here, A is the imager strand, B the target strand and C the duplex.
Then, the average time spent in the ON-state τB (bright or bound time)
is defined as:

τB =
1

kOFF
.

The ON state is designed to be transient by using oligomers that are
8-10 nucleotide long, resulting in τB values in the range of hundreds of
milliseconds to seconds in imaging buffer. The dissociation rate is ex-
ponentially dependent on the duplex length, hence as a rule of thumb,
τB increases one order of magnitude for each base pair (bp) added. Re-
ported values for a 9 bp interaction are 0.625 s and 5 s for a 10 bp inter-
action [21]. Consequently, the binding and unbinding creates a blinking
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Figure 5: DNA-PAINT. A target structure is decorated with a docking strand
that is the reverse complement to imager strands with fluorophores
in solution. Upon binding of the imager strand to docking strand, the
signal intensity locally increases. Repeated binding and unbinding
becomes apparent as blinking and can be used for super-resolution
microscopy.
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fluorescence signature and can be used for super-resolution microscopy.
The binding duration can be precisely tuned by changing the strand
length, GC content, temperature or buffer salinity. Additionally, the fre-
quency of binding can be tuned by either changing the concentration
of imager strands c or the association constant kON . Here, the average
time in the OFF-state τD (dark or dissociated time) is defined as:

τD =
1

kON · c
.

DNA-PAINT kinetics are described in more detail in Chapter 3 when the
in silico simulation of DNA-PAINT data is discussed.
The tunability of τD and τB when using DNA-PAINT allows one to collect
large photon numbers and achieve very high localization precision in the
subnanometer-range. A key advantage of DNA-PAINT is that multiplex-
ing through orthogonal DNA sequences is possible. In this approach,
termed Exchange-PAINT [22], targets are labeled with orthogonal se-
quences. By sequential imaging of one target at a time and subsequent
buffer exchange, multiple targets can be recorded using the same dye.
This circumvents the limitation of being restricted to spectrally distinct
dyes and bypasses chromatic aberration corrections. I will introduce a
technique that uses Exchange-PAINT to increase resolution in Chapter
4. As the blinking of DNA-PAINT originates from DNA hybridization it
is highly predictable and can, therefore, be used to gain quantitative
information. Even if a spot cannot be resolved, its kinetic signature
can be used to estimate the number of DNA-PAINT docking sites within.
This technique is called qPAINT [23] and will be discussed in more detail
in Chapter 4.
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1.3 dna nanotechnology and dna origami

This section will give an introduction to DNA nanotechnology starting
with the properties of deoxyribonucleic acid (DNA), which is followed
by a brief historical overview of the key developments of DNA nanotech-
nology and DNA origami.

1.3.1 Properties of DNA

While DNA is widely known as the carrier of genetic information, it
is also a biopolymer with remarkable properties that make it ideal to
use as a programmable building block for the creation of DNA nanos-
tructures. DNA consists of two long polynucleotide chains that are com-
posed of four different nucleobases, adenine (A), cytosine (C), guanine
(G) and thymine (T). Each nucleobase is covalently linked to a phos-
phate and sugar, and this subunit is called nucleotide. The sugars and
phosphates form an alternating chain also known as the backbone. Per
convention, the 5’end of the DNA polymer carries a phosphate group,
while the 3’-end has a hydroxyl group. [24]. The shapes and chemi-
cal structures of the bases allow hydrogen bonds to form between A
and T and G and C. For A and T, two bonds form, while for G and
C three bonds form. This complementary base pairing, which is com-
monly known as the Watson-Crick base pairing, enables the base pairs
to form a three-dimensional structure, the double-helix that is the ener-
getically most favorable arrangement. Here, the coiling of two strands
creates two grooves, a wider major groove, and a smaller minor groove.
Ultimately, Watson-Crick base pairing enables to design programmable
binding interactions for supramolecular assembly. This is the founda-
tion of DNA nanotechnology.
As the base pairs are horizontal in the double helix, their π bonds can
interact with each other. This phenomenon, called π stacking or base
stacking, is reported to be the main stabilizing factor in the DNA dou-
ble helix [25].
Reported values for B-DNA which is the typical form for base pairing in
standard conditions are 10.5 nucleotide pairs per turn with a center-to-
center distance between adjacent nucleotides of 0.34 nm and a diameter
of 2 nm with a right-handed helix.
For a schematic overview of the DNA double helix and the chemical
structure refer to Figure 6. In the context of this thesis ssDNA will
refer to single-stranded-DNA while dsDNA refers to the duplex.
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Figure 6: The DNA double helix. The left image shows a space-filling model of
the DNA double helix that shows the major and minor groove. The
right side shows the chemical structure of DNA. For B-DNA, each
turn is made up of 10.5 nucleotide pairs with a center-to-center
distance between adjacent nucleotide pairs being 0.34 nm. The nu-
cleobases are held in place by a chain of phosphates and sugars. Per
convention, the 5’-end of the DNA polymer is carrying a phosphate
group, while the 3’-end has a hydroxyl group. Bases form either
two (A - T) or three (G - T) hydrogen bonds. The complementary
Watson-Crick base pairing makes DNA a programmable building ma-
terial. Image adapted from [26, 27].
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1.3.2 Historical overview

Not only does DNA store and transmit genetic information, in the field
of DNA nanotechnology it is successfully used as a structural build-
ing material. Its origins go back to Nadrian C. Seeman, who in 1982
proposed using base pairing of single-stranded overhangs of short DNA
strands to form junctions. The use of the predictable Watson-Crick base
pairing interaction was intended to create 3D crystals to create a scaf-
fold for the 3D organization of molecules [28]. In the following decades,
it was possible to build extended DNA structures using double-crossover
(DX) molecules compromising two DNA double helices linked together
by two strand exchanges [29].
A major breakthrough in DNA nanotechnology was achieved by the idea
of DNA origami by Paul Rothemund in 2006. Here, a long viral DNA
strand is folded into desired shapes and patterns. This is achieved by
adding short complementary single-stranded DNA strands, that bind
together selected parts of the DNA and held the structures in places.
This allowed making structures of arbitrary complexity with nanome-
ter precision, such as the map of the Americas, smiley faces, stars, and
rectangles [30].
The design process was significantly facilitated with the introduction
of caDNAno by Shawn M. Douglas in 2009. This is an open-source soft-
ware package with a graphical user interface that allows the design and
definition of staple strands for DNA origami structures [31]. Additional
software tools that facilitate the design are vHelix [32] and CanDo that
allows the simulation and prediction of 3D solution shape and flexibil-
ity of DNA nanostructures [33].
Recent advances in the design principles of DNA nanostructures include
the idea of single-stranded tiles. Here, a structure is composed out of
small LEGO-like molecular bricks without the need for a scaffold strand
[34, 35]. This design principle was successfully used to create 3D struc-
tures with gigadalton size with 10,000 unique components [36].

1.3.3 The rectangular origami

In Paul W. K. Rothemund’s initial publication of 2006, a rectangular
DNA origami structure was demonstrated. Jungmann et al. corrected
for the presence of a superhelical twist that occurs as inter-strand
crossovers arise every 32 bp, resulting in 10.67 bp per helix turn. Com-
pared to the 10.5 bp per helix turn, the helical periodicity of double-
stranded DNA in its B-Form results in the helices in the structure to be
slightly underwound [37].
In the context of this thesis, the twist-corrected rectangular DNA
origami – tcRRO, which will here be referred to as RRO, was used as
a molecular pegboard. It has dimensions of approx. 60 nm x 90 nm and
consists of 192 staples and was folded with a 7249 bases long (M13mp18)
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scaffold strand. Consisting out of one layer of 25 parallel DNA helices,
it is a flat structure with a height of 2 nm. For surface attachment,
eight biotinylated extensions were included - leaving 176 positions for
staple extensions. The staples are designed so that within one helix
a 3’-extension, as well as a double crossover, is found every 32 bases.
As the pattern is shifted on the adjacent helix, a hexagonal grid pat-
tern is achieved with 5 nm distance between each hexagon in x- and
y-direction. Extensions at the 3’-end of the staples above the biotin
anchors will point downwards. Refer to Figure 7 for an overview of the
staple routing and the pegboard scheme.

5 nm

Origami Pegboard Staple Routing

80 nm

60
 n

m
5 nm

5 nm

Anchors

DNA-PAINT Handles

Figure 7: Rectangular origami pegboard. The origami pegboard is a flat DNA
origami nanostructure that has 176 positions arranged in a hexago-
nal grid pattern that can be extended to have DNA-PAINT handles
at specific positions. The center-to-center distance of each hexagon
is 5 nm. For surface attachment, eight positions have been modified
(green hexagons) to have biotinylated strands pointing downwards
out of the structure for surface attachment.



2
DNA ORIGAMI AND FLUORESCENCE
MICROSCOPY

As noted in the introductory chapter, DNA nanostructures allow
nanometer-precise placement of guest molecules and can function as
a molecular breadboard. In the past, they have been extensively used
to serve as tools in fluorescence microscopy. Previous demonstrations in
this domain included FRET rulers [38], brightness standards [39], nano-
barcodes [40] and nanoscopic rulers [41].
In this chapter, I will discuss the use of DNA origami as tools for flu-
orescence microscopy with two examples. First, I will introduce the
concept of Metafluorophores, referring to DNA origami nanostructures
with digitally tunable optical properties. Second, I will show how super-
resolution microscopy can be used to study accessibility and incorpora-
tion of DNA nanostructures.

2.1 metafluorophores

One major advantage of fluorescence microscopy is that multiple molec-
ular species in one sample can be detected simultaneously by using spec-
trally distinct fluorescent tags. However, the number of targets that can
be identified at the same time is limited by the number of unambigu-
ously detectable dyes. Ideally, one wants to study the interaction of
hundreds of molecular species at the same time, which creates the need
for a novel type of programmable tag that allows multiplexing and can
be reliably distinguished.
To address this challenge, we explored the capability of transforming
DNA origami into such a label by decorating it with various amounts of
fluorophores in specific patterns. As we chose a rectangular structure
with dimensions of 90 nm x 60 nm, well below the diffraction limit, it
cannot be distinguished from a conventional fluorophore when using
conventional fluorescence microscopy. We, therefore, named this type
of structure Metafluorophore.

2.1.1 Decorating origami with fluorophores

To explore the capabilities of DNA origami to serve as a new kind
of fluorophore, we constructed structures with a prescribed number
of dyes, ranging from 6 to 132. We found that there is a linear de-
pendence of fluorescence intensity on the number of dyes. This was
confirmed for Atto647N, Cy3, and Atto 488 dyes, showing we could
precisely engineer the brightness of our metafluorophores. We then cre-

17



18 dna origami and fluorescence microscopy

ated multicolor metafluorophores by combining the different dyes on
the origami. We noticed a significant decrease in fluorescence intensity
due to FRET. To circumvent this, we arranged fluorophores of the same
species in columns and introduced spacing between fluorophores of dif-
ferent species. The resulting design resembled a barcode and was found
to prevent FRET successfully.

2.1.2 Creating distinguishable tags

As one ideally wants to create a tag that can be unambiguously distin-
guished from another, we performed experiments to identify separable
intensity levels. We found that the four intensity levels, containing 6,
14, 27 and 44 fluorophores, showed only little overlap, allowing the
unique identification of labels. By combinatorially labeling the differ-
ent intensity levels we created a total of 124 distinguishable structures.
The performance was tested by randomly selecting 25 structures and
measuring them together in a sample. Here, only 12.6% of the detected
structures were unexpected (that were detected albeit not being in the
sample). We could increase this performance by creating more robust
subsets (e.g., using intensity levels with less overlap) at the cost of re-
ducing the total number, and had 4.6% unexpected structures for a
subset with 64 structures and 0.4% unexpected structures for a subset
with 20 structures.

2.1.3 Further developments

As a potential application for our newly created metafluorophores, we
successfully performed quantitative nucleic acid detection. Here, we ex-
tended our metafluorophores with a handle region that would bind to
the target DNA strand. By additionally adding biotinylated capture
strands we could capture the probes on the surface and perform a read-
out.
As a way to further increase the number of distinguishable metafluo-
rophores, we chose to characterize dyes that spectrally overlap accord-
ing to their photostability. The acquisition of several images and sub-
sequent determination of the decay constant revealed distinguishable
species.
To address potential limitations of metafluorophores coming from their
size and subsequent limitation in diffusability, we additionally explored
how metafluorophores could be directly assembled at the target site.
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Sub–100-nm metafluorophores with digitally tunable
optical properties self-assembled from DNA
Johannes B. Woehrstein,1,2,3* Maximilian T. Strauss,1,2,3* Luvena L. Ong,1,4 Bryan Wei,1,5†

David Y. Zhang,1,5‡ Ralf Jungmann,1,2,3,5§ Peng Yin1,5§

Fluorescence microscopy allows specific target detection down to the level of single molecules and has become
an enabling tool in biological research. To transduce the biological information to an imageable signal, we have
developed a variety of fluorescent probes, such as organic dyes or fluorescent proteins with different colors.
Despite their success, a limitation on constructing small fluorescent probes is the lack of a general framework to
achieve precise and programmable control of critical optical properties, such as color and brightness. To ad-
dress this challenge, we introduce metafluorophores, which are constructed as DNA nanostructure–based flu-
orescent probes with digitally tunable optical properties. Each metafluorophore is composed of multiple
organic fluorophores, organized in a spatially controlled fashion in a compact sub–100-nm architecture using
a DNA nanostructure scaffold. Using DNA origami with a size of 90 × 60 nm2, substantially smaller than the
optical diffraction limit, we constructed small fluorescent probes with digitally tunable brightness, color, and
photostability and demonstrated a palette of 124 virtual colors. Using these probes as fluorescent barcodes, we
implemented an assay for multiplexed quantification of nucleic acids. Additionally, we demonstrated the
triggered in situ self-assembly of fluorescent DNA nanostructures with prescribed brightness upon initial hy-
bridization to a nucleic acid target.

INTRODUCTION
Fluorescence microscopy is a powerful tool for biological research (1).
Beyond imaging molecules in bulk, its high specificity and sensitivity
allow the detection of single biomolecules (2, 3). This is usually achieved
with fluorescent tags, such as genetically encodable fluorescent proteins
(4, 5), organic dyes, or inorganic fluorescent nanoparticles (6). While
fluorescent proteins can be coexpressed with the target protein of inter-
est, organic and inorganic dyes need to be coupled, for example, to anti-
bodies, small molecules, or DNA to specifically label targets such as
proteins or nucleic acids (7).

A major advantage of fluorescence microscopy is the possibility of
simultaneously detecting and identifying multiple molecular species in
one sample by using spectrally distinct fluorescent tags (colors). How-
ever, this so-called multiplexed detection is typically restricted by the
number of unambiguously detectable spectral colors in the visible range;
the broad emission spectra of organic fluorophores limit spectral multi-
plexing to about four to five dyes.

Thus, fluorescence microscopy is in need of novel types of programma-
ble tags, which allow the unambiguous detection of ideally hundreds of dis-
tinct target species while maintaining the desired properties of “classical”
dyes, such as their nanoscale size and target labeling capabilities. However,
only limitedsuccess towardprogrammablemolecular tagshasbeenachieved
so far (8–10), mainly because of the lack of independent and precise control
of properties, such as intensity, color, size, and molecular recognition.

Here, we introduce a general framework for engineering sub–
100-nm–sized tags with digitally tunable optical properties, such as
brightness and color, using tools from DNA nanotechnology (11–16).
Each tag is composed of multiple organic fluorophores, organized in a
spatially controlled fashion in a compact subdiffraction volume. This
makes the composite fluorophore tag appear similar to a traditional or-
ganic fluorophore when visualized under a diffraction-limited micro-
scope. Inspired by the definition of metamaterials, we therefore call this
tag a metafluorophore.

However, unlike a traditional organic fluorophore, this meta-
fluorophore has digitally and independently tunable optical proper-
ties, such as intensity levels and color mixing ratios. To construct these
particles, we use DNA nanostructures as a platform to organize organic
fluorophores in a subdiffraction volume. A great variety of fluorescent
nanoparticles have been constructed by doping or filling a suitable car-
rier [for example, silicananoparticles (SiNP), polystyreneparticles, hydro-
gels, and dendrimers] with fluorophores (17) and have been used in
diverse bioimaging applications. In contrast to these previous fluorophore-
decorated nanoparticles, the DNA nanostructure–based metafluoro-
phore has the unique advantage of enabling digitally tunable control of
the exact copy number of the fluorophores over a large dynamic range
(one to hundreds) and digitally precise control of the color ratio as well
as the spatial arrangement of these fluorophores.

This independent tunability of both intensity and color enables the
construction of more than 100 well-defined metafluorophores. An
intensity-based multiplexing approach expanded with combinations
of multiple colors can thus overcome the limitations of spectral multi-
plexing, and the metafluorophores can serve as nanoscale intensity
codes (analogous to “barcodes” and hereafter referred to as such) for
high-content imaging.

Traditionally, there have been several ways to create unique barcode
signatures based on properties such as geometry (10, 18–26) and inten-
sity (8–10, 25, 27–31). Geometrical barcoding is achieved by spacing
distinct fluorescent sites beyond the spatial resolution of the used imag-
ing system (that is, >250 nm for diffraction-limited systems and >20 to
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40 nm for super-resolution systems). In combination with spectrally
distinct fluorophores, combinatorial labeling exponentially increases
the number of distinguishable barcodes. However, geometrical barcod-
ing leads to an increased label size due to the necessity of spacing
fluorophores sufficiently apart for accurate detection of the spatial
pattern of the barcode. So far, only a few submicrometer barcode
systems based on geometry or fluorescence intensity have been reported
(9, 10, 24–26, 28), whereas none demonstrated hundreds of barcodes
with sizes below 100 nm.

In intensity barcoding implementations, distinguishable barcodes
are usually realized by controlling the number of fluorophores per spe-
cies, thus allowing the unambiguous detection of different intensity
levels. Compared to geometrical barcodes, the key advantage of inten-
sity barcodes is that they require neither the construction nor the detec-
tion of spatially resolvable fluorescent features. Thus, intensity barcodes
could be much smaller.

Although intensity barcodes with thousands of colors have been
proposed, in practice, only bulky and micrometer-sized barcodes have
been constructed for hundreds of species (8, 32). This extended spatial
size is necessary to ensure robust separation between intensity levels
because these approaches lack the molecular tunability of fluorophore
number, spacing, and positioning, leading to unwanted photophysical
effects, such as self-quenching and Förster resonance energy transfer
(FRET) (33) between dye molecules. Because our proposed meta-
fluorophores feature precise molecular control over number, spacing,
and arrangement of fluorophores in a nanoscale volume, they can serve
as a platform for intensity barcodes without the discussed drawbacks.

Beyond the prescribed tunability of size, color, and brightness, the
DNAorigami approach also permits the use of other tunable optical prop-
erties to further increase the multiplexing level of metafluorophores. As
an example of this approach, we report here metafluorophores with
tunable photostability.

We also apply these metafluorophores as molecular barcodes in a
multiplexed nucleic acid detection assay. By functionalizing distinctly
colored metafluorophores with specific, single-stranded DNA handles,
we are able to capture and subsequently identify and quantify a multi-
tude of synthetic DNA targets.

Finally, we can also use DNA nanotechnology (34–38) to achieve
control over both the position and the order of assembly of the
structure’s components. Specifically, using reconfigurable DNAmono-
mers, we can explicitly control the location and kinetic pathway of the
metafluorophore assembly. To demonstrate this, we implemented a trig-
gered version of our metafluorophore that dynamically self-assembles
from metastable monomers only in the presence of a biomolecular
trigger in situ.

RESULTS
Designing a metafluorophore
Nanoscale metafluorophores can be designed and fabricated with tun-
able properties. Structural DNA nanotechnology enables researchers to
build nanoscale shapes andpatternswith almost arbitrary complexity in a
self-assembled fashion.Here, we use theDNAorigami technique (12, 14)
as a building platform for our metafluorophore.

In DNA origami, a long, single-stranded DNAmolecule (called the
“scaffold”) is folded into programmable shapes by ~200 short, single-
stranded DNA strands (called “staples”) (12). Every staple has a defined
sequence and specifically binds certain parts of the scaffold together.
Structures are usually assembled in a one-pot reaction using thermal

annealing. After the self-assembly is completed, the scaffold is “folded”
into the desired shape, with the staple strands at prescribed positions in
the final origami.

Here, we use a two-dimensional (2D), rectangular DNA origami
consisting of 24 parallel DNA double helices with dimensions of 90 ×
60 nm2 (Fig. 1A, fig. S1, and tables S1 and S2). This specific structure
contains 184uniquely addressable staple strands, which can be function-
alized to display a large variety ofmolecules, such as fluorophores, nano-
particles, etc. (14).

One modular and economic way to attach molecules of interest to
thismolecular pegboard is the use of so-called “handle” and “antihandle”
strands (12). Here, the staple strand at the position where one wants to
attach a molecule is extended with a 21-nt-long single-stranded handle
sequence (table S3). The complementary antihandle is functionalized
with the entity that should be arranged on the DNA origami structure
(Fig. 1A). Staples carrying the handle sequences and the functionalized
antihandle strands are usually part of the one-pot assembly mix. Dis-
tinct target species can be attached to the origami pegboard by using
orthogonal handle strand sequences (26).

To “label” targets with our DNA origami–based metafluorophore,
we could use specific target-binding staple strands. Labeling can either
be achieved by direct hybridization to a DNA or RNA strand on the
target molecule (handle-/antihandle-binding) or be mediated by using
antibodies or small-molecule binders for protein labeling (39, 40).

Tunable brightness
DNA origami has already proven useful as a versatile platform inmany
fluorescence applications, such as single-molecule studies (41, 42)
and super-resolution microscopy (41, 43–47). Recently, DNA origa-
mi has been used to create brightness standards for fluorescence mi-
croscopy (48, 49).

Here, we engineered metafluorophores with tunable brightness. We
designed DNA origami structures with a prescribed number of dyes,
ranging from 6 to 132 (Fig. 1A and fig. S2).We assembled each origami
species using a staple strand mix that contained dye-labeled antihandle
versus handle strands in a 2.25:1 molar ratio (protocol S1). After self-
assembly and purification, the metafluorophores (carrying eight bio-
tinylated capture strands) were immobilized on streptavidin-coated
glass slides in custom-made flow chambers (protocol S2) (26, 46, 47).

Imaging was performed on a ~100 × 100–mm2 area containing
~1000 DNA origami structures, and single images were acquired for
10 s using light-emitting diode (LED) illumination on an inverted epi-
fluorescence microscope (see the Supplementary Materials). Surface
density was adjusted so that individual origami structures appeared
as distinct bright spots in the fluorescent image. After image acquisi-
tion, a spot detection algorithm was used to identify individual DNA
origami structures. In a subsequent step, a 2D Gaussian fit was per-
formed within a 10 × 10–pixel2 area containing a spot. The volume
under the Gaussian function was used as the measure of intensity.
Narrow intensity distributions for experiments with only one meta-
fluorophore population revealed that most of the spots are well-formed
single DNA origami, which is in good agreement with earlier super-
resolution studies (50).

Our structures showed a linear dependence of fluorescence intensity
on the number of dyes. We confirmed this linear dependence for Atto
647N, Cy3, and Atto 488 dyes using DNA structures carrying up to
132 dyes per DNA origami (Fig. 1, B to D, and figs. S3 and S4). Dyes
were spaced approximately equidistantly (see pictograms) on the
DNA origami. After evaluating optimal acquisition settings (figs. S5
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and S6), measurements for all species were performed independently
by analyzing ~10,000 molecules.

Intrinsic variations in measured fluorescence intensity are likely due
to structure-to-structure variations on the number of dyes as well as
stochastic properties of fluorescence emission of the dyes themselves
(51). Extrinsic variations from sample to sample mainly originate from
differences in image acquisition, such as slightly different focal planes or
photobleaching. If the fluorescence emission from a dyemolecule is not
acquired in perfect focus, fewer photons will be collected, and thus, the
measured intensity will be decreased. Tominimize this effect, we used a

focus-maintaining system.Repeated image acquisition of the same sam-
plewith intermittent refocusing yieldsmean-to-mean variations of ~5%
(fig. S7). Additionally, each image acquisition “bleaches” the samples by
~0.8 to 2.8%, depending on the dye (fig. S8).

An important feature of a metafluorophore is its nanoscale size. To
engineer and construct compact metafluorophores, dye molecules need
to be spaced close together while preventing unwanted dye-dye interac-
tions, such as self-quenching (52). To demonstrate that dye-dye inter-
actions are effectively prevented in our metafluorophore design, we
performed experiments with origami structures carrying 14 dyes with
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low labeling density (~16-nm dye-to-dye distance) or 14 dyes with high
labeling density (~5-nm dye-to-dye distance) and compared their fluo-
rescence intensity distributions (Fig. 1, E to G, and fig. S9). Atto 647N–,
Cy3-, and Atto 488–labeled structures with low and high labeling den-
sities showed the same fluorescence intensities within ourmeasurement
accuracy.

Tunable color
A key requirement for multicolored nanoscale metafluorophores is the
ability to tune brightness and color independently. As brieflymentioned
above, our DNA-based metafluorophores can be “functionalized” with
multiple orthogonal handle strands that can, in turn, bind spectrally dis-
tinct dye-labeled antihandle strands. Thus, we can design structures la-
beledwith eitherAtto 647N, Cy3, Atto 488, or any combination thereof.

If spectrally distinct fluorophores are brought into close proximity
(that is, closer than ~10 nm), they may exhibit FRET (33). In FRET, the
fluorophore with the shorter excitation wavelength (donor) transfers
energy to the fluorophore with the longer excitation wavelength (accep-
tor) through nonradiative dipole-dipole coupling. If FRET occurs, the
donor dye’s emission fluorescence intensity will be decreased, depend-
ing, inter alia, on the proximity and number of adjacent acceptor dyes.

Tomaintain prescribed fluorescence intensities when usingmultiple
fluorescent colors in our metafluorophores, we must prevent potential
FRET between spectrally distinct dye molecules. Thus, we investigated
whether FRET occurs in ourmetafluorophore designs and thereby lim-
its our capability to precisely design their fluorescence intensity and
color. We first investigated a design with 44 randomly arranged Atto
647N, Cy3, and Atto 488 dyes (Fig. 2, A to C, respectively, and fig.
S10). This random arrangement was tested by comparing two different
sample species: One contained all three dyes, and one contained only a
single species. The resulting intensity distributions suggest that Atto 488
and Cy3 act as FRET donors because they exhibited a significant de-
crease in fluorescence intensity for the origami species containing pos-
sible acceptor fluorophores. The mean intensities for Atto 488 and
Cy3 dyes were reduced by approximately 50 and 40%, respectively,
compared to the control species with only one single fluorescent color.
However, the mean fluorescence intensity for Atto 647N was un-
changed because this dye lacked a potential FRET acceptor fluorophore.

The finding that FRET can alter fluorescence emission intensity of
themetafluorophore by as much as 50% in randomly labeled structures
limits our ability to control fluorescence color and intensity indepen-
dently. However, the precise programmability of DNA origami allows
us to increase the spacing of spectrally distinct dyes, thus preventing
FRETwhilemaintaining high labeling densities and nanoscale structure
dimensions.

To prevent the undesired FRET, we changed the random dye layout
to a “column-like” arrangement, where the three dye species are posi-
tioned in spatially distant zones (Fig. 2, D to F, and figs. S10 and S11).
Repeating the same experiments as in Fig. 2 (A to C), fluorescence
intensities between multi- and single-color species were unchanged;
thus, our modified column-like layout prevents FRET (Fig. 2, D to F).
This finding now allows us to tune the brightness and color of our
metafluorophores independently. Having established the ability to en-
gineer photophysical properties, such as intensity and color, wewill next
investigate potential applications of DNA-based metafluorophores.

Multiplexed tagging
One of the most important features of metafluorophores is their useful-
ness as labeling probes formultiplexed target detection.Wenowhave to

consider the question of how to construct metafluorophores as multi-
plexed labels on the basis of intensity and color combinations. This
poses the challenge that we need to be able to unambiguously identify
prescribed intensity levels.

Because of stochastic photon emission, imperfect labeling, and in-
complete staple incorporation, theDNAorigami–basedmetafluorophores
show a finite intensity distribution for a structure with a designed num-
ber of dyes (Fig. 3A). If the intensity distributions of two distinct bar-
code levels (or numbers of dyes per structure) are engineered to have no
overlap, each measured intensity value can be unambiguously assigned
to a specific barcode. The number of distinct barcode speciesN scales as
N = ab, with b being the number of spectrally distinct colors and a the
number of distinguishable intensity levels per color.

With a maximum number of 132 staple strands available for modi-
fication and 3 distinct dyes, the largest number of dyes per color per
structure is 132/3 = 44. The smallest number of dye molecules that
can be robustly detected using our standard inverted fluorescence mi-
croscope is 6.

By measuring the width of the intensity distribution for different
numbers of dyes on a DNA origami, we identified a total of four non-
overlapping levels that can be used in a barcoding application, cor-
responding to 6, 14, 27, and 44 dyes (fig. S12). Combinatorial labeling
with three spectrally distinct dyes and five intensity levels (including 0),
allows for amaximumof 53 − 1 = 124 barcodes with our current design.

We tested our ability to design, fabricate, and robustly identify all
124 possible barcodes. After self-assembly and purification of the bar-
codes, we pooled and immobilized them in a streptavidin-modified flow
chamber (Fig. 3, B and C). Here, image acquisition was performed se-
quentially, starting with the longest wavelength and subsequently imag-
ing the shorter wavelengths to minimize photobleaching. Data analysis
(spot detection and intensitymeasurement)was performed as described
above and carried out in each color channel separately. During image
analysis, each detected spot (and thus barcode) was assigned a co-
ordinate and corresponding intensity value for each color. Spots that
appeared at the same position in two or more color channels (colocal-
ization) were combined and assigned to the samemetafluorophore (for
details, see the Supplementary Materials).

To identify our metafluorophore with a specific barcode ID, the
measured intensity values were compared to a lookup table to assign
the correct intensity level (for details, see the SupplementaryMaterials).
One can further obtain a lookup table for each sample acquisition by
creating a histogram of all measured intensity values (fig. S12). This
has the benefit of a “real-time” test for sample performance (for details,
see the SupplementaryMaterials). The overlap of adjacent distributions
is an important measure for barcoding performance because it repre-
sents intensity levels that cannot be unambiguously assigned to a spe-
cific barcode level. To quantify this overlap and discard corresponding
barcodes, we fitted a Gaussian function to the intensity distribution of
each level. The intersection points of adjacentGaussianswere calculated
and subsequently used to determine regionswithout overlap (for details,
see the Supplementary Materials).

Our ability to fabricate and identify all possible 124 barcodes in one
sample is demonstrated in Fig. 3D. Variations in molecule counts are
due to different DNA origami concentrations, likely introduced in their
folding and purification process.

To benchmark the barcoding performance of ourmetafluorophores,
we studied subsets of barcodes (that is, only 25 of the possible 124 bar-
codes in one sample) and introduced the following measures: From all
detectedmetafluorophores, thosewith valid intensity values (for example,
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outside levels of overlapping intensity distributions) are qualified
barcodes. As barcode subsets are measured, these qualified barcodes
may consist of two subpopulations: expected barcodes (that is, the 25 bar-
codes in the sample) and unexpected (or false-positive) barcodes (the
99 barcodes not present in the sample). Consequently, we defined a
signal-to-noise ratio (SNR) as 〈expected〉/〈unexpected〉. Together, these
measures determine the overall performance of our barcoding system.

The first subset contained 25 randomly selected barcodes of the
124 barcodes in Fig. 3D (Fig. 3E and table S4).Wemeasured 2155 spots,
of which 13.5% were discarded as unqualified barcodes with intensity
values within overlapping regions. The discarded spots included mis-
folded structures as well as spots comprising multiple barcodes (that
is, spaced closer than the spatial resolution of our imaging system).
For this 25-barcode subset, 87.4% of the qualified barcodes were the

expected ones. We determined an SNR of 27. A substantial population
of false positives were single-colored barcodes with low fluorescence in-
tensities (that is, identified as “6-0-0,” “0-6-0,” or “0-0-6”). We hypoth-
esize that this is an artifact arising from fluorescent surface impurities.

In case the maximum multiplexing capacity is not required, more
robust barcode sets with higher performance can be designed. One strat-
egy is to use three-color barcodes (that is, all three colorsmust be present
for each barcode species), making detection and identification more
robust (that is, allowing the rejection of single- and double-colored spots).
A total of 43 = 64 three-color barcodes can be constructed using our cur-
rent metafluorophore design.We benchmarked these barcodes by ac-
quiring a subset of 12 structures (Fig. 3F and table S5). Here, 512 spots
were detected, and 92.5% were qualified barcodes, of which 95.4%
were the expected ones. The SNR was determined to be 90.

N
or

m
al

iz
ed

 c
ou

nt
s

Intensity (a.u.)
0 100 200 300 400

0

0.5

1

N
or

m
al

iz
ed

 c
ou

nt
s

Intensity (a.u.)
0 100 200 300 400

0

0.5

1
N

or
m

al
iz

ed
 c

ou
nt

s

Intensity (a.u.)
0 10 20 30 40

0

0.5

1

50

N
or

m
al

iz
ed

 c
ou

nt
s

Intensity (a.u.)

0

0.5

1

0 10 20 30 40 50

N
or

m
al

iz
ed

 c
ou

nt
s

Intensity (a.u.)
0 50 100 150 200

0

0.5

1

N
or

m
al

iz
ed

 c
ou

nt
s

Intensity (a.u.)

0

0.5

1

0 50 100 150 200

A D

B E

C F

Atto 647N

Cy3

Atto 488

Atto 647N

Cy3

Atto 488

Fig. 2. Multicolor metafluorophores. (A to C) “Randomly” labeled metafluorophores may result in significant decrease in fluorescence intensity (B and C) due to FRET,
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Another strategy is to reduce the number of intensity levels, thereby
reducing overlapping intensity distributions. As a demonstration, we
constructed barcodes with three intensity levels (0, 14, and 44 dyes).
Additionally, barcodes were required to consist of at least two colors,
allowing a maximum of 33 − 6 − 1 = 20 distinguishable barcodes. We
measured a subset of 5 barcodes (N = 664) with a qualification ratio of
100%; that is, all detected spots were positively identified as valid bar-
codes (Fig. 3G and table S6). Here, only three false positives were
counted, yielding 99.6% expected barcodes.

We note that the number of barcodes in a subset is a crucial factor
when evaluating the barcoding performance of a system. When using
large subsets, one may make a false identification of a spot without no-
ticing because the identified barcodemay also be part of the used subset.
On the opposite side, when using a small subset, identification accuracy
may be biased because only a small fraction of the barcodes is tested.

Ultrasensitive, quantitative, and multiplexed nucleic
acid detection
Multiplexed detection applications are readily realized by combining
the metafluorophore’s reliable identification capabilities with barcode-
specific target recognition. Inspired by the NanoString nCounter digital
nucleic acid quantification system, where structurally flexible, surface-
immobilized, and geometrically encoded fluorescent barcodes are used
in highly multiplexed digital counting of molecular targets (22), we im-
plemented a multiplexed in vitro nucleic acid detection assay using
metafluorophores. Similarly, our method allows for highly multiplexed
molecular quantificationwith in-principle similarmultiplexing capabil-
ity. Compared to the nCounter system, our metafluorophore-based as-
say has four unique advantages. First, our method has a much simpler
operational workflow: Our system does not require electrophoretic
stretching of the structurally flexible barcodes or sophisticated software
to decode these geometrical patterns; additionally, no target-barcode
purification is required. Second, because the metafluorophore can pack
manymore dyes per area [132 dyes on one origami (90 nm × 60 nm) in
contrast to 1 dye per 50 base pairs (17 nm) for nCounter], it enables
faster image acquisition speed and thus higher throughput (because
we have brighter spots). Third, the higher dye density also allows the

use of potentially simpler, lower-cost, and standard imaging platforms
(we used commercially available confocal and widefield microscopes).
Finally, the metafluorophore is manufactured using a simple one-pot
self-assembly reaction that, in principle, can be fully automated rather
than labor-intensive manual in vitro transcription methods.

In our detection assay, each nucleic acid target (here, eight synthetic
DNA strands) was associated with a metafluorophore. The chosen
metafluorophores were programmed to specifically bind the target by
replacing the eight biotinylated staples (previously used to attach the
metafluorophore to the surface) with staples that are extended with a
target-complementary 21-nt-long sequence at the 5′ end. To increase
the chance of hybridization (and thus the speed of the detection), we
used eight target-specific strands per metafluorophore. Because of their
high excess over targets, we expect each metafluorophore to bind either
one or no target. To detect the target-metafluorophore duplexes on a
microscopy slide (comparable to the experiments in Fig. 3), we intro-
duced a biotinylated DNA strand (“capture strand”) complementary to
a second 21-nt region on the target (see Fig. 4, A and B).

The three components were combined in a hybridization buffer and
incubated for 24 hours (seeMaterials andMethods).We chose concen-
trations of 1 nMbiotinylated capture strands and approximately 250pM
metafluorophores per target.With this high excess ofmetafluorophores
over targets, we assumed that every targetmoleculewas labeledwith one
barcode. Targets were added in different amounts to assay quantification
and sensitivity (see Fig. 4C and table S7). After incubation, the mixture
was added into streptavidin-coated flow chambers as before and incu-
bated for 10 min. The chamber was subsequently washed and sealed.

Data acquisition can be performed on a large variety of fluorescence
microscopes. Widefield microscopes, as used in the characterization of
the fluorescently labeled DNA origami described above, can efficiently
record large areas and are readily available in many laboratories and so
are laser scanning confocalmicroscopes. To demonstrate that themeta-
fluorophores canbeplatform-independently identified in a robust fashion
and thus easily used inmost laboratories, we used confocal microscopes
for data acquisition in the nucleic acid detection experiments.

To assess the precision of this nucleic acid detection platform, we
designed eight capture-target-metafluorophore triplets and added
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Fig. 4. Quantitative nucleic acid detection. (A and B) Schematic of the hybridization reaction. A metafluorophore is programmed to hybridize to part (green) of a
specific nucleic acid target. A biotinylated capture strand binds to a second region (red) and thus immobilizes the complex on a streptavidin-coated surface, yielding
fluorescence images comparable to Fig. 3B. Each positively identified metafluorophore indicates a single copy of a nucleic acid target. (C) The number of detected
targets is directly proportional to their concentration in the sample of interest. Targets were added with defined concentrations (blue bars) and subsequently identified
in the expected ratios (green bars). Five different field of views have been recorded, enabling the calculation of error bars. The lowest target concentration [target 3 (t3)
and target 4 (t4)] was 1.5 pM. Target 1 (t1) and target 2 (t2) were not added, and corresponding identifications are due to nonspecific binding of metafluorophores to
the surface and potential false-positive identifications.
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different amounts of six targets to the reaction. The remaining two
targets were not added and, thus, indicated barcodes nonspecifically
bound to the surface (that is, without cognate target) and false posi-
tives as before (see fig. S13 for exemplary fluorescent image). The
number of detected triplets is directly proportional to the initial tar-
get concentration, and the targets can thus be quantified relative to
each other. Figure 4C shows the successful detection and precise
quantification of targets with initial concentrations of 13.5, 4.5, and
1.5 pM, the latter corresponding to a target amount of only ~100 fg.
The number of counted metafluorophores has been adjusted by using
a calibration sample with equally concentrated targets, to minimize
effects of unequal initial concentrations (fig. S14).

Additional metafluorophore properties
Beyond brightness and color, we can use additional dye properties to
expand the tunability of ourmetafluorophores. This is done by the con-
trolled modification of the structures with groups of fluorescent mol-
ecules displaying the desired property. Suitable dye properties include
fluorescence lifetime, the ability to photoactivate and switch, and pho-
tostability. These parameters can be tuned independently, similar to
brightness and color, thus presenting additional orthogonal axes of
adjustability. This is especially valuable for multiplexed tagging be-
cause the number of unambiguous labels scales with the power of in-
dependent parameters.

Here, we demonstrate the differentiation and identification based
on the photostability of dyes. As a proof of concept, we designedmeta-
fluorophores that contained two dyes with similar emission spectra but
different photostability under our imaging conditions. We chose Atto
647Nas a dyewith slower bleaching constant (that is,more photostable)
andAlexa 647 as a dyewith faster bleaching constant (that is, less photo-
stable). In a time-lapsed image acquisition experiment, the structures
containing Alexa 647 dyes bleach faster than the ones with Atto
647N dyes. As the fluorescence intensity decreases exponentially, we
can measure the decay constant, which is then used as a parameter for
photostability.

Figure 5A shows a time-lapsed series of images of the two types of
structures in one sample, where one species bleaches faster than the oth-
er. Metafluorophores that contain multiple orthogonal properties can
be identified in a multidimensional graph (Fig. 5B). For example, we
can plot the bleaching (or decay) constant versus the fluorescence inten-
sity. Distinct populations corresponding to different metafluorophore
configurations can be easily separated and identified (Fig. 5B). A 1D
histogram of the decay constants (Fig. 5C) demonstrates that the pho-
tostability can be used as an orthogonal tunable metafluorophore prop-
erty, similar to intensity discussed above.

Triggered assembly of metafluorophores
DNA nanotechnology allows us to program the formation of meta-
fluorophores in an environmentally responsive fashion: Structures can
be programmed to form only upon detection of a user-specified trigger.
By building on previous triggered assembly schemes (34, 36), we use
here short fluorescently labeled, metastable hairpins that assemble into
a finite triangular structure if, and only if, a target molecule acting as
trigger is present (Fig. 6A and table S8). As a proof-of-concept study,
we showed the in vitro triggered assembly of a prescribed-size (10 dyes)
triangular metafluorophore using a trigger strand, immobilized by a
dye-labeled capture strand on a glass surface.

First, an Alexa 647–labeled and biotinylated capture strand and a
trigger strand were annealed and immobilized on a glass surface coated
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yellow), whereas the one with the less photostable dyes (that is, Alexa 647) appears
blue. The fluorescence decay constant can be used as a parameter to quantitatively
describe the photostability. The decay constant is obtained by fitting a single exponen-
tial decay to the intensity versus time trace. Scale bars, 5 mm. (B) Intensity versus decay
constant histograms for three different metafluorophore samples containing Atto
647N dyes (green), Alexa 647 dyes (blue), and both dyes (red), respectively (note that
only one species was present in each sample). (C) 1D histogram of the decay constants
shows three distinguishable decay constant distributions (schematics in the legend
show the dye arrangement on the metafluorophores).

S C I ENCE ADVANCES | R E S EARCH ART I C L E

Woehrstein et al., Sci. Adv. 2017;3 : e1602128 21 June 2017 8 of 12

 on M
arch 1, 2018

http://advances.sciencem
ag.org/

D
ow

nloaded from
 

2.1 metafluorophores 27



with bovine serum albumin (BSA)–biotin–streptavidin. Second, Cy3-
labeled metastable hairpins were flown in and incubated for 60 min
(protocol S3). Last, DNA origami–based metafluorophores carrying
44 Atto 488–labeled and 10 Cy3-labeled strands were bound to the sur-
face, as intensity reference.

Image acquisition was carried out by sequentially recording the
Alexa 647, Cy3, and Atto 488 channels (Fig. 6B). Colocalization in
the Alexa 647 and Cy3 channels represents the triangles, whereas Atto
488 and Cy3 colocalization identifies the origami references.

To benchmark the formation performance of the triangles, we com-
pared the intensities of the origami reference structures with the inten-
sities of the triangles in the Cy3 channel (Fig. 6C). Gaussian fits to both
intensity distributions reveal an almost perfect overlap with a mean-
to-mean variation of less than 2%, suggesting successful triangle forma-
tion. Both the formation of the triangle in the presence of the trigger and
the metastability of the hairpins in the absence of the trigger were fur-
ther confirmed by a formation gel assay (fig. S15 and protocol S4).

We note that the triggered assembly scheme used here demonstrates
a number of novel features compared to previous triggered assembly
schemes. Unlike hybridization chain reaction (HCR) (34), which
produces a linear polymer structure of unspecified length, a structure

of precisely defined size and shape is formed here. Additionally, unlike
previous triggered assembly of defined-size structures [for example,
dendrimers (36) and tetrahedron (35)] that uses a large number of
uniquemonomer species, the scheme here uses only onemonomer spe-
cies, and its final size and shape are controlled by the length of the
trigger strand.

We expect the triggered formation of themetafluorophore to be par-
ticularly useful for future in situ imaging applications: The fluorescent
hairpin monomers, upon detecting a trigger attached to the target (for
example, anmRNAor a protein), will form themetafluorophore in situ.
Compared to structures preformed ex situ, the in situ ones have two
critical conceptual advantages. First, the monomer has a smaller size
than the metafluorophore and thus can more easily penetrate deep
tissues with faster diffusion kinetics. Second, because the bright meta-
fluorophore only forms at the target site, possible false positives caused
by nonspecific interactions of preassembled barcodes with cellular
components can be avoided, and the signal amplification at the target
site that resulted from the triggered aggregation of fluorescent mono-
mers will help to increase signal-to-background ratios.

Related in situ fluorescence imaging approaches have been demon-
strated with great success, such as single-molecule fluorescence in situ
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Fig. 6. Triggered assembly of metafluorophores. (A) Schematic of triggered assembly of triangular metafluorophores constructed from 10 metastable Cy3-labeled
DNA hairpin strands. A so-called capture strand (labeled with Alexa 647) is attached to a glass surface via biotin-streptavidin coupling. A long “trigger strand” can
hybridize to the capture strand. The trigger strand consists of four concatenated domains, “1-A,” where the subdomain “1” is 20 nt long and the subdomain “A” is 12 nt
long. Hairpin strands coexist metastably in the absence of the trigger and only assemble into the desired structure upon exposure to the trigger. More specifically, the
introduction of a repetitive single-stranded trigger initiates the assembly of kinetically trapped fluorescent hairpin monomers, which produce a second row of binding
sites. These binding sites further enable the assembly of successive rows of monomers, with each row containing one fewer monomer than the previous. After
assembly of 10 hairpins (labeled with Cy3) to a single trigger strand, no further trigger sequences are displayed, and assembly is terminated, yielding a triangular-
shaped metafluorophore of fixed dimensions. (B) Fluorescence images of triangles assembled in situ on a glass surface. The capture strands are labeled with Alexa 647
(red), whereas the hairpins are labeled with Cy3 (green). DNA origami with 10 Cy3 and 44 Atto 488 (blue) dyes were added to the sample as intensity references. DNA
origami can be identified at the positions where Atto 488 and Cy3 signals colocalize. In the schematic below the overlay fluorescence image, the blue spot indicates the
Atto 488–labeled origami marker; green spots indicate the expected overlay of Alexa 647–labeled capture strand and the triangle composed of Cy3-labeled hairpin
monomers. Gray crosses indicate nonspecific binding of hairpins to the surface. Scale bars, 1 mm. (C) Triangular metafluorophores (green) and reference DNA origami
(blue) intensity distributions are overlapping, thus indicating the formation of the triangles as expected.
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hybridization (smFISH) (9, 53, 54) andHCR (34, 55). Compared to pre-
vious approaches, metafluorophores have several conceptual advan-
tages. Compared to smFISH, the tunability of our metafluorophores
allows us to assemble more complex structures at the target site by, for
example, using a transducer (initiator)molecule that is used to program
complex structure assembly on-site. Compared to HCR, where the
length of the polymerization and, thus, the number of fluorophores per
target are not well defined, the metafluorophore has a precisely defined
size and, thus, controlled intensity, whichmay eventually lead to higher
multiplexing capability.

DISCUSSION
Here, we introduced the concept of a metafluorophore, which can be
viewed as a new kind of dye with digitally tunable optical properties,
can be hundreds of times brighter with arbitrarily prescribed intensity
levels, and has digitally tunable “color.”We implemented this concept
using DNA origami–based self-assembled nanostructures and were
thus able to design metafluorophores with high labeling density (~5-nm
dye-to-dye distance) while preventing self-quenching. Furthermore, the
precise spatial control over dye positions on the nanostructures allowed
us to successfully construct nanoscale multicolor metafluorophores,
where FRET between spectrally distinct dyes is prevented.

Combining these features, we were able to construct 124 unique
intensity barcodes for high-content imaging. We demonstrated the
feasibility of this approach, benchmarked the in vitro performance,
and showed the high specificity, identification accuracy, and low
false-positive rate.

We also demonstrated the ultrasensitive detection and precise quan-
tification of nucleic acids in an easy,multiplexed, and fast assay. Beyond
surface-basedmicroscopy applications, the combination of high bright-
ness, small size, and high multiplexing capacity of metafluorophores
suggests potential future applications, such as flow cytometry and
fluorescence-activated cell sorting (a subtype of flow cytometry) for high-
throughput identification. We also envision our DNA nanostructure–
based metafluorophores to be extended to even smaller sizes by using
the recently developed single-stranded tile assembly approach (15,16,56).
Finally, we envision our metafluorophores based on triggered assembly
to be a particularly useful tool for improving SNRand labeling efficiency
in quantitative smFISH applications.

MATERIALS AND METHODS
DNA origami self-assembly
Self-assembly was performed in a one-pot reaction with a total volume
of 20 ml containing 10 nM scaffold strands (M13mp18), 100 nM folding
staples, 150 nM biotinylated strands, 100 nM strands with dye-handle
extension, and 225 nM fluorescently labeled antihandles in folding
buffer (1× TAE buffer with 12.5 mMMgCl2). The solution was heated
up to 65°C for 5 min and subsequently cooled down to 4°C over the
course of 1 hour. DNA origamis were purified by agarose gel electro-
phoresis (1.5% agarose and 1× TAE buffer with 12.5 mM MgCl2) at
4.5 V/cm for 1.5 hours on ice. Gel bands were cut, crushed and filled
into a Freeze ‘N Squeeze column, and spun for 5 min at 1000g at 4°C.

Microscopy sample preparation
Coverslips (No. 1.5, 18 × 18 mm2, ~0.17 mm thick) and microscopy
slides (3 × 1 inch2, 1 mm thick) were cleaned with isopropanol. Flow
chambers were built by sandwiching two strips of double-sided sticky

tape between the coverslip and the glass slide, resulting in a channelwith
a volume of ~20 ml. The channel was incubatedwith 20 ml of BSA-biotin
solution (1 mg/ml) in buffer A [10 mM tris-HCl, 100 mM NaCl, and
0.05%Tween20 (pH8)] for 2min.The chamberwas subsequentlywashed
with 40 ml of buffer A, then incubated with 20 ml of streptavidin solution
(0.5 mg/ml) in buffer A for 2 min. Next, a buffer exchange was per-
formed by washing the chamber with 40 ml of buffer A, followed by ad-
dition of 40 ml of buffer B [5mM tris-HCl, 10mMMgCl2, 1mMEDTA,
and 0.05% Tween 20 (pH 8)]. Then, 20 ml of buffer B with ~300 pM
DNA origami metafluorophores was added and incubated for 2 min
and subsequently washed with 40 ml of buffer B. Finally, the chamber
was sealed with epoxy before imaging.

Image acquisition parameters
Image acquisition parameters for Figs. 1, 2, 3, and 5A were integration
time of 10 s and LED power of 60%, whereas parameters for Figure 5B
were integration time of 5 s and LEDpower of 60%. The decay constant
was determined by acquiring a series of 10 consecutive frames and
fitting the intensity versus time trace with a single exponential decay
function. Data acquisition was performed on a Zeiss Axio Observermi-
croscope with Colibri LED light source.

Multiplexed nucleic acid detection
Incubation was performed at room temperature in saline-sodium cit-
rate (SSC)–based hybridization buffer [4× SSC, 5×Denhardt’s solution,
5%dextran sulfate, 0.1%Tween20, and salmonspermDNA(0.1mg/ml)].
Flow chamber volume was designed to be ~5 ml. Data acquisition was
performed on a Zeiss LSM 780 confocal microscope.

Triggered assembly on a surface
Capture and trigger strands were annealed in a thermocycler directly be-
fore adding to the sample at 1 mM in 1× TAEwith 12.5 mMMgCl2 and
0.05% Tween 20 (85°C for 5 min, gradient from 85° to 10°C in 15min).
Hairpin strands were annealed in a thermocycler directly before adding
to the sample at 1 mM in 1×TAEwith 12.5mMMgCl2 (85°C for 5min,
gradient from 85° to 10°C in 15 min). A flow chamber (see above) was
prepared with three layers of sticky tape, resulting in a volume of ~60 ml.
The chamber was then incubated with 60 ml of BSA-biotin solution
(1 mg/ml) in buffer A for 2 min and then washed with 120 ml of buffer
A. Next, the chamber was incubated with 60 ml of streptavidin solution
(0.5mg/ml) in bufferA for 2min, followed by awashing stepwith 120ml
of buffer A. Subsequently, a buffer exchange was performed by adding
120 ml of buffer C (1×TAEwith 12.5mMMgCl2 and 0.05%Tween 20).
Then, 60 ml of buffer C with 25 pM annealed capture-trigger duplexes
were added and incubated for 1 min. The chamber was washed with
120 ml of buffer C and incubated with 60 ml of 100 pM DNA origami
standards for 2 min. After washing with 120 ml of buffer C, 60 ml of
buffer C with 30 nM annealed hairpin was added. After 20-min incu-
bation, the chamber was washed with 120 ml of buffer C. Hairpin incu-
bation was repeated three times. Finally, the chamber was washed with
120 ml of buffer C and sealed with epoxy before imaging.

SUPPLEMENTARY MATERIALS
Supplementary material for this article is available at http://advances.sciencemag.org/cgi/
content/full/3/6/e1602128/DC1
fig. S1. caDNAno DNA origami design.
fig. S2. Schematic DNA origami staple layouts of single-color metafluorophores (6 to 132).
fig. S3. Linear dependence of intensity on the number of dyes per DNA origami (calibrated).
fig. S4. Intensity distributions for 6 to 132 dyes.

S C I ENCE ADVANCES | R E S EARCH ART I C L E

Woehrstein et al., Sci. Adv. 2017;3 : e1602128 21 June 2017 10 of 12

 on M
arch 1, 2018

http://advances.sciencem
ag.org/

D
ow

nloaded from
 

2.1 metafluorophores 29



fig. S5. Excitation power variation.
fig. S6. Integration time variation.
fig. S7. Refocusing performance.
fig. S8. Photostability.
fig. S9. Schematic DNA origami staple layouts of self-quenching study.
fig. S10. FRET investigation dye patterning (random and column-wise).
fig. S11. Intensity barcode dye patterns.
fig. S12. Intensity distributions for 124 barcodes in one sample.
fig. S13. Exemplary fluorescent image of nucleic acid detection.
fig. S14. DNA detection calibration.
fig. S15. Triggered assembly formation gel assay.
table S1. DNA origami staple sequences.
table S2. M13mp18 scaffold sequence.
table S3. Fluorescently labeled DNA sequences.
table S4. Intensity barcode subset (25 of 124).
table S5. Intensity barcode subset (12 of 64).
table S6. Intensity barcode subset (5 of 20).
table S7. DNA detection sequences and corresponding barcodes.
table S8. Triggered assembly sequences.
protocol S1. DNA origami self-assembly.
protocol S2. Microscopy sample preparation.
protocol S3. Triggered assembly on surface.
protocol S4. Triggered assembly in solution and gel assay.
Materials
Optical setup
Software section
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2.2 incorporation study

In the prevision section, the applicability of DNA origami as a tool for
fluorescence microscopy was demonstrated with the metafluorophores
and highlights how fluorescence microscopy can benefit from the field
of DNA nanotechnology. However, this positive interaction is not one-
sided. On the other hand, fluorescence microscopy and super-resolution
microscopy, in particular, can be used to study DNA origami nanostruc-
tures. In the following section, I will introduce the idea of the incor-
poration study, where I used DNA-PAINT super-resolution microscopy
to systematically study the incorporation and accessibility of staples in
DNA origami.
The self-assembly of DNA nanostructures is a remarkable process, which
can be stressed by recapitulating a typical folding mix with nanomo-
lar (10−9) concentrations and microliter (10−6) volumes. Given Avo-
gadro’s constant (1023) this leaves one with 108 structures that each
self-assembled into a previously designed structure. Here, a central
point is to assess how successful the folding is on a single-molecule
level. This can be further stressed when thinking about achieving the
goal of turning static DNA nanostructures into dynamic nanomachines.
It is evident that even one missing staple is of great importance for the
functionality of the final machine. An immediate example of how this
affects the efficiency of a technique is given with the metafluorophores
from the previous section. Here, one reason for the fluorophore level
broadness arises from incorporation and is therefore directly affecting
the sensitivity of this technique.

2.2.1 DNA-PAINT to study incorporation

Typically, the effectiveness of folding is analyzed by bulk gel assays.
In 2014 Wagenbauer et al. proposed the usage of a de-Bruijn probe
to quantify the number of unpaired base pairs as a measure of folding
efficiency via gel readout [43]. Three years later, Myhrvold et al. pub-
lished a technique that uses sequencing to quantify the amount of staple
abundance [44]. When imaging a DNA nanostructure with DNA-PAINT,
there are, in contrast to the design, spots missing. A typical example
is a 20 nm grid structure, that is designed to have 12 binding sites. On
average, only 10 binding sites will be imaged with DNA-PAINT. As the
imaging of DNA-PAINT sites is a direct visualization of not only the
successful folding of a strand into a structure but also its accessibility
for the imaging strand, DNA-PAINT is an ideal technique to systemati-
cally study DNA origami nanostructures on a single molecule and staple
level.
First, we developed a software tool that assesses incorporation of DNA
origami datasets that were acquired with DNA-PAINT. The software tool
was thoroughly benchmarked with simulated data containing a known
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ground truth and was able to accurately determine incorporation. We
then systematically analyzed different folding parameters, such as dif-
ferent foldings ramps, MgCl2-concentrations, and variations in staple
excess, and found that they have little influence on the incorporation
of staples. A parameter that had considerable influence on the incor-
poration was the excess of staple strands with respect to the scaffold.
Here, we concluded that an excess of at least 50x is recommended.
After finding that incorporation values could be differentiated on a sin-
gle staple level, we systematically evaluated all accessible staples of the
flat rectangular DNA origami structure. We found an average incorpo-
ration efficiency of 84% with higher incorporation values towards the
center and lower towards the edges.

2.2.2 Incorporation and accessibility

Additional experiments were conducted to untangle incorporation from
accessibility which resulted in a 7% offset when translating the mea-
sured accessibility values to determine incorporation. By using a force-
clamp structure to probe staples away from the surface, and probing
the accessibility of scaffold loops we tested for effects that were induced
by surface interaction. We concluded that surface-interaction is not sig-
nificantly affecting the experimental results.





2.2 incorporation study 35
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Structural DNA nanotechnology1,2 has revolutionized the
field of molecular self-assembly by harnessing the pro-
grammability and specificity of DNA hybridization for

sequence-guided self-assembly. DNA origami3, in particular,
marked a breakthrough, allowing researchers to readily design
and build structures of almost arbitrary shape and complexity4–
11. In DNA origami, a long single strand (the “scaffold”) is folded
into a pre-designed shape by ~200 short, complementary strands
(the “staples”). Each staple has a unique sequence and specifically
binds parts of the scaffold together during thermal annealing,
thus folding the scaffold into the pre-designed shape. While the
large variety of shapes constructed to-date is impressive, the true
power of DNA origami lies in the addressability of specific sites
on the structure with sub-nanometer precision and accuracy12–16

via the modification of single staples. Successful addressability of
a staple is directly linked to its incorporation and accessibility: the
staple has to be incorporated efficiently and it needs to be
accessible for downstream attachment of guest molecules, e.g., via
complementary strand hybridization or direct chemical mod-
ification. Hence, it is necessary to characterize both factors on the
single-staple level with absolute quantification. Although, recent
studies assessed the overall structural integrity using bulk gel
assays17 and the relative abundance of single staples using next-
generation sequencing18, we still lack the ability to quantify
incorporation and accessibility in an absolute manner on the level
of single staples. Recent advancements in optical super-resolution
microscopy19 allow for precise, noninvasive characterization of
objects below the diffraction limit of light. Specifically, DNA
Points Accumulation in Nanoscale Topography (DNA-PAINT)
20,21 super-resolution microscopy is well-suited to characterize
DNA nanostructures because it can achieve the thus far unpre-
cedented spatial resolution of ~5 nm, enabling the quantification
of the accessibility and absolute incorporation efficiency of every
single staple in a DNA origami structure22.

Results
In silico validation of the method. Transient, repetitive binding
of dye-labeled oligonucleotides (“imager” strands) to their com-
plementary targets (“docking” sites) can be observed as apparent
blinking (Fig. 1a). The apparent blinking is used to reconstruct
super-resolution images that visualize the designed pattern of
docking sites, e.g., a 20-nm-grid structure (based on the two-
dimensional (2D) rectangular DNA origami, details about the
design are shown in Supplementary Figs. 1 and 2). These 20-nm-
grids, however, stochastically miss reconstructed points at
designed sites21,23 because the docking sites at these missing
points are not transiently visited by an imager strand. This could
be explained by two mechanisms: (1) staples are not incorporated
into the structure; or (2) staples are incorporated, but docking
sites are not available for binding of imager strands (i.e.,
sequestered). As a result, these positions are not accessible for
downstream modification (Fig. 1b). To assess this accessibility, we
developed a software tool that detected DNA origami structures
in a reconstructed DNA-PAINT image and subsequently aligned
them to a template structure to create a sum image (Fig. 1c and
Supplementary Figs. 3 and 4). Then, we quantified the number of
localizations at each docking site in the sum image. As the
binding of imager strands to their docking sites is repetitive, we
defined a minimum number of localizations as a threshold value:
sites with values below this threshold were classified as not
detected (Fig. 1c). To validate our analysis workflow, we per-
formed in silico DNA-PAINT experiments of 20-nm-grids with
an occurrence probability of individual docking sites ranging
from 30 to 100% using the software program Picasso21. The
number of detected docking sites was in good agreement with the

number of simulated docking sites (Fig. 1d), which confirmed the
applicability of our analysis approach to measure the detectability
of single docking sites.

Investigating incorporation and accessibility. Next, we decou-
pled the two possible underlying mechanisms for non-detectable
docking sites: (1) incorporation and (2) accessibility. In order to
assay each mechanism, we designed a 20-nm-grid carrying staples
that are simultaneously extended with orthogonal docking sites
on the 3′- and 5′-end (Fig. 2a). We then performed sequential
two-color DNA-PAINT imaging and interactively evaluated 100
origami structures with a total of 1200 designed docking sites (the
imaging results are shown in Fig. 2b and Supplementary Fig. 5).
In 78.5% of the cases, we detected a signal from both docking sites
(3′- and 5′-end). In 5%, we only detected the 3′-end site, and in
7.2%, only the 5′-end site. No site at all was detected in 9.3% of all
cases. Since the detection of 3′- and 5′-ends should be indepen-
dent of each other, we estimated that there was a ~2.4% prob-
ability that neither the 3′-end nor the 5′-end of an actually
incorporated staple was detected. Therefore, we concluded that in
the 9.3% of the cases (in which no site was detected) the staple
was indeed not incorporated. Ultimately, this allowed us to assess
the accessibility of docking sites for downstream studies, as well
as to quantify the actual incorporation efficiency of single staples.
To translate accessibility to absolute staple incorporation effi-
ciency, we added an offset of +7% when imaging the accessibility
of a 3′-end site (since we typically use 3′-end extensions as
docking sites in DNA-PAINT, we concentrated on 3′-ends for the
following experiments). Nevertheless, as the vision of structural
DNA nanotechnology24 is to arrange matter in a prescribed
manner by site-specific attachment of molecular entities, we
believe the ultimate measure of quality for DNA origami should
be the accessibility of docking sites. Therefore, we focus on
detection efficiencies (i.e., accessibility) for the rest of this study.

Assembly conditions and staple detection. We investigated the
influence of different assembly conditions on the detection effi-
ciency of individual staples. First, we evaluated the number of
detected sites as a function of the annealing time: for the 20-nm-
grid, we tested annealing times ranging from 5min to 3 days
(Fig. 3b) and determined detection efficiencies for all 12 staple
positions separately. Since the 20-nm-grid has rotational and
mirror symmetry, we then averaged over all 12 sites of a single
grid to obtain an average detection efficiency per origami. We
measured an average detection efficiency of ~82% for all
annealing times (standard deviation σ= 1.3%), underlining the
remarkable robustness of the 2D rectangular DNA origami25.
Additionally, magnesium concentrations between 8 and 16 mM
during folding, as well as the long-term storage at room tem-
perature of purified 20-nm-grids did not result in any significant
change in detection efficiency (Supplementary Figs. 6 and 7).
Second, we investigated the detection efficiency of staples with
respect to their molar excess over the scaffold ranging from ten
times to ~500 times molar excess (Fig. 3c and Supplementary
Fig. 8). The efficiency improved by more than 10% when
increasing the excess from ten times to ~500 times (from 72 to
84% on average) and followed a Michaelis–Menten kinetic (for fit
parameters see Supplementary Table 1).

Quantifying the accessibility of individual docking sites. Next,
we moved away from an average measure of detection efficiency
and tested our capability to accurately quantify the accessibility of
single docking sites. Accordingly, we designed two distinct
structures that break the rotational and mirror symmetry of the
regular 20-nm-grid. Each structure carried an alignment pattern
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in the form of an arrowhead and a line, as well as three (3 binding
sites (BS)) or six (6 BS) docking sites (Fig. 3d). These two
structures enabled us to probe the following: first, false positives
(i.e., detected sites in 3 BS that are only present in 6 BS); second,
the ability to site-specifically probe the detection efficiency. We
first tested for false positives and detection efficiencies of single
sites using in silico DNA-PAINT data and detected 0% false
positives and 100% of the simulated true positive staples (number
of simulated structures n= 50). Then, we performed in vitro
DNA-PAINT experiments (Supplementary Figs. 9 and 10) and
detected an average of 2% false positives (number of analyzed
structures n= 250). Furthermore, the standard deviation between
detection efficiencies of the same sites on the two different
structures was ~2.6%. These findings suggested that there are no
systematic errors induced by our approach, emphasizing our
ability to quantify absolute numbers of detected sites in DNA
origami structures. At the same time, we measured a large dif-
ference (>10%) in the percentage of detected sites for positions
4–6 on both 3 BS and 6 BS structures (in the range of 72–83%),
which indicated that there is a positional dependency of detection
and therefore staple incorporation.

Quantifying every staple in a DNA origami structure. Finally,
this led us to quantify the accessibility of every single staple in the
2D rectangular DNA origami structure. We designed a total of 18
different rectangles, each comprising of an alignment pattern
(arrowhead+ line) and a unique arrangement of 12 detection
sites per rectangle (Fig. 4a and Supplementary Fig. 11) to allow
template identification for each structure (Fig. 4b). These 18
unique designs enabled us to individually probe a total of
168 staples in a single DNA-PAINT acquisition experiment
(Supplementary Figs. 12 and 13). We deliberately left out staple

strands surrounding the biotinylated strands for surface attach-
ment (white hexagons in Fig. 4c), as staple orientation and
routing at these locations are inconsistent with the standard
design of the rectangle. We then quantified the accessibility for all
168 staples and constructed a heatmap of the rectangle displaying
the accessibility as a function of docking-site position (Fig. 4c).
The results indicate a consistently lower efficiency of detection on
the outside of the structure (with a minimum of 41%) compared
to inner areas where detection efficiencies reached 88% (the
average detection efficiency for all strands was 77%). Taking the
detection efficiency offset of 7% determined by the results from
Fig. 2, this translates to absolute incorporation efficiencies of
48–95% with an average of 84%, in good agreement with quali-
tative results of relative staple abundance from next-generation
sequencing26. A heatmap displaying the translated values of
absolute incorporation efficiencies is shown in Supplementary
Fig. 14.

To further evaluate our assumption that we can directly
translate the detection efficiency offset from Fig. 2 to strand
incorporation and eliminate possible accessibility effects, we
targeted a single-stranded section of the scaffold strand
(Supplementary Fig. 16a) on the edge of the 2D rectangular
origami (scaffold loop). The assumption was that this scaffold
loop must be present in every structure. We detected the scaffold
loop in 90% of all cases. To further investigate the effect of
potential surface interaction, we used a three-dimensional DNA
origami structure, the force clamp27. This structure spans a
section of the scaffold strand between two pillars more than 20
nm above the surface. Here, we mimicked the single-stranded
scaffold loop we targeted in the 2D rectangular origami
(Supplementary Fig. 16b) and found a 91% detection efficiency,
indicating that there is no significant effect arising from surface
interactions. We additionally used the force-clamp structure to
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directly investigate the effect of accessibility on the detection
efficiency. For this we modified the force clamp structure to
exhibit a slightly stretched and thus ideally accessible scaffold
section (Supplementary Fig. 16c). The measured detection
efficiency of 97% suggests that the maximum error arising from
accessibility is 3%. To translate our results back to incorporation,
we hybridized a staple to the scaffold between the two pillars of
the force clamp (Supplementary Fig. 16d). The 32 nt staple (same
length as the staples in the 2D rectangular origami) was extended
with the 3′-end docking site used throughout this study. Here, we
measured a detection efficiency of the docking site of 94%,
suggesting an error of 3% caused by incomplete incorporation.
Ultimately, we conclude that the offset determined in Fig. 2 can
be used to directly estimate incorporation from measured
detection efficiency.

The transient binding of imager strands to their docking sites
should not be affected by the position of the docking site on the
DNA origami bound to flat surface20,26. Therefore, we argue that
the change in detection efficiency as a function of docking site

position is indeed an effect of an underlying change in
incorporation efficiency. This could be explained by the fact that
staples at the edges and corners are missing neighboring helices
and/or lack stacking interactions to neighboring strands. This
hypothesis is further supported by qualitatively comparing our
heatmap to finite-element-based modeling (Supplementary
Fig. 15) of thermal fluctuation of the same rectangular origami
using the software tool Cando28. Further quantitative assessment
of these effects could be achieved by sequence-level coarse-
grained29 or fully atomistic30 molecular dynamics simulations.

Discussion
In recent years, many DNA origami-related studies reported on
the attachment yield of various functional entities, such as
streptavidin16,20, DNA walkers31,32, gold nanoparticles33, motor
proteins34, and DNA strands23,35. We collected eight values for
reported yields and translated these values into incorporation
efficiencies of single staples (Supplementary Table 2). The
translated incorporation values are either in good agreement with
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our average incorporation efficiency of 84% or match our mea-
sured maximum incorporation of 95%. Thus, our study now
provides a quantitative explanation of these reported attachment
yields. From our results, we derive two recommendations for
researchers planning to use DNA origami structures for the
arrangement of functional entities. First, staples that are used as
sites for downstream modification should be included in at least a
50 times molar excess over the scaffold to maximize the incor-
poration and thus efficiency of downstream modifications. Sec-
ond, attachment points of downstream modifications, as well as
tracks for hybridization cascades (e.g., for DNA walkers of loca-
lized chemical reaction networks) based on the rectangular ori-
gami design should be placed at points of high incorporation
efficiency (Fig. 4c) and should—if possible—be designed redun-
dantly (as already established for the attachment of metallic
nanoparticles36).

In conclusion, we presented a method for the absolute quan-
tification of single strand incorporation and downstream mod-
ification accessibility by using the unique capabilities of DNA-
PAINT super-resolution microscopy to achieve single-staple-level
resolution (we achieved a maximum localization precision of 1.37
nm as calculated by a nearest neighbor based analysis37, see
Supplementary Table 3). We believe that our method will allow
for rational engineering of the design and assembly process of
DNA nanostructures in order to maximize downstream attach-
ment. This method is not limited to the 2D rectangular DNA
origami structure shown here, but can be applied to virtually any
DNA-nanostructure geometry. Additionally, this approach can be
directly used to characterize the labeling efficiency of antibodies
or cellular proteins and nucleic acids, potentially making it of
great interest for super-resolution microscopy in general and
quantitative structural biology in particular.

Methods
Materials and buffers. Unmodified, dye-labeled, and biotinylated DNA oligo-
nucleotides were purchased from MWG Eurofins or Integrated DNA Technologies.
DNA scaffold strands were purchased from Tilibit (p7249, identical to M13mp18).
Streptavidin was purchased from Thermo Fisher (catalog number: S-888). Bovine
serum albumin (BSA) and BSA-biotin obtained from Sigma-Aldrich (catalog
number: A8549). Glass slides and coverslips were purchased from Marienfeld (cat.
no. 0107032) and Thermo Fisher (cat. No. 10756991). Freeze ‘N Squeeze columns
were ordered from Bio-Rad (cat. no. 732-6165). Polyethylene glycol (PEG)-8000
was purchased from Merck (cat. No. 6510-1KG). Four buffers were used for sample
preparation and imaging: buffer A (10 mM Tris-HCl pH 7.5, 100 mM NaCl, 0.05%
Tween 20, pH 7.5); buffer B (5 mM Tris-HCl pH 8, 10 mM MgCl2, 1 mM EDTA,
0.05% Tween 20, pH 8); buffer O (5 mM Tris-HCl pH 8, 12.5 mM MgCl2, 1 mM
EDTA, 0.05% Tween 20, pH 8) and buffer O+ (same as O, but supplemented with
1× PCA, 1× PCD, and 1× Trolox). A concentration of 100× Trolox: 100 mg Trolox,
430 μl 100% Methanol, 345 μl 1 M NaOH in 3.2 ml H2O. A concentration of 40×
PCA: 154 mg PCA, 10 ml water, and NaOH were mixed and adjusted to pH 9.0.
100× PCD: 9.3 mg PCD, 13.3 ml of buffer (100 mM Tris-HCl pH 8, 50 mM KCl, 1
mM EDTA, 50% Glycerol). PEG-buffer was used for PEG precipitation37 (15%
PEG-8000, 500 mM NaCl, 12.5 mM MgCl2 in TAE pH 8.0).

Super-resolution microscopy setup. Fluorescence imaging was carried out on an
inverted Nikon Eclipse Ti microscope (Nikon Instruments) with the Perfect Focus
System, applying an objective-type total internal reflection fluorescence (TIRF)
configuration with an oil-immersion objective (Apo SR TIRF 100×, NA 1.49, Oil).
Two lasers were used for excitation: 561 nm (200 mW, Coherent Sapphire) or 640
nm (150 mW, Toptica iBeam smart). The laser beam was passed through cleanup
filters (ZET561/10 or ZET642/20, Chroma Technology) and coupled into the
microscope objective using a beam splitter (ZT561rdc or ZT647rdc, Chroma
Technology). Fluorescence light was spectrally filtered with an emission filter
(ET600/50m and ET575lp or ET705/72m and ET665lp, Chroma Technology) and
imaged on an electron-multiplying charge-coupled device (EMCCD) camera
(Andor iXon Ultra 897, used for Figs. 1a and 3c) or sCMOS camera (Andor Zyla
4.2, used for Figs. 3b, d, and 4) without further magnification, resulting in an
effective pixel size of 160 nm (EMCCD) or 130 nm (sCMOS after 2 × 2 binning).

DNA origami self-assembly. Self-assembly of DNA origami was accomplished in
a one-pot reaction mix with 40 µl total volume, consisting of 10 nM scaffold strand,
100 nM folding staples, 10 nM biotinylated staples (500 nM for Fig. 2 and

Supplementary Fig. 16d), and 1 µM (Figs. 1b, 2, 3b, and 4) or varying concentra-
tions (Fig. 3c) of docking site strands (5′-staple-TTATACATCTA-3′) in folding
buffer (1× TE buffer with 12.5 mM MgCl2). The reaction mix was then subjected to
a thermal annealing ramp using a thermocycler (Mastercycler Nexus Gradient,
Eppendorf or Tetrad 2, Bio-Rad). If not otherwise noted, the reaction mix was first
incubated at 80 °C for 5 min and then cooled from 60 to 4 °C in steps of 1 °C per
3.21 min and then held at 4 °C until stored at −20 °C protected from light. Samples
for the measurement with varying staple excess (Fig. 3c) were purified via three
rounds of PEG precipitation by adding the same volume of PEG-buffer, cen-
trifuging at 10,000×g at 4 °C for 30 min, removing the supernatant, and resus-
pending in folding buffer. Structures for Fig. 2 were gel purified by mixing with 1×
loading dye and subsequently subjected to agarose gel electrophoresis (1.5%
agarose, 0.5× TAE, 10 mM MgCl2, 1× SYBR Safe) at 3 V cm−1 for 3 h. Gel bands
were extracted, crushed, filled into a Freeze ‘N Squeeze column, and centrifuged for
5 min at 1000×g at 4 °C. Force-clamp structures were designed and assembled as
described before27. The staple excess of the extended staple in the structure of
Supplementary Fig. 16d was 100× over the scaffold.

Sample preparation. For sample preparation, a piece of coverslip and a glass slide
were sandwiched together by two strips of double-sided tape (Scotch, cat. no.
665D) to form a flow chamber with inner volume of ~20 μl. First, 20 µl of biotin-
labeled bovine albumin (1 mg/ml, dissolved in buffer A) was flushed into the
chamber and incubated for 2 min. The chamber was then washed with 40 µl of
buffer A. A volume of 20 µl of streptavidin (0.5 mg ml−1, dissolved in buffer A) was
then flushed through the chamber and allowed to bind for 2 min. After washing
with 20 µl of buffer A and subsequently with 20 µl of buffer B, 20 µl of biotin-
labeled DNA structures (~100–400 pM, see Supplementary Table 4) in buffer B
were flushed into the chamber and incubated for 2 min. The chamber was washed
with 40 µl of buffer B. Finally, 20 µl of the imager solution was flushed into the
chamber, which was subsequently sealed with epoxy (Toolcraft, cat. no. TC-EPO5-
24) before imaging.

Imaging conditions. Refer to Supplementary Table 4 for an overview of imaging
conditions and Supplementary Table 5 for the imager strand sequences. Supple-
mentary Table 3 shows the super-resolution data properties of all measurements.

Data simulation. In silico experiments were performed using the simulation
module of the Picasso18 software package. For Fig. 1c, 50 structures consisting of 12
BS spaced 20 nm apart (the “20-nm-grid” structure) were simulated with varying
incorporation of staple strands (30–100%). Further simulation parameters were an
image size of 128 × 128 px and an acquisition time of 50 min (15,000 frames at 200
ms integration time). For the simulation of the 3 BS and 6 BS structure of Fig. 3d,
again 50 structures with the same parameters were simulated. For each simulation
run, a dark time of 12.5 s and a bright time of 0.5 s were used, corresponding to 5
nM imager strand concentration at a constant association rate of 1.6 × 106M−1 s
−1. Further simulation parameters were a pixel size of 160 nm, a detection rate of
35 photons × ms−1 kW−1 cm−2, a budget of 1.5 × 106 photons, a power density of
1.5 kW × cm−2, and a full width half-maximum of the point-spread-function of
309 nm.

Data analysis. First, super-resolution images were reconstructed and drift-
corrected with the render module of Picasso. For the automated evaluation with
our MATLAB program, individual structures were selected with Picasso’s “pick
similar” feature. For the experiments involving the detection of single BS (Figs. 3d
and 4), structures were additionally filtered manually by using Picasso’s “plot pick”
feature. Structures that did not display a correct alignment pattern were discarded.
An overview of all selected structures is shown in Supplementary Figs. 9, 10, 12,
and 13. Localizations of selected structures were saved as *.hdf5 file and subse-
quently converted to a *.trace.mat, drift file and mbox file, which then could be
imported into the MATLAB program.

The template of each structure was automatically generated after selection of the
docking site pattern on the 2D origami map in the template tool. An image was
generated by placing Gaussian distributions (σ= 3 nm, σ= 2 nm for Fig. 3c or σ=
1 nm for the single site measurements shown in Figs. 3d and 4) of binding events
on the previously defined positions.

For evaluation, a subset with n structures of all selected structures in the *.trace.
mat file was used (Fig. 3b, c: n= 500; Fig. 3d: n= 250; Fig. 4: two datasets were
combined and the minimum number of structures that was present for each
structure type was used, n= 186). Next, the software aligned each structure to the
structure template: the localizations of each structure were isolated and a super-
resolution image of the structure was generated by calculating a 2D histogram of
these localizations. The super-resolution image was rotated stepwise in a circle and
in each step cross-correlated to the template image. The rotation angle with the
highest correlation coefficient was determined. This rotation angle and the
corresponding xy-shift were then used to transform the localization list in order to
align the structure to its template. After alignment, the program counted the
number of localizations in a circle with a diameter of 20 nm (Figs. 1c and 3c), 18
nm (Fig. 3b), 6 nm (Fig. 4), or 5 nm (Fig. 3d) around the predefined docking site
positions of the template. The number of localizations per docking site for all
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structures was displayed in a histogram within the program. This histogram was
used to determine the correct detection threshold. This threshold was subsequently
used to calculate the presence of each docking site for a given structure. Finally, the
program displayed the percentage of detected docking sites for all evaluated
structures.

For dual-channel measurements (Fig. 2), 100 structures were manually selected
in the reconstructed super-resolution image from Picasso. For each selected
structure, the presence or absence of both colors at each docking site was registered.

Data availability. All data supporting the findings of this study are available within
the paper and its Supplementary Information. All RAW data are available upon
request. The MATLAB program and source code for evaluation are available for
download at http://www.jungmannlab.org. All sequences of the DNA origami
structures are given in Supplementary Tables 6 and 7.
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3
DNA-PA INT AND SUPER -RESOLUTION
MICROSCOPY

The unique properties of DNA-PAINT make it a versatile toolbox with
numerous applications for today’s researchers. However, the true value
of a technique comes from its adaptability. This can only be achieved
when easy-to-follow protocols and tools for benchmarking and trou-
bleshooting are provided. Additionally, impressive demonstrations of
performance help spark interest and underline applicability. In our
years of performing DNA-PAINT, we quickly realized the increasing in-
terest of the scientific community to apply the method. As the training
and providing support on a single user-level was very time consuming
and best practice guidelines vastly improved since the initial publica-
tions, the demand for a unified reference increased.
In an attempt to meet these goals we prepared an in-depth protocol
for all relevant steps to perform high-performance DNA-PAINT super-
resolution microscopy. The protocol covers the creation of DNA origami
test samples, in situ sample preparation, multiplexed data acquisi-
tion, data simulation, super-resolution image reconstruction and post-
processing such as drift correction, molecule counting (qPAINT) and
particle averaging. The protocol is meant to be completed within 1-2
days. An integral part of this protocol was the creation of an inte-
grated software package, named Picasso. The software package allows
all computational steps required for the protocol to be performed. The
source code of the program was made publicly available as open source
at GitHub so that the community can readily modify it for further
optimization.
In order to simplify the process of getting to know the technique, I im-
plemented a simulation module, which allows the in silico simulation
of DNA-PAINT experiments. This enables the creation of raw data as
it would originate from an experiment and thus allows the researcher
to not only get acquainted with downstream processing, but also to
quickly assess the feasibility of DNA-PAINT for a specific research ques-
tion. The underlying fundamentals of the simulation module are pre-
sented in the next chapter. A more advanced method of benchmarking
comes with the usage of DNA nanostructures that allow in vitro perfor-
mance tests. To streamline the production of DNA origami nanostruc-
tures I employed a module that allows designing different patterns of
DNA-PAINT docking sites on a flat, two-dimensional structure by just
pointing and clicking at the respective positions on a canvas, allowing
even novice users to create the desired DNA nanostructures. By first
performing simulations, then working with artificial nanostructures and

45



46 dna-paint and super-resolution microscopy

ultimately performing in situ experiments, one can master the art of
DNA-PAINT in a stepwise process.
To showcase resolution capabilities, we performed DNA origami mea-
surements to resolve 5 nm distances. For this, we designed an ’MPI’
and ’LMU’-pattern on the nanostructures and could achieve a nearest
neighbor based analysis (NeNA) [46] localization precision of 1.4 nm
(MPI) and 1.0 nm (LMU).
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INTRODUCTION
For biomedical research, super-resolution microscopy is a prom-
ising tool developed in recent years, allowing optical imaging 
beyond the diffraction limit of light, for up to molecular-scale 
resolution inside cells. The significance of this group of imag-
ing modalities is underlined by the Nobel Prize in Chemistry 
in 2014 ‘for the development of super-resolved fluorescence 
microscopy’. Super-resolution has been achieved by a variety of 
imaging modalities, most notably nonlinear structured illumina-
tion microscopy (SIM)1, stimulated emission depletion (STED) 
microscopy2, (fluorescent) photo-activated localization micros-
copy ((f)PALM)3,4 and (direct) stochastic optical reconstruction 
microscopy ((d)STORM)5,6. All these techniques achieve image 
resolution beyond the diffraction limit by controlling the state 
of fluorophores such that only a small subset of them are detect-
able at any given time. However, super-resolution approaches can 
be generally divided into the following two groups according to 
the specific mechanism for controlling the fluorophore state7: 
(i) illumination-pattern-based (SIM and STED) and (ii) single- 
molecule-localization-based (PALM and STORM) methods. All 
these super-resolution methods have been successfully used to 
reveal biological insights8–12, but each has its own advantages 
and difficulties. A practical advantage of both illumination-based 
methods is that they do not require specific fluorophores, which 
makes these techniques straightforward to use for biologists with 
conventional samples. However, instrumental implementations 
are typically more complex and intricate. By contrast, the branch 
of localization-based techniques uses stochastic blinking of spe-
cific fluorescent probes. This blinking permits them to be observed 
one at a time so that their spatial coordinates can be localized with 
subdiffraction precision13. Typically, this blinking is an intrinsic 
property of fluorescent proteins (PALM) or specific organic dyes 
(STORM), which can be provoked by specific excitation schemes 
and buffer conditions14,15. Although instrumentation is typically  

simpler for localization-based as compared with illumination-
based modalities, the complexity lies in achieving suitable blink-
ing behavior of the dyes. Troubleshooting often means testing a 
number of parameters such as the choice of dye, labeling den-
sity, buffer conditions and excitation illumination, making the 
blinking a hard-to-control phenomenon. In fact, the choice of 
‘well-behaving’ probes is limited, and further development of 
substantially improved probes is complex and time-consuming. 
Moreover, because of the limited choice of probes with appropri-
ate blinking kinetics, photon rates and excitation conditions, mul-
tiplexing is still difficult to implement. Furthermore, the complex 
photophysics of the probes impedes the predictability of blinking 
events so that quantitative image interpretation is error-prone. 
Last, owing to limited photon rates and bleaching, optimal locali-
zation precision and spatial sampling are still not achieved—the 
two major factors in resolution16. Although many biological ques-
tions could be addressed with the aforementioned techniques8–12, 
researchers are still struggling with these complications to truly 
exploit the power of super-resolution microscopy.

A different route to single-molecule localization microscopy 
is PAINT17. Here, instead of labeling target molecules with fixed 
fluorophores, freely diffusing dyes17 or dye-labeled ligands (as in 
uPAINT)18 target molecules of interest by permanent or transient 
binding. PAINT is straightforward to implement and does not 
require special experimental conditions to obtain photoswitch-
ing, as long as probes are able to diffuse and reach their target 
molecules. However, PAINT’s original implementation makes it 
difficult to specifically label a larger variety of biomolecules, as 
interactions are mainly limited to hydrophobic interactions or 
electrostatic coupling and are thus difficult to program.

DNA nanotechnology represents a promising tool for utiliz-
ing the advantages of the PAINT concept and establishing a pro-
grammable target–probe interaction system at the same time. 

Super-resolution microscopy with DNA-PAINT
Joerg Schnitzbauer1–3, Maximilian T Strauss1–3, Thomas Schlichthaerle1,2, Florian Schueder1,2 & Ralf Jungmann1,2

1Department of Physics and Center for Nanoscience, Ludwig Maximilian University, Munich, Germany. 2Max Planck Institute of Biochemistry, Martinsried, Germany.  
3These authors contributed equally to this work. Correspondence should be addressed to R.J. (jungmann@biochem.mpg.de).

Published online 18 May 2017; doi:10.1038/nprot.2017.024

Super-resolution techniques have begun to transform biological and biomedical research by allowing researchers to observe 
structures well below the classic diffraction limit of light. DNA points accumulation for imaging in nanoscale topography (DNA-
PAINT) offers an easy-to-implement approach to localization-based super-resolution microscopy, owing to the use of DNA probes. 
In DNA-PAINT, transient binding of short dye-labeled (‘imager’) oligonucleotides to their complementary target (‘docking’) strands 
creates the necessary ‘blinking’ to enable stochastic super-resolution microscopy. Using the programmability and specificity of DNA 
molecules as imaging and labeling probes allows researchers to decouple blinking from dye photophysics, alleviating limitations 
of current super-resolution techniques, making them compatible with virtually any single-molecule-compatible dye. Recent 
developments in DNA-PAINT have enabled spectrally unlimited multiplexing, precise molecule counting and ultra-high, molecular-
scale (sub-5-nm) spatial resolution, reaching ~1-nm localization precision. DNA-PAINT can be applied to a multitude of in vitro 
and cellular applications by linking docking strands to antibodies. Here, we present a protocol for the key aspects of the DNA-
PAINT framework for both novice and expert users. This protocol describes the creation of DNA origami test samples, in situ sample 
preparation, multiplexed data acquisition, data simulation, super-resolution image reconstruction and post-processing such as 
drift correction, molecule counting (qPAINT) and particle averaging. Moreover, we provide an integrated software package, named 
Picasso, for the computational steps involved. The protocol is designed to be modular, so that individual components can be chosen 
and implemented per requirements of a specific application. The procedure can be completed in 1–2 d. 
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Specifically, DNA-based PAINT (DNA-PAINT) has been devel-
oped as a straightforward approach to overcome some limitations 
of current localization-based super-resolution techniques19–24. 
Similar to the original PAINT concept, DNA-PAINT decouples 
blinking from dye photophysics, but it also adds the program-
mability and specificity of using DNA molecules as imaging and 
labeling probes. A DNA-PAINT system, illustrated in Figure 1a, 
consists of the following two components: a docking strand and 
an imager strand. These are short, complementary single-stranded 
DNA oligomers, usually 8–10 nucleotides long. Although the 
docking strand is fixed to a biological target of interest (e.g., using 
standard immunolabeling approaches with DNA-conjugated 
antibodies targeting proteins of interest25 or direct hybridiza-
tion of docking strands to DNA or RNA molecules), the imager 
strand is conjugated to an organic dye and diffuses freely in the 
imaging buffer. Generally, imager strands appear undetectable 
in the camera because they diffuse over numerous camera pixels 
during the duration of a single frame. However, owing to their 
complementary sequence, imager strands can transiently bind 
to docking strands. During the bound state, imager strands are 
fixed at the same place for an extended amount of time, allowing 
the camera to accumulate enough photons from the dye to be 
detected. The binding duration depends solely on the stability of 
the formed DNA duplex, and can hence be programmed at will 
(e.g., by modulating strand length, GC content, temperature or 
salinity of the imaging buffer). On the other hand, the frequency 
of binding events is tunable by the influx rate of imager strands 

(e.g., by modulating either the concentration of imager strands 
in the buffer or the association constant). As a result, the user has 
fine control over the blinking kinetics, which is independent of 
dye properties or illumination specifics. To date, DNA-PAINT 
has been used to resolve nanometer-scale structures of DNA ori-
gami (Fig. 1b), as well as those of cellular proteins, by conjugating 
docking strands to antibodies (Fig. 1c–e).

Advantages and limitations of the method
The properties of DNA-PAINT result in several improvements 
over more traditional super-resolution approaches. First, the 
use of DNA-based imaging probes enables high multiplexing by 
Exchange-PAINT20 that is restricted only by the number of orthog-
onal DNA sequences, as compared with the spectrally distinct 
dyes used in classic multiplexing experiments. Figure 2 illustrates 
the concept, procedure and results of Exchange-PAINT experi-
ments in vitro and in situ. When tagging biological targets with 
orthogonal docking strand sequences, they can be probed sequen-
tially by the respective complementary imager strands (Fig. 2a).  
Specifically, after one DNA-PAINT image has been acquired, the 
buffer can be exchanged to introduce a different imager strand 
species. Repeated imaging, washing and reintroduction of new 
imager strand species then allows researchers to create a multi-
plexed image of many biological targets. Although we have thus 
far demonstrated nine-target super-resolution imaging25, multi-
plexing could reach thousands of species, as the only limitation is 
the orthogonality of DNA-PAINT sequences.
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Figure 1 | DNA-PAINT. (a) DNA-PAINT concept. Transient binding of dye-labeled DNA strands (imagers) to their complementary target sequence (docking  
site) attached to a molecule of interest. The transient binding of imager strands is detected as ‘blinking’, illustrated by the intensity versus time trace.  
(b) Diffraction-limited (left) and super-resolved DNA-PAINT images (right) of DNA origami nanostructures. Each structure consists of 12 docking strands  
that are arranged in a 20-nm grid (scheme in lower right corner). (c) In situ protein-labeling strategy for DNA-PAINT using primary and DNA-conjugated 
secondary antibodies. (d) Overlay of a diffraction-limited α-tubulin image (top left) with a super-resolved DNA-PAINT image (bottom right). (e) Close-ups of the  
highlighted area in d, comparing diffraction-limited image (left) with DNA-PAINT super-resolved image (right). Scale bars, 100 nm (b), 2 µm (d), 500 nm (e).
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Second, the predictability and tunability of DNA binding and 
unbinding events, combined with effectively nonexistent bleach-
ing, allow for accurate quantitative image interpretation (i.e., 
counting of single molecules in an integer manner), implemented 
in quantitative PAINT (qPAINT)22. Figure 3 depicts the qPAINT 
concept, procedure and results. A more detailed description of 
the method will be given below.

Third, DNA-PAINT simplifies the selection of suitable dyes 
for imaging, as the parameter space is reduced from rather com-
plex photophysical properties (e.g., switching behavior) to basi-
cally a single parameter—the photon budget. This also means 
that DNA-PAINT can use a large pool of existing fluorophores 
that were previously not applicable to localization-based super- 
resolution microscopy.

Finally, by programming the binding duration, an extremely 
high number of photons can be detected from a single binding 
(or blink) event, enabling optimal localization precision. The 
only limitations regarding the achievable photon budget are 
experimental time and photobleaching during a single bind-
ing event. However, the latter can be greatly reduced by specific 
imaging buffer compositions, such as oxygen-scavenging systems  

and triplet-state quenchers26–28. Even if bleaching of individ-
ual dyes does occur, it has only a minimal detrimental effect 
overall, because of the practically infinite supply of replenish-
able ‘fresh’ imager strands from solution. All things considered,  
photobleaching—which is a considerable complication for all 
other super-resolution techniques—is eliminated as a restric-
tion on achieving optimal sampling of the biological structure 
under investigation. Such optimized experimental conditions 
for high localization precision, combined with intricate drift 
correction methods, enable imaging at thus far unprecedented 
resolution in optical microscopy, for the first time enabling true 
molecular-scale resolution23, which, to our knowledge, has not 
been achieved using any other super-resolution method. Example 
results of images with localization precisions of ~1 nm, yield-
ing resolution better than 5 nm, and intermediate results of the 
applied drift correction are shown in Figure 4. To achieve these 
results, a large number of DNA origami structures were used as 
drift markers, considering first the whole structure, followed by 
the use of individual DNA-PAINT binding sites as fiducials. To 
eventually translate the in vitro ultra-resolution achievements to 
in situ samples such as fixed cells, a key challenge is the labeling 

Time

ON

OFF

P2

P1

Pn

P1*

P1*

P2

P1

Pn

P2

P1

Pn

P2*
P2*

P2

Pn

Imaging with P1*a

d e f g

b cWashing Overlay of n cycles

P1*
P2*

Imaging with P2*

P1

Fluid exchange
for in vitro samples

Fluid exchange
for in situ samples

DNA origami

5 
nm

Figure 2 | Exchange-PAINT. (a) Schematic representation of sequential Exchange-PAINT imaging of multiple targets with orthogonal sequences using the same 
fluorophore. Left to right: P1* imager strands are in solution and interact with their complementary target sequence, P1. After the first acquisition round, 
the P1* imager strands are washed away and P2* imagers are introduced to image the next target. This is then repeated for the remaining target cycles, and 
pseudocolors are assigned for each respective imaging round. Last, all rounds are aligned and overlaid to form the final multiplexed Exchange-PAINT image 
of n targets. (b) Fluid exchange chamber for in vitro samples (e.g., for DNA origami imaging). Liquid is introduced by pipetting into the inlet. The outlet is 
attached to a syringe with a flexible tube to remove the liquid. (c) Fluid exchange chamber for in situ samples (i.e., used for in situ cellular imaging). Two 
tubes with syringes are connected to an 8-well chambered cover glass to facilitate fluid exchange. (d) Two rounds (‘colors’) Exchange-PAINT image of a frame-
like DNA origami structure carrying two orthogonal docking strand species (red and cyan; see also f, for design schematics). (e) Pseudocolor image after 
alignment of the imaging rounds using Picasso’s automated align function. (f) Top: DNA origami design. Bottom: Close-up (white box from e) of one frame-like 
structure. The distance between red and blue handles is ~5 nm. (g) In situ Exchange-PAINT image of protein targets a-tubulin (red) and Tom20 (cyan) with 
two primary and DNA-conjugated secondary antibody sandwiches. Inset: Images of one alignment marker (gold nanoparticle) in each Exchange-PAINT round 
without channel alignment (top), after Picasso’s automated cross-correlation analysis (middle) and after manually selecting the particle as an alignment 
fiducial (bottom). Scale bars, 100 nm (d, e), 20 nm (f), 2 µm (g), 300 nm (g, insets).
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probe size. The size of the labeling probes introduces a linkage 
error and effectively limits the labeling density (because of sterical 
hindrance). Both these effects finally limit the achievable resolu-
tion. One way to address these issues in cells could be the use of 
smaller labeling agents such as nanobodies29 or aptamers30, rather 
than antibodies.

Although DNA-PAINT offers several advantages over tradi-
tional super-resolution techniques, as discussed above, we also 
note that there are currently limitations. One disadvantage is the 
fact that ‘imager’ strands are nonfluorogenic, with the following 
two implications: first, DNA-PAINT is limited to optical section-
ing techniques such as total internal reflection (TIR), oblique31 
or light-sheet32 illumination because of elevated background 
fluorescence originating from unbound imager strands. Second, 
the nonfluorogenic nature of imager strands furthermore sets 
an upper limit to the achievable image acquisition speed as com-
pared with those of STED, PALM, STORM or SIM. Furthermore, 
DNA-PAINT applications are currently limited to fixed speci-
mens. Live-cell imaging could be more difficult to achieve as  
compared with the aforementioned techniques, because of the 
complexity of infusing dye-labeled nucleic acid strands into liv-
ing cells and the unforeseen consequences of introducing nucleic 
acids in general. However, we note that DNA-PAINT applications 
to molecules on cell surfaces such as membrane-bound receptors 
should be feasible even for living cells.

All in all, the DNA-PAINT imaging framework greatly reduces 
many technical difficulties of localization-based super-resolution 
microscopy and opens up possibilities for new technical devel-
opment and biological applications. It will therefore allow many 
research groups to address their biological question with much 
greater efficiency. To ease the adoption of DNA-PAINT for novice 
and expert researchers in the super-resolution field, this proto-
col details the involved procedures and provides an integrated  
software package, named Picasso, which is specifically designed 
for DNA-PAINT applications. Except for data acquisition, Picasso 
can handle all computational efforts required in this protocol, 
including in silico data simulation, DNA origami design, and 
basic and advanced functionality for localization-based super- 
resolution microscopy.

Overview of the main procedures
The overarching goal of this protocol is to enable both novices 
and expert users to quickly obtain high-quality DNA-, Exchange-
PAINT and qPAINT imaging data in silico, in vitro and in situ, 
without prior expertise in super-resolution microscopy. Here, we 
are using the term in vitro for DNA-PAINT studies with DNA ori-
gami structures on BSA/biotin/streptavidin-coated glass slides. By 
contrast, in situ is used to describe experiments involving fixed-cell 
samples. The protocol is based on several studies19,20,22,23,25 and is 
arranged into four major sections, as illustrated in Figure 5: sample 
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Figure 3 | qPAINT. (a) Design schematics for two DNA origami structures with 12 target sites spaced 20 nm apart (top, black-dotted box) and 42 binding sites 
spaced 10 nm apart (bottom, gray-dotted box), respectively. (b) DNA origami structures with 12 binding sites (top) exhibit fewer binding (blinking) events 
as compared with structures with 42 binding sites (bottom), resulting in longer dark times (τd1) and shorter dark times (τd2) for the 20-nm grids and 10-nm 
grids, respectively. (c) Mean dark times τd1 and τd2 are obtained by fitting the cumulative distribution function of the dark times. (d) To measure binding 
sites for a structure of interest, DNA origami nanostructures are used to calibrate the influx rate (here displayed as the number of blinks per frame). Visual 
inspection of the DNA origami defines the units (or binding sites) per pick (here only origami displaying 12 binding sites are picked for calibration, top) and 
can be used to calculate the influx rate (Picasso software dialog, bottom). (e) Visual inspection of 20-nm-grid DNA origami structures in comparison with 
qPAINT-predicted binding sites after calibration shows good agreement. (f) Visual comparison of 10-nm-grid DNA origami with predicted binding sites via 
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green, n = 1,818). Scale bars, 50 nm.
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preparation (in vitro and in situ), data acquisition, image recon-
struction and image post-processing. For sa mple preparation, 
we describe the following two procedures: in vitro imaging (i.e., 
of DNA origami nanostructures) (Steps 1–18; Box 1) and in situ 

imaging (i.e., of cell samples) (Steps 19–33). Although not covered 
in this protocol, the procedures could be adjusted for DNA-PAINT 
imaging in tissue or whole organisms. Subsequently, we explain 
data acquisition (Steps 34–49), including a detailed procedure  
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translational
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c d

NeNA localization precision = 1.4 nm
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Figure 4 | ‘Ultra-resolution’ with DNA-PAINT. (a) Workflow for ultra-resolution imaging with advanced drift correction and particle averaging. (b) Multistage 
drift correction with Picasso. Top: 20-nm-grid DNA origami structures used as reference structures and drift markers. Bottom: DNA origami target structure 
(designed to display the letters ‘MPI’ (upside down) with 5-nm ‘docking strand resolution’) present in the same sample as the 20-nm origami. In the first 
drift correction stage, an RCC procedure is applied to the whole field of view (image column after RCC arrow shows results). The second step uses Picasso’s  
semiautomated particle pick function (picked structure visualized by yellow circle) to select 1,675 DNA origami structures as fiducials for drift correction 
(drift for all structures is globally averaged and subtracted from the localization data). The result for this step is depicted in the third column. The third and 
last iteration uses the individual binding sites of the 20-nm grid for drift correction. Here, 29,157 binding sites were used as fiducial markers. The resulting 
image for the MPI target structures shows clearly resolved single binding sites spaced 5 nm apart. (c) Selection of two MPI origami after drift correction. 
Localization clusters of individual DNA-PAINT binding sites with a distance of ~5 nm are well resolved and circular, indicating that the residual drift is 
minimal and rotationally invariant. (d) Selection of two DNA origami, designed to show the letters ‘LMU’, from a different sample than in b,c,e, but after an 
analogous drift correction as shown in b. The images demonstrate minimal residual drift similar to that of the MPI structures shown in c. (e) Average image 
of 295 DNA origami with the letters ‘MPI’. The mean number of localizations in individual images is 3,485 ± 1,197. All DNA-PAINT binding sites are visible, 
even though individual images miss binding sites because of incomplete strand incorporation, as seen in c. (f) Average image of 215 DNA origami with the 
letters ‘LMU’. The mean number of localizations in the individual images is 2,323 ± 436. Scale bars, 10 nm (c–f). 
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to achieve very high spatial resolution (<5 nm) with DNA-PAINT, 
which requires particular care in sample preparation and data 
acquisition (Box 2). Furthermore, we lay out the procedure to 
simulate typical DNA-PAINT data in silico for test and optimiza-
tion purposes (Box 3). Then, image reconstruction is explained 
in two steps: fitting of single-molecule spots and subsequent ren-
dering of the super-resolution image (Steps 50–58). Finally, we 
describe multiple procedures for post-processing such as drift 
correction (Steps 59 and 60), selection of regions of interest (Steps 
61–68), filtering of localizations (Step 69A), quantitative imaging 
with qPAINT (Step 69B and C), particle averaging (Step 69D) and 
channel alignment for multiplexed images (Step 69E). Additional 

steps required for multiplexed imaging with Exchange-PAINT are 
described as optional steps in the respective sections.

One of the defining components of this protocol for DNA-
PAINT is an integrated software package called Picasso, which ena-
bles researchers to quickly obtain meaningful reconstructed image 
results without the need of additional third-party software tools.

The Picasso software package
Like similar localization-based super-resolution methods, DNA-
PAINT requires intricate data analysis. For that matter, we provide 
an integrated software package named ‘Picasso’ (free to download 
from http://www.jungmannlab.org). Although Picasso is suitable 
for any localization microscopy technique, it provides specific 
support for DNA-PAINT applications, e.g., qPAINT. All compu-
tational steps described in this protocol can be performed with 
Picasso. This includes designing of DNA origami structures and 
simulating typical DNA-PAINT data. After installation, Picasso is 
available as several stand-alone (but interlinked) modular compo-
nents with graphical user interfaces. The components are named 
‘Design’, ‘Simulate’, ‘Localize’, ‘Filter’, ‘Render’ and ‘Average’. The 
‘Design’ component allows the user to visually design rectan-
gular 2D DNA origami structures, which we call Rothemund’s 
rectangular origami (RRO)33, with DNA-PAINT handles. For 
that matter, ‘Design’ autogenerates order lists and pipetting 
instructions. With ‘Simulate’, the user may generate typical 
DNA-PAINT raw data from in silico simulations. After data have 
been acquired or simulated, the ‘Localize’ component allows the 
user to identify and fit the coordinates of single-molecule spots.  
‘Picasso: Filter’ offers a convenient tool to inspect the localization 
list, plot histograms of localization properties and filter locali-
zations with undesired properties. Super-resolution images can 
be rendered and inspected with the Picasso component ‘Render’. 
‘Picasso: Render’ also offers various post-processing func-
tions such as advanced drift correction and quantitative image 
evaluation by qPAINT. Last, the ‘Average’ module provides the 
functionality to perform particle averaging (i.e., rotational and 
translational alignment) of multiple images of the same structure. 
Analogous to single-particle reconstruction in the electron micro-
scopy field, this procedure helps to improve the signal-to-noise 
ratio of images. Overviews of the graphical user interfaces for the 
‘Design’, ‘Simulate’, ‘Localize’, ‘Render’ and ‘Filter’ components are 
shown in Supplementary Figures 1–5.

Although in principle a cross-platform development, we 
currently supply a one-click installer of Picasso for Microsoft 
Windows 64-bit operating systems. This single executable  
setup file can be downloaded from our website at http://www.
jungmannlab.org. Picasso is developed in Python, and the source 
code is available at https://github.com/jungmannlab/picasso.

Design and preparation of DNA origami structures
As DNA-PAINT makes use of the programmability of (transient) 
DNA strand hybridization to enable super-resolution imaging, 
DNA-based objects are convenient in vitro test targets for imaging. 
Nucleic acids can serve as powerful building blocks for nanom-
eter-scale structures based on sequence-guided self-assembly, 
which is the foundation of structural DNA nanotechnology34,35. 
DNA origami are complex, self-assembled, 2D or 3D struc-
tures created by annealing DNA strands of specifically designed 
sequences33. In DNA origami, a long single-stranded DNA 

In situ
Labeling
sample

preparation

19 – 33
Box 1

In vitro
Design
sample

preparation

1 – 18

In silico

Filter

Picking

Average
Kinetics/
qPAINT

Image
recon-

struction
50 – 58

Image
postpro-
cessing
59 – 60

Box 3

69A

61– 68

69B/C 69D

Ultra- 
resolution

Box 2

Channel
alignment

69E

Sample
preparation

Data
acquisition

34 – 49

Figure 5 | DNA-PAINT protocol workflow. Starting with sample preparation, 
the user can perform either in vitro or in situ experiments. Next, data 
acquisition is performed (parameters for ‘Ultra-resolution’ are described 
in Box 2). The user may additionally generate DNA-PAINT data by in silico 
simulations. During image reconstruction, single-molecule fluorescence 
spots are localized, and resulting super-resolution images are visualized with 
‘Picasso: Render’. Image post-processing focuses first on drift-correction 
procedures. Then, special emphasis is given to analyzing the localization-
based DNA-PAINT data through picking regions of interest, performing 
kinetic and qPAINT analysis, averaging images for ultra-resolution analysis 
and channel alignment for Exchange-PAINT or filtering of the localization 
list. Program icons indicate in which Picasso component the respective step 
is performed—hexagons: ‘Design’; microchip: ‘Simulate’; mountain peaks: 
‘Localize’; paint palette: ‘Render’; funnel: ‘Filter’; stacked layers: ‘Average’. 
The Picasso program icons are based on contributions from the Noun Project 
(https://thenounproject.com)—‘Design’: hexagon by Creative Stall;  
‘Simulate’: microchip by Futishia; ‘Localize’: mountains by Montana Rucobo; 
‘Filter’: funnel by José Campos; ‘Render’: paint palette by Vectors Market; 
‘Average’: layers by Creative Stall.
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molecule (called the ‘scaffold’, derived from M13mp18 single-
stranded phage DNA) is folded into a desired shape by ~200 short,  
single-stranded DNA strands (called ‘staples’). Each staple has 
a defined sequence and specifically binds certain parts of the 
scaffold together. Structures are usually assembled in a one-pot 
reaction using thermal annealing. After the self-assembly is com-
pleted, the scaffold is ‘folded’ into the desired shape with the staple 
strands at prescribed positions in the final origami.

The rather complex and time-consuming procedure of manu-
ally designing DNA origami structures has been markedly simpli-
fied by computer-aided design tools, such as the freely available 
caDNAno36 and vHelix37 packages, as well as by simulation  
programs such as CanDo38. Furthermore, folding protocols for 
structure formation are now optimized for structure yield and 
folding speed39–41. In addition, several methods for subsequent 
purification of DNA nanostructures from unwanted excess of sta-
ple strands are described in the literature, such as agarose gel puri-
fication42, rate-zonal centrifugation43 or PEG purification44.

One of the early applications of DNA origami was its use as a 
microscopy standard in the form of a self-assembled nanoruler45. 
Owing to the unique positioning accuracy of DNA origami and 
its excellent structural integrity, the structures present an ideal 
platform to directly validate imaging methods and compare 
instrumentation. Specifically, they are a valuable tool in calibrat-
ing fluorescence and super-resolution microscopes46.

Although it is possible to create a wide range of structures with 
the DNA origami technique, some are more suitable for use as a 
reference structure with DNA-PAINT than others. In this proto-
col, we use a flat, rectangular 2D DNA origami structure, adapted 
from the one originally described33, here referred to as RRO. With 
dimensions of 90 × 70 nm and, in our case, 176 freely address-
able staples arranged in a hexagonal lattice with 5-nm spacing, 

it is an ideal structure for DNA-PAINT imaging (see Fig. 1b  
as an example). For surface immobilization, the structure is 
modified with eight biotinylated staple strands that can bind to 
a BSA–biotin–streptavidin-coated glass surface.

‘Picasso: Design’ is an essential tool in this protocol that reduces 
all design steps to a minimum. Figure 6 shows screenshots and 
outlines the procedure for creating DNA origami, from design to 
purification. For a detailed overview of the graphical user inter-
face, refer to Supplementary Figure 1. The program displays a 
hexagonal lattice that serves as a canvas representing all possible 
staple positions available for modification in the RRO struc-
ture. It features a ‘point-and-click’ approach, so that the desired  
pattern can be made by simply ‘painting’ on the canvas. Clicking 
a hexagon will fill it with a previously selected color; each color 
corresponds to a built-in staple extension on the 3′-end. As all 
modifications are just staple extensions of the RRO structure, 
the core sequences are not altered, and time-consuming tasks 
such as altering the routing of staples or modifying their base 
sequence are not necessary. In addition, ‘Picasso: Design’ auto-
matically calculates folding recipes for a given design based on 
optimized excess rates for the RRO and creates visual pipetting 
aids for 96-well plates so that pipetting of staple mixes is greatly 
facilitated. In consequence, the creation of DNA origami refer-
ence structures for DNA-PAINT can be achieved in the most  
straightforward way.

In situ sample preparation
A unique advantage of fluorescence microscopy, making it one 
of the preferred characterization tools in biological research, is 
its ability to interrogate biomolecules of interest, such as proteins 
or nucleic acids, with high efficiency and specificity. Generally,  
fluorescent labeling of target molecules is achieved either by 

Box 1 | Construction of a fluid exchange chamber for in situ imaging  
● TIMING 30 min 
Procedure
For in situ Exchange-PAINT experiments, we recommend a simple, custom-built fluid exchange system. The lid of an 8-well chambered 
cover glass can be modified with one inlet and one outlet, which can be connected to imaging and washing buffer reservoirs by 
silicone tubing. The modified lid can be used for multiple imaging experiments, although the connected tubing should be thoroughly 
cleaned before reuse. Using a syringe, flush at least 3 ml (as reference for 1-m tubing with a 1.5-mm diameter; adjust accordingly) of 
H2O, followed by 3 ml of 80% EtOH and finally 3 ml of H2O, through the tubing. Follow these instructions to prepare such a lid:
1. Drill two holes with a diameter of 1.5 mm into the lid of an 8-well chambered cover glass, so that two needles can penetrate it.
2. Use a rotary tool with cutting disc or equivalent to remove the syringe connectors from two 1.2 × 40-mm needles. Alternatively, use 
a side cutter (although this could potentially lead to a ‘less clean cut’) and squeeze the channel shut. To reopen, carefully apply pres-
sure with the side cutter at the side of the cut. Make sure that the needle is at least 2.5 cm long to be able to reach the bottom  
of the chambered cover glass.
! CAUTION Handle the needles with care and do not puncture yourself.
3. Cut away the sharp end of one of the needles, so the channel can reach the bottom of the wells. Carefully apply pressure to open 
the metallic channel of the needle at the cut side with the side cutter.
! CAUTION Handle the needles with care and do not puncture yourself.
4. Connect the cut needles to ~50 cm of tubing. Make sure that the tubing is long enough that there is enough space to handle the 
liquids and syringes at the microscope. To connect the tubing to the syringes, use 1.1 × 40-mm needles on the other end of the tubing.
 CRITICAL STEP The length of the tubing depends heavily on the accessibility of the microscope; adjust the tubing length for proper 
handling.
5. For imaging, fix the tubing to the microscope body via tape.
 CRITICAL STEP Leakage could lead to damage of the microscope. Check all tubing and connections before use.

54 dna-paint and super-resolution microscopy
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genetically fusing a protein tag to the target47 or by attaching an 
external binder molecule during a staining procedure—e.g., dye-
labeled antibodies48. For DNA-PAINT, the labeling requirement 
is that a DNA docking strand is attached to the target. Although 
a variety of strategies could be feasible for that29,30,49–52, this 
protocol focuses on immunostaining with DNA-conjugated anti-
bodies25. Specifically, we describe how antibodies can be chemi-
cally modified and used for in situ DNA-PAINT imaging of fixed  
cells (Steps 19–33).

The concept of in situ DNA-PAINT with primary and sec-
ondary antibody labeling is shown in Figure 1c: imager strands 
from solution transiently bind to handle sites on the secondary 
antibody. Imaging results for in situ samples prepared with anti-
body labeling are shown in Figure 1d,e, displaying a gradient 
overlay of diffraction-limited microtubules in comparison with 
the reconstructed super-resolved image. Furthermore, Figure 2g 
shows DNA DBCO-labeled antibody staining of Tom20, located 
mainly at the outer mitochondrial membrane, and DNA thiol-
labeled antibody staining of microtubules.

Various avenues are possible for attaching DNA strands to 
antibodies, including biotin–streptavidin linkage20 or covalent 
attachment of the DNA to the antibody22,53,54. Although biotin–
streptavidin linkage was used in the initial in situ DNA-PAINT 
demonstration20, we here discuss a covalent attachment strat-
egy, which was used in subsequent work22 similar to previously 
reported strategies for DNA–protein conjugation53,54. Here, an 
NHS ester linker is covalently attached to amino groups on the 
antibody and to certain functional groups on the DNA, such as 
reduced thiols22, azides53,55, alkynes53 or DBCO55, for click chem-
istry. This results in cross-talk-free attachment, as well as smaller 
linker sizes between antibody and DNA strand, as compared with 
the biotin–streptavidin linkage20.

Depending on the target molecules under investigation, it is 
furthermore important to evaluate different fixation strategies. 

For example, structural proteins, such as actin filaments or micro-
tubules, can be fixed with pre-extraction and glutaraldehyde to 
decrease background and preserve structural integrity56. However, 
structural artifacts can arise from the various fixation strategies. 
For an in-depth discussion of fixation artifacts, we refer to a recent 
article by Whelan et al.57. DNA-PAINT was also applied to tissue 
samples, as was recently shown in Drosophila embryos22, generally 
following the same procedures as described here. However, we do 
note that potential changes to the herein described protocol for 
more complex tissue samples might become necessary.

Data acquisition
A multitude of acquisition software packages are available for 
performing localization-based super-resolution microscopy, in 
particular for commercial microscope setups. In this protocol, we 
describe our procedures based on the freely available open-source 
acquisition software µManager58. µManager is used in a wide 
range of microscopy areas and offers broad device support for 
microscope bodies, cameras and peripherals. The Picasso software 
suite is specifically designed to be compatible with µManager.

Currently, two types of cameras are typically used in the field 
of single-molecule localization-based imaging—scientific com-
plementary metal oxide semiconductor (sCMOS)- and electron-
multiplying charge coupled device (EMCCD)-based cameras. 
sCMOS cameras provide better temporal resolution because of 
their faster readout electronics, resulting in a larger optical field 
of view as compared with EMCCDs under similar conditions. 
EMCCD cameras, in comparison, provide better quantum yields 
in low-light applications and thus higher signal-to-noise ratios59. 
As DNA-PAINT provides comparably higher signal-to-noise 
ratios (SNRs), both camera types are suitable in this context.

It has been shown that a pixel-dependent noise calibra-
tion for sCMOS cameras can improve localization precision in 
STORM60. However, for DNA-PAINT experiments—including the  

Box 2 | Ultra-resolution imaging ● TIMING ~7 h 
Procedure
To achieve ultra-resolution (<5 nm), imaging conditions must be carefully adjusted. The key to higher spatial resolution is to extract 
more photons per frame from a blinking event while simultaneously keeping the background low. This can be achieved by optimizing 
the laser excitation power, as well as the fluorescence ON time (and adjusting the integration time accordingly). The background can 
be reduced, for example, by decreasing the imager concentration. In this case, the acquisition time should be increased to ensure  
proper sampling of the target structure. However, with an imager concentration that is too low, drift correction might become less  
accurate owing to the smaller number of localizations per frame. We also want to note that the number of drift markers in a field of 
view should be as high as possible, to ensure precise drift correction. One way to achieve this is to make use of the larger field of  
view obtainable with today’s sCMOS cameras. For advanced drift correction, a 20-nm and a 10-nm grid DNA origami should be used  
as fiducials. Furthermore, oxygen-scavenging systems, such as the PCA/PCD/Trolox (PPT) system, allow the harvesting of more photons  
as they increase fluorophore stability27. The following steps describe in detail how to achieve ultra-resolution for imaging DNA  
origami structures.
1.  Design and fold DNA origami structures for ultra-resolution imaging—e.g., the LMU or MPI logo. In addition, fold 20-nm and  
10-nm grid DNA origami for use as drift markers (see Steps 1–17).
2. Prepare the oxygen-scavenging system PPT at least 1 h before imaging.
3. Prepare a sample with the target structure and DNA origami drift markers (see Step 18) using the following parameters:
● Origami solution ratio: 1/4 target structure (i.e. LMU or MPI logo), 1/4 20-nm drift marker, 1/4 10-nm drift marker  
and 1/4 Buffer B+
● Imager concentration (with PPT): 0.5 nM–1 nM.
4. Follow steps 34–48 with the following adjustments: 350 ms exposure time, 80,000 total number of frames. Set the excitation power 
density to ~4.5 kW/cm2 at the sample plane.
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ultra-resolution measurements in this protocol—we did not 
account for the pixel-dependent noise of our sCMOS camera. 
Although such calibration might also improve DNA-PAINT 
image quality, it was not required to achieve the ~1-nm localiza-
tion precision that allowed us to resolve 5-nm spaced binding sites 
on DNA origami structures (Fig. 4).

In this protocol, we generally suggest rather long camera inte-
gration times (a few hundred milliseconds) as compared with 
other localization-based microscopy methods such as PALM or 
STORM. Typically, for localization-based super-resolution tech-
niques, the integration time is roughly matched to the ON-time  
of blink events to maximize the signal-to-noise ratio of the fluo-
rescence image. Analogously, the integration times suggested here 
are roughly matched to the binding kinetics of the recommended 
nine-base-pair DNA duplex. This allows the collection of far more 

photons in a single frame as compared with typical PALM or 
STORM experiments, thus enabling better localization precision. 
However, it is worth noting that the combination of slower blink-
ing and longer integration time comes at the expense of extended 
total data acquisition time to detect the same number of events. 
Nonetheless, it is certainly possible to shorten the binding duration,  
integration time and thus the total acquisition time by using DNA 
duplexes with fewer base pairs. For example, the recommended 
integration time for 8-mers is only tens of milliseconds and that 
for 7-mers is even less. With such faster kinetics, the integra-
tion time and achievable localization precision would then be 
similar to those in PALM or STORM experiments. An advantage 
of DNA-PAINT is therefore that it gives the researcher intricate 
control over the desired localization precision as a trade-off for 
total acquisition time.

Box 3 |  In silico simulation of DNA-PAINT data ● TIMING 10–60 min 
Picasso’s simulation module (‘Picasso: Simulate’) is a tool for evaluating experimental conditions for DNA-PAINT and generating ground-
truth data for test purposes. This allows systematic analysis of how different experimental parameters such as imager concentration, 
target density or integration time influence the imaging quality and whether the target structure can be resolved with DNA-PAINT.
By default, ‘Picasso: Simulate’ starts with preset parameters that are typical for a DNA-PAINT experiment. Thus, meaningful raw  
DNA-PAINT data can be readily simulated for a given input structure without the need of a super-resolution microscope. The simulation 
output is a movie file in .raw format, as it would be generated during an in vitro DNA-PAINT experiment on a microscope.

Procedure
1. Start ‘Picasso: Simulate’.
2. Define the number and type of structures that should be simulated in the group ‘Structure’. Predefined grid- and circle-like structures 
can be readily defined by their number of columns and rows, or their diameter and the number of handles, respectively. Alternatively, 
a custom structure can be defined in an arbitrary coordinate system. To do so, enter comma-separated coordinates into ‘Structure X’ 
and ‘Structure Y’. The unit of length of the respective axes can be changed by setting the spacing in ‘Spacing X,Y’. For each coordinate 
point, an identifier for the docking site sequence needs to be set in ‘Exchange labels’ as a comma-separated list. Correctly defined 
points will be updated live in the ‘Structure [nm]’ window. Note that entries with missing x coordinate, y coordinate or exchange label 
will be disregarded. When a structure has been previously designed with ‘Picasso: Design’, it can be imported with ‘Import structure 
from design’. A probability for the presence of a handle can be set with ‘Incorporation’. By default, all structures are arranged on a  
grid with boundaries defined by ‘Image size’ in ‘Camera parameters’ and the ‘Frame’ parameter in the ‘Structure’ group. ‘Random  
arrangement’ distributes the structures randomly within that area, whereas ‘Random orientation’ rotates the structures randomly.  
Selecting the button ‘Generate positions’ will generate a list of positions with the current settings and update the preview panels.  
A preview of the arrangement of all structures is shown in ‘Positions [Px]’, whereas an individual structure is shown in ‘Structure [nm]’.
3. The group ‘PAINT Parameters’ allows adjustment of the duty cycle of the DNA-PAINT imaging system. The mean dark time is  
calculated by τd = (kon·c)−1. The mean ON time in a DNA-PAINT system is dependent on the DNA duplex properties. For typical 9-bp 
imager/docking interactions, the ON time is ~500 ms. ON times can be experimentally estimated with Picasso as described in Step 69B.
4. In ‘Imager Parameters’, fluorophore characteristics such as PSF width and photon budget can be set. Adjusting the ‘Power density’ 
field affects the simulation analogously to changing the laser power in an experiment.
5. The ‘Camera parameters’ group allows the user to set the number of acquisition frames and integration time. The default image size 
is set to 32 pixels. As the computation time increases considerably with image size, it is recommended to simulate only a subset of the 
actual camera field of view.
6. Select ‘Simulate data’ to start the simulation. The simulation will begin by calculating the photons for each handle site of every 
structure and then converting it to a movie that will be saved as a .raw file, ready for subsequent localization. All simulation settings 
are saved and can be loaded at a later time with ‘Load from previous simulation’.
?  TROUBLESHOOTING
7. (Optional step for multiplexing) Multiplexed Exchange-PAINT data can be simulated by adjusting the ‘Exchange Labels’ setting.  
For each handle in the custom coordinate system (‘Structure X’, ‘Structure Y’), an Exchange round can be specified. The different  
imaging rounds can be visually identified by color in the ‘Structure [nm]’ figure. For each round, a new movie file will be generated.  
By default, the simulation software detects the number of exchange rounds based on the structure definition and will simulate all  
multiplexing rounds with the same imaging parameters. It is possible to have different imaging parameters for each round, e.g.,  
when using image s with different ON-times. To do so, one can simulate multiplexing rounds individually. In the ‘Exchange rounds  
to be simulated’ field, enter only the rounds that should be simulated with the current set of parameters. Change the set parameters 
and the multiplexing round and simulate the next data sets. Repeat until all multiplexing rounds are simulated.
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The number of localizations and thus the total experiment time 
strongly influence the resolution of a localization-based super-
resolution image. Ideally, to resolve a target structure, it should 
be spatially probed at least at its Nyquist frequency61. More pre-
cisely, it has been shown that the overall image resolution for 
localization-based super-resolution microscopy is governed by 
two main factors: sampling density and localization precision16. 
In the same work, it was demonstrated that longer acquisition 
times increase spatial resolution of the reconstructed image 
because of increased spatial sampling up to the point at which 
image resolution is solely limited by localization precision. As the 
molecule density of a target structure might be unknown, it is 
often necessary to evaluate a range of acquisition times to deter-
mine how many frames are sufficient to represent the structure 
with the desired resolution. In silico simulations of localization- 
based super-resolution imaging can be a practical method of 
assaying a large number of data acquisition parameters such as 
the total acquisition time62, reducing the need for time-con-
suming experiments. The Picasso software package comes with 
a module for simulating DNA-PAINT data, thus providing the 
tools for this approach. A more detailed discussion of the ‘Picasso: 
Simulate’ module follows below. Finally, we want to provide an 
exemplary thought-experiment as a guide to estimating appro-
priate acquisition lengths t. Consider an imager concentration 

c of 10 nM and a probe association rate kon of 106 (Ms)−1. This 
leads to a mean time in between binding events (or dark time 
τd) for a single site of 100 s according to τd = (kon × c)−1. For an 
~98% probability (P) of any single binding site being visited at 
least once, a total imaging time of t = 4 × τd = 400 s is required, 
according to P = 1 – e−t/τd. To achieve multiple binding events 
per site resulting in a decent image quality, we recommend a total 
imaging time of ~33 min.

In silico simulation of DNA-PAINT data
A fundamental challenge in single-molecule localization micro-
scopy is to systematically design, optimize and validate super-
resolution experiments. In silico simulations provide a convenient 
way to address this challenge. Software packages such as SuReSim 
generate a ground truth model and simulate localization micros-
copy data using parameters matching an experimental microscope  
setup62. Similar to this approach, the Picasso software suite 
can simulate localization data with its ‘Simulate’ component, 
which is specifically tailored to DNA-PAINT. In a graphical 
user interface, shown in Figure 7 and Supplementary Figure 2, 
simulation parameters can be set for the type of target struc-
ture, DNA-PAINT kinetics, dye properties and hypothetical data 
acquisition settings such as integration time and total number of  
acquisition frames.
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Figure 6 | Designing DNA origami structures for DNA-PAINT with ‘Picasso: Design’. (i) Screenshot of the design interface displaying a 20-nm grid structure  
with 12 docking sites (red) selected to carry the extension P1. After design is completed, a list of plates is generated as a .csv file ready for ordering (ii). 
‘Picasso: Design’ also creates PDF sheets that can be placed underneath the ordered 96-well plates to facilitate pipetting of staple strands (iii). The folding 
table (iv) gives detailed instructions for preparing components to assemble the DNA nanostructure through thermal annealing. Staple master mixes are 
pipetted from the plates according to the pipetting scheme. For a successful assembly process, single-stranded DNA scaffold, biotinylated staples, staple 
master mixes (unmodified core (gray) and docking-strand-extended (red) staples), water and folding buffer need to be mixed (v). After structures are formed 
(usually through thermal annealing), an agarose gel can be run for analysis or subsequent structure purification (vi). Here, a DNA ladder (L) and the  
scaffold strand (S) are seen as clear bands together with bands for the correctly folded DNA structures and excess staple strands (Ex). Extracted origami 
structures are now ready for DNA-PAINT imaging.
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The simulated imaging targets are nanometer-sized 2D struc-
tures (similar to RROs) on which the positions of DNA-PAINT 
handles can be defined. These handles serve as a ground truth 
model for localization events. On the basis of the values set for 
DNA-PAINT kinetics, the simulation algorithm will calculate a 
kinetic series of ON- and OFF-events over the total acquisition 
time for each handle.

The duration of an ON-event is calculated by random selection 
from an exponential distribution defined by a mean ON-time. 
This time can be either determined experimentally (i.e., using 
Picasso’s kinetic analysis tool; see Step 69B) or estimated by the 
number of base pairs in the imager/docking strand duplex19.  
The length of an OFF-event is generated accordingly. Here, the 
mean OFF-time is calculated from the user-defined binding rate 
constant and the imager concentration19.

The user-defined integration time of the simulated camera is 
used as a sampling window to calculate how long an imager was 

bound during each frame. To emulate experimental results, the 
simulation randomly selects a photon detection rate for each 
binding event from a normal distribution. The mean and standard 
deviation of this normal distribution increase linearly with the 
user-definable laser power density according to experimentally 
determined coefficients. For each frame (or fraction of a frame) in 
which the binding event occurs, the detected number of photons 
is then selected randomly from a Poisson distribution. The mean 
of this Poisson distribution is equal to the mean expected photon 
number for the binding event duration within this frame (photon 
detection rate × duration). In addition, the simulation considers 
an upper-limit for detected photons from a single binding event, 
based on a user-defined photon budget per fluorophore.

After the number of photons for all binding events in each 
frame is calculated, photons are distributed around the center 
position of their handle by a user-adjustable 2D normal distribu-
tion, representing the microscope’s point spread function (PSF). 

a

Start: ci = 1 nM ci = 20 nM ci = 5 nM ci = 5 nM
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c
Simulated RAW data

Reconstructed
DNA-PAINT data

Figure 7 | Simulating DNA-PAINT raw data from DNA origami-like structures. (a) Overview of the graphical user interface for ‘Picasso: Simulate’. A DNA-PAINT 
simulation can be defined by parameters in four categories, indicated by colored frames: ‘Structure’ (blue), PAINT parameters (red), ‘Imager parameters’ 
(green) and ‘Camera parameters’ (yellow). Two overview plots are shown in the upper row. ‘Positions [Px]’ shows the arrangement of individual structures 
within the field of view and ‘Structure [nm]’ shows the positions of DNA-PAINT binding sites in an individual structure. The positions of binding sites in 
individual structures can be defined in the ‘Structure’ section by (i) importing RRO structures designed with ‘Picasso: Design’, (ii) using predefined geometric 
shapes (circles, grids), or (iii) manually entering coordinates. In the ‘PAINT parameters’ section, kinetic parameters for DNA-duplex formation can be set. 
Imager-related properties (PSF width, laser power, photon budget, photon detection rate and background) are defined in the ‘Imager parameters’ section. 
Last, acquisition settings, such as image size, integration time, number of frames and pixel size can be set in the ‘Camera parameters’ section. (b) Example 
of simulated raw DNA-PAINT data in ‘Picasso: Localize’ after spot identification and fitting. The simulation program simulates blinking events as if they were 
acquired with a microscope. (c) Reconstructed DNA-PAINT image from data generated with ‘Picasso: Simulate’. The overview of all structures corresponds 
to the ‘Positions [Px]’ window shown in a. A close-up shows the structure that is presented in the ‘Structure [nm]’ window in a. (d) Example of an iterative 
process for optimizing DNA-PAINT experiments with simulations. A DNA origami structure is simulated with an imager concentration of 1 nM (Simulation 1). 
The simulation shows that the concentration is too low, because features of the structure are not clearly visible. Consequently, in a next iteration, data are 
simulated with a higher concentration, here 20 nM (Simulation 2). Now the simulation reveals that the imager concentration chosen is too high, resulting 
in ‘cross-talk’ localizations between the structures. Such cross-talk arises when two imagers bind simultaneously to nearby structure sites. Their diffraction-
limited images spatially overlap and are falsely identified as a single event with a fitted center coordinate in between the two true positions. For the next 
iteration, the imager concentration is decreased to 5 nM. The resulting simulation shows structures with clear features and no inter-structure cross-talk. 
Hence, the 5 nM imager concentration was chosen to perform a DNA-PAINT experiment (Experiment), which in turn is in good agreement with the simulation. 
Scale bars, 500 nm (c), 100 nm (c inset, d).
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This results in a list of all photon positions for each frame, which 
is converted to an image by calculating a 2D histogram. Poissonian 
noise is added to each frame specified by the background level. 
Finally, the frames are exported as a raw movie file. The default 
values for all parameters were estimated from calibration  
experiments on our TIR fluorescence (TIRF) setup described in 
the EQUIPMENT section. The imager sequence for calibration 
experiments was CTAGATGTAT (P1), which was labeled with a 
Cy3B dye that was excited by a 561-nm laser.

Super-resolution image reconstruction
After a movie of DNA-PAINT data has been acquired (either  
in silico, in vitro or in situ), single-molecule spots must be identi-
fied and fitted to find their center position with subpixel accuracy. 
These routines are performed with Picasso’s ‘Localize’ compo-
nent. An overview of the graphical user interface with identified 
and fitted localizations is shown in Supplementary Figure 3,  
as well as screenshots of parameter dialogs.

A multitude of spot identification algorithms have been devel-
oped and applied to localization-based super-resolution micro-
scopy63. In ‘Picasso: Localize’, spot identification makes use of 
the image gradient to minimize the impact of nonhomogeneous 
background. First, local maxima are detected by identifying pixels 
with highest count in their local neighborhood. This local neigh-
borhood is defined by a square box around the pixel with a user-
defined side length. Then, the net gradient (Gnet) is calculated for 
each box around a local maximum pixel by 

Gnet i i
box

= ⋅∑ g u

where the sum is taken over all pixels of the box, gi is the central 
difference gradient at pixel i and ui is a unit vector originating 
at pixel i and pointing toward the center pixel of the box. Hence, 
the net gradient of a spot is the sum of intensity flowing toward 
the spot center, which is roughly proportional to the number of 
signal photons. A user-defined minimum threshold for the net 
gradient defines whether a spot will be further considered for 
fitting or disregarded.

After spots have been identified by the net gradient method, 
their box serves as input for a maximum likelihood fitting pro-
cedure64. Although a plethora of spot-fitting algorithms have 
been published and used for localization microscopy63, we chose 
to implement the maximum likelihood algorithm because it 
achieves theoretically minimum uncertainty at the Cramer-Rao 
lower bound with good computational performance. However, 
it is critical to this fitting algorithm that the camera images be 
converted correctly to photons, because the algorithm incorpo-
rates the Poisson noise statistics inherent to light detection. In 
‘Picasso: Localize’, the user can set the required parameters for 
converting camera counts to photons. One result of the maximum  
likelihood fitting is the Cramer-Rao lower bound (CRLB) for each 
spot. The localization precision is then obtained by calculating 
the square root of the CRLB.

Finally, super-resolution images are rendered with the ‘Picasso: 
Render’ component based on a list of subpixel spot center coordinates  
(see Supplementary Fig. 4 for an interface overview). The super-
resolution image is a pixel image with arbitrary pixel size, although 
super-resolution pixels that are too large result in insufficient spa-
tial sampling and a potential loss in resolution. We define the ratio 

of super-resolution image pixels to camera pixels as the ‘oversam-
pling’ parameter. In Picasso, the oversampling can be set either 
manually or automatically according to how far the user zooms 
into the image. In the dynamic case, each computer display pixel 
corresponds to one pixel of the super-resolution image.

Picasso offers several rendering modes for the super-resolution  
image. The basic option is to use no ‘Blur’, in which case the 
super-resolution image is merely a 2D histogram of localization 
coordinates65. The second option is ‘One-Pixel-Blur’, in which the 
2D histogram is convolved with a Gaussian probability density 
function of volume and standard deviation equal to one. The 
third option, ‘Global Localization Precision’, is similar to the 
‘One-Pixel-Blur’. However, the standard deviation of the Gaussian 
kernel is set to the median localization precision of all localiza-
tion coordinates. In the fourth option, ‘Individual Localization 
Precision’, each localization is added to the super-resolution image 
as a Gaussian probability density with volume equal to one and 
standard deviation equal to the individual coordinate localization  
precision3. For the localization-precision-based representation 
methods (‘Global’ and ‘Individual Localization Precision’), a 
minimum blur width can be defined by the user, so that the blur 
width is equal to the localization precision, unless the precision 
is smaller than the set minimum blur width.

Picasso furthermore allows for contrast adjustment of the 
super-resolution image based on the density of localizations in 
one super-resolution image—i.e., the number of localizations per 
pixel (or in the case of ‘blurred’ images, the sum of probability 
densities from localizations at each pixel).

Drift correction
A critical post-processing step for localization-based super-resolu-
tion imaging is to compensate for stage drift that occurred during 
data acquisition. In fact, with intricate drift correction methods, 
extremely high resolution (well below 5 nm) can be achieved23. 
After such post-processing steps, drift is almost completely 
removed as a factor for resolution degradation. Consequently, 
localization precision and structure sampling are the only remain-
ing factors that determine image quality. Even so, localization  
precision can be greatly optimized, because DNA-PAINT decou-
ples dye photophysics from blinking, and particle averaging 
(described below) allows reducing of the effects of undersampling 
the structure of interest.

Picasso offers two major routes for drift correction: (i) using 
the localization events themselves and (ii) using specific fidu-
cials in the sample. The localization-events-based drift correction 
is an implementation of a redundant cross-correlation (RCC) 
algorithm66 in which localizations are split and rendered into 
multiple super-resolution images according to their temporal 
appearance in the movie. Image cross-correlation of all result-
ing super-resolution images then yields the spatial shift between 
temporal movie segments from which the drift is interpolated. 
Another conventional way for compensating drift in localization-
based super-resolution microscopy is by using fiducial markers3. 
Such fiducial markers are luminescent and typically observed in 
the same emission channel as the fluorescent signal. Commonly 
used fiducials are gold nanoparticles, quantum dots and fluores-
cently dyed microspheres. With Picasso, localizations from such 
fiducial markers can be selected and used for drift correction, 
as the localizations can be assumed to originate from a single  
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point-like source. Recent developments in extremely high reso-
lution in DNA-PAINT applications have used a large number 
of DNA origami as fiducial markers23. When using hundreds of 
DNA origami structures as markers, their intrinsic size does not 
affect the drift estimation because of their random rotational 
orientation. In the same work, an additional drift correction 
step was applied by selecting single DNA-PAINT binding sites as 
drift markers. Similar to the case of whole DNA origami, a large 
number of binding sites (usually several thousands) are required, 
as each individual site does not comprise sufficient localizations 
to interpolate the drift for each movie frame accurately. Although 
DNA origami and their DNA-PAINT binding sites are excellent 
choices, this type of fiducial-based drift estimation is not limited 
to these structures. It is feasible to use any distinctly visible land-
marks in the image as fiducial markers—for example, protein 
clusters such as the nuclear pore complex.

In this protocol, we recommend subsequent applications of drift 
correction by RCC and, if available, fiducial-based correction with 
DNA origami markers followed by fiducial-based correction with 
single DNA-PAINT binding sites as markers. Example results after 
each drift correction step of such a process are shown in Figure 4b. 
In the final images, drift is almost completely eliminated as a factor 
in image resolution. This is corroborated by the fact that the spread 
of imaged DNA-PAINT binding sites is similar to the estimated 
localization precision by nearest neighbor analysis (NeNA)67.

Multiplexing
One major benefit of DNA-PAINT is its straightforward exten-
sion to multiplexed imaging. Here, the simplest implementation 
is to use spectrally distinct dyes coupled to orthogonal imager 
sequences68. Unlike other multiplexed localization-based super-
resolution techniques69, no photo-switching of dyes is necessary, 
and thus it is rather simple to find compatible spectrally distinct 
fluorophores68 (i.e., Atto488, Cy3B and Atto655).

However, one major drawback of spectral multiplexing is the 
limited number of distinguishable dyes in the visible spectrum. 
This limitation can be overcome with Exchange-PAINT20. Here, 
the unique programmability of DNA-PAINT docking and imager 
strands is used to enable spectrally unlimited multiplexing by 
sequentially applying orthogonal imager strands (carrying the 
same dye) to targets of interest.

In each imaging round, only one imager species is present in solu-
tion for one target. After acquisition, the imager is washed out and 
the imager for the next round is introduced. This is then repeated 
for the total number of targets. A multicolor image is achieved by 
assigning a pseudocolor to each imaging round and stacking the 
acquisitions on top of each other, which is depicted in Figure 2a.

Preparation of samples for Exchange-PAINT is similar to that 
for singleplex experiments, only that an open chamber allowing 
for fluid exchange is used as displayed in Figure 2b,c.

To create multicolor images, Picasso automatically assigns pseu-
docolors when several data sets are loaded. Different imaging rounds 
potentially comprise an offset with respect to each other because of 
instrumentation drift during data acquisition. However, alignment 
procedures can detect and correct for such image offsets.

Picasso offers cross-correlation or fiducial-based alignment 
algorithms. When images share features as reference points, such 
as DNA origami or the general cell shape, the cross-correlation 
can align images with high precision—e.g., sub-5-nm channel 

alignment, as demonstrated in Figure 2d–f. When few reference 
points are available, e.g., for in situ imaging of different cell tar-
gets, alignment markers or drift fiducials can be added to the 
sample and used in Picasso’s alignment procedure.

A distinct advantage of Exchange-PAINT over spectral multi-
plexing is that for each imaging round the same dye is used, and 
thus misalignment and inhomogeneous image warping due to 
chromatic aberrations are avoided. This allows for very precise 
channel alignment and makes Exchange-PAINT ideal for colocali-
zation studies to assess spatial proximity and possible molecular 
interactions. Such results are illustrated in the in situ example 
in Figure 2g, in which the morphology of the mitochondrial  
network and the spatial relationship to microtubules is studied. 
It shows how mitochondria are embedded in the microtubule 
network, as described in previous work70.

Quantitative imaging with qPAINT
Most super-resolution studies to date harness their exquisite sub-
diffraction spatial resolution to address challenges in the bio-
logical sciences by structural imaging. However, although still 
challenging, counting integer numbers of biomolecules when 
localization precision is insufficient to spatially resolve them can 
bring further insight into biological systems8,71,72. To achieve this, 
researchers began using the spatiotemporal information of single-
molecule localization microscopy data sets beyond just binning 
localization events for visualization. The basic concept involves 
extracting molecule numbers by evaluating the kinetics of the 
blinking behavior of photoswitchable molecules73–75. Most of 
these counting techniques use rather complex modeling of the 
dye photophysics, in some cases combined with spatiotemporal 
clustering72–76. However, incumbent techniques have certain limi-
tations that prevent them from achieving the highest accuracy and 
precision over a wide range of molecular densities in resolution-
limited areas. These limitations generally lead to overcounting 
or undercounting artifacts, because the dyes typically have envi-
ronmentally sensitive photophysics that are hard to predict and 
model. Furthermore, distinct dyes behave differently even under 
similar experimental conditions, which severely complicates 
multiplexed quantitative imaging. In addition, inhomogeneous 
excitation and photoactivation intensities due to uneven illumina-
tion across a sample can lead to inaccurate quantification as well.  
Last, dyes typically bleach over the course of an experiment, which 
deteriorates quantification accuracy and precision.

Recently, DNA-PAINT has been used to achieve precise and accu-
rate counting—because of its independence from dye photophysics 
and immunity to photobleaching—in an implementation called 
qPAINT22. In contrast to the traditional approach of fixing blinking 
dyes to the target molecule, DNA-PAINT creates target ‘blinking’ by 
transient binding of dye-labeled imager strands to complementary 
docking strands on the target. As opposed to dye photoswitch-
ing, DNA hybridization kinetics is more predictable. Hence, com-
bined with the effective absence of photobleaching, qPAINT can  
extract molecule numbers with high precision and accuracy.

Figure 3 illustrates the procedure and results of a typical 
qPAINT experiment. Using Picasso’s quantification capabilities, 
we now provide users with an integrated software solution for 
calibrating and quantifying molecule numbers in DNA-PAINT 
data sets. qPAINT relies on the fact that mean dark times for a 
given influx rate of imager strands (ξ = kon × c) are dependent 
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only on the number of docking strands (and thus biomolecules) 
in an area of interest. To illustrate this, we compare two DNA 
origami structures, carrying 12 or 42 binding sites in 20-nm and 
10-nm grid arrangements, respectively (Fig. 3a). A schematic  
representation of their respective intensity vs. time traces is shown 
in Figure 3b. By plotting the cumulative distribution function 
of both dark time distributions, we can obtain mean dark times 
for the two structures (Fig. 3c). To translate these dark times to 
actual numbers of binding sites (or units), the influx rate per 
unit needs to be calibrated. This can be achieved with DNA ori-
gami structures in which binding sites can be visually identified 
(see Fig. 3d, 20-nm grid structures displaying 12 binding sites).  
In Picasso, users can now select these calibration structures dis-
playing a known number of units (or binding sites in this case) 
and calibrate the probe influx rate for subsequent quantification 
of target molecules of interest in the same data set (Fig. 3d).

The results for a typical qPAINT experiment post calibration 
are illustrated in Figure 3e–g. 20-nm DNA origami grid structures 
can be used to compare visually counted numbers of spots with 
qPAINT results, which are in good agreement (Fig. 3e). Note that 
not all DNA origami carry all binding sites, because typical staple 
incorporation efficiencies are <100%. qPAINT allows binding-site 
identification on 10-nm DNA origami grid structures, in which 
single sites are not clearly identifiable (Fig. 3f).

Finally, Picasso allows users to quickly obtain statistics from 
qPAINT data sets using its integrated ‘Pick’ and ‘Pick similar’ 
tools. Figure 3g illustrates the resulting number of binding-site 
distributions for 20-nm and 10-nm DNA origami grid struc-
tures in a single sample. The average number of binding sites is 
in excellent agreement with expectations. For 20-nm structures, 
the incorporation efficiency is ~78%, whereas it is slightly lower 
for 10-nm grid structures at 70%. This, however, is to be expected, 
as staple incorporation efficiency should be lower for larger num-
bers of modified staple strands in DNA origami structures.

Filtering localizations
After identification and fitting of single-molecule spots, filtering 
the list of localizations might improve super-resolution image 
quality3,5,6,69,70,77. Only after fitting a single-molecule spot, are 
properties such as spot width or an accurate estimation of the 
number of photons available. Hence, spot identification itself 
may not reliably rule out false-spot detections. A typical filter-
ing procedure is to remove localizations with spot widths that 
are too small or too large. Ideally the spot width matches that of 
the microscope’s PSF. Therefore, if the spot width is, for exam-
ple, too big, it is likely that the spot originates from two close-
by and overlapping events. The resulting fit coordinate will be 
between the two correct center positions and should therefore 
be disregarded. Another example of filtering is to remove local-
izations with a number of photons or a localization precision 
that is too low. After such filtering, the super-resolution image 
quality can improve, because only high-precision localizations 
remain. Picasso’s ‘Filter’ component provides a convenient, visu-
ally guided way to filter localizations based on histograms of their 
properties. An overview of its graphical user interface, as well 
as screenshots of filtering procedures in progress, is shown in 
Supplementary Figure 5. We recommend studying histograms 
of localization properties and joint histogram maps of two 
localization properties with the goal of identifying the true signal  

population and removing false populations or outliers. An 
overview of localization properties saved by Picasso is shown  
in the Supplementary Manual.

Particle averaging
When imaging a structure that appears multiple times in the 
field of view, aligning the individual images on top of each other 
and ‘summing them up’ can generate an ‘average’ image with 
improved image quality23,78. Such a procedure is analogous to the 
particle averaging often applied for structural biology in single-
particle electron microscopy79 and has already been successfully 
applied to localization-based super-resolution microscopy80,81. 
Although, strictly speaking, we do not create an ‘averaged’ but 
rather a ‘sum image’ from all localizations, we here will con-
tinue to use the notion of averaging as a historical term from 
the electron microscopy field. ‘Averaging’ primarily increases 
the image signal-to-noise ratio, which translates for localization 
microscopy to the proportion of true, high-precision localiza-
tions (signal) to false or imprecise localizations (noise). Hence, 
structure sampling, a major factor for image resolution16, can be 
improved by the averaging procedure. This is exemplified by the 
individual and average images of two RRO DNA origami struc-
tures in Figure 4c–f, showing the letters ‘MPI’ and ‘LMU’. The 
average image comprises a greatly enhanced signal-to-noise ratio 
as compared with images of individual structures. Moreover, 
even though some binding sites are missing in individual struc-
tures, averaging could reconstruct all binding sites and resolve 
their ~5-nm distances well.

Picasso offers a graphical user interface for averaging multiple 
images of the same structure with the ‘Average’ component. The 
underlying algorithm does not require a reference and is based 
on a traditional procedure borrowed from single-particle electron 
microscopy82. Briefly, the individual images are first translation-
ally aligned on top of each other by overlaying the center of mass 
of localizations. Then, several iterations of rotational and refined 
translational alignment are applied. In each iteration, an average 
image is constructed by pooling all localizations and rendering 
them on a super-resolution pixel grid. Then, localizations from 
each individual structure are rotated over 360 degrees in small 
steps and rendered as a super-resolution image for each rotational 
step. The angular step size is dynamically chosen so that the rota-
tion distance at twice the root mean square (RMS) deviation of all 
localizations from their center of mass matches the size of a super-
resolution pixel. Each rotated image is cross-correlated with the 
average image of the current iteration, and the maximum value and 
position of the cross-correlation are recorded. Finally, the localiza-
tions of an individual structure are rotated and translated according 
to the rotation and translation with the highest cross-correlation 
value. In the next iteration, a new improved average image can be 
generated from the now updated localization coordinates. After a 
certain number of iterations, the average image will converge—i.e., 
the pixel values will not change after an iteration. At this point, the 
algorithm can be stopped, and the new localization list is saved.

Averaging results, as shown in Figure 4e,f, rely on experimental 
conditions and post-processing steps that are specifically aimed 
at ultra-resolution. In particular, intricate drift correction as 
described above is a key contribution. Experimental conditions for 
ultra-resolution are described in Box 2; refer to Supplementary 
Figures 6–9 for structure design.
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MATERIALS
REAGENTS
! CAUTION All reagents can be potentially hazardous and should be handled 
only by trained personnel.
DNA labeling

PBS, pH 7.2 (Life Technologies, cat. no. 20012-019)
0.5 M EDTA, pH 8.0 (Ambion, cat. no. AM9261) ! CAUTION EDTA may 
cause eye and skin irritation; avoid breathing the dust or fumes.
DMF (Thermo Fisher Scientific, cat. no. 20673) ! CAUTION DMF is a toxic 
and flammable liquid; protect your eyes and skin, and avoid breathing the 
dust or fumes. It may also damage fertility and cause harm to the unborn 
child. Handle it under a chemical hood.
AffiniPure Donkey Anti-Rat IgG (Jackson ImmunoResearch,  
cat. no. 712-005-150)
AffiniPure Donkey Anti-Rabbit IgG (Jackson ImmunoResearch,  
cat. no. 711-005-152)
AffiniPure Goat Anti-Mouse IgG (Jackson ImmunoResearch,  
cat. no. 115-005-003)

Antibody labeling via maleimide-PEG2-succinimidyl ester
Maleimide-PEG2-succinimidyl ester (Sigma-Aldrich, cat. no. 746223)
No-Weigh Format DTT (Thermo Fisher Scientific, cat. no. 20291)  
! CAUTION This compound causes skin and respiratory pathway irritation, 
as well as serious eye irritation. It is toxic if swallowed and causes long-term 
damage to aquatic life.
Micro BCA Protein Assay Kit (Thermo Fisher Scientific, cat. no. 23235)
Thiol-DNA (P1 handle: Thiol-TTATACATCTA; MWG Eurofins)
Thiol-DNA (P3 handle: Thiol-TTTCTTCATTA; MWG Eurofins)

Antibody labeling via DBCO-sulfo-NHS ester
DBCO-sulfo-NHS ester (Jena Bioscience, cat. no. CLK-A124-10)
Azide-DNA (Biomers.net) P1 Handle: Azide-TTATACATCTA
Azide-DNA (Biomers.net) P3 Handle: Azide-TTTCTTCATTA

Immunofixation and cell imaging
8-well chambered cover glasses (Eppendorf, cat. no. 0030742036 or  
Thermo Fisher Scientific, cat. no. 155409)
BSA (Sigma-Aldrich, cat. no. A4503-10g)
Triton X-100 (Carl Roth, cat. no. 6683.1) ! CAUTION This compound is 
toxic if swallowed, and it can cause serious eye damage.
0.22-µm sterile filters (Merck/EMD Millipore, cat. no. SLGS033SS)
Sodium chloride (Ambion, cat. no. AM9759) ! CAUTION Sodium  
chloride may cause skin and eye irritation, and it may be harmful if  
inhaled or swallowed.
Sodium borohydride (Carl Roth, cat. no. 4051.1) ! CAUTION This  
compound reacts in a volatile manner with H2O, is toxic if swallowed  
and can cause serious skin damage. Handle it under a chemical hood.
16% (vol/vol) Paraformaldehyde (Electron Microscopy Sciences,  
cat. no. 15710) ! CAUTION This compound is flammable, a carcinogen and 
toxic if swallowed; avoid breathing the fumes or dust. It can cause serious 
eye, skin or respiratory pathway irritation. Handle it under a chemical hood.
25% (vol/vol) Glutaraldehyde (SERVA, cat. no. 23115.01) ! CAUTION Glu-
taraldehyde is toxic if swallowed; it causes serious skin damage, and acute 
and chronic toxicity in aquatic life. Avoid breathing the fumes or dust. Wear 
protective equipment and handle the compound under a chemical hood.
α-Tubulin (YL1/2) antibody (Thermo Fisher Scientific, cat. no. MA1-80017)
α-Tubulin (DM1A) mouse antibody (Cell Signaling, cat. no. 3873S)
Tom20 (FL-145) rabbit antibody (Santa Cruz, cat. no. sc-11415)
DNA-labeled secondary antibodies and imager kit (Ultivue, cat. no. U10001)
Imager strand (P1-Cy3B: CTAGATGTAT-Cy3B; Eurofins Genomics)
Imager strand (P3-Atto655: GTAATGAAGA-Atto655; Eurofins Genomics)
Imager strand (P3-Cy3B: GTAATGAAGA-Cy3B; Eurofins Genomics)

Cell culture
PBS, pH 7.2 (Thermo Fisher Scientific, cat. no. 20012-019)
MEM (Thermo Fisher Scientific, cat. no. 31095-052)
Eagle’s Minimum Essential Medium (EMEM; ATCC, cat. no. 30-2003)
l-Glutamine (Thermo Fisher Scientific, cat. no. 25030-149)
Non-essential amino acids (Thermo Fisher Scientific, cat. no. 11140-035)
FBS (Thermo Fisher Scientific, cat. no. 10500-064)
Penicillin–streptomycin (P/S; Thermo Fisher Scientific, cat. no. 15140-122) 
! CAUTION It may damage fertility and cause harm to the unborn child. 
Avoid breathing fumes or dust.
Trypsin-EDTA (Thermo Fisher Scientific, cat. no. 25300-054)
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HELA cell line (Leibniz Institute DSMZ: Catalogue of Human and Animal 
Cell Lines (http://www.dsmz.de), cat. no. ACC-57) ! CAUTION The cell lines 
used in your research should be regularly checked to ensure that they are 
authentic and they are not infected with mycoplasma.
BS-C-1 cell line (ATCC, cat. no. CCL-26) ! CAUTION The cell lines used in 
your research should be regularly checked to ensure that they are authentic 
and they are not infected with mycoplasma.

DNA origami folding
Staple strands, modified and unmodified (Eurofins Genomics)
M13 bacteriophage ssDNA scaffold p7249 (New England BioLabs,  
cat. no. N4040S)
Tris, pH 8.0, 1 M (Ambion, cat. no. AM9856) ! CAUTION Tris can cause skin 
and serious eye irritation.
EDTA, pH 8.0, 0.5 M (Ambion, cat. no. AM9261) ! CAUTION EDTA may 
cause eye and skin irritation; avoid breathing the dust or fumes.
Water (Gibco, cat. no. 10977-035)
Magnesium, 1 M (Ambion, cat. no. AM9530G)
Agarose (Biomol, cat. no. 01280.100)
50× TAE Buffer (Fluka Analytical, cat. no. 67996-10L-F)
SYBR safe DNA gel stain (Invitrogen, cat. no. SS33102) ! CAUTION Protect 
your eyes and avoid breathing the dust, fumes or mist; it causes eye, skin 
and respiratory irritation.
DNA gel loading dye (Thermo Fisher Scientific, cat. no. R0611)
DNA ladder (Invitrogen, cat. no. 10787-018)

In vitro sample preparation
Protocatechuic acid (PCA; Sigma-Aldrich, cat. no. 37580-25G-F) ! CAUTION 
PCA causes skin, respiratory pathway and serious eye irritation. Avoid 
breathing the dust, fumes or mist.
Protocatechuate 3,4-dioxygenase (PCD; Sigma-Aldrich, cat. no. P8279-25UN)
Trolox (Sigma-Aldrich, cat. no. 238813-1G) ! CAUTION Trolox causes skin, 
respiratory pathway and serious eye irritation. Avoid breathing the dust, 
fumes or mist.
NaOH (VWR, cat. no. 31627.290) ! CAUTION NaOH causes serious skin 
and eye damage; avoid breathing the dust, fumes or mist. Wear protective 
equipment.
Methanol (Sigma-Aldrich, cat. no. 32213-2.5L) ! CAUTION Methanol is a 
flammable liquid, and it is toxic upon ingestion and skin contact; avoid 
breathing the dust, fumes or mist.
Potassium chloride (Carl Roth, cat. no. 6781.1)
Glycerol (Sigma-Aldrich, cat. no. 65516-500ml)
Isopropanol (Carl Roth, cat. no. 33539-2.5L-R) ! CAUTION Vapor and liquid 
phases are easily flammable, and the compound causes heavy eye irritation.
Epoxy Glue (Toolcraft, cat. no. TC-EPO5-24)
Albumin, biotin-labeled bovine (Sigma-Aldrich, cat. no. A8549-10MG)
Streptavidin (Thermo Fisher Scientific, cat. no. S888)
Tween 20 (Sigma-Aldrich, cat. no. p2287)

EQUIPMENT
Thermocycler (Mastercycler Nexus Gradient; Eppendorf, cat. no. 6331000017)
10-liter Tank (Carl Roth, cat. no. K653.1)
Sub-cell GT system gel chamber (Bio-Rad, cat. nos. 170 4401-4406 and  
170 4481-4486)
PowerPac basic power supply (Bio-Rad, cat. no. 1645050)
Microwave (Severin, cat. no. 7891)
Erlenmeyer flask, 250 ml (Carl Roth, cat. no. NY87.1)
Razor blade (Carl Roth, cat. no. CK07.1)
Visi-blue light transilluminator (UVP, cat. no. 95-0461-02)
Centrifuge 5430R (Eppendorf, cat. no. 5428000414)
NanoDrop 2000c (Thermo Fisher Scientific, cat. no. ND-2000c)
Shaker (GFL, cat. no. 3015)
Biological safety cabinet (HeraSafe; Thermo Electron Corporation,  
cat. no. 51022482)
Water purification system (PURELAB classic; ELGA LabWater,  
cat. no. CLXXUVFM2)
Incubator (Heracell 240; Thermo Fisher Scientific, cat. no. 51026333)
Pipetboy acu 2 (Integra, cat. no. 155017)
Eppendorf Research plus 0.1–2.5 µl pipette (Eppendorf, cat. no. 3120000011)
Eppendorf Research plus 0.5–10 µl pipette (Eppendorf, cat. no. 3120000020)
Eppendorf Research plus 2–20 µl pipette (Eppendorf, cat. no. 3120000038)
Eppendorf Research plus 10–100 µl pipette (Eppendorf, cat. no. 3120000046)
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Eppendorf Research plus 20–200 µl pipette (Eppendorf, cat. no. 3120000054)
Eppendorf Research plus 100–1000 µl pipette (Eppendorf, cat. no. 3120000062)
Multipette M4 pipette (Eppendorf, cat. no. 4982000314)
Eppendorf Research plus, 8-channel, 0.5–10 µl pipette (Eppendorf,  
cat. no. 3122000019)
Gel imager (Typhoon FLA 9500; GE, cat. no. 28996943)
Side cutter (Hoffmann Group, cat. no. 725310)
Amicon spin filters, 3 kDa (Merck/EMD Millipore, cat. no. UFC500396)
Amicon spin filters, 100 kDa (Merck/EMD Millipore, cat. no. UFC510096)
Nap5 columns (GE Healthcare, cat. no. 17-0853-02)
Zeba desalting spin columns (Thermo Fisher Scientific, cat. no. 89882)
Amicon spin filters, 100 kDa (Merck/EMD Millipore, cat. no. UFC510096)
NORM-JECT 2-ml syringe (Henke Sass Wolf, cat. no. 4020-000V0)
NORM-JECT 10-ml syringe (Henke Sass Wolf, cat. no. 4100-000V0)
NORM-JECT 20-ml syringe (Henke Sass Wolf, cat. no. 4200-000V0)
FINE-JECT Needle, 1.2 × 40 mm (Henke Sass Wolf, cat. no. 4710012040)
FINE-JECT Needle, 1.1 × 40 mm (Henke Sass Wolf, cat. no. 4710011040)
Silicon tubing, inner diameter = 0.5 mm, outer diameter = 1 mm (GM GmbH, 
cat. no. 35605)
T75 Flasks (Falcon, cat. no. 353136)
10-ml Serological pipettes (Greiner Bio-One, cat. no. 607180)
5-ml Serological pipettes (Greiner Bio-One, cat. no. 606180)
2-ml Serological pipettes (Falcon, cat. no. 357507)
Glass Pasteur pipettes (Brand, cat. no. 747720)
90-nm Gold particles (prepared in house83)
DNA LoBind Tube, 0.5 ml (Eppendorf, cat. no. 0030 108.035)
PCR tubes (Trefflab, cat. no. 96.09852.9.01)
Freeze ’N Squeeze columns (Bio-Rad, cat. no. 732-6165)
Aluminum foil (VWR, cat. no. 391-1257)
1.5-ml Eppendorf tubes (Eppendorf, cat. no. 0030 120.086)
15-ml Falcon tubes (Falcon, cat. no. 352096)
50-ml Falcon tubes (Falcon, cat. no. 352070)
ibidi sticky-Slide VI 0.4 (ibidi, cat. no. 80608)
High-precision cover glasses 18 × 18 mm, no. 1.5H (Marienfeld,  
cat. no. 0107032)
High-precision cover glasses 24 × 60 mm, no. 1.5H (Marienfeld,  
cat. no. 0107242)
Microscopy slide (Thermo Fisher Scientific, cat. no. 10756991)
Double-sided adhesive tape (Scotch, cat. no. 665D)
Weighing paper (VWR International, cat. no. 12578-121)

TIRF super-resolution setup
Optical air table (Newport, cat. no. RS4000-46-12)
Inverted fluorescence microscope (Nikon, Ti Eclipse with Perfect Focus System)
XY Stage (Physik Instrumente, cat. no. M-545.2MN)
Lenses and mirrors (Thorlabs)
Filter cubes (Chroma Technology, cat. nos. TRF49904-NK, TRF49909-NK, 
TRF49914-NK)
Oil-immersion objective, 100× Apo SR TIRF objective, numerical aperture 
(NA) = 1.49, working distance (WD) = 0.12 (Nikon)
Immersion oil, refractive index (n) = 1.515 (23 °C), (Nikon, Type A)
sCMOS camera (Hamamatsu Orca Flash 4.0 V2)
EMCCD camera (Andor, iXon Ultra, model no. DU-897)
Excitation laser, 488 nm, 200 mW (Toptica iBeam smart, model no.  
488-S-HP)
Excitation laser, 561 nm, 200 mW (Coherent Sapphire, model no. 561-200 
CW CDRH)
Excitation laser, 640 nm, 150 mW (Toptica, iBeam smart, model no. 640-S)
Microscopy slide thermal power sensor (Thorlabs, model no. S170C)
Digital power meter (Thorlabs, model no. PM100D)
Acquisition computer: a computer used to acquire microscope data with 
the µManager software package58. See EQUIPMENT SETUP for hardware 
requirements.
Analysis computer: a computer with a Microsoft Windows 64-bit operating 
system. See EQUIPMENT SETUP for hardware requirements.
Analysis software: our analysis software package ‘Picasso’ can be downloaded  
from our website at http://www.jungmannlab.org.

REAGENT SETUP
Pre-extraction buffer  The pre-extraction buffer consists of 0.4% (vol/vol) 
glutaraldehyde and 0.25% (vol/vol) Triton X-100 in 1× PBS at pH 7.2. It can be 
stored at −20 °C for 12 months.
Enhanced microtubule fixative  The enhanced microtubule fixative consists 
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of 3% (vol/vol) glutaraldehyde in 1× PBS at pH 7.2, and it can be stored at 
−20 °C for 12 months.
Standard fixative  The standard fixative consists of 3% (vol/vol)  
paraformaldehyde and 0.1% (vol/vol) glutaraldehyde in 1× PBS at pH 7.2.  
It can be stored at −20 °C for 12 months.
Blocking solution  The blocking solution contains 3% (wt/vol) BSA and 
0.2% (vol/vol) Triton X-100 in 1× PBS at pH 7.2, and it must be filter- 
sterilized. It can be stored at 4 °C for up to 6 weeks.
Antibody dilution solution  The antibody dilution solution contains 3% 
(wt/vol) BSA in 1× PBS at pH 7.2, and it must be filter-sterilized. It can be 
stored at 4 °C for up to 6 weeks.
DTT solution  The DTT solution consists of 250 mM DTT, 1.5 mM EDTA 
and 0.5× PBS, pH 7.2. It must be freshly prepared for the reduction of the 
thiolated DNA.
BCA mix  The BCA mix includes 500 µl of reagent A, 500 µl of reagent B and 
25 µl of reagent C (from the Micro BCA Protein Assay Kit), and it must be 
freshly prepared.
HeLa cell medium  The HeLa cell medium consists of MEM, 10% (vol/vol) 
FCS, 1% (vol/vol) P/S, 2 mM l-glutamine and 1× non-essential amino acids. 
HeLa cell medium can be stored at 4 °C for up to 4 months.
BSC1 cell medium  The BSC1 cell medium consists of EMEM, 10% (vol/vol) 
FCS and 1% (vol/vol) P/S.
Cross-linker aliquots  Cross-linkers should be divided into aliquots at a 
concentration of 10 mg/ml in DMF, and they can be stored at −80 °C for up 
to 12 months.
Buffer A  Buffer A consists of 10 mM Tris-HCl and 100 mM NaCl at pH 8.0, 
and it can be stored at room temperature (RT; 21 °C) for 6 months.
Buffer A+  Buffer A+ consists of 10 mM Tris-HCl, 100 mM NaCl and 0.05% 
(vol/vol) Tween 20 at pH 8.0, and it can be stored at RT for 6 months.
Buffer B  Buffer B consists of 5 mM Tris-HCl, 10 mM MgCl2 and 1 mM 
EDTA at pH 8.0, and it can be stored at RT for 6 months.
Buffer B+  Buffer B+ consists of 5 mM Tris-HCl, 10 mM MgCl2, 1 mM EDTA 
and 0.05 % (vol/vol) Tween 20 at pH 8.0, and it can be stored at RT for 6 months.
Buffer C  Buffer C consists of 1× PBS at pH 7.2 supplemented with addi-
tional 500 mM NaCl, and it can be stored at RT for up to 6 months.
Exchange washing buffer  Exchange washing buffer consists of Buffer B+ for 
in vitro samples and of 1× PBS, pH 7.2, for in situ samples; it can be stored at 
RT for 6 months.
100× Trolox solution  100× Trolox solution consists of 100 mg of Trolox, 430 µl 
of methanol and 345 µl of NaOH (1 M) in 3.2 ml of H2O. It should be divided 
into 20-µl portions in PCR tubes and can be stored at −20 °C for up to 6 months.
40× PCA solution  40× PCA solution consists of 154 mg of PCA in 10 ml of 
water, adjusted to pH 9.0 with NaOH. The solution should be divided into 
20-µl aliquots in PCR tubes and can be stored at −20 °C for up to 6 months.
100× PCD solution  100× PCD solution consists of 9.3 mg of PCD and  
13.3 ml of buffer (50% glycerol stock in 50 mM KCl, 1 mM EDTA and  
100 mM Tris–HCl, pH 8.0). It should be divided into 20-µl aliquots in PCR 
tubes and can be stored at −20 °C for up to 6 months.
Oxygen-scavenging system PPT solution  PPT solution consists of a 1:1:1 
ratio of 1× PCA/1× PCD/1× Trolox. Mix with imaging buffer at least 1 h 
before imaging.
Imager solution  For in vitro samples, the imager solution consists of 1× 
Buffer B+, optional scavenger system PPT solution (1× Buffer B+, 1× PCA, 
1× PCD, 1× Trolox) and a fluorophore-labeled DNA strand. For in situ  
samples, the imager solution consists of 1× Buffer C, optional scavenger 
system PPT solution (1× Buffer C, 1× PCA, 1× PCD, 1× Trolox)  and a 
fluorophore-labeled DNA strand. The concentration range for the fluorophore-
labeled DNA strand is highly target dependent, but it ranges between 100 pM 
and 10 nM. The solution should always be freshly prepared.
10× Folding buffer  10× folding buffer consists of 125 mM MgCl2, 100 mM 
Tris and 10 mM EDTA at pH 8.0, and it can be stored at RT for up to 6 months.
Gel buffer  Gel buffer consists of 1× TAE buffer, and it can be stored at RT 
for 1 year.
Gel running buffer  Gel running buffer consists of 1× TAE buffer and  
12.5 mM MgCl2, and it can be stored at RT for up to 1 year.
BSA–biotin stock  BSA–biotin stock contains 10 mg/ml BSA–biotin in Buffer 
A, and it should be divided into 20-µl aliquots. It can be stored at −20 °C for 
up to 6 months.
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BSA–biotin solution  BSA–biotin solution contains 1 mg/ml BSA–biotin  
in Buffer A+ and should be freshly prepared. It can be stored for up to  
3 d at 4 °C.
Streptavidin stock  Streptavidin stock contains 10 mg/ml streptavidin in 
Buffer A and should be divided into 10-µl aliquots. It can be stored at −20 °C 
for up to 6 months.
Streptavidin solution  Streptavidin solution contains 0.5 mg/ml streptavidin in 
Buffer A+ and should be freshly prepared. It can be stored for up to 3 d at 4 °C.
Staple strands  Staple strands can be ordered in different purity grades. 
High-purity salt-free purification is sufficient for standard staples; however, 
we recommended ordering modified staples, such as those with fluorophores 
or biotins, HPLC or PAGE purified. Staple strands for nanostructures  
should be ordered in 96-well plates (0.2 ml) to facilitate the handling and 
creation of master mixes with the help of multipipettes. To keep the manual 
handling to a minimum, the staples should be ordered prediluted at a 
 concentration of 100 µM in H2O. The plates can be stored at −20 °C for  
at least 12 months.
EQUIPMENT SETUP
Acquisition computer  The following computer system was used for all data 
acquisition in this protocol: Dell Precision T7910, Dual Intel Xeon Processor 
E5-2620 v3 at 2.4 GHz (12 cores), 32 GB RAM, four 2 TB HDD configured 
in a Hardware RAID 0, Windows 7 Professional 64-bit operating system.  
 CRITICAL A RAID 0 setup is optimized for fast input/output. For long-term 
data storage, users are advised to use data storage facilities with daily backup 
available to research groups at universities or research institutes.

Acquisition software  As image acquisition software, install µManager, an 
open-source software58 that can be downloaded from https://micro-manager.org.  
Follow the installation instructions and set up the software to control the 
microscope equipment.
Analysis computer  We do recommend performing all postacquisition steps 
with Picasso on a separate analysis workstation. The hardware requirements 
depend on the specific file size of the data set to be analyzed. Generally, the most 
important factors are the number of available CPU cores and RAM. The follow-
ing system was used for all analyses in this protocol: Dell Precision T7910, Dual 
Intel Xeon CPU E5-2680 v3 at 2.5 GHz (24 cores), 256 GB RAM and four 2 TB 
HDD configured in a Hardware RAID 0, Windows Server 2012 R2 64-bit  
operating system.  CRITICAL A RAID 0 setup is optimized for fast input/output. 
For long-term data storage, users are advised to use data storage facilities with 
daily backup available to research groups at universities or research institutes.
Analysis software  Download the ‘Picasso’ installer available at our website 
(http://www.jungmannlab.org). Follow the installation instructions. Multiple 
Picasso components will appear as shortcuts in a start menu subfolder 
named ‘Picasso’.
Power density calibration  Determine the laser power at the sample by 
placing the microscopy slide thermal power sensor with immersion oil on 
the sample holder. The power density is then calculated as an average density 
over the illuminated area. See Supplementary Table 1 for an exemplary 
calibration on our microscope.
Fluid exchange chamber  To prepare a fluid exchange chamber for in situ 
imaging, see Box 1.

PROCEDURE
Design of DNA nanostructures ● TIMING 1 h
1|	 Start ‘Picasso: Design’, which displays a canvas of a hexagonal lattice, representing the staple strand positions  
(Fig. 6) in a 2D RRO33.

2|	 Design a pattern of DNA-PAINT binding sites by clicking on the canvas hexagons. Clicking on a hexagon will change  
its color and marks the respective staple to be extended with an external sequence. Each color corresponds to a specific 
extension that may be defined later. The default state without an external extension is indicated by a gray hexagon.  
The center-to-center distance between two hexagons is ~5 nm on the DNA origami. To change the ‘current color’, click on  
a colored hexagon in the color palette to the right. Clicking on a hexagon with a currently selected color will reset the  
‘current color’ to the unmarked state (gray). Click ‘Clear’ to reset all hexagons in the lattice. The eight white double-hexagons 
within the structure are placeholders for biotinylated staples for surface attachment and are not intended for modification. 
In total, the structure consists of 176 staples available for modification.

3|	 Click ‘Save’ to save the design. Progress can be saved at any time and loaded at a later point by selecting ‘Load’.  
A screenshot of the design can be saved by clicking on ‘Screenshot’.

4|	 Click on ‘Extensions’ to specify the extensions corresponding to each color. A table with all the colors present in the  
design will open. A selection of commonly used DNA-PAINT handles can be obtained via the dropdown menu in the ‘Preselection’  
column. This list can be extended by modifying ‘paint_sequences.csv’ in the subfolder ‘picasso’ of the Picasso install directory. 
See Supplementary Table 2 for a table of the default sequences. Alternatively, define a custom ‘Shortname’ and ‘Extension’ 
by entering them in the table. After defining all colors used in the canvas, select ‘OK’ to confirm the extensions. The display 
will update with the ‘Shortname’. The sequence specified will be added to the 3′-end of the staple and will point out of the 
structure (away from the cover glass). For a full list of all unmodified core staples, refer to Supplementary Table 3.

5|	 Once the design step is complete, the sequences for the corresponding structure need to be obtained. Click on ‘Get 
plates’ to generate a staple list for ordering. As an RRO origami structure consists of 184 staples, the staples in the list are 
arranged in two 96-well plates, so that each well corresponds to a position on the hexagonal lattice. It is possible to export 
only the sequences of a particular structure (in total, two plates) or to get a list of plates for which all possible positions 
are extended with all extensions used in the design. This is particularly useful in the case in which different origami designs 
with different extensions and patterns will be tested, so all staples are ready to be mixed and matched for subsequent  
design iterations. The software will export the list in .csv format, so that the file can be used for direct ordering at your 
favorite oligo synthesis company. Choose high-purity salt-free purification and order oligonucleotides in solution with a 
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concentration of 100 µM in H2O (see also Reagent Setup). Store the .csv file in a folder so that the program can later create 
pipetting schemes based on your plate stock. In addition, order the biotinylated staples (for cover glass attachment of the 
DNA origami) that can be found in Supplementary Table 4.
 PAUSE POINT Typically, synthesis of unmodified oligonucleotides at a commercial vendor will take between 2 and  
10 working days.

Folding of DNA structures ● TIMING 6–7 h
6|	 Once all sequences are obtained, staples with the same extension are pooled together from plates and place in micro-
centrifuge tubes as stock mixes. Picasso will generate a visual pipetting aid to help identify which staples need to be pooled 
together in a separate microcentrifuge tube. To so initiate this, select ‘Pipetting scheme’ and select the folder with all 
previously generated plates. ‘Picasso: Design’ will search in all .csv files in that folder for sequences that are needed for the 
design. Note that only .csv files that contain staple lists (that were generated with ‘Get plates’ in ‘Picasso: Design‘) should 
be present in that folder. A list will be generated with all necessary sequences and the visual pipetting aid in .pdf format for 
the origami stock mixes. The dimensions of the printed pipetting scheme match those of typical 96-well plates, so that wells 
that need to be pipetted can be easily identified.
 CRITICAL STEP If the software does not find all sequences that are needed in the plate list, it will display an error 
message but still compile the pipetting aid and the staple list. Missing staples are indicated by ‘NOT FOUND’ in the list.

7|	 Print out the pipetting aid and place a transparent 96-well plate above it. Pool staples according to their color and 
the pipetting aid for stock mixes in microcentrifuge tubes. The volume of each staple that is needed when pooling can be 
estimated considering the final amount of structures. When folding, i.e., 40 µl of DNA origami with a 10-nM final scaffold 
concentration (enough for ~80 DNA-PAINT experiments), the amount of staples needed is ~0.04 µl for each core staple and 
~0.4 µl for each extended staple. As pipetting precision decreases with small volumes, pipette at least 1 µl per staple when 
pooling for mixes. Avoid contamination of the plates, do not talk while pipetting and cover the plates whenever possible. 
Seal the plates immediately after use. Store mixes at −20 °C in tubes for up to 12 months.

8|	 Select ‘Folding Scheme’ to generate a table with a folding protocol. Adjust the initial concentrations in the table  
according to the ordered stocks and click ‘Recalculate’, if applicable. The software will automatically calculate the  
concentration of a strand in a staple mix depending on the number of staples in the mix. Adjust ‘Excess’ or ‘Total Volume’  
to your needs and mix all items on the folding scheme list in the calculated quantities. Refer to Supplementary Table 5  
for n exemplar folding table.

9|	 Use a thermocycler and fold the origami mix using the following thermal gradient:

Cycle number Parameters

1 80 °C

2–57 60 °C–4 °C, 3 min 12 s per °C

58 Hold at 4 °C

 PAUSE POINT The structures can be stored at 4 °C for up to 1 week or at −20 °C in DNA LoBind Tubes for long-term storage 
(at least several months).

Purification of DNA nanostructures ● TIMING ~3.5 h
10| Purify the DNA nanostructures using your favorite method. Several methods for purification of DNA nanostructures,  
such as Gel42, rate-zonal centrifugation43 and PEG44, are described in the literature. For DNA-PAINT, it is possible in most 
cases to use the structures without purification, as excess staple strands will be washed out of the flow chamber.
 CRITICAL STEP When folding DNA origami for the first time, it is recommended to run an agarose gel to confirm the  
folding (Fig. 6). Typically, well-folded monomeric structures will appear as a single sharp gel band (upper highlighted area  
in the gel in Fig. 6) together with a faster migrating band consisting of excess staple strands (lower highlighted area in the 
gel in Fig. 6).
 PAUSE POINT The structures can be stored at 4 °C for up to 1 week or at −20 °C in DNA LoBind Tubes for at least 1 year.

11| Prepare a solution of 1.8 g of agarose in 120 ml of gel buffer in an Erlenmeyer flask (1.5% (wt/vol)).
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12| Use a microwave to heat up and completely solubilize the agarose solution by stirring the flask in between the heating phases.
! CAUTION Use heat-resistant gloves when handling the hot flask to avoid burns.

13| If no agarose particle traces are visible anymore, let the solution cool for 1 min, and add 1.5 ml of 1M MgCl2 and 14 µl 
of Sybr Safe.
! CAUTION Avoid inhaling solutions with Sybr Safe.

14| Pour the solution into a gel chamber, add an appropriate comb and let it solidify for 45 min.

15| Load the gel with the DNA origami structures. Prepare two lanes for a DNA ladder and scaffold (same concentration  
as origami) as reference. Mix the origami solution with loading dye (20 µl of folded DNA Origami + 5 µl of loading dye) and 
run the gel in running buffer at 90 V for 90 min at 4 °C or on ice.

16| Acquire an image using a gel imager for documentation.

17| Cut out the origami band with a razor blade on a blue-light transilluminator table. The origami band should appear as  
a distinct band with a slight shift as compared with the scaffold. Excess staples will have created a broader band that 
traveled further. Crush the gel piece with a pestle, transfer it to a Freeze ’N Squeeze column, and spin it for 6 min at 1,000g 
at 4 °C. Keep the flow-through and discard the filter.
? TROUBLESHOOTING
 PAUSE POINT The origami can be stored at 4 °C for 1 week or at −20 °C in LoBind tubes for long-term storage.

Preparation of DNA origami for DNA-PAINT imaging ● TIMING ~45 min
18| There are two options for preparing microscopy slides. See option A for the preparation in a custom-built flow chamber 
that will be sealed after immobilization of structures and addition of imager solution. For Exchange-PAINT experiments that 
require fluid exchange, see option B for preparation in an open chamber. The process of making custom-built chambers is 
also depicted in Supplementary Figure 10.
(A) Immobilization in a custom-built chamber
	 (i) �Clean the microscopy slide and the cover glass with isopropanol and dry it with lab wipes.
	 (ii) �Prepare a flow chamber by taping two stripes of double-sided adhesive tape ~8 mm apart on the microscopy slide and 

form a flow chamber by placing a cover glass on top. The resulting channel will have a volume of ~20–30 µl. Use a 
pipette tip and press the cover glass firmly against the sticky tape. The sticky tape will appear darker when the cover 
glass is in good contact. 
 CRITICAL STEP Do not use excessive force, as the glass may break.

	 (iii) �Remove excess adhesive tape by pulling the tape over the edges of the cover glass.
	 (iv) �Fill the chamber with 20 µl of BSA–Biotin solution (1 mg/ml) and incubate it for 2 min.
	 (v) �Wash the channel with 40 µl of Buffer A+ by holding the tip of a folded lab wipe on one end of the channel and  

simultaneously pipetting in washing buffer on the other side. The capillary forces of the tissue will suck the liquid 
out of the chamber, whereas the pipetting will introduce additional volume. Control the flow by variation of pipetting 
speed and tissue pressure. 
 CRITICAL STEP Avoid bubbles by keeping an even flow. Do not let the chamber dry out. Practice with an empty 
slide and water if necessary.

	 (vi) �Add 20 µl of streptavidin solution (0.5 mg/ml) to the channel and incubate it for 2 min.
	 (vii) �Wash the channel with 40 µl of Buffer A+.
	(viii) �Wash the channel with 40 µl of Buffer B+.
	 (ix) �Add 20 µl of (5 µl of gel-purified DNA origami and 15 µl of Buffer B+) origami solution and incubate for 2 min. 

? TROUBLESHOOTING
	 (x) �Wash the channel with 40 µl of Buffer B+.
	 (xi) �Add 20 µl of imager solution to the channel. 

 CRITICAL STEP Imager concentration has a critical role in proper acquisition of DNA-PAINT data. For in vitro  
samples, consider an ~5 nM imager concentration for a DNA nanostructure with 12 binding sites as a start value.

	 (xii) �(Optional) For spectral multiplexing, use 2 different DNA sequences with spectrally distinct fluorophores, such as  
Cy3B and Atto655.

	(xiii) �Use epoxy glue to seal the chamber. Pour the glue on a piece of weighing paper, mix with a pipette tip and distribute 
the glue evenly on the edges of the cover glass. Once the chamber is sealed, place the pipette tip standing up in the 
remaining epoxy to later evaluate the glue dryness.
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	(xiv) �Wait for ~15 min for the epoxy to dry. The drying process can be evaluated by checking the pipette tip in the epoxy. 
Once the epoxy is completely dry, the pipette tip should stick. The sample is now ready for imaging. 
 CRITICAL STEP Wait until the epoxy is completely dry to avoid glue contamination of the microscope objective.

(B) Immobilization in a 6-channel ibidi sticky-Slide
	 (i) �Clean the cover glass (24 × 60 mm) with isopropanol and dry it with lab wipe.
	 (ii) �Attach the cover glass upside down to the sticky-Slide and press it with the help of a pipette tip against the cover glass.
	 (iii) �Add 80 µl of BSA–biotin solution to the channel. Tilt the slide slightly to ensure that the chamber is completely  

filled and incubate it for 5 min.
	 (iv) �Wash the channel with 180 µl of Buffer A+ by pipetting the solution into one opening and pipetting out 180 µl  

from the opposing opening.
	 (v) �Incubate 40 µl of streptavidin solution twice for 5 min.
	 (vi) Wash the channel with 180 µl of Buffer A+.
	 (vii) Wash the channel with 180 µl of Buffer B+.
	(viii) �Icubate the DNA origami solution (20 µl of gel-purified DNA origami + 60 µl of Buffer B+) for 20 min. 

? TROUBLESHOOTING
	 (ix) �Wash the channel two times with 100 µl of Buffer B+.
	 (x) �Add Imager strand solution to the sample for imaging. 

 CRITICAL STEP Imager concentration has a critical role in proper acquisition of DNA-PAINT data.  
For in vitro samples, consider ~5 nM for DNA nanostructures with 12 binding sites as a start value. (Optional)  
For spectral multiplexing, use two different DNA sequences with spectrally distinct fluorophores, such as  
Cy3B and Atto655.

	 (xi) �Put the lid back on the chamber. The sample is now ready for imaging.

Sample preparation for in situ samples
19| Generate DNA-conjugated secondary antibodies. Here, two methods are presented: option A describes the use of a  
maleimide-PEG2-succinimidyl ester cross-linker, which links free amino groups on the protein to reduced thiolated DNA22, 
and option B describes the use of a DBCO-sulfo-NHS ester, which binds to amino groups on the protein and via copper-free  
click chemistry to an azide-modified DNA strand55. The copper-free click chemistry allows for conjugation of multiple 
antibody species in parallel, whereas the attachment via Maleimide chemistry is more cost-effective, considering the DNA 
components. The reduction of the thiol group and the subsequent purification of the DNA from DTT using the Nap-5 column 
is time-consuming and time-critical. Long waiting times will lead to disulfide bridging of the DNA strands. The copper-free 
click chemistry in comparison does not have such a time-consuming and time-critical step in regard to the reagent stability, 
and therefore allows for parallel labeling of the antibodies. Alternatively, DNA-labeled antibodies can also be obtained from 
Ultivue (http://www.ultivue.com).
(A) DNA labeling of antibodies via maleimide-PEG2-succinimidyl ester for cellular labeling ● TIMING 1 d 1 h
	 (i) �To reduce the thiolated DNA for the Maleimide reaction, mix 30 µl of 1-mM thiolated DNA with 70 µl of freshly  

prepared DTT solution and incubate the mixture on a shaker for 2 h at RT covered with aluminum foil.
	 (ii) �Concentrate the antibody using Amicon spin filters (100 kDa). Wash the filters with 1× PBS for 10 min at 14,000g  

at 4 °C. Discard the flow-through, add 300 µl of antibody solution and spin at 14,000g for 5 min at 4 °C. Discard the  
flow-through and invert the spin filter in an empty tube. Spin for 6 min at 1,000g at 4 °C. Adjust the volume to 100 µl  
with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer. Keep the antibody on ice. The final 
concentration should be >1.5 mg/ml.

	 (iii) �Prepare the cross-linker solution in 1× PBS and add it to the antibody in a 10:1 molar ratio. Incubate the solution  
for 90 min at 4 °C on a shaker covered in aluminum foil. Start the reaction 1 h after the DNA reduction step  
was started. 
 CRITICAL STEP The desired amount of cross-linker must be no more than 5 µl in volume in order to avoid adding 
too much of DMF or diluting the antibody further.

	 (iv) �20 min before the DNA reduction step is completed, start to equilibrate a Nap-5 column with ddH2O filled to the  
top three times. Add DNA–DTT solution to the column and immediately add 400 µl of ddH2O. After 400 µl has passed 
through, add 1 ml of ddH2O and start collecting fractions immediately. Collect three drops in the first four tubes,  
two drops in the following four and one drop in the last eight tubes. Starting from the last collected tube, add 25 µl 
of BCA mix to the tubes. If DTT is still present, the solution turns purple. Discard those tubes. If no color change  
is visible anymore, discard the next tube as well and measure the concentration of the remaining fractions via the  
NanoDrop spectrophotometer. Pool the fractions with the highest concentrations. The highest fractions will have a  
DNA concentration between 200 and 800 ng/µl. 
 CRITICAL STEP If DTT is still present in the DNA solution, it will interfere with the Maleimide reaction.
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	 (v) �Concentrate the reduced DNA using Amicon spin filters (3 kDa). Wash the filter with 1× PBS for 30 min at 14,000g  
at 4 °C. Discard the flow-through and add the pooled fractions of reduced DNA to the filter. Centrifuge for 30 min  
at 14,000g at 4 °C and discard the flow-through. Invert the spin filter in an empty new tube and spin for 6 min at 
1,000g at 4 °C. Measure the concentration with the NanoDrop spectrophotometer; the DNA should have a concentra-
tion >700 ng/µl.

	 (vi) �After the antibody–cross-linker reaction has completed, use a Zeba desalting column to remove the linker. Remove the 
storage solution by centrifugation at 1,500g for 1 min at 4 °C. Mark the side where the resin slid up, and perform the 
subsequent centrifugation steps in the same orientation. Wash the Zeba column with 300 µl of PBS and centrifuge it 
at 1,500g for 1 min at 4 °C. Dry the bottom of the column and use a fresh 1.5-ml tube. Add the antibody–cross-linker 
solution to the Zeba column, and spin at 1,500g for 2 min at 4 °C. Discard the Zeba column, retain the flow-through 
and measure the concentration with the NanoDrop spectrophotometer. The antibody concentration should be > 1.5 
mg/ml.

	 (vii) �Incubate a 10:1 molar ratio of thiolated DNA to antibody overnight on a shaker covered in aluminum foil in  
a cold room.

	(viii) �Remove excess DNA by Amicon spin filtration (100 kDa). For this, wash the filters with 1× PBS for 10 min at 14,000g 
at 4 °C. Discard the flow-through, add antibody–DNA solution, add 300 µl PBS and spin at 14,000g for 5 min at 4 °C. 
Discard the flow-through and invert the spin filter into an empty tube. Spin the solution for 6 min at 1,000g at 4 °C. 
Adjust the volume to 100 µl with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer.  
The peak signal should be shifted toward 260 nm from 280 nm, and the concentration should be >5 mg/ml because  
of the stronger absorbance of DNA. Keep the antibody on ice and store it at 4 °C for a maximum of 6 months. 
? TROUBLESHOOTING

(B) Labeling via DBCO-sulfo-NHS ester ● TIMING 4 h
	 (i) �Concentrate the antibody using Amicon spin filters (100 kDa). For this, wash the filters with 1× PBS for 10 min at 

14,000g at 4 °C. Discard the flow-through, add 300 µl of antibody solution and spin at 14,000g for 5 min at 4 °C.  
Discard the flow-through and invert the spin filter in an empty tube. Spin for 6 min at 1,000g at 4 °C. Adjust the  
volume to 100 µl with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer. Keep the  
antibody on ice. The final concentration should be >1.5 mg/ml.

	 (ii) �Prepare 5 µl of cross-linker solution in 1× PBS so that the final solution after addition of 100 µl of the antibody  
contains a 10:1 molar ratio of cross-linker to antibody. Incubate the solution for 90 min at 4 °C on a shaker covered  
in aluminum foil.

	 (iii) �After the antibody–cross-linker reaction is completed, use a Zeba desalting column to remove the linker. Remove the 
storage solution by centrifugation at 1,500g for 1 min at 4 °C. Mark the side where the resin slid up, and perform the 
subsequent centrifugation steps in the same orientation. Wash the Zeba column with 300 µl of 1× PBS at 1,500g for  
1 min at 4 °C. Dry the bottom of the column and use a fresh 1.5-ml tube. Add antibody–cross-linker solution to the 
Zeba column and spin it at 1,500g for 2 min at 4 °C. Discard the Zeba column, retain the flow-through and measure 
the concentration on the NanoDrop spectrophotometer. The antibody concentration should be >1.5 mg/ml.

	 (iv) �Create a 15:1 molar ratio of DNA to antibody and incubate the solution for 1 h at RT on a shaker covered in aluminum 
foil.

	 (v) �Remove the excess DNA by Amicon spin filtration (100 kDa). For this, wash the filters with 1× PBS for 10 min at 
14,000g at 4 °C. Discard the flow-through, add antibody-DNA solution, add 300 µl of 1× PBS and spin at 14,000g for 
5 min at 4 °C. Discard the flow-through and invert the spin filter in an empty tube. Spin for 6 min at 1,000g at 4 °C. 
Adjust the volume to 100 µl with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer.  
The peak signal should be shifted toward 260 nm from 280 nm, and the concentration should be >5 mg/ml because  
of the stronger absorbance of DNA. 
? TROUBLESHOOTING
 PAUSE POINT Keep the antibody on ice and store it at 4 °C for a maximum of 6 months.

Immunofixation of cells ● TIMING 2.5 d
 CRITICAL In Steps 20–33, we describe procedures for immunofixation optimized for DNA-PAINT super-resolution micros-
copy. Fixation strategies depend on the target of interest, as well as on the antibody-recognition motifs57.
20| Seed 30,000 cells in 8-well chambered cover glasses, and let them grow overnight at 37 °C and 5% CO2 in an incubator.

21| After 24 h, the cells are ready to be fixed.

22| In this step, fixative is added to the cells; this can be performed in two ways: option A, an optimized protocol for maximum 
preservation of cellular cytoskeletal structures (recommended for imaging microtubules) and option B, a standard protocol.

68 dna-paint and super-resolution microscopy
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(A) Optimized microtubule fixation
	 (i) �Pre-extract the cells with prewarmed (37 °C for 10 min) pre-extraction buffer for 90 s.
	 (ii) �Remove the extraction buffer and fix the cells for 15 min in prewarmed enhanced microtubule fixative.
(B) Standard fixation
	 (i) �Fix the cells in standard fixative for 15 min.

23| Aspirate the fixative solution and reduce the sample with 1 mg/ml sodium borohydride for 7 min.
 CRITICAL STEP Sodium borohydride must be prepared just before application to the sample and is very volatile.

24| Wash the chamber four times (1 × 20 s, 3 × 5 min) with 1× PBS at pH 7.2.

25| Block and permeabilize the cell sample in blocking buffer for 90 min at RT.

26| Dilute the primary antibody according to supplier instructions in antibody dilution buffer, and incubate the sample  
at 4 °C overnight on a rocking platform.

27| Wash the sample three times for 5 min in 1× PBS.

28| Dilute DNA-labeled secondary antibody (5–50 µg/ml) in antibody dilution buffer, and apply it to the sample  
for 60 min. (Optional) For multiplexing experiments, use different secondary antibodies with orthogonal DNA handles;  
see Supplementary Table 2 for recommended sequences.

29| Wash the sample three times for 5 min in 1× PBS.

30| Dilute 90-nm gold particles at a 1:10 ratio in PBS as fiducial markers and incubate for 5 min on the cell sample.

31| Wash the sample three times for 5 min in 1× PBS.

32| Add a target-specific imager solution to the sample.
 CRITICAL STEP Imager concentration has a critical role in proper acquisition of DNA-PAINT data. The concentration should 
be adjusted for the target (hence docking strand) density. For microtubules, we recommend starting with a 500 pM imager 
strand concentration and adjusting as necessary.

33| (Optional) For multiplexed Exchange-PAINT experiments, place the exchange lid with the connected tubing on the  
chambered cover glass.

Data acquisition ● TIMING 10 min to 10 hours
 CRITICAL The following section describes the procedure for performing DNA-PAINT experiments using imager sequences 
labeled with Cy3B fluorophores. As the SNR for DNA-PAINT is rather high, both CCD or sCMOS cameras are suitable for  
imaging. The procedure is written for use of an iXon Ultra DU-897 EMCCD camera, although electron-multiplying is not  
necessary. Considerations in regard to acquisition of images with ultra-high resolution are described in Box 2. For test  
purposes, raw DNA-PAINT data can also be simulated in silico with ‘Picasso: Simulate’ (see Box 3 for procedure details).
34| Place the sample on the microscope stage, and move the objective up until the immersion oil touches the sample.

35| (Optional) For multiplexing with Exchange-PAINT, attach tubing with syringes to the exchange chamber. Consider using 
an ~15-ml syringe volume of exchange buffer per exchange round for in situ exchange experiments, and ~1 ml of exchange 
buffer per exchange round for in vitro experiments. For in situ experiments, additionally attach tubing to the chamber inlet. 
Put the connected syringes into plastic trays to avoid accidental fluid spills. The syringes should be at the same level as the 
chamber to avoid liquid exchange, as they are communicating vessels.
 CRITICAL STEP Handle liquids extremely carefully if they are close to the microscope. Improper handling and leakage can 
lead to damage of delicate microscope components.

36| Start µManager, select the configuration file for the camera and select ‘Ok’. The main window of µManager will open.

37| Set ‘Exposure [ms]’ with regard to the following considerations: exposure times for DNA-PAINT experiments are dependent  
on the imager length and concentration, the imaging buffer and the docking strand density of the target structure. Typical 
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exposure times for 9-bp DNA duplexes are hundreds of milliseconds, and those for 8-bp DNA duplexes are tens of  
milliseconds, as they have a shorter ON-time. For the samples used in Figure 1, an exposure time of 300 ms for in vitro 
(Buffer B+) and 200 ms for in situ (Buffer C) samples was used. ‘Picasso: Simulate’ can be used to determine ideal exposure 
times for given sample parameters. As a general rule of thumb, camera integration times should be matched to mean  
ON-times of DNA-PAINT imager/docking duplexes for best performance; these can be experimentally determined using  
Picasso (see Step 69B). Refer to Supplementary Table 6 for the acquisition settings used for the images in this protocol.

38| Open ‘Tools’ > ‘Device Property Browser’.

39| Set the camera parameters: set ‘Output_Amplifier’ to ‘Conventional’, set ‘Region of Interest’ to ‘Full Image’, set ‘Frame 
Transfer’ to ‘On’, set ‘PixelType’ to ‘16bit’, set ‘ReadMode’ to ‘Image’ and set ‘Camera shutters’ to ‘Open’.

40| Click on ‘Live’ in the main window, and the ‘Snap/Live’ window will appear. Select ‘Autostretch’ in the contrast settings. 
The ‘Snap/Live’ window should show background noise.

41| Set the laser to a low power density of 0.25 kW/cm2 at the sample plane (refer to the calibration as performed in the 
Equipment Setup), and open the laser shutter.
? TROUBLESHOOTING

42| Focus the image.
 CRITICAL STEP A focused image should show blinking diffraction-limited spots, each representing the binding and  
unbinding of an imager strand to its target. Adjust the contrast by dragging the black and white triangles in the ‘Contrast’ 
window if needed. For prefocusing, preferably use a focus-lock system such as the Nikon Perfect Focus System or, in case of  
in situ samples, prefocus with the bright-field image.
? TROUBLESHOOTING

43| Increase the laser power to a power density of ~ 2.5 kW/cm2 at the sample plane.

44| Adjust the laser incident angle. When starting in an epifluorescence configuration, increase the angle until  
total internal reflection occurs. Continue until no more light is reflected and the signal decreases. Then, go back by  
decreasing the angle and optimize the SNR. When imaging structures beyond the TIRF illumination range, decrease the  
incident angle—potentially moving to oblique (HILO) illumination31—just until the structure of interest is properly  
illuminated. Keeping the incident angle as high as possible limits out-of-focus excitation above the target structure,  
which is particularly critical for DNA-PAINT, as free imager strands in solution increase background and therefore affect  
imaging quality adversely.

45| In the device manager, adjust the ‘Readout Mode’ to the frequency with the lowest readout noise possible for the  
currently selected integration time. This is usually the lowest frequency at which the readout time does not exceed  
the exposure time. The readout time will be displayed in ‘ReadoutTime’ and should be shorter than the ‘Exposure’ time.  
Please double-check that the field ‘ActualInterval-ms’, which denotes the true duration between two frames, does not  
exceed the exposure time.

46| Click on ‘Multi-D-Acq.’ in the main window to open the ‘Multi-Dimensional Acquisition’ window. Activate ‘Time points’ 
and set the ‘Number’ to the number of frames to be acquired—e.g., 7,500 for in vitro samples and 15,000 for in situ samples. 
These exemplar numbers for total acquisition frames are suggestions for initial experiments and may have to be adjusted  
according to the specific experiment. For a detailed discussion of optimal acquisition time, refer to Nieuwenhuizen et al.16 
and respective sections in the introduction of this protocol.

47| Set the interval to ‘0’ and ‘ms’. Set ‘Acquisition Order’ to ‘Time’. Activate ‘Save images’ and set a destination filename and folder.

48| Select ‘Acquire!’ to start the acquisition. A live image will pop up. The progress of the acquisition can be followed  
on the upper left corner.
? TROUBLESHOOTING

49| (Optional) Multiplexed image acquisition. There are two methods for performing multiplexed target acquisition with  
DNA-PAINT. Spectral multiplexing (option A) uses spectrally distinct fluorophores, whereas Exchange-PAINT multiplexing 

70 dna-paint and super-resolution microscopy



©
20

17
 M

ac
m

ill
an

 P
u

b
lis

h
er

s 
L

im
it

ed
, p

ar
t 

o
f 

S
p

ri
n

g
er

 N
at

u
re

. A
ll 

ri
g

h
ts

 r
es

er
ve

d
.

© 2017 Macmillan Publishers Limited, part of Springer Nature. All rights reserved. © 2017 Macmillan Publishers Limited, part of Springer Nature. All rights reserved.

protocol

nature protocols | VOL.12 NO.6 | 2017 | 1221

(option B) uses (typically) the same fluorophore attached to orthogonal DNA species that are sequentially supplied to the 
sample. With Exchange-PAINT, only one species is present in the imager buffer in each multiplexing round, and it will be 
washed out afterward. Option A provides a relatively fast workflow for imaging multiple targets by imaging in multiple emis-
sion channels. Option B has almost no limitation in multiplexing but requires a fluid exchange system. In addition, option B 
provides the capability of using the most favorable fluorophore for all targets. Refer to Supplementary Table 7 for a list of 
dye recommendations for DNA-PAINT.
(A) Spectral multiplexing
	 (i) �Perform Steps 34–48 for the first fluorophore. 

 CRITICAL STEP To reduce photodamage, start acquisition with the dye that has the longest excitation wavelength, 
and then proceed to those with shorter wavelengths.

	 (ii) �After acquisition of the first imager species, change the laser line and the filter set on the microscope to match the 
next wavelength.

	 (iii) �Click on ‘Live’ in the main window of µManager and adjust the TIRF angle if necessary.
	 (iv) �Adjust the file name in the ‘Multi-Dimensional Acquisition’ window.
	 (v) �Select ‘Acquire!’ to start a new acquisition.
	 (iv) �(Optional) Repeat the procedure for any other spectrally distinct imager species in solution.
(B) Exchange multiplexing
	 (i) �Perform Steps 34–48 to acquire a movie for the first imager species.
	 (ii) �Click on ‘Live’ in the main window and adjust the contrast so that individual blinking events are visible. Deselect  

‘Autostretch’. It is important to keep the contrast to determine when all imagers are washed out.
	 (iii) �Apply several washing steps while observing the ‘Live/Snap’ window until no more blinking events are visible.  

One washing step consists of filling the chamber by adding exchange buffer (for in vitro imaging use ~180 µl,  
and for in situ imaging use 1 ml) to the inlet and then removing the same volume from the outlet. For in situ  
imaging a total of ~15 ml and for in vitro imaging a total of ~1 ml of exchange buffer will be needed per  
exchange round. 
 CRITICAL STEP Do not remove all liquid from the chamber; it should never dry out. Perform liquid exchange slowly 
to avoid introducing air bubbles into the chamber or disturbing the sample. 
? TROUBLESHOOTING

	 (iv) �After washing, introduce a new imager solution into the chamber. For in vitro samples, simply pipette the required 
amount into the chamber and remove the same amount from the outlet. For in situ samples, empty the inlet tubing  
by disconnecting the empty syringe and pumping air through it. Connect a new 2-ml syringe with a new imager  
solution and fill the chamber.

	 (v) �While introducing the new imager, the ‘Live/Snap’ window should show reappearing blinking events.
	 (vi) �Adjust the filename in the ‘Multi-Dimensional Acquisition’ window.
	 (vii) �Select ‘Acquire!’ to start a new acquisition.
	(viii) �(Optional) Repeat the procedure for subsequent imaging rounds.

Image reconstruction ● TIMING 5–30 min
50| Identification and fitting of single-molecule spots. In ‘Picasso: Localize’, open a movie file by dragging the file into  
the window or by selecting ‘File’ > ‘Open’. If the movie is split into multiple µManager .tif files, open only the first file.  
Picasso will automatically detect the remaining files according to their file names.

51| Adjust the image contrast (select ‘View’ > ‘Contrast’) so that the single-molecule spots are clearly visible.

52| To adjust spot identification and fit parameters, open the ‘Parameters’ dialog (select ‘Analyze’ > ‘Parameters’).

53| In the ‘Identification’ group, set the ‘Box side length’ to the rounded integer value of 6 × σ + 1, where σ is the standard 
deviation of the PSF. In an optimized microscope setup, σ is one pixel, and the respective ‘Box side length’ should be set to 7.  
The value of ‘Min. net gradient’ specifies a minimum threshold above which spots should be considered for fitting. The net 
gradient value of a spot is roughly proportional to its intensity, independent of its local background. By checking ‘Preview’, 
the spots identified with the current settings will be marked in the displayed frame. Adjust ‘Min. net gradient’ to a value at 
which only spots are detected (no background).

54| In the ‘Photon conversion’ group, adjust ‘EM Gain’, ‘Baseline’, ‘Sensitivity’ and ‘Quantum Efficiency’ according to your 
camera specifications and the experimental conditions. Set ‘EM Gain’ to 1 for conventional output amplification. ‘Baseline’ is 
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the average dark camera count. ‘Sensitivity’ is the conversion factor (electrons per analog-to-digital (A/D) count) and  
‘Quantum Efficiency’ should be set according to the average emission wavelength.
 CRITICAL STEP These parameters are critical to converting camera counts to photons correctly. The quality of the upcom-
ing maximum likelihood fit strongly depends on a Poisson photon noise model, and thus on the absolute photon count.

For simulated data, generated with ‘Picasso: Simulate’ as described in Box 3 and Figure 7, set the parameters as follows:  
‘EM Gain’ = 1, ‘Baseline’ = 0, ‘Sensitivity’ = 1, ‘Quantum Efficiency’ = 1.

55| From the menu bar, select ‘Analyze’ > ‘Localize (Identify & Fit)’ to start spot identification and fitting in all movie 
frames. The status of this computation is displayed in the window’s status bar. After completion, the fit results will be saved 
in a new file in the same folder as the movie, in which the filename is the base name of the movie file with the extension 
‘_locs.hdf5’. Furthermore, information about the movie and analysis procedure will be saved in an accompanying file with  
the extension ‘_locs.yaml’; this file can be inspected using a text editor.

56| Rendering of the super-resolution image: In ‘Picasso: Render’, open a movie file by dragging a localization file (ending 
with ‘.hdf5’) into the window or by selecting ‘File’ > ‘Open’. The super-resolution image will be rendered automatically.  
A region of choice can be zoomed into by a rectangular selection using the left mouse button. The ‘View’ menu contains 
more options for zooming and panning.

57| (Optional) Adjust rendering options by selecting ‘View’ > ‘Display Settings’. The field ‘Oversampling’ defines the number 
of super-resolution pixels per camera pixel. The contrast settings ‘Min. Density’ and ‘Max. Density’ define at which number of 
localizations per super-resolution pixel the minimum and maximum color of the colormap should be applied.

58| (Optional) For multiplexed image acquisition, open HDF5 localization files from other channels subsequently.  
Alternatively, drag and drop all HDF5 files to be displayed simultaneously.

Image post-processing: drift correction ● TIMING seconds to minutes
59| Picasso offers two procedures to correct for drift: an RCC algorithm66 (option A), and use of specific structures  
in the image as drift markers23 (option B). Although option A does not require any additional sample preparation,  
option B depends on the presence of either fiducial markers or inherently clustered structures in the image. On the other 
hand, option B often supports more precise drift estimation and thus allows for higher image resolution. To achieve the  
highest possible resolution (ultra-resolution), we recommend consecutive applications of option A and multiple rounds of  
option B. The drift markers for option B can be features of the image itself (e.g., protein complexes or DNA origami) or  
intentionally included markers (e.g., DNA origami or gold nanoparticles). When using DNA origami as drift markers, the  
correction is typically applied in two rounds: first, with whole DNA origami structures as markers, and, second, using  
single DNA-PAINT binding sites as markers. In both cases, the precision of drift correction strongly depends on the  
number of selected drift markers.
(A) Redundant cross-correlation drift correction
	 (i) �In ‘Picasso: Render’, select ‘Postprocess’ > ‘Undrift by RCC’.
	 (ii) �A dialog will appear asking for the segmentation parameter. Although the default value, 1,000 frames, is a sensible 

choice for most movies, it might be necessary to adjust the segmentation parameter of the algorithm, depending on 
the total number of frames in the movie and the number of localizations per frame66. A smaller segment size results in 
better temporal drift resolution but requires a movie with more localizations per frame.

	 (iii) �After the algorithm finishes, the estimated drift will be displayed in a pop-up window and the display will show the 
drift-corrected image.

(B) Marker-based drift correction
	 (i) �In ‘Picasso: Render’, pick drift markers as described in Steps 61–64. Use the ‘Pick similar’ option (Step 65) to  

automatically detect a large number of drift markers similar to a few manually selected ones. 
 CRITICAL STEP If the structures used as drift markers have an intrinsic size larger than the precision of individual 
localizations (e.g., DNA origami, large protein complexes), it is critical to select a large number of structures.  
Otherwise, the statistic for calculating the drift in each frame (the mean displacement of localization to the  
structure’s center of mass) is not valid.

	 (ii) �Select ‘Postprocess; > ‘Undrift from picked’ to compute and apply the drift correction.

60| (Optional) Save the drift-corrected localizations by selecting ‘File’ > ‘Save localizations’.

72 dna-paint and super-resolution microscopy
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Picking of regions of interest ● TIMING 5–30 min
61| Manual selection. Open ‘Picasso: Render’ and load the localization HDF5 file to be processed.

62| Switch the active tool by selecting ‘Tools’ > ‘Pick’. The mouse cursor will now change to a circle.

63| Set the size of the pick circle by adjusting the ‘Diameter’ field in the tool settings dialog (‘Tools’ > ‘Tools Settings’).

64| Pick regions of interest using the circular mouse cursor by clicking the left mouse button. All localizations within the 
circle will be selected for further processing.

65| (Optional) Automated region of interest selection. Select ‘Tools’ > ‘Pick similar’ to automatically detect and pick structures 
that have similar numbers of localizations and RMS deviation (RMSD) from their center of mass than already-picked struc-
tures. The upper and lower thresholds for these similarity measures are the respective standard deviations of already-picked 
regions, scaled by a tunable factor. This factor can be adjusted using the field ‘Tools’ > ‘Tools Settings’ > ‘Pick similar ± 
range’. To display the mean and standard deviation of localization number and RMSD for currently picked regions, select ‘View’ 
> ‘Show info’ and click ‘Calculate info below’.

66| (Optional) Exporting of pick information. All localizations in picked regions can be saved by selecting ‘File’ > ‘Save picked 
localizations’. The resulting HDF5 file will contain a new integer column ‘group’ indicating to which pick each localization is 
assigned.

67| (Optional) Statistics about each pick region can be saved by selecting ‘File’ > ‘Save pick properties’. The resulting  
HDF5 file is not a localization file. Instead, it holds a data set called ‘groups’ in which the rows show statistical values  
for each pick region.

68| (Optional) The picked positions and diameter itself can be saved by selecting ‘File’ > ‘Save pick regions’. Such saved pick 
information can also be loaded into ‘Picasso: Render’ by selecting ‘File’ > ‘Load pick regions’.

Additional post-processing steps
69|Depending on the experimental goals, a variety of post-processing steps may be used. To filter localizations based on 
their properties, for example to remove localizations below a certain photon threshold, use option A. For investigating the 
statistics of DNA-PAINT binding kinetics and how to count DNA-PAINT binding sites with qPAINT22, use options B and C,  
respectively. Option D describes the procedure to generate an average image of multiple structures. Finally, option E  
describes the procedure to align images from multiplexed experiments.
(A) Filtering of localizations ● TIMING 5–10 min
	 (i) �Open a localization HDF5 file in ‘Picasso: Filter’ by dragging it into the main window or by selecting ‘File’ > ‘Open’.  

The displayed table shows the properties of each localization in rows. Each column represents one property (e.g.,  
coordinates, number of photons); see the Supplementary Manual for details.

	 (ii) �To display a histogram from values of one property, select the respective column in the header and select ‘Plot’ > 
‘Histogram’ (Ctrl + h). 2D histograms can be displayed by selecting two columns (press Ctrl to select multiple columns) 
and then selecting ‘Plot’ > ‘2D Histogram’ (Ctrl + d).

	 (iii) �Left-click and hold the mouse button down to drag a selection area in a 1D or 2D histogram. The selected area will be 
shaded in green, as shown in Supplementary Figure 5b,c. Each localization event with histogram properties outside 
the selected area is immediately removed from the localization list.

	 (iv) �Save the filtered localization table by selecting ‘File’ > ‘Save’.
(B) Analysis of blinking kinetics ● TIMING 5–60 min
	 (i) �In ‘Picasso: Render’, pick regions of interest as described in Steps 61–65.
	 (ii) �Select ‘View’ > ‘Show info’.
	 (iii) �In the opened dialog, click ‘Calculate info below’. The mean and standard deviation per pick of several values will be 

calculated and displayed. The ‘Length’ row describes the blinking ‘ON’ time (τb) and the ‘Dark time’ row describes the 
blinking ‘OFF’ time (τd).

	 (iv) �Click ‘Histograms’ to open a new window showing histograms for the picked region’s kinetics.
	 (v) �(Optional) Individual values for each picked region can be obtained by exporting the data. Select ‘File’ > ‘Save  

pick properties’. The saved HDF5 file will contain a data set called ‘groups’, in which each row corresponds to one  
pick region.
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(C) Counting of molecule numbers with qPAINT ● TIMING 5–60 min
	 (i) �In ‘Picasso: Render’, pick calibration regions as described in Steps 61–64. Typically, calibration regions are regions with 

a known number of binding sites. Do not use the option ‘Pick similar’ (Step 65), as this may bias the calibration.
	 (ii) �Select ‘View’ > ‘Show info’ and click ‘Calculate info below’.
	 (iii) �Set ‘# Units per pick’ to the number of units to which the counting should be calibrated. Typically, one unit is equal  

to one DNA-PAINT binding site, but other user-defined units might be suitable too. This could, i.e., be useful in the 
case in which calibration is performed on single antibodies, which can carry multiple docking strands for protein  
quantification using qPAINT. The final counting result will be reported in number of units. For example, if the  
calibration regions contain 12 binding sites and the counting result should be reported in ‘number of binding sites’, 
then ‘# Units per pick’ should be to be set to 12.

	 (iv) �Click ‘Calibrate influx’ for an estimation of the influx rate from the calibration regions kinetics. The influx rate will  
be displayed in the respective field. As an alternative to the experimental calibration, the influx rate (ξ) can be  
theoretically calculated via ξ = kon × c if the ON rate (kon) and imager concentration (c) are known. In that case,  
enter the influx rate manually into the respective field.

	 (v) �Select ‘Tools’ > ‘Clear picks’ to remove the calibration pick selections.
	 (vi) �Pick structures of interest (Steps 61–65) from which the unknown number of units should be determined.
	 (vii) �In the ‘Info’ dialog, click ‘Calculate info below’. The mean number of units per picked region will be displayed in the ‘# 

Units’ row, as calculated from the currently displayed influx rate.
	(viii) �(Optional) The individual number of units for each picked region can be obtained by exporting pick property data. 

Select ‘File’ > ‘Save pick properties’. The saved HDF5 file will contain a data set called ‘groups’, which holds statistics 
about each pick region as rows, including a column for the unit number (‘n_units’).

(D) Particle averaging ● TIMING 10–30 min
	 (i) �In ‘Picasso: Render’, pick structures to be averaged as in Steps 61–65.
	 (ii) �Save the picked localizations by selecting ‘File’ > ‘Save picked localizations’.
	 (iii) �Load the resulting file with picked localizations into ‘Picasso: Average’ by selecting ‘File’ > ‘Open’ or dragging and  

dropping it into the window.
	 (iv) �‘Picasso: Average’ will immediately perform a translational alignment of the picked structures and display an average 

image. Rotational and refined translational alignment will follow in the next steps.
	 (v) �Select ‘Process’ > ‘Parameters’ and adjust the ‘Oversampling’ parameter. We recommend choosing the highest number 

at which the average image still appears smooth. High oversampling values result in substantial computational time. 
Hence, it might be useful to first use low oversampling to generate a less-refined average image and perform a second 
averaging step with higher oversampling for optimized resolution.

	 (vi) �Adjust the number of average iterations in the ‘Iterations’ field. In most cases, a value of 10 is more than sufficient.  
If you are unsure about the computational time of the process, choose one iteration as a starting point. More  
iterations can be added later by repeating the processing steps. After a certain number of iterations, the average  
image will converge, meaning that it will not change with more iterations.

	 (vii) �Select ‘Process’ > ‘Average’ to perform particle averaging with the current oversampling for the set number of  
iterations. This step can be repeated with different settings. The program will use the current average image  
as a starting point.

	(viii) �Once the average image has converged, save the transformed localizations by selecting ‘File’ > ‘Save’. The resulting 
HDF5 localization file contains the aligned localizations in the center of the movie dimensions. It can be loaded like 
any other HDF5 localization file into ‘Picasso: Render’.

(E) Aligning of channels from multiplexed experiments ● TIMING 5–10 min
	 (i) �To align images from multiplexed data acquisition, the images need to share some features as reference points.  

Such reference features can be the cell shape for in situ images (typically, background is higher inside the cell)  
or overlapping clusters (for example, on the same DNA origami). If alignment results are ambiguous or not satisfying 
because of the lack of inherent reference features, drift or alignment markers should be included and imaged in  
all channels.

	 (ii) �In ‘Picasso: Render’ display all HDF5 localization files to be aligned.
	 (iii) �(Optional) If the reference features are too weak to create proper alignment, they can be selected manually,  

as described in Steps 61–65. Ensure that within a picked region the reference structures of all channels are included.
	 (iv) �Select ‘Postprocess’ > ‘Align’.
	 (v) �(Optional) Export the aligned localizations by selection ‘File’ > ‘Save localizations’.

? TROUBLESHOOTING
Troubleshooting advice can be found in Table 1.
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Table 1 | Troubleshooting table.

Steps Problem Possible reason Solution

Sample preparation

Step 17 There is no band  
visible on the gel

Depending on the used final scaffold 
concentration, the bands can  
appear very faint on the blue-light 
transilluminator table and seem  
difficult to excise

To improve brightness of the sample band, use a more  
sensitive DNA stain such as SYBR Gold, or increase scaffold 
concentration

The structure does 
not fold

Thermal gradients have an important 
role during the assembly process of 
DNA nanostructures. However, the 
rectangle 2D origami design shows 
extremely robust folding behavior and 
forms with high yield within ~75 min

Different temperature gradients between 15 and 72 h  
can be used to improve folding performance. Prepare fresh 
staple stocks for the origami structure with particular focus 
on correct magnesium concentration and staple excess

Step 
18A(ix), 
18B(viii)

There are not 
enough DNA origami 
structures on the 
surface

Depending on the purification 
method, different origami concentra-
tions are obtained—e.g., the size of 
the excised gel band will influence 
the concentration after the Freeze  
‘N Squeeze column purification step

Compensate for this by incubating with a higher origami  
concentration and/or increased incubation time. 
Concentration adjustment can be estimated by counting the 
number of targets on the surface and interpolating to the 
desired density. A good sample density can be achieved by 
incubation with 125–500 pM of origami. Typical concentra-
tions after gel purification are between 1 and 2 nM, and 
those after PEG purification are approximately 8–10 nM. 
Alternatively, the DNA origami solution can be incubated 
longer (up to 45 min)

Step 
19A(viii), 
19B(v)

After purification, 
there still seem to 
be free DNA strands 
in solution

The DNA strands might not be 
completely filtered out by the spin 
columns, which are optimized for 
protein concentration

For further purification of DNA-labeled antibodies, use  
size-exclusion column chromatography to remove the free 
DNA (with a Superdex 75/200)

Not enough DNA 
strands are attached 
to the antibodies

Not enough cross-linker or DNA  
was used

For more DNA handles attached to the antibodies, use larger 
excess of cross-linker (40×) and DNA (30×). However, please note 
that an increased DNA-to-antibody ratio might lead to reduced 
binding affinity of antibodies or increased off-target binding

Data acquisition

Step 41 Poor data quality Laser power not adjusted to sample To achieve the best possible data quality, it is important to 
extract the largest possible number of photons from a single 
binding (blinking) event of the fluorophores. A good indicator of 
a suitable laser power setting can be estimated by measuring 
the bright time versus laser power. Increase laser power until 
the bright time decreases. What happens is that imager strands 
start to bleach while they are still bound to docking strands. 
This should be the upper limit of your laser power setting. 
When a laser power meter is available, a good reference value 
for power densities in DNA-PAINT experiments using, i.e., Cy3B 
as dye and 561-nm laser excitation is 1–6 kW/cm2

Step 42 The focal plane is 
difficult to find

Focusing was not performed in  
bright-field mode, or the immersion 
oil was not in contact with the  
cover glass.

For cellular samples, focusing should be performed in  
bright-field. For DNA nanostructures, the immersion oil on 
the objective should touch the cover glass; use oblique 
illumination and then slowly raise the objective until the 
surface of the cover glass is reached. Monitor the approach 
in ‘Live’ mode. Reaching the cover glass will be visible via 
an increase in fluorescence and appearance of diffraction-
limited blinking spots. Add fluorescent beads that have 
increased brightness to find the focal plane, if necessary

(continued)
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● TIMING
Steps 1–5, design of DNA nanostructures: 1 h
Steps 6–9, folding of DNA nanostructures: 6–7 h
Steps 10–17, purification of DNA nanostructures: ~3.5 h
Step 18, preparation of DNA origami for DNA-PAINT imaging: 45 min
Step 19A, preparation of DNA-labeled antibodies using maleimide-PEG2-succinimidyl ester: 1 d and 1 h
Step 19B, labeling via DBCO-sulfo-NHS ester: 4 h
Steps 20–33, immunofixation of cells: 2.5 d
Steps 34–49, data acquisition: 10 min to 10 h; for each multiplexing round ~20 min–2 h
Steps 50–58, image reconstruction: 5–30 min
Steps 59 and 60, drift correction: seconds to minutes
Steps 61–68, picking of regions of interest: 5–30 min
Step 69A, filtering of localizations: 5–10 min
Step 69B, analysis of blinking kinetics with qPAINT: 5–60 min
Step 69C, counting of molecule numbers with qPAINT: 5–60 min
Step 69D, particle averaging: 10–30 min
Step 69E, aligning of channels for multiplexed experiments: 5–10 min
Box 1, construction of a fluid exchange chamber for in situ imaging: 30 min
Box 2, ultra-resolution imaging: ~7 h
Box 3, in silico simulation of DNA-PAINT: 10–60 min

ANTICIPATED RESULTS
Examples of single-color DNA-PAINT super-resolution images can be found in Figure 1. Panel b presents an image of a DNA 
origami with a three-by-four grid of binding sites, as designed with ‘Picasso: Design’. Measured distances between individual 
binding sites are in good agreement with the designed origami. Panels d and e show a DNA-PAINT image of microtubules  
in situ, immunolabeled with primary and secondary antibodies. Hollow microtubule structures, observed here as two parallel 
lines because of the 2D projection, are characteristic for a high labeling density and localization precision.

Expected results for multiplexed DNA-PAINT experiments by Exchange-PAINT are shown in Figure 2. Panels d, e and f show 
in vitro DNA origami imaged with multiple ‘Exchange’ rounds before (d) and after (e,f) alignment. The image after alignment 
shows that the DNA nanostructure is in good agreement with the designed pattern of binding sites. In situ Exchange-PAINT 
images of microtubules and Tom20, which localizes to mitochondria, are shown in panel g. The inset in panel g shows gold 
particles imaged in both rounds and demonstrates the alignment steps for the two images. The gold particles colocalize after 
the alignment procedure, and the different channels do not comprise any cross talk between them.

Results for counting DNA-PAINT binding sites via quantitative PAINT (qPAINT) can be found in Figure 3. Visual inspection 
of individual origami structures shows they match the predicted binding sites from the qPAINT analysis.

Expected results for ultra-resolution imaging, including the intermediate steps for drift correction and a final image from averaging 
multiple structures, can be seen in Figure 4. Key features of a successful ultra-resolution experiment are very high NeNA localization 
precision (~1 to 1.5 nm) and the ability to visually separate individual binding sites spaced 5 nm apart on the origami structures.

Table 1 | Troubleshooting table (continued).

Steps Problem Possible reason Solution

Step 48 The sample drifts in 
xy and/or focus is 
lost during image 
acquisition

Setup not equilibrated Before image acquisition, allow the sample to ‘equilibrate’ 
on the microscope for 5–15 min. Adjust room temperature to 
maintain a constant ambient temperature to avoid additional 
thermal drift of microscope and stage components

Step 
49B(iii)

The imager strands 
are difficult to  
wash away

Cellular samples are highly cross-
linked through the fixation process. 
Imager strands might be trapped in 
the cross-linked network

We recommend incubating with the washing solution for  
3 min so that the imager strands can diffuse into the  
large reservoir. In addition, washing with gentle flow  
can be effective

Box 3, 
step 6

The simulation of a 
DNA-PAINT data set 
takes a long time

The time required to simulate data 
sets is dependent on the number of 
structures, imager concentration, 
frames and image size

As computation time increases with image size, it is  
recommended to avoid exceeding an image size of  
64 × 64 pixels. A simulation with the standard settings 
should take <1 min on the described analysis computer

76 dna-paint and super-resolution microscopy
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Note: Any Supplementary Information and Source Data files are available in the 
online version of the paper.
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3.2 simulation of single molecule fluorescence
data

In the previous chapter, I introduced the DNA-PAINT protocol and the
software package Picasso. In the following section, I will present the
fundamentals of the simulation module of Picasso.
The simulation of single-molecule fluorescence data from a known
ground-truth allows straightforward benchmarking and feasibility anal-
ysis of experiments. In recent years, several simulation packages
have been developed for use in super-resolution microscopy, notably
SuReSim [48], TestStorm [49] and the SOFI Simulation Tool [50], that
are specifically targeted for optimization purposes such as understand-
ing imaging parameters and interpret imaging artifacts.

• SuReSim starts from ground-truth structure data and allows to
either simulate 3D localizations or raw movie stacks to explore
how changing experimental parameters can affect potential imag-
ing outcomes.

• TestStorm is a MATLAB based simulation software for the gen-
eration of test data stacks. It contains advanced physical models
such as scalar and vector-based point spread functions, polariza-
tion sensitive detection, drift, spectral crosstalk and structured
background.

• SOFI Simulation Tool is intended as a simple qualitative com-
parison of simulated super-resolution optical fluctuation imag-
ing (SOFI) images. It incorporates SOFI and STORM algorithms
and displays and describes the SOFI image processing steps in a
tutorial-like fashion.

In principle, all software packages use the same fundamental approach
for simulating fluorescence data - Monte Carlo methods. In the follow-
ing section, we will discuss how they can be used as a tool for performing
experiments in silico and how they are implemented in the simulation
module in the Picasso software package.

3.2.1 The Monte Carlo method

Kroese et al. define a Monte Carlo simulation as the generation of
random objects or processes by means of a computer that in many cases
simply involves random sampling from certain probability distributions
[51].
An illustrative way on how Monte Carlo methods or random sampling
can be used to solve problems numerically is the approximation of
π. Here, a widely used example solves this problem geometrically by
drawing random X,Y values in the range of [0, 1] that define points
in the XY -Plane. These points will be randomly distributed in a unit
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square. By defining a quarter circle with radius 1, one can easily use
the circle equation to determine whether each point is within the circle
or not. Assuming that the points are randomly distributed, the ratio
of points within the circle to the number of points within the square
can be used to approximate the ratio of their areas:

nCircle
nSquare

≈ ACircle
ASquare

=
r2π

4 · r2 .

Ultimately this gives a direct estimate of π:

π ≈ 4 · nCircle
nSquare

.

In the following sections, it will be discussed how the typical processes
within a fluorescence experiment can be modeled by Monte Carlo Meth-
ods.

3.2.2 Simulation outline

The workflow to perform a simulation with the Picasso module consists
of the following steps:

1. Set handle positions to define a ground-truth model

2. Simulate kinetic traces for each handle

3. Sample the kinetic trace with the integration time window

4. Calculate the number of photons that are emitted and detected
in each frame and handle

5. Simulate photon emission in 2D

6. Collect photons with a virtual camera and convert into a movie

3.2.3 Simulate kinetic traces

As already mentioned in Chapter 1 the additional information that
is needed to super-resolve a target molecule with a stochastic super-
resolution approach is taken from the time domain. Therefore, it is im-
perative that a fluorescence signal originating from the target molecule
is time-dependent. When experiencing a stepwise-like switching from
an ON- to an OFF-state the target is blinking. The time dependency
can be described by average ON- and OFF-times and their underlying
distribution functions. In the case of DNA-PAINT, the blinking behavior
is caused by DNA hybridization.
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Starting from the foundations presented in the introductory chapter,
a DNA-PAINT system can be described as pseudo–first-order reaction
with association rate (kON ) and dissociation rate (kOFF ):

A+B
kON


kOF F

C.

The two rates define the average time being in the respected states:
τB = 1

kOF F
and τD = 1

kON ·c . The dwell time distribution for τB and
τD follows an exponential distribution [21]. Therefore, in order to simu-
late a DNA-PAINT kinetic trace, we can draw a random OFF-time and
ON-time from the respective exponential distributions and concatenate
them. This process is repeated until the desired trace length is achieved.
Refer to Figure 8 for an exemplary trace and the respective probability
distributions.
Each exponential distribution can be defined by its mean dwell time.
For τB this is exponentially dependent from the number of nucleotides
of the imager-handle-duplex that is bound to the surface. As a rule
of thumb, τB increases one order of magnitude for each bp added. Re-
ported values for a 9 bp interaction are 0.625 s and 5 s for a 10 bp
interaction [21].
When knowing the association rate kON and imager concentration c,
τD can be directly calculated:

τD =
1

kON · c
.
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kOFF
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Figure 8: Simulation of a kinetic trace from a DNA-PAINT system. The DNA-
PAINT system can be described as the binding and unbinding of
imager strands in solution to the target handle that is attached to
the target molecule. The association and dissociation rate define the
average dwell times, which follow an exponential probability distri-
bution. A DNA-PAINT kinetic trace can be simulated by randomly
sampling ON- and OFF-times from said distributions and concate-
nating them to a kinetic trace.
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For algorithmic simplicity, the simulation module of Picasso always
starts with an OFF-event. Therefore it is necessary to have at least sev-
eral binding events when wanting to accurately analyze kinetic traces.

3.2.4 Simulating photon emission and acquisition

Once the kinetic trace of a handle is generated, the next step is to
simulate photon emission. For this, the spatial distribution of a given
number of photons around their center position needs to be estimated.
As discussed in Chapter 1, light that is traveling from a point-like
source through the microscope will be imaged as an Airy-Disc pattern
that can be approximated with a Gaussian function.
Therefore, the photon emission can be simulated by using a 2D-
Gaussian emitter with its mean being the handle position x, y. Here, the
σ of the Gaussian is defined by the PSF of the imaging system. When
simulating the emission of n photons, we can draw their positions from
a normal distribution N for x and y:

x0..n, y0..n ∼ N (x,σ2),N (y,σ2).

While this approach achieves a high precision because it considers
individual photons, it is computationally expensive for large photon
numbers. In the latter case, individual photons will not be statistically
significant and computation can be sped up by e.g. directly simulating
pixel intensities.
To calculate how many photons are emitted and detected in each frame,
one needs to sample the kinetic trace, specifically the ON-times with
the integration time. Depending on the time point of hybridization
and dissociation of the imager strand to the handle, the imager is
in an ON-state and thus emits photons for either a full frame or
a fraction thereof. Next, we assume a photon emission rate that is
constant for the field of view (FOV) and laser-power dependent, a
normally distributed photon detection rate and a Poissonian model for
the photon detection. We use this model in the following algorithm to
calculate the photon numbers:

First, a photon detection rate ṅ is drawn from a normal distribution
N :

ṅ ∼ N (µ,σ2).
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Subsequently, the kinetic trace is used to determine the binding du-
ration ∆t for the for each frame, which can be used to calculate the
number of photons nemitted that are being emitted:

nemitted = ṅ · ∆t.

Lastly, the number of photons that are detected within that frame
ndetected is modeled to follow a Poissonian distribution P:

ndetected ∼ P(nemitted).

This last step takes into account that the exact moment of photon emis-
sion is uncertain. As this follows a Poissonian distribution it is to note
that for large photon numbers this last step will not be of significance.
As an example, for 100 photons, the resulting standard deviation is
only 10%, for 1000 it is 3.2%.
The average lifetime of a fluorophore is considered with the idea of a
maximum photon-budget, a maximum number of photons that are emit-
ted by a fluorophore before it bleaches.
After knowing the number of photons that are being simulated in each
frame, the Gaussian emitter can be used to simulate photon positions
for each handle and each frame. Lastly, photon lists need to be con-
verted to a 2D image by creating a 2D-Histogram. Poissonian image
noise is added to each frame.
To consider camera saturation, pixel values are capped at the bit-depth
of the image (216− 1 for 16 bit). All images are concatenated to create
a movie file.

3.2.5 Parameters and background model

In order to create realistic in silico simulations, simulation parameters
need to be matched to real-life experiments. The first set of parameters
can be used from an existing experimental setup, such as the pixel size
of the microscope camera. Other parameters are changed depending
on the experiment, such as imager concentration and integration time.
To create exact simulation results, it is essential to identify parame-
ters that affect the imaging resolution. For typical DNA-PAINT imaging
acquisitions, localizations have high photon numbers. The imaging per-
formance is thus mainly defined by the laser power and imager concen-
tration, which determines the background level.
To have a background model that can be used to estimate the back-
ground B for different parameters, I implemented the following equa-
tion:
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B = (CLaser +CImager · c) · ILaser · ∆t.

It contains two constants, one reflecting the background arising from in-
creasing imager concentration CImager, the other from increasing laser
power CLaser. The nested multiplications arise from the following con-
siderations:

• The background has to be zero if the laser power ILaser or the
integration time ∆t is zero.

• If the no imager c = 0 is present, there will still be signal arising
from background fluorescence that scales with laser power and
integration time.

The constants were experimentally determined by measuring slides with
buffer and the respective imager concentration and fitting to the back-
ground equation.
Based on the calculated background model, Poissonian noise is added
to each frame.

3.2.6 In silico simulations of biological processes

A first showcase on how to use the simulation tool was within a collab-
orative project with the group of Ralf Jacob of the Philipps University
Marburg. They studied the molecular mechanism to recruit galectin-3
into multivesicular bodies for polarized exosomal secretion [52]. GS-
DIM super-resolution light microscopy was employed and a key ques-
tion here was whether this approach would be capable of distinguishing
the principal stages of the three-stage recruiting mechanism – binding,
budding, and scission. In order to test the feasibility of the GSDIM-
approach, I first analyzed the experimental data and iterated through
several simulation settings to create a model that matches the exper-
imental data. To model the different recruiting stages I created three
models of multivesicular bodies with spheres. Figure 9 shows a com-
parison of experimental data and the in silico data of the simulation
model. The simulation data was used to support the hypothesis that
the GSDIM approach would, in principle be, capable of observing the
stages of the recruiting mechanism.
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Stage Experiment Model Simulation

Figure 9: Simulation of the three-stage recruiting mechanism of multivesicular
bodies (MVBs). The three stages are depicted on the left side. Exper-
imental data for the three stages was acquired and used to estimate
imaging performance. A simulation model was created to simulate
the process of binding with having MVBs in different distances. Im-
ages show several structures together as ’Average Intensity’. Scale
bars: 250 nm. Image adapted from [52].





4
ADVANCES IN DNA-PA INT

As previous chapters elucidated, DNA-PAINT exhibits several features
that make this technique particularly useful for biologists. Amongst
these are high resolution, the capability to count molecules from their
kinetic signature and the possibility to attach DNA-PAINT handles to
antibodies for biological imaging. In this chapter, I will introduce some
key developments in the field of DNA-PAINT that aim to further increase
the use case of DNA-PAINT for the biological sciences. First, a method to
further improve resolution via sequential imaging termed RESI. Second,
imaging conditions that allow the absolute counting of molecules in
unresolvable spots. Third, the use of SNAP-tag as an improved label
for biological imaging.

4.1 resolution enhancement via sequential imaging:
resi

The achievable resolution of current super-resolution techniques is
steadily increasing. When Stefan Hell proposed his STED microscope
in 1994, he theoretically estimated it to be capable of resolving 35 nm.
With the latest advance in STED - MINFLUX nanoscopy, which was
presented in 2016, he demonstrated localization precisions of ≈ 1 nm
for particle tracking and was able to resolve 6 nm distances on DNA
origami nanostructures [18].
Earlier in the same year, Mingjie Dai et al. demonstrated localization
precisions of < 1 nm and resolved 5 nm distances on DNA origami [53]
using DNA-PAINT.
While these results are impressive benchmarks that prove the potential
of super-resolution techniques to enter the resolution domain of elec-
tron microscopy, they are typically achieved in environments that can
be precisely controlled. Imaging of biological systems - in contrast to
DNA nanostructures - comes with several traits that negatively influ-
ence imaging performance so that comparable resolution values have
yet to be demonstrated.
After all, even for super-resolution techniques, every imaging system
will exhibit a certain achievable resolution limit. This poses a funda-
mental limitation when one wants to investigate a biological structure
that is well below this boundary.
Here, I propose the idea of RESI – resolution enhancement via sequen-
tial imaging, which uses the unique multiplexing capability of DNA-
PAINT to push this microscopy technique further to resolve structures
beyond its nominal resolution.

87
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When imaging a target structure with DNA-PAINT, an imager strand
in solution will bind to the corresponding handle strand at the target
structure and can be localized. Depending on the number of photons
emitted in relation to the background signal (SNR) a localization will
exhibit a certain localization precision σ. As each binding event can
last several frames, the localizations of several frames that belong to
one binding can be linked or merged, into one localization with higher
localization precision. Assuming that each localization has the same
localization precision, the localization precision of the merged localiza-
tion will increase with the square root of the number of localizations
that are merged. This is commonly known as the standard error of the
mean:

σ =
σ√
n

.

One of the unique properties of DNA-PAINT is that, in contrast to other
SMLM techniques, the target will not bleach in a conventional sense.
Usually, a fluorophore is attached to the target, and after harvesting
the full photon budget, no more photons can be exploited for increasing
the localization precision. For DNA-PAINT, the fluorophore of an imager
may bleach, but for the next binding event a new imager with a fresh
fluorophore from solution will attach to the target strand and can be
exploited. It is, therefore, possible to not only link localizations from
one binding event but also from several binding events to ultimately
perform unlimited sampling of a single binding site. Fitting of infinite
localizations yields in principle an unlimited localization precision for
the detection of the binding site.
One should note, however, that this can only be done when single bind-
ing sites can be identified. The fitting of localizations that come from
a dense cluster of binding sites that do not allow unambiguous identifi-
cation is not possible. Therefore, the increase in localization precision
itself does not directly translate to a higher possible resolution.
To use this increased localization precision to increase resolution, we
use the multiplexing capabilities of DNA-PAINT. Here, we can use or-
thogonal sequences to label the same target. By imaging each sequence
sequentially, each imaging round will have decreased labeling density
as only a fraction of all targets are imaged, allowing the unique identi-
fication of individual binding sites.
This principle can be exemplified when imaging a line structure that
has 12 labels in close enough proximity that they cannot be individually
resolved (see Figure 10). When alternating the labels with orthogonal
sequences and splitting the image acquisition into four imaging rounds,
the labeling density is decreased by a factor of 4. From an initial label
distance of 5 nm that was not resolvable, the distance in each round
is 20 nm which is long enough to be resolved. The individual localiza-
tions can be unambiguously attributed to a single binding site. For each
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imaging step, orthogonal imagers are introduced into the system and
washed out after image acquisition. Finally, all reconstructed imaging
rounds are overlayed, and the resulting image now resolves the individ-
ual handle positions.

4.1.1 Precision, accuracy and resolution

The previous subsection already used the terms resolution and preci-
sion. To increase clarity on how these concepts are used in this thesis,
they will be discussed as follows:
In general, the ability of a system to measure entities is characterized by
its precision and accuracy. Precision refers to the occurrence of random
errors while accuracy refers to systematic errors. Accuracy in the literal
sense means how accurate the system is in determining the true value,
therefore refers to the difference between true value and observation.
In contrast, precision refers to the spread that occurs when performing
the experiment several times.
In the context of super-resolution imaging, the term accuracy would de-
scribe how far the determined position deviates from the actual position
of the target structure. Evidently, for experimental data, the ground
truth is not a parameter that can be directly determined. Here, DNA
origami structures can be used as a nanoscopic ruler to approximate
the underlying true positions. Additionally, the size of the label and
linker that are needed for fluorescence microscopy will add a linkage
error to the true center position. In that sense, we will neglect accu-
racy and use the localization precision as a quantitative parameter to
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Figure 10: Left side: Conventional super-resolution microscopy will be limited
by its imaging resolution, handles that are too close cannot be re-
solved. Right side: RESI approach. Sequential labeling and imaging
can decrease the labeling density of the sample. This allows identifi-
cation of single binding sites, fitting of individual localizations and
subsequent localization precision increase. Each sequential imag-
ing round will be overlayed to create a RESI image with increased
resolution.



90 advances in dna-paint

compare the performance of different imaging methods.
When having a number of localizations, the localization precision can
be approximated by a 2D Gaussian distribution with defined σ. The
average distance E|x| to the true center position, also known as the
average absolute deviation, or mean absolute deviation can then be
calculated as follows:

E|x|
σ

=

√
2
π
≈ 0.798.

Therefore, when the standard deviation of the localization precision is
known one can estimate the average distance (and hence the error) to
the center of the emitter.
In the context of this thesis, we use the term resolution to refer to
whether two spots in close proximity can be distinguished or not. Specif-
ically, the idea of FWHM≈ 2.3548 · σ is being used.

4.1.2 Increasing localization precision

As already introduced, the localization precision σ that can be achieved
when fitting several localization scales with the inverse square root of
their quantity. As the number of localizations that occur are dependent
on the imaging time t, imager concentration c and kon, and as the initial
localization precision is dependent on the imager concentration σ(c) the
increase in precision can be described as follows:

σ =
σ(c)√
c · 1

kon
· t

.

Accordingly, there are two ways to increase σ for a given σ: (1) to in-
crease imaging time and (2) to increase imager concentration. Because
of the different SNR, an increase of imager concentration not only in-
creases the sampling rate but also decreases the localization precision.
Assuming that the background increases linearly with imager concen-
tration while having a square root dependency for precision, it becomes
clear that the determining factor for increasing localization precision is
an increase in imaging time.
While in principle the increase of localization precision is unlimited, pos-
sible practical limitations can occur, e.g., when DNA hybridization is ex-
hausted that results in deactivation of the binding site or the bleaching
of all imager strands in solution which would require buffer exchange.
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4.1.3 Localizations and binding events

Another technicality that needs to be considered is the distinction of
localizations and binding events in terms of localization precision. De-
pending on the chosen integration time a binding event can either span
over one or several frames. When assuming a constant photon emission
rate over the binding duration a localization with higher localization
precision will be split into i localizations with lower localization preci-
sion. Theoretically, this will not affect the final localization precision
as the localization precision scales with the square root of the number
of photons. Note that σ√

n
= σ·

√
i√

n·i . However, additional noise that arises
from increasing the sampling rate (i.e., shot noise or higher readout
noise when using a higher readout frequency) will make fewer local-
izations preferable. Additionally, decreasing the integration time will
decrease the resolution in the first place and therefore reduces the frac-
tion of localizations that can be identified as belonging to only one
binding site.
As the number of binding events can be directly estimated from the
kinetic parameters of the measurement, we can easily use it to calcu-
late the final localization precision. Accordingly, one can estimate the
localization precision of a single binding event σB by determining the
average number of localizations per event. This is approximately the
ratio of ON-time to the integration time ∆t:

σB ≈ σ ·
∆t
τB

.

4.1.4 Deterministic and stochastic labeling

In the example of the line structures, the orthogonal labels were in-
tentionally placed so that the distance between the same sequence is
maximized. This labeling approach is referred to as deterministic la-
beling. This can only be obtained when one has precise control of the
position of target sequences for a given target. While this can readily be
achieved for programmable DNA nanostructures such as DNA origami,
this is typically not the case for biological samples. To reduce the la-
beling density here, the target structure can be labeled stochastically,
which refers to the random labeling of the same target with orthogonal
targets.
The probability that two labels will be within a distance that is not
resolvable while also having the same sequence and thus will not be
separable decreases with the number of labels. As these binding sites
cannot be unambiguously identified, they cannot be used for RESI. One
can think of a virtual labeling efficiency Ev to describe the fraction of
points that can be used for resolution increase. Ev will be a function
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of the target density ρ, the number of orthogonal sequences S and the
initial resolution σ:

Ev = Ev(ρ,S,σ).

As for an experimental setup, one will need to estimate the required
labeling efficiency and resolution for the specific research question. Ap-
proximating ρ to be the number N of particles in a 2D space with
the area A, on average, each particle will occupy an area of a2 = A

N

with side length a. Therefore, there is a square-root dependency for the
average particle to particle distance and the labeling density. In other
words, if one wants to push a given labeling density so that the result-
ing average distance of points is half in order to increase the resolution,
one will need at least four orthogonal sequences S:

a ∼
√
S → σ ∼

√
S.

4.1.5 Testcase DNA origami

In order to test the feasibility of RESI, flat rectangular DNA origami
nanostructures (RRO) were used for benchmarking.
As an initial step, a line pattern was designed to measure the poten-
tial resolution increase. The line consists of eight handles, each 10 nm
apart. The handles were alternated with orthogonal sequences, X61
(TT-TCCTCAATT) and X70 (TT-TCAATATCT ) so that the effec-
tive distance in each imaging round was 20 nm. Additional sequence
identification marker handles were placed in opposing corners of the
structure. Refer to Figure 11 for a schematic of the structure and the
experimental results. For the assessment of resolution it was found that
analyzing single structures is not ideal for several reasons: First, depend-
ing on the Gaussian illumination profile of the microscope, the power
density will vary and will decrease towards the edges, leading to a res-
olution gradient. Second, as the binding and unbinding of DNA-PAINT
is a statistical process, there will be variance in sampling for individual
samples. Lastly, structures can exhibit deformations and missing han-
dles. Ultimately the determined resolution from two structures from
the same measurement may differ. To address this, I chose to make the
comparison in resolution increase more quantitative by picking several
structures to create a sum image, and estimated an average resolution
by fitting Gaussians to the resulting profiles. For the alignment of the
picked structures to the sum image, I consider both rounds simulta-
neously so that they can be aligned although not having overlapping
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staple positions.

Round I Round II

10 nm Composite

Sum of 144 structures

Composite RESI Simulation

20nm Exchange

Figure 11: 2x Exchange RESI measurement: A line structure was designed
that exhibited 20 nm distances per round and 10 nm in the com-
posite. From the field of view, 144 structures were selected, and
the resolution in each imaging round was determined. The mean
resolution per round was 13.54 nm, making it impossible to resolve
the 10 nm distances. This becomes evident in the sum image of
the composite. After RESI reconstruction, an average resolution of
3.15 nm was achieved, enough to clearly resolve the 10 nm distances.
The origami measurement was validated with in-silico simulations
that showed a similar resolution increase.

As a second step, in silico simulations were performed to assess the
potential resolution increase for the given structure. For this, simula-
tion conditions were matched to the final experimental conditions. The
imaging parameters were fine-tuned so that the overall imaging resolu-
tion of the system was worse than 10 nm so that one is unable to resolve
the designed line pattern. A total of n = 49 line structures were picked
from the field of view and aligned on top of each other to form a sum
image. Displaying only one round at a time and fitting the resulting
spots with Gaussians can be used to determine an average resolution.
In the simulation case, it was determined to be 10.96 nm. After fitting
an average of N = 32 binding events (114 localizations), the resulting
average resolution after RESI was 1.85 nm, resulting in an effective res-
olution increase of 5.9.
Here, the resolution increase is roughly the square root of the number
of binding events (

√
32 = 5.66):

σRESI ≈ σ ·
√
N .
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For the experimental data, determined NeNA values (FWHM) for the X61
round were 11.54 nm and the X70 round 19.59 nm, well above 10 nm. A
total of n = 144 line structures were picked from the field of view and
aligned on top of each other to form a sum image as previously done
with the simulation data. When displaying a composite image, meaning
that both rounds are displayed at the same time, it is evident that the
imaging resolution is not sufficient to resolve individual binding sites.
Refer to Figure 12 for experimental data. In contrast, the sum images
of the individual rounds show the binding sites. Note that the different
intensity arises from deviations in sampling.
Fitting of the four peaks resulted in the in a mean resolution (FWHM)
of 13.54 nm (13.08 nm for X61 and 13.97 nm for X70). The FWHM for
the reconstructed RESI dataset was 3.15 nm, resulting in a resolution
increase of 4.3.
Kinetic analysis revealed an average of 77 binding events for X61 (604
localizations) and 33 binding events for X70 (207 localizations). Again,
the resolution increase is in the order of the square root of the number
of binding events (

√
33 = 5.74,

√
77 = 8.77).

Giving the achievable FWHM resolution of 3.15 nm it should also be
possible to resolve the 5 nm hexagonal pattern on a DNA origami.
To test this, the line structure pattern was decorated with
two additional sequences, X68 (TT-ATCAATCTT) and X72 (TT-
TTAAATCCT) to decrease the composite distance to 5 nm while keep-
ing the distance of 10 nm per round. Again, 144 structures were se-
lected and evaluated for RESI. The composite image of all structures
shows that the original resolution of the imaging system is not able
to resolve the individual distances while the RESI reconstructed data
clearly resolves the 5 nm hexagonal zig-zag pattern that arises from the
hexagonal pattern arrangement. This highlights how RESI can be used
to increase the imaging resolution via sequential imaging and fitting.

Round I
5nm Exchange

Round II Round III Round IV

Composite RESI Simulation5 nm Composite

Figure 12: 4x Exchange RESI measurement: The addition of two additional
exchange rounds scales the effective distance down to 5 nm. Us-
ing RESI, an imaging system with less than 10 nm could resolve
distances below 5 nm.
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4.2 counting absolute molecule numbers

In the previous section, recent developments in terms of the achievable
resolution in super-resolution microscopy were discussed. Researchers
are now capable of resolving structures with nanoscale resolution. How-
ever, counting molecules in complexes and specifically determining ab-
solute copy numbers of proteins in localization data that cannot be
resolved remains challenging. In this section, I will introduce absolute
qPAINT, which explores the imaging conditions of classical qPAINT to
be able to count absolute handle numbers. Ultimately, together with
site-specific, stoichiometric 1:1 labeling this will allow counting abso-
lute protein copy numbers. I benchmarked measurement conditions to
use absolute qPAINT using DNA nanostructures and nuclear pore com-
plexes.

4.2.1 Requirements for absolute counting

Classical qPAINT is a capable technique to extract quantitative informa-
tion from repetitive hybridization events. When knowing the influx rate
of an imaging system, it is possible to estimate handle numbers given
a kinetic trace. In order to push qPAINT to be able to count absolute
molecule numbers, it is not only necessary to find a stoichiometric 1:1
label but also to optimize imaging conditions so that populations can
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Figure 13: Concept of absolute qPAINT. Left side: Repetitive hybridization
of fluorophore-labeled imager strands not only can be used for
super-resolution microscopy but also yields quantitative informa-
tion. While a single binding site in an unresolvable spot will be vis-
ited with a certain frequency, the frequency for two binding sites
in close proximity will be double because of statistical indepen-
dence. Right side: When analyzing the number of binding events,
short image acquisitions will exhibit too little binding events to un-
ambiguously distinguish monomers from dimers. For acquisitions
that are long enough the distribution of binding events will show
two populations making the distinction of absolute copy numbers
possible.
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be unambiguously identified. A useful benchmark to assess the count-
ing capabilities of DNA-PAINT is to test whether one can distinguish
a monomer from a dimer. While a single binding site will be visited
with a certain frequency, the frequency for two binding sites in close
proximity will be doubled because of statistical independence. While
the frequency can be measured through several ways, e.g., by measur-
ing dark-times, calculating their mean or fitting them to a cumulative
distribution and taking the inverse, it is useful to simply count the num-
ber of binding events as a parameter for the frequency. For short image
acquisitions, the populations of the number of binding events arising
from the two populations will overlap. A distinction and unambiguous
identification are thus not possible. However, for acquisitions that are
long enough, the difference in kinetics will be better sampled, and the
populations can be separated.
The fundamental requirements for the imaging conditions can be esti-
mated when considering the prerequisite that the probability distribu-
tion of the number of binding events of a monomer P (X1) should not
overlap with the probability distribution of a dimer P (X2):

P (X1) ∩ P (X2) = ∅.

Assuming that this probability distribution is Poissonian, the σ of a
population is equal to the square root of the average number n of
binding events:

σ =
√
n.

As the Poissonian can be approximated with a Gaussian for large n, we
expect that for an interval of 3σ we have 99.7% coverage of all observed
number of binding events. Hence in order to have almost no overlap
between two populations, the distance between the mean number of
events of each distribution n2 − n1 needs to be at least the sum of 3σ1
and 3σ2. When distinguishing a monomer from a dimer 2 · n1 = n2 the
distance is n1 and therefore:

3 · √n1 + 3 ·
√

2n1 ≥ n1 ⇒ n ≥ 52.46.

Consequently, the average number of binding events per site that needs
to be detected is at least 53. Given a typical imager concentration of
c = 2.5 nM and a kon = 1.6 · 106 this would translate to ≈ 217 minutes
of image acquisition. The theoretical assumptions can be validated by
in silico simulation of a sample with each 100 single and double binding
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sites for an imaging duration of 45000 frames at 300 ms integration time
(225 minutes) with above imaging conditions. Examining the number
of binding events reveals two distinct peaks at 49 ± 6.2 and 96.7 ±
8.6 binding events. Refer to Figure 14 for the simulated distribution.
Similiar, for 2σ and a coverage of 95%, this would be n1 = 23.31 with
an imaging time of ≈ 96 minutes.
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Figure 14: Simulation of imaging parameters for double peak detection. A
total of each 100 single and double binding sites were simulated
with the following imaging parameters: Imager concentration c =
2.5 nM, kon = 1.6 · 106 and a total acquisition time of 225 minutes
(45000 frames at 300 ms integration time). As expected from the-
oretical considerations two distinct peaks at 49 ± 6.2 and 96.7 ±
8.6 binding events can be identified.
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While the principle requirement for absolute counting is just a suffi-
ciently long imaging time with respect to the imager concentration,
the optimization of imaging conditions needs careful tuning. Typically,
performance increase for qPAINT will come at the cost of imaging res-
olution. In the following, several imaging parameters are qualitatively
discussed on how they affect the performance in different regimes.

• Laserpower: Laserpower needs to be sufficiently high to be able to
detect single-molecule binding events. For high-resolution imag-
ing, one wants to exploit the full photon budget of the fluorophore,
hence typically high laser powers in combination with oxygen
scavenging systems are used. However, for kinetic measurements,
lower laser powers are preferred as it will minimize the induction
of photo effects that affect the stability of the acquisition.

• Imager concentration: Low imager concentrations will decrease
the background and thus increase the localization precision. How-
ever, they also decrease the sampling and therefore requires longer
imaging times for accurate qPAINT.

• Integration time:While for high-resolution acquisition the integra-
tion time is ideally in the range of the ON-time of the imager to
increase SNR, for qPAINT measurements, smaller integration times
are preferred as they have increased time-sampling. However, the
integration time needs to be sufficiently high to collect enough
photons to enable single-molecule detection. Refer to Figure 15
for a simulation of the effect of integration time and resolution
as well as the relative error introduced for the determination of
kinetic parameters. In general, longer integration times will lead
to an overestimation of ON-times, while integration times that
are too short will lead to an underestimation. As OFF-times are
typically much larger than the integration times they experience
little variation.

• Photostabilizing buffers: The usage of photostabilizing buffers
may increase photon yield and may reduce free radicals in solu-
tion as unwanted bleaching is prevented, however as most buffers
use enzymatic reactions they are time critical.

Therefore, it is required to find the matching imaging conditions for the
specific target. A fundamental question here is how good the imaging
resolution and the qPAINT resolution should be. As for the measure-
ments that follow I chose imaging parameters of 10 mW (measured be-
fore the backport of the microscope) for a 561 nm laser, 2.5 nM imager
concentration with Cy3b, 200 ms integration time for 60.000 frames
with Buffer C).
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Figure 15: Simulation on the effect of integration time on resolution and deter-
mination of dark and bright time. A total of 100 binding sites with
a bright time of 500 ms, dark time of 12 500 ms and an imaging
duration of 1 h were simulated. Left: Influence on the achievable
resolution. Analyzing the NeNA parameter as a measure for reso-
lution reveals a local optimum for resolution when matching the
integration time to the bright time. Right: Influence on bright and
dark time determination. For small integration times, the reduced
photon count can cause binding events not to be detected, result-
ing in an underestimation of the bright time. For integration times
that are too large, the bright time will be overestimated. In con-
trast, the dark time shows little variation as it is much larger than
the integration time and is thus measured with adequate sampling.
Therefore, for the accurate determination of bright and dark times,
it is advisable to choose the shortest integration time that still has
sufficient photons to detect single-molecule binding events.
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4.2.2 Absolute counting on DNA origami

To benchmark the capability of DNA-PAINT for absolute counting, I
tested the theoretical assumptions with DNA origami nanostructures.
Here, I mimicked a monomer/dimer structure by decorating a flat sheet
origami structure with DNA-PAINT docking sites. Two diagonal corners
contain one binding site while the other two contain two binding sites.
After image acquisition and reconstruction, individual origami struc-
tures were identified, and the binding sites in their corners were se-
lected. A histogram of the number of binding events for 4455 binding
sites is shown in Figure 16. Here, a bimodal distribution with two peaks
at 65 (σ = 15) and 114 (σ = 14) is visible, clearly demonstrating the
distinction of monomer and dimer-population.
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Figure 16: Absolute qPAINT for DNA origami: DNA origami structures contain-
ing two docking sites in two opposing corners and one in the other
two were imaged with DNA-PAINT and imaging conditions that are
optimized for absolute qPAINT measurements. (Left side). Picking
the corners of each origami (yellow circles in inset) and counting
the number of binding events yielded a bimodal distribution with
peaks at 65 and 114, allowing the unique identification of the re-
spective populations. Scale bars: 100 nm.
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4.3 snap-tag for biological imaging

One major reason why the remarkable achievements in resolution
cannot be directly translated to imaging cellular components is that
the current labeling approaches are limited by either large label
sizes (e.g., antibodies) or the sparse availability of small and efficient
binders. The first labels that enabled DNA-PAINT imaging of biological
targets were formed by reacting biotinylated docking strands with
streptavidin and incubating them with biotinylated antibodies. When
using primary and secondary antibodies, an additional linkage error of
10-15 nm is introduced.
Here, a potential solution is the use of self-labeling tags such as SNAP,
which has a molecular weight of 19.4 kDa. SNAP-tag is a mutant
of the DNA repair protein O6-alkylguanine-DNA alkyltransferase that
reacts with benzylguanine (BG). This allows specific and rapid covalent
binding of the SNAP-tag with a synthetic probe. Expansion of the
SNAP-tag labeling method to DNA-PAINT is feasible, as BG-modified
oligos are readily commercially available, and additionally allow
stoichiometric 1:1 labeling. However, the use of SNAP-tag requires
genetic engineering of cell lines.
The nuclear pore complex (NPC) is of great interest for super-resolution
imaging. NPCs act as gatekeepers within a cell and are responsible
for the exchange of components between the nucleus and cytoplasm
they play an important role in an organism. They have been studied
extensively by electron-microscopy methods over the last decades.
Today’s models assume a double-ring structure composed of nuclear
and cytoplasmic ring. Each ring consists of an inner and outer ring
which are formed by the arrangement of a so-called Y-complex in an
eightfold symmetry. The Y-complex consists of several nucleoporins.
Individual nucleoporins in the outer rings are laterally shifted to
the ones in the inner rings, here a distance of ≈ 12 nm for NUP107
is expected. For the architecture of NUP107, one expects a radial
diameter of ≈ 100 nm and a z-distance between the double-rings
of ≈ 50 nm. Consequently, resolving the double-ring structure is an
impressive benchmark for an imaging method.
Refer to Figure 17 for a reaction scheme and a structural overview of
the nuclear pore complex.
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Figure 17: SNAP-Tag and nuclear pore complex. Upper panel: Schematic of
the SNAP-tag labeling reaction. The protein of interest is fused to
a SNAP-tag. Using a BG-oligo, a DNA-PAINT docking site can be
fused to the SNAP-tag. Image adapted from [54] and [55]. Lower
panel: Overview of the double-ring structure of a nuclear pore with
eightfold symmetry. Individual Nucleoporines form the so-called
Y-Complex (right side) and arrange in an inner and outer ring on
the nuclear pore. For NUP107, one expects a radial diameter of
≈ 100 nm and a z-distance between the double-rings of ≈ 50 nm.
For neighboring NUP107 on the inner and outer ring, a distane
of ≈ 12 nm is estimated. Images reproduced with permission from
[56].
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4.3.1 Labeling efficiceny

A critical point when imaging biological targets is the achievable label-
ing efficiency. As one knows the symmetrical structure of NUPs from
electron microscopy, they can be used for straightforward determina-
tion of labeling efficiency. For a fully assembled NUP, a total of 32
NUP107 are expected, of which 16 are in each the cytoplasmic and
nuclear ring. Each ring itself consists out of an inner and outer ring
with each eight NUP107 that are arranged in an eightfold symmetry.
As neighboring NUPs on the inner and outer ring are in close proximity,
they might not be resolved, depending on the resolution of the imaging
system. Each observed cluster then, can either have one or two han-
dles. In order to assess the influence of labeling efficiency on the cluster
distribution and hence the final representation when being imaged, I
simulated the labeling fraction with respect to the labeling efficiency
using Monte Carlo methods. The distribution is displayed in Figure 18.
Evidently, for low labeling efficiency, the majority of NUP107 will not
be imaged, and most of the unresolved spots will be single. For higher
labeling efficiencies, the fraction of labeled NUPs will increase causing
more and more to be labeled twice.
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Figure 18: Influence of the labeling efficiency and the labeling fraction. The
labeling efficiency will have a tremendous impact on the expected
label distribution for an unresolved spot. For low labeling efficiency,
the majority of NUP107 will not be imaged, and if a cluster is
detected, it is very likely to be single NUP107. For higher labeling
efficiencies, the fraction of labeled NUPs will increase and more
and more will be labeled twice.
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4.3.2 Absolute counting of NUP107

In a previous section, I demonstrated measurement conditions that
allow absolute counting of binding sites for DNA origami. SNAP-tag
permits extending this concept for cellular applications. For this,
NUP107, a protein in the nuclear pore complex was targeted via the
SNAP-tag label. This label allows stochiometric 1:1 labeling of the
target NUP107.
As the arrangement of the NUP107 is in the form of a 3D double-ring
structure with the rings being ≈ 50 nm apart, the previously used
approach used for DNA origami of picking individual binding sites in
2D is not possible, as binding sites can overlap in z. To overcome
this, I used measurement conditions that not only can resolve the
double-ring structure in 3D but also perform absolute counting. For
picking in 3D, a k-means clustering algorithm was implemented. In
brief, it randomly places a given number of cluster centers within the
3D space and assigns each localization to the closest cluster. Then,
the center of mass for each cluster is used to update the cluster center.
The algorithm is repeated until convergence. Once all localizations
are attributed to a cluster, they can be used for downstream kinetic
analysis (i.e., counting).

With the chosen imaging parameters of 10 mW (measured before the
backport of the microscope) for a 561 nm laser, 2.5 nM imager concen-
tration with Cy3b, 200 ms integration time at 60.000 frames with Buffer
C it was possible to identify NPCs and individual NUP107 clusters, ar-
ranged in eightfold symmetry. An NPC average with assumed eight-fold
symmetry shows that the double ring structure can be well separated
(See Figure 19).
For qPAINT evaluation, I picked 104 NPCs and used k-means clustering
to identify individual NUP107. For this, the number of clusters for k-
means was manually set, and outliers were removed. For all NPCs a total
of 499 clusters were detected. The resolution of the measurement was
determined with the NeNA parameter to be 13.78 nm (FWHM), which is
close to the expected inner-to-outer-ring distance of 12 nm of two neigh-
boring NUP107. However, as the exact linker position is not known, the
actual distance and whether they can be resolved remains ambiguous,
leaving the possibility to either expect 32 or 16 clusters within each ring
for the given imaging conditions. Evaluation of the number of binding
events showed a unimodal distribution with a mean value of 58 binding
events (σ = 19). The distribution overlapped with the monomer peak
of the origami measurement, suggesting that each cluster consists of a
single binding site.
The number of clusters in each NPCs can be translated into a labeling
efficiency of either ≈ 30% when assuming that one should resolve all 32
clusters or ≈ 15% for the 16 cluster case. A comparison with the label-
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ing chart of Figure 18 reveals that the probability of detecting single
clusters is ≈ 82% (30% labeling) or ≈ 91% (15% labeling), which are
in good agreement with the observed unimodal distribution. Refer to
Figure 19 for schematics of cluster analysis and experimentally deter-
mined distribution.
Arguably, the true power of absolute counting comes when being able
to determine the number of absolute molecules in an unresolvable spot.
While the unimodal distribution demonstrates that quantitative label-
ing and absolute counting can be achieved using SNAP-tag and DNA-
PAINT, ideally one wants to count multiple copy numbers. To demon-
strate this, it would be necessary to image nucleoporins that are closer
together and well below the resolution limit. Additionally, an increase
in labeling efficiency is needed, so that the dimer population is suffi-
ciently large. To obtain an equally sized dimer population, a labeling
efficiency of 67% would be required.
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Figure 19: Absolute qPAINT for NUP107 with SNAP-tag: To test the feasibil-
ity of absolute counting in a cellular context, NUP107 was labeled
with SNAP-tag and measured with absolute qPAINT measurement
conditions. Upper panel: Left shows an overview of a nucleus with
NPCs and labeled nucleoporin NUP107. The middle image is a
zoom-in that shows individual NPCs and their localization clusters
in 2D. The right panel shows an average of several nuclear pores
in 3D, showing that the double ring structure can be resolved. For
the creation of the average, an eight-fold symmetry was assumed.
Lower panel: To evaluate the data, 104 nuclear pore complexes were
picked and analyzed via a k-means clustering algorithm in 3D. It
allows attributing a localization to each cluster and subsequent ki-
netic analysis. The number of binding events followed a unimodal
distribution with a fitted mean of 58 binding events. Also shown is
the bimodal distribution from the previous DNA origami measure-
ment, overlapping with the monomer distribution of the origami,
indicating that each NUP107 cluster contains a single binding site.
Scale bars: Overview 10 µm, zoom-in 100 nm.
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5
OUTLOOK

The technological advancements presented in this thesis highlight
the beneficial interplay of DNA nanotechnology and fluorescence mi-
croscopy. Not only can DNA nanotechnology be used to improve fluo-
rescence methods but also to obtain a greater understanding of DNA
nanotechnology itself. DNA nanotechnology can provide a constant in
an environment that is typically determined by nature’s variability.
As for DNA-PAINT, imaging of the nuclear pore complex gives an out-
look on how this technique can be a valuable tool for today’s biologists.
Major advantages of this method are high resolution, and the ability
to perform absolute counting while also retaining multiplexing capa-
bilities. With DNA-PAINT reaching the resolution domain of electron
microscopy methods but still having the benefits of single-molecule flu-
orescence microscopy, the potential for structural biology applications
becomes evident.
One major challenge that needs to be addressed will be finding appro-
priate labels for highly multiplexed experiments. The ideal probe will
be small in size, has a known quantitative stoichiometry, exhibits high
labeling efficiency and can be readily created for a multitude of targets.
While SNAP-tag has proven to be a useful small stoichiometric label to
create high-resolution images, it necessitates cell line engineering and
poses a bottleneck.
Currently, the advantages of DNA-PAINT come at the price of rather
long image acquisition times at high power densities, effectively limit-
ing it to the imaging of fixed cells. Here, further technological advances
will be required to make this technology applicable to live-cell imaging.
Additional challenges will arise when considering downstream data pro-
cessing. As more and more data is acquired, powerful computational
tools will be required to generate meaningful insight. Here, the recent
advancements in computer science regarding machine learning should
be applied to alleviate future data processing.
Ultimately, future research questions will require a combination of sev-
eral skillsets: biologists, physicists, chemists, engineers and computer
scientists - and will truly be an interdisciplinary effort.
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fig. S1. caDNAno DNA origami design. Circular DNA scaffold (blue) is routed in horizontal loops to form 24 parallel helices. Staple strands (gray) 

connect parts of the scaffold and form the rectangle. Eight strands are biotinylated on the 5’-end (orange). Most gray staples’ 3’ and 5’-ends 

are on the same DNA origami face. However, Biotin and dye functionalizations are intended to protrude on opposite faces. With the help of 

adjacent staples, the orange staples are shifted by one helix. This switches the 3’ and 5’-ends to the opposite face. Red crosses define base-

skips, which are required to prevent the DNA origami from twisting.  
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fig. S2. Schematic DNA origami staple layouts of single-color metafluorophores (6 to 132). Hexagons represent 3’-ends of all 176 staples, 

compare to figure S1. Orange shapes represent biotinylated staple strands, protruding on the opposite face. Black hexagons represent staples 

with 3’-handle extension, see table S3. Pattern is the same for Atto 647N, Cy3 and Atto 488. (a) is a not functionalized structure, corresponding 

to the caDNAno layout. (b) 6, (c) 12, (d) 18, (e) 24, (f) 30, (g) 54, (h) 72, (i) 84, (j) 108 and (k) 132 dyes attached. 
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fig. S3. Linear dependence of intensity on the number of dyes per DNA origami (calibrated). From 6 to 132 dyes per DNA origami, the 

intensity scales linearly for (a) Atto 647N, (b) Cy3 and (c) Atto 488. Investigated samples are identical to those in Figure 1 of the main text. 

However, samples contained the structure of interest and additionally a second DNA origami with a significantly different dye count as 

reference. This allows comparison and calibration of measured intensities and thereby reduces sample-to-sample variations. Corresponding 

data in Figure 1 of the main text is not calibrated.  
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fig. S4. Intensity distributions for 6 to 132 dyes. Data corresponds to figure S3, where mean and standard deviation of the distributions are 

plotted. (a) Atto 647N. (b) Cy3. (c) Atto 488. Investigated samples contained the structure of interest and a second DNA origami with a 

significantly different dye count as reference. Reference intensity distributions are not shown. 
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fig. S5. Excitation power variation. The measured intensity of a 30 dye metafluorophore scales linear with the applied excitation intensity for 

(a) Atto 647N, (b) Cy3 and (c) Atto 488. More than 12,000 metafluorophores were evaluated per data point. Camera integration times were 

constant at 10 s. All subsequent measurements throughout this study were performed at 60 %. 

 

 

 

fig. S6. Integration time variation. DNA origami-based metafluorophore recordings were measured using a Hamamatsu ORCA Flash 4.0 sCMOS 

camera. Integration times were varied from 2 s to 10 s per recording and show a linear increase in intensity of a 30 dye metafluorophore for (a) 

Atto 647N, (b) Cy3 and (c) Atto 488 at 60 % excitation intensity. More than 12,000 metafluorophores were evaluated per data point.  

 
 

 
fig. S7. Refocusing performance. While repeated focusing attempts may lead to imaging in different focal planes, different focal planes may 

yield different intensities of a single target. The same samples, containing DNA origami based metafluorophores with 30 dyes, were imaged and 

refocused five times for (a) Atto 647N, (b) Cy3 and (c) Atto 488. Plots are normalized to the average value (colored line).  
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fig. S8. Photostability. Repeated recording of the same area causes photobleaching of the dyes. The measured intensity drops exponentially. 

Measurements were performed at 60 % excitation power and integration times of 10 s per frame on a 30 dye DNA origami metafluorophore for 

(a) Atto 647N (-0.77 %), (b) Cy3 (-1.37 %) and (c) Atto 488 (-2.80 % per acquisition) on the Zeiss Axio Observer microscope. 

 
 
 
 
 

 
 

fig. S9. Schematic DNA origami staple layouts of self-quenching study. (a to c) Sparse dye patterning on DNA origami with ~15 nm dye-to-dye 

distance, for Atto 647N (red), Cy3 (green) and Atto 488 (blue). (d to f) Dense dye patterning on DNA origami with ~5 nm dye-to-dye distance, for 

Atto 647N (red), Cy3 (green) and Atto 488 (blue). 
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fig. S10. FRET investigation dye patterning (random and column-wise). (a to d) Mixed dye patterns, corresponding to Figure 2 (a-c) of the main 

text. (e to h) Column-wise dye pattern with inter-color spacing > 10 nm, corresponding to figure 2 (d-f) of the main text. 

 
 
 

 

 
 
fig. S11. Intensity barcode dye patterns. The column-wise dye pattern separates distinct dyes > 10 nm and thus prevents FRET. (a) 6, (b) 14, (c) 

27 and (d) 44 dyes attached per color. These layouts were used to independently control brightness levels for all three colors in the barcode 

studies. 
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fig. S12. Intensity distributions for 124 barcodes in one sample. Exemplary intensity distributions of 25 distinct metafluorophores combined in 

one sample for (a) Atto 647N, (b) Cy3 and (c) Atto 488. Four levels (corresponding to 6, 14, 27 and 44 dyes) are clearly distinguishable. 

Overlapping regions in between peaks were identified (see software section) and barcodes displaying corresponding intensities were classified 

as unqualified. 
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fig. S13. Exemplary fluorescent image of nucleic acid detection. Three-color confocal image of the nucleic acid detection experiment. Eight 

different barcodes were used (see table S7), six of them specifically tethered to the glass surface by synthetic DNA targets. Note that the 

fluorescent image (and thus the data analysis) is comparable to the image in Fig. 3b. Identifying all barcodes yields the first data set (i.e. the 

green bars) in figure S14b. 
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fig. S14. DNA detection calibration. (a) Eight DNA targets (See table S7) have been added to a detection assay at the same designed 

concentration (12.5 pM). Due to imperfect initial determination of target concentration and subsequent pipetting errors, the different targets 

are not detected with the same frequency. However, this target-to-target variation is constant between samples. By normalizing the average of 

each target to a reference target (here Target ID ‘3’), a calibration table can be produced. This allows the normalization of future measurements 

with the same targets. (b) Counted metafluorophores from the same experiment as shown in Fig. 4c, before normalization. In contrast to (a), 

targets have been added at different concentrations: 0 pM (targets 1 and 2), 1.5 pM (targets 3 and 4), 4.5 pM (targets 5 and 6) and 13.5 pM 

(targets 7 and 8). Since targets 1 and 2 have been omitted, the corresponding detections represent non-specifically bound metafluorophores 

and false-positives. 

 

 

  

 
fig. S15. Triggered assembly formation gel assay. See 'triggered assembly gel assay protocol' for details. Capture strands (CAP) are labeled with 

Alexa 647 (red), hairpins (HP) with Cy3 (green). Trigger strands (T) are unlabeled. Lane 1 (1 pmol CAP) and 3 (12 pmol) serve as reference for 

CAP and HP migration speeds. Lanes 4 - 7 show reactions performed at 30 C, lanes 8 - 11 at 24 C, respectively (1 pmol CAP each).  

Control lanes 7 and 11 are missing the (T) strand, thereby inhibiting triangle formation. Lanes only show CAP and HP bands, in agreement with 

the reference bands. 

Assembly reactions in lanes 5 and 9 had 12 fold excess of HP strands over CAP strands (10.9 over T) and triangles (10 HP per triangle) are 

formed as indicated by the strong band migrating slower than the reference bands. The presence of a CAP reference band indicates that not all 

CAP strands formed a triangle. Since HP strands are in slight stoichiometric excess in regards to the triangles, a weak HP band is notable. 

Lanes 6 and 10 contain reactions with higher HP excess. Product bands appear to migrate slightly slower than the product bands in lane 5 and 9, 

indicating only marginally increased triangle size.  

Reactions in lanes 4 and 8 were had insufficient HP to fully assemble a triangle (<5 of 10 strands). Lanes show a faster product band than the 

corresponding 12x and 20x lanes, implying only partly assembled triangles. The green HP band is very weak, indicating complete usage of HP 

strands. 
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table S1. DNA origami staple sequences. The colors match those in the caDNAno layout shown in fig. S1. The first 

column denotes the staples position according to the caDNAno layout. The first digit indicates the helix the 5’-end is 

located on (y-coordinate), the succeeding number in brackets marks the number of base pairs the 5’-end is away 

from the boundary (x-coordinate). The second pair of numbers corresponds to the 3’-end in similar fashion. 

 

Position Sequence Color Description 

0[111]1[95] TAAATGAATTTTCTGTATGGGATTAATTTCTT  Structure strand 

0[143]1[127] TCTAAAGTTTTGTCGTCTTTCCAGCCGACAA  Structure strand 

0[175]0[144] TCCACAGACAGCCCTCATAGTTAGCGTAACGA  Structure strand 

0[207]1[191] TCACCAGTACAAACTACAACGCCTAGTACCAG  Structure strand 

0[239]1[223] AGGAACCCATGTACCGTAACACTTGATATAA  Structure strand 

0[271]1[255] CCACCCTCATTTTCAGGGATAGCAACCGTACT  Structure strand 

0[47]1[31] AGAAAGGAACAACTAAAGGAATTCAAAAAAA  Structure strand 

0[79]1[63] ACAACTTTCAACAGTTTCAGCGGATGTATCGG  Structure strand 

1[128]4[128] TGACAACTCGCTGAGGCTTGCATTATACCAAGCGCGATGATAAA  Structure strand 

1[160]2[144] TTAGGATTGGCTGAGACTCCTCAATAACCGAT  Structure strand 

1[192]4[192] GCGGATAACCTATTATTCTGAAACAGACGATTGGCCTTGAAGAGCCAC  Structure strand 

1[224]3[223] GTATAGCAAACAGTTAATGCCCAATCCTCA  Structure strand 

1[256]4[256] CAGGAGGTGGGGTCAGTGCCTTGAGTCTCTGAATTTACCGGGAACCAG  Structure strand 

1[32]3[31] AGGCTCCAGAGGCTTTGAGGACACGGGTAA   Structure strand 

1[64]4[64 TTTATCAGGACAGCATCGGAACGACACCAACCTAAAACGAGGTCAATC   Structure strand 

1[96]3[95] AAACAGCTTTTTGCGGGATCGTCAACACTAAA   Structure strand 

10[111]8[112] TTGCTCCTTTCAAATATCGCGTTTGAGGGGGT   Structure strand 

10[143]9[159] CCAACAGGAGCGAACCAGACCGGAGCCTTTAC   Structure strand 

10[175]8[176] TTAACGTCTAACATAAAAACAGGTAACGGA   Structure strand 

10[207]8[208] ATCCCAATGAGAATTAACTGAACAGTTACCAG   Structure strand 

10[239]8[240] GCCAGTTAGAGGGTAATTGAGCGCTTTAAGAA   Structure strand 

10[271]8[272] ACGCTAACACCCACAAGAATTGAAAATAGC   Structure strand 

10[47]8[48] CTGTAGCTTGACTATTATAGTCAGTTCATTGA   Structure strand 

10[79]8[80] GATGGCTTATCAAAAAGATTAAGAGCGTCC   Structure strand 

11[128]13[127] TTTGGGGATAGTAGTAGCATTAAAAGGCCG   Structure strand 

11[160]12[144] CCAATAGCTCATCGTAGGAATCATGGCATCAA   Structure strand 

11[192]13[191] TATCCGGTCTCATCGAGAACAAGCGACAAAAG   Structure strand 

11[224]13[223] GCGAACCTCCAAGAACGGGTATGACAATAA   Structure strand 

11[256]13[255] GCCTTAAACCAATCAATAATCGGCACGCGCCT   Structure strand 

11[32]13[31] AACAGTTTTGTACCAAAAACATTTTATTTC   Structure strand 

11[64]13[63] GATTTAGTCAATAAAGCCTCAGAGAACCCTCA   Structure strand 

11[96]13[95] AATGGTCAACAGGCAAGGCAAAGAGTAATGTG   Structure strand 

12[111]10[112] TAAATCATATAACCTGTTTAGCTAACCTTTAA   Structure strand 

12[143]11[159] TTCTACTACGCGAGCTGAAAAGGTTACCGCGC   Structure strand 

12[175]10[176] TTTTATTTAAGCAAATCAGATATTTTTTGT   Structure strand 

12[207]10[208] GTACCGCAATTCTAAGAACGCGAGTATTATTT   Structure strand 

12[239]10[240] CTTATCATTCCCGACTTGCGGGAGCCTAATTT   Structure strand 
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12[271]10[272] TGTAGAAATCAAGATTAGTTGCTCTTACCA   Structure strand 

12[47]10[48] TAAATCGGGATTCCCAATTCTGCGATATAATG   Structure strand 

12[79]10[80] AAATTAAGTTGACCATTAGATACTTTTGCG   Structure strand 

13[128]15[127] GAGACAGCTAGCTGATAAATTAATTTTTGT   Structure strand 

13[160]14[144] GTAATAAGTTAGGCAGAGGCATTTATGATATT   Structure strand 

13[192]15[191] GTAAAGTAATCGCCATATTTAACAAAACTTTT   Structure strand 

13[224]15[223] ACAACATGCCAACGCTCAACAGTCTTCTGA   Structure strand 

13[256]15[255] GTTTATCAATATGCGTTATACAAACCGACCGT   Structure strand 

13[32]15[31] AACGCAAAATCGATGAACGGTACCGGTTGA   Structure strand 

13[64]15[63] TATATTTTGTCATTGCCTGAGAGTGGAAGATT   Structure strand 

13[96]15[95] TAGGTAAACTATTTTTGAGAGATCAAACGTTA   Structure strand 

14[111]12[112] GAGGGTAGGATTCAAAAGGGTGAGACATCCAA   Structure strand 

14[143]13[159] CAACCGTTTCAAATCACCATCAATTCGAGCCA   Structure strand 

14[175]12[176] CATGTAATAGAATATAAAGTACCAAGCCGT   Structure strand 

14[207]12[208] AATTGAGAATTCTGTCCAGACGACTAAACCAA   Structure strand 

14[239]12[240] AGTATAAAGTTCAGCTAATGCAGATGTCTTTC   Structure strand 

14[271]12[272] TTAGTATCACAATAGATAAGTCCACGAGCA   Structure strand 

14[47]12[48] AACAAGAGGGATAAAAATTTTTAGCATAAAGC   Structure strand 

14[79]12[80] GCTATCAGAAATGCAATGCCTGAATTAGCA   Structure strand 

15[128]18[128] TAAATCAAAATAATTCGCGTCTCGGAAACCAGGCAAAGGGAAGG   Structure strand 

15[160]16[144] ATCGCAAGTATGTAAATGCTGATGATAGGAAC   Structure strand 

15[192]18[192] TCAAATATAACCTCCGGCTTAGGTAACAATTTCATTTGAAGGCGAATT   Structure strand 

15[224]17[223] CCTAAATCAAAATCATAGGTCTAAACAGTA   Structure strand 

15[256]18[256] GTGATAAAAAGACGCTGAGAAGAGATAACCTTGCTTCTGTTCGGGAGA   Structure strand 

15[32]17[31] TAATCAGCGGATTGACCGTAATCGTAACCG   Structure strand 

15[64]18[64] GTATAAGCCAACCCGTCGGATTCTGACGACAGTATCGGCCGCAAGGCG   Structure strand 

15[96]17[95] ATATTTTGGCTTTCATCAACATTATCCAGCCA   Structure strand 

16[111]14[112] TGTAGCCATTAAAATTCGCATTAAATGCCGGA   Structure strand 

16[143]15[159] GCCATCAAGCTCATTTTTTAACCACAAATCCA   Structure strand 

16[175]14[176] TATAACTAACAAAGAACGCGAGAACGCCAA   Structure strand 

16[207]14[208] ACCTTTTTATTTTAGTTAATTTCATAGGGCTT   Structure strand 

16[239]14[240] GAATTTATTTAATGGTTTGAAATATTCTTACC   Structure strand 

16[271]14[272] CTTAGATTTAAGGCGTTAAATAAAGCCTGT   Structure strand 

16[47]14[48] ACAAACGGAAAAGCCCCAAAAACACTGGAGCA   Structure strand 

16[79]14[80] GCGAGTAAAAATATTTAAATTGTTACAAAG   Structure strand 

17[160]18[144] AGAAAACAAAGAAGATGATGAAACAGGCTGCG   Structure strand 

17[224]19[223] CATAAATCTTTGAATACCAAGTGTTAGAAC   Structure strand 

17[32]19[31] TGCATCTTTCCCAGTCACGACGGCCTGCAG   Structure strand 

17[96]19[95] GCTTTCCGATTACGCCAGCTGGCGGCTGTTTC   Structure strand 

18[111]16[112] TCTTCGCTGCACCGCTTCTGGTGCGGCCTTCC   Structure strand 

18[143]17[159] CAACTGTTGCGCCATTCGCCATTCAAACATCA   Structure strand 

18[175]16[176] CTGAGCAAAAATTAATTACATTTTGGGTTA   Structure strand 

18[207]16[208] CGCGCAGATTACCTTTTTTAATGGGAGAGACT   Structure strand 

18[239]16[240] CCTGATTGCAATATATGTGAGTGATCAATAGT   Structure strand 
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18[271]16[272] CTTTTACAAAATCGTCGCTATTAGCGATAG   Structure strand 

18[47]16[48] CCAGGGTTGCCAGTTTGAGGGGACCCGTGGGA   Structure strand 

18[79]16[80] GATGTGCTTCAGGAAGATCGCACAATGTGA   Structure strand 

19[160]20[144] GCAATTCACATATTCCTGATTATCAAAGTGTA   Structure strand 

19[224]21[223] CTACCATAGTTTGAGTAACATTTAAAATAT   Structure strand 

19[32]21[31] GTCGACTTCGGCCAACGCGCGGGGTTTTTC   Structure strand 

19[96]21[95] CTGTGTGATTGCGTTGCGCTCACTAGAGTTGC   Structure strand 

2[111]0[112] AAGGCCGCTGATACCGATAGTTGCGACGTTAG   Structure strand 

2[143]1[159] ATATTCGGAACCATCGCCCACGCAGAGAAGGA   Structure strand 

2[175]0[176] TATTAAGAAGCGGGGTTTTGCTCGTAGCAT   Structure strand 

2[207]0[208] TTTCGGAAGTGCCGTCGAGAGGGTGAGTTTCG   Structure strand 

2[239]0[240] GCCCGTATCCGGAATAGGTGTATCAGCCCAAT   Structure strand 

2[271]0[272] GTTTTAACTTAGTACCGCCACCCAGAGCCA   Structure strand 

2[47]0[48] ACGGCTACAAAAGGAGCCTTTAATGTGAGAAT   Structure strand 

2[79]0[80] CAGCGAAACTTGCTTTCGAGGTGTTGCTAA   Structure strand 

20[111]18[112] CACATTAAAATTGTTATCCGCTCATGCGGGCC   Structure strand 

20[143]19[159] AAGCCTGGTACGAGCCGGAAGCATAGATGATG   Structure strand 

20[175]18[176] ATTATCATTCAATATAATCCTGACAATTAC   Structure strand 

20[207]18[208] GCGGAACATCTGAATAATGGAAGGTACAAAAT   Structure strand 

20[239]18[240] ATTTTAAAATCAAAATTATTTGCACGGATTCG   Structure strand 

20[271]18[272] CTCGTATTAGAAATTGCGTAGATACAGTAC   Structure strand 

20[47]18[48] TTAATGAACTAGAGGATCCCCGGGGGGTAACG   Structure strand 

20[79]18[80] TTCCAGTCGTAATCATGGTCATAAAAGGGG   Structure strand 

21[120]23[127] CCCAGCAGGCGAAAAATCCCTTATAAATCAAGCCGGCG   Structure strand 

21[160]22[144] TCAATATCGAACCTCAAATATCAATTCCGAAA   Structure strand 

21[184]23[191] TCAACAGTTGAAAGGAGCAAATGAAAAATCTAGAGATAGA   Structure strand 

21[224]23[223] CTTTAGGGCCTGCAACAGTGCCAATACGTG   Structure strand 

21[248]23[255] AGATTAGAGCCGTCAAAAAACAGAGGTGAGGCCTATTAGT   Structure strand 

21[32]23[31] TTTTCACTCAAAGGGCGAAAAACCATCACC   Structure strand 

21[56]23[63 AGCTGATTGCCCTTCAGAGTCCACTATTAAAGGGTGCCGT   Structure strand 

21[96]23[95] AGCAAGCGTAGGGTTGAGTGTTGTAGGGAGCC   Structure strand 

22[111]20[112] GCCCGAGAGTCCACGCTGGTTTGCAGCTAACT   Structure strand 

22[143]21[159] TCGGCAAATCCTGTTTGATGGTGGACCCTCAA   Structure strand 

22[175]20[176] ACCTTGCTTGGTCAGTTGGCAAAGAGCGGA   Structure strand 

22[207]20[208] AGCCAGCAATTGAGGAAGGTTATCATCATTTT   Structure strand 

22[239]20[240] TTAACACCAGCACTAACAACTAATCGTTATTA   Structure strand 

22[271]20[272] CAGAAGATTAGATAATACATTTGTCGACAA   Structure strand 

22[47]20[48] CTCCAACGCAGTGAGACGGGCAACCAGCTGCA   Structure strand 

22[79]20[80] TGGAACAACCGCCTGGCCCTGAGGCCCGCT   Structure strand 

23[128]23[159] AACGTGGCGAGAAAGGAAGGGAAACCAGTAA   Structure strand 

23[160]22[176] TAAAAGGGACATTCTGGCCAACAAAGCATC   Structure strand 

23[192]22[208] ACCCTTCTGACCTGAAAGCGTAAGACGCTGAG   Structure strand 

23[224]22[240] GCACAGACAATATTTTTGAATGGGGTCAGTA   Structure strand 

23[256]22[272] CTTTAATGCGCGAACTGATAGCCCCACCAG   Structure strand 
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23[32]22[48] CAAATCAAGTTTTTTGGGGTCGAAACGTGGA   Structure strand 

23[64]22[80] AAAGCACTAAATCGGAACCCTAATCCAGTT   Structure strand 

23[96]22[112] CCCGATTTAGAGCTTGACGGGGAAAAAGAATA   Structure strand 

3[160]4[144] TTGACAGGCCACCACCAGAGCCGCGATTTGTA   Structure strand 

3[224]5[223] TTAAAGCCAGAGCCGCCACCCTCGACAGAA   Structure strand 

3[32]5[31] AATACGTTTGAAAGAGGACAGACTGACCTT   Structure strand 

3[96]5[95] ACACTCATCCATGTTACTTAGCCGAAAGCTGC   Structure strand 

4[111]2[112] GACCTGCTCTTTGACCCCCAGCGAGGGAGTTA   Structure strand 

4[143]3[159] TCATCGCCAACAAAGTACAACGGACGCCAGCA   Structure strand 

4[175]2[176] CACCAGAAAGGTTGAGGCAGGTCATGAAAG   Structure strand 

4[207]2[208] CCACCCTCTATTCACAAACAAATACCTGCCTA   Structure strand 

4[239]2[240] GCCTCCCTCAGAATGGAAAGCGCAGTAACAGT   Structure strand 

4[271]2[272] AAATCACCTTCCAGTAAGCGTCAGTAATAA   Structure strand 

4[47]2[48] GACCAACTAATGCCACTACGAAGGGGGTAGCA   Structure strand 

4[79]2[80] GCGCAGACAAGAGGCAAAAGAATCCCTCAG   Structure strand 

5[160]6[144] GCAAGGCCTCACCAGTAGCACCATGGGCTTGA   Structure strand 

5[224]7[223] TCAAGTTTCATTAAAGGTGAATATAAAAGA   Structure strand 

5[32]7[31] CATCAAGTAAAACGAACTAACGAGTTGAGA   Structure strand 

5[96]7[95] TCATTCAGATGCGATTTTAAGAACAGGCATAG   Structure strand 

6[111]4[112] ATTACCTTTGAATAAGGCTTGCCCAAATCCGC   Structure strand 

6[143]5[159] GATGGTTTGAACGAGTAGTAAATTTACCATTA   Structure strand 

6[175]4[176] CAGCAAAAGGAAACGTCACCAATGAGCCGC   Structure strand 

6[207]4[208] TCACCGACGCACCGTAATCAGTAGCAGAACCG   Structure strand 

6[239]4[240] GAAATTATTGCCTTTAGCGTCAGACCGGAACC   Structure strand 

6[271]4[272] ACCGATTGTCGGCATTTTCGGTCATAATCA   Structure strand 

6[47]4[48] TACGTTAAAGTAATCTTGACAAGAACCGAACT   Structure strand 

6[79]4[80] TTATACCACCAAATCAACGTAACGAACGAG   Structure strand 

7[120]9[127] CGTTTACCAGACGACAAAGAAGTTTTGCCATAATTCGA   Structure strand 

7[160]8[144] TTATTACGAAGAACTGGCATGATTGCGAGAGG   Structure strand 

7[184]9[191] CGTAGAAAATACATACCGAGGAAACGCAATAAGAAGCGCA   Structure strand 

7[224]9[223] AACGCAAAGATAGCCGAACAAACCCTGAAC   Structure strand 

7[248]9[255] GTTTATTTTGTCACAATCTTACCGAAGCCCTTTAATATCA   Structure strand 

7[32]9[31] TTTAGGACAAATGCTTTAAACAATCAGGTC   Structure strand 

7[56]9[63] ATGCAGATACATAACGGGAATCGTCATAAATAAAGCAAAG   Structure strand 

7[96]9[95] TAAGAGCAAATGTTTAGACTGGATAGGAAGCC   Structure strand 

8[111]6[112] AATAGTAAACACTATCATAACCCTCATTGTGA   Structure strand 

8[143]7[159] CTTTTGCAGATAAAAACCAAAATAAAGACTCC   Structure strand 

8[175]6[176] ATACCCAACAGTATGTTAGCAAATTAGAGC   Structure strand 

8[207]6[208] AAGGAAACATAAAGGTGGCAACATTATCACCG   Structure strand 

8[239]6[240] AAGTAAGCAGACACCACGGAATAATATTGACG   Structure strand 

8[271]6[272] AATAGCTATCAATAGAAAATTCAACATTCA   Structure strand 

8[47]6[48] ATCCCCCTATACCACATTCAACTAGAAAAATC   Structure strand 

8[79]6[80] AATACTGCCCAAAAGGAATTACGTGGCTCA   Structure strand 

9[128]11[127] GCTTCAATCAGGATTAGAGAGTTATTTTCA  Structure strand 
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9[160]10[144] AGAGAGAAAAAAATGAAAATAGCAAGCAAACT  Structure strand 

9[192]11[191] TTAGACGGCCAAATAAGAAACGATAGAAGGCT  Structure strand 

9[224]11[223] AAAGTCACAAAATAAACAGCCAGCGTTTTA  Structure strand 

9[256]11[255] GAGAGATAGAGCGTCTTTCCAGAGGTTTTGAA  Structure strand 

9[32]11[31] TTTACCCCAACATGTTTTAAATTTCCATAT  Structure strand 

9[64]11[63] CGGATTGCAGAGCTTAATTGCTGAAACGAGTA  Structure strand 

9[96]11[95] CGAAAGACTTTGATAAGAGGTCATATTTCGCA  Structure strand 

        

4[63]6[56] Biotin – ATAAGGGAACCGGATATTCATTACGTCAGGACGTTGGGAA – 3’   5’-Biotin modification 

4[127]6[120] Biotin - TTGTGTCGTGACGAGAAACACCAAATTTCAACTTTAAT – 3’   5’-Biotin modification 

4[191]6[184] Biotin - CACCCTCAGAAACCATCGATAGCATTGAGCCATTTGGGAA – 3’   5’-Biotin modification 

4[255]6[248] Biotin - AGCCACCACTGTAGCGCGTTTTCAAGGGAGGGAAGGTAAA – 3’   5’-Biotin modification 

18[63]20[56] Biotin - ATTAAGTTTACCGAGCTCGAATTCGGGAAACCTGTCGTGC – 3’   5’-Biotin modification 

18[127]20[120] Biotin - GCGATCGGCAATTCCACACAACAGGTGCCTAATGAGTG – 3’   5’-Biotin modification 

18[191]20[184] Biotin - ATTCATTTTTGTTTGGATTATACTAAGAAACCACCAGAAG – 3’   5’-Biotin modification 

18[255]20[248] Biotin - AACAATAACGTAAAACAGAAATAAAAATCCTTTGCCCGAA – 3’   5’-Biotin modification 
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table S2. M13mp18 scaffold sequence. 

 
TTCCCTTCCTTTCTCGCCACGTTCGCCGGCTTTCCCCGTCAAGCTCTAAATCGGGGGCTCCCTTTAGGGTTCCGATTTAGTGCTTTACGGCACCTCGACCCCAAAAAAC

TTGATTTGGGTGATGGTTCACGTAGTGGGCCATCGCCCTGATAGACGGTTTTTCGCCCTTTGACGTTGGAGTCCACGTTCTTTAATAGTGGACTCTTGTTCCAAACTGG

AACAACACTCAACCCTATCTCGGGCTATTCTTTTGATTTATAAGGGATTTTGCCGATTTCGGAACCACCATCAAACAGGATTTTCGCCTGCTGGGGCAAACCAGCGTGG

ACCGCTTGCTGCAACTCTCTCAGGGCCAGGCGGTGAAGGGCAATCAGCTGTTGCCCGTCTCACTGGTGAAAAGAAAAACCACCCTGGCGCCCAATACGCAAACCGCCTC

TCCCCGCGCGTTGGCCGATTCATTAATGCAGCTGGCACGACAGGTTTCCCGACTGGAAAGCGGGCAGTGAGCGCAACGCAATTAATGTGAGTTAGCTCACTCATTAGGC

ACCCCAGGCTTTACACTTTATGCTTCCGGCTCGTATGTTGTGTGGAATTGTGAGCGGATAACAATTTCACACAGGAAACAGCTATGACCATGATTACGAATTCGAGCTC

GGTACCCGGGGATCCTCTAGAGTCGACCTGCAGGCATGCAAGCTTGGCACTGGCCGTCGTTTTACAACGTCGTGACTGGGAAAACCCTGGCGTTACCCAACTTAATCGC

CTTGCAGCACATCCCCCTTTCGCCAGCTGGCGTAATAGCGAAGAGGCCCGCACCGATCGCCCTTCCCAACAGTTGCGCAGCCTGAATGGCGAATGGCGCTTTGCCTGGT

TTCCGGCACCAGAAGCGGTGCCGGAAAGCTGGCTGGAGTGCGATCTTCCTGAGGCCGATACTGTCGTCGTCCCCTCAAACTGGCAGATGCACGGTTACGATGCGCCCAT

CTACACCAACGTGACCTATCCCATTACGGTCAATCCGCCGTTTGTTCCCACGGAGAATCCGACGGGTTGTTACTCGCTCACATTTAATGTTGATGAAAGCTGGCTACAG

GAAGGCCAGACGCGAATTATTTTTGATGGCGTTCCTATTGGTTAAAAAATGAGCTGATTTAACAAAAATTTAATGCGAATTTTAACAAAATATTAACGTTTACAATTTA

AATATTTGCTTATACAATCTTCCTGTTTTTGGGGCTTTTCTGATTATCAACCGGGGTACATATGATTGACATGCTAGTTTTACGATTACCGTTCATCGATTCTCTTGTT

TGCTCCAGACTCTCAGGCAATGACCTGATAGCCTTTGTAGATCTCTCAAAAATAGCTACCCTCTCCGGCATTAATTTATCAGCTAGAACGGTTGAATATCATATTGATG

GTGATTTGACTGTCTCCGGCCTTTCTCACCCTTTTGAATCTTTACCTACACATTACTCAGGCATTGCATTTAAAATATATGAGGGTTCTAAAAATTTTTATCCTTGCGT

TGAAATAAAGGCTTCTCCCGCAAAAGTATTACAGGGTCATAATGTTTTTGGTACAACCGATTTAGCTTTATGCTCTGAGGCTTTATTGCTTAATTTTGCTAATTCTTTG

CCTTGCCTGTATGATTTATTGGATGTTAATGCTACTACTATTAGTAGAATTGATGCCACCTTTTCAGCTCGCGCCCCAAATGAAAATATAGCTAAACAGGTTATTGACC

ATTTGCGAAATGTATCTAATGGTCAAACTAAATCTACTCGTTCGCAGAATTGGGAATCAACTGTTATATGGAATGAAACTTCCAGACACCGTACTTTAGTTGCATATTT

AAAACATGTTGAGCTACAGCATTATATTCAGCAATTAAGCTCTAAGCCATCCGCAAAAATGACCTCTTATCAAAAGGAGCAATTAAAGGTACTCTCTAATCCTGACCTG

TTGGAGTTTGCTTCCGGTCTGGTTCGCTTTGAAGCTCGAATTAAAACGCGATATTTGAAGTCTTTCGGGCTTCCTCTTAATCTTTTTGATGCAATCCGCTTTGCTTCTG

ACTATAATAGTCAGGGTAAAGACCTGATTTTTGATTTATGGTCATTCTCGTTTTCTGAACTGTTTAAAGCATTTGAGGGGGATTCAATGAATATTTATGACGATTCCGC

AGTATTGGACGCTATCCAGTCTAAACATTTTACTATTACCCCCTCTGGCAAAACTTCTTTTGCAAAAGCCTCTCGCTATTTTGGTTTTTATCGTCGTCTGGTAAACGAG

GGTTATGATAGTGTTGCTCTTACTATGCCTCGTAATTCCTTTTGGCGTTATGTATCTGCATTAGTTGAATGTGGTATTCCTAAATCTCAACTGATGAATCTTTCTACCT

GTAATAATGTTGTTCCGTTAGTTCGTTTTATTAACGTAGATTTTTCTTCCCAACGTCCTGACTGGTATAATGAGCCAGTTCTTAAAATCGCATAAGGTAATTCACAATG

ATTAAAGTTGAAATTAAACCATCTCAAGCCCAATTTACTACTCGTTCTGGTGTTTCTCGTCAGGGCAAGCCTTATTCACTGAATGAGCAGCTTTGTTACGTTGATTTGG

GTAATGAATATCCGGTTCTTGTCAAGATTACTCTTGATGAAGGTCAGCCAGCCTATGCGCCTGGTCTGTACACCGTTCATCTGTCCTCTTTCAAAGTTGGTCAGTTCGG

TTCCCTTATGATTGACCGTCTGCGCCTCGTTCCGGCTAAGTAACATGGAGCAGGTCGCGGATTTCGACACAATTTATCAGGCGATGATACAAATCTCCGTTGTACTTTG

TTTCGCGCTTGGTATAATCGCTGGGGGTCAAAGATGAGTGTTTTAGTGTATTCTTTTGCCTCTTTCGTTTTAGGTTGGTGCCTTCGTAGTGGCATTACGTATTTTACCC

GTTTAATGGAAACTTCCTCATGAAAAAGTCTTTAGTCCTCAAAGCCTCTGTAGCCGTTGCTACCCTCGTTCCGATGCTGTCTTTCGCTGCTGAGGGTGACGATCCCGCA

AAAGCGGCCTTTAACTCCCTGCAAGCCTCAGCGACCGAATATATCGGTTATGCGTGGGCGATGGTTGTTGTCATTGTCGGCGCAACTATCGGTATCAAGCTGTTTAAGA

AATTCACCTCGAAAGCAAGCTGATAAACCGATACAATTAAAGGCTCCTTTTGGAGCCTTTTTTTTGGAGATTTTCAACGTGAAAAAATTATTATTCGCAATTCCTTTAG

TTGTTCCTTTCTATTCTCACTCCGCTGAAACTGTTGAAAGTTGTTTAGCAAAATCCCATACAGAAAATTCATTTACTAACGTCTGGAAAGACGACAAAACTTTAGATCG

TTACGCTAACTATGAGGGCTGTCTGTGGAATGCTACAGGCGTTGTAGTTTGTACTGGTGACGAAACTCAGTGTTACGGTACATGGGTTCCTATTGGGCTTGCTATCCCT

GAAAATGAGGGTGGTGGCTCTGAGGGTGGCGGTTCTGAGGGTGGCGGTTCTGAGGGTGGCGGTACTAAACCTCCTGAGTACGGTGATACACCTATTCCGGGCTATACTT

ATATCAACCCTCTCGACGGCACTTATCCGCCTGGTACTGAGCAAAACCCCGCTAATCCTAATCCTTCTCTTGAGGAGTCTCAGCCTCTTAATACTTTCATGTTTCAGAA

TAATAGGTTCCGAAATAGGCAGGGGGCATTAACTGTTTATACGGGCACTGTTACTCAAGGCACTGACCCCGTTAAAACTTATTACCAGTACACTCCTGTATCATCAAAA

GCCATGTATGACGCTTACTGGAACGGTAAATTCAGAGACTGCGCTTTCCATTCTGGCTTTAATGAGGATTTATTTGTTTGTGAATATCAAGGCCAATCGTCTGACCTGC

CTCAACCTCCTGTCAATGCTGGCGGCGGCTCTGGTGGTGGTTCTGGTGGCGGCTCTGAGGGTGGTGGCTCTGAGGGTGGCGGTTCTGAGGGTGGCGGCTCTGAGGGAGG

CGGTTCCGGTGGTGGCTCTGGTTCCGGTGATTTTGATTATGAAAAGATGGCAAACGCTAATAAGGGGGCTATGACCGAAAATGCCGATGAAAACGCGCTACAGTCTGAC

GCTAAAGGCAAACTTGATTCTGTCGCTACTGATTACGGTGCTGCTATCGATGGTTTCATTGGTGACGTTTCCGGCCTTGCTAATGGTAATGGTGCTACTGGTGATTTTG

CTGGCTCTAATTCCCAAATGGCTCAAGTCGGTGACGGTGATAATTCACCTTTAATGAATAATTTCCGTCAATATTTACCTTCCCTCCCTCAATCGGTTGAATGTCGCCC

TTTTGTCTTTGGCGCTGGTAAACCATATGAATTTTCTATTGATTGTGACAAAATAAACTTATTCCGTGGTGTCTTTGCGTTTCTTTTATATGTTGCCACCTTTATGTAT

GTATTTTCTACGTTTGCTAACATACTGCGTAATAAGGAGTCTTAATCATGCCAGTTCTTTTGGGTATTCCGTTATTATTGCGTTTCCTCGGTTTCCTTCTGGTAACTTT

GTTCGGCTATCTGCTTACTTTTCTTAAAAAGGGCTTCGGTAAGATAGCTATTGCTATTTCATTGTTTCTTGCTCTTATTATTGGGCTTAACTCAATTCTTGTGGGTTAT

CTCTCTGATATTAGCGCTCAATTACCCTCTGACTTTGTTCAGGGTGTTCAGTTAATTCTCCCGTCTAATGCGCTTCCCTGTTTTTATGTTATTCTCTCTGTAAAGGCTG

CTATTTTCATTTTTGACGTTAAACAAAAAATCGTTTCTTATTTGGATTGGGATAAATAATATGGCTGTTTATTTTGTAACTGGCAAATTAGGCTCTGGAAAGACGCTCG

TTAGCGTTGGTAAGATTCAGGATAAAATTGTAGCTGGGTGCAAAATAGCAACTAATCTTGATTTAAGGCTTCAAAACCTCCCGCAAGTCGGGAGGTTCGCTAAAACGCC

TCGCGTTCTTAGAATACCGGATAAGCCTTCTATATCTGATTTGCTTGCTATTGGGCGCGGTAATGATTCCTACGATGAAAATAAAAACGGCTTGCTTGTTCTCGATGAG

TGCGGTACTTGGTTTAATACCCGTTCTTGGAATGATAAGGAAAGACAGCCGATTATTGATTGGTTTCTACATGCTCGTAAATTAGGATGGGATATTATTTTTCTTGTTC

AGGACTTATCTATTGTTGATAAACAGGCGCGTTCTGCATTAGCTGAACATGTTGTTTATTGTCGTCGTCTGGACAGAATTACTTTACCTTTTGTCGGTACTTTATATTC

TCTTATTACTGGCTCGAAAATGCCTCTGCCTAAATTACATGTTGGCGTTGTTAAATATGGCGATTCTCAATTAAGCCCTACTGTTGAGCGTTGGCTTTATACTGGTAAG

AATTTGTATAACGCATATGATACTAAACAGGCTTTTTCTAGTAATTATGATTCCGGTGTTTATTCTTATTTAACGCCTTATTTATCACACGGTCGGTATTTCAAACCAT

TAAATTTAGGTCAGAAGATGAAATTAACTAAAATATATTTGAAAAAGTTTTCTCGCGTTCTTTGTCTTGCGATTGGATTTGCATCAGCATTTACATATAGTTATATAAC

CCAACCTAAGCCGGAGGTTAAAAAGGTAGTCTCTCAGACCTATGATTTTGATAAATTCACTATTGACTCTTCTCAGCGTCTTAATCTAAGCTATCGCTATGTTTTCAAG

GATTCTAAGGGAAAATTAATTAATAGCGACGATTTACAGAAGCAAGGTTATTCACTCACATATATTGATTTATGTACTGTTTCCATTAAAAAAGGTAATTCAAATGAAA

TTGTTAAATGTAATTAATTTTGTTTTCTTGATGTTTGTTTCATCATCTTCTTTTGCTCAGGTAATTGAAATGAATAATTCGCCTCTGCGCGATTTTGTAACTTGGTATT

CAAAGCAATCAGGCGAATCCGTTATTGTTTCTCCCGATGTAAAAGGTACTGTTACTGTATATTCATCTGACGTTAAACCTGAAAATCTACGCAATTTCTTTATTTCTGT

TTTACGTGCAAATAATTTTGATATGGTAGGTTCTAACCCTTCCATTATTCAGAAGTATAATCCAAACAATCAGGATTATATTGATGAATTGCCATCATCTGATAATCAG

GAATATGATGATAATTCCGCTCCTTCTGGTGGTTTCTTTGTTCCGCAAAATGATAATGTTACTCAAACTTTTAAAATTAATAACGTTCGGGCAAAGGATTTAATACGAG

TTGTCGAATTGTTTGTAAAGTCTAATACTTCTAAATCCTCAAATGTATTATCTATTGACGGCTCTAATCTATTAGTTGTTAGTGCTCCTAAAGATATTTTAGATAACCT

TCCTCAATTCCTTTCAACTGTTGATTTGCCAACTGACCAGATATTGATTGAGGGTTTGATATTTGAGGTTCAGCAAGGTGATGCTTTAGATTTTTCATTTGCTGCTGGC

TCTCAGCGTGGCACTGTTGCAGGCGGTGTTAATACTGACCGCCTCACCTCTGTTTTATCTTCTGCTGGTGGTTCGTTCGGTATTTTTAATGGCGATGTTTTAGGGCTAT

CAGTTCGCGCATTAAAGACTAATAGCCATTCAAAAATATTGTCTGTGCCACGTATTCTTACGCTTTCAGGTCAGAAGGGTTCTATCTCTGTTGGCCAGAATGTCCCTTT

TATTACTGGTCGTGTGACTGGTGAATCTGCCAATGTAAATAATCCATTTCAGACGATTGAGCGTCAAAATGTAGGTATTTCCATGAGCGTTTTTCCTGTTGCAATGGCT

GGCGGTAATATTGTTCTGGATATTACCAGCAAGGCCGATAGTTTG 
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table S3. Fluorescently labeled DNA sequences. 

 

Label Handle 

5' - GTGATGTAGGTGGTAGAGGAA – Atto 647N  staple – TTCCTCTACCACCTACATCAC – 3’ 

5' - TATGAGAAGTTAGGAATGTTA - Cy3 staple - TAACATTCCTAACTTCTCATA – 3’ 

5' - CGAGTTTAGGAGAGATGGTAA – Atto 488 staple - TTACCATCTCTCCTAAACTCG – 3’ 

 

 

 

 
table S4. Intensity barcode subset (25 of 124). 

 

Barcode-No RED GRN BLU Subset No 

1 6 0 0 

 2 14 0 0 

 3 27 0 0 

 4 44 0 0 

 5 0 6 0 

 6 6 6 0 1 

7 14 6 0 

 8 27 6 0 

 9 44 6 0 

 10 0 14 0 

 11 6 14 0 

 12 14 14 0 

 13 27 14 0 2 

14 44 14 0 

 15 0 27 0 

 16 6 27 0 3 

17 14 27 0 

 18 27 27 0 

 19 44 27 0 

 20 0 44 0 

 21 6 44 0 

 22 14 44 0 

 23 27 44 0 4 

24 44 44 0 5 

25 0 0 6 

 26 6 0 6 

 27 14 0 6 

 28 27 0 6 6 

29 44 0 6 7 
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30 0 6 6 

 31 6 6 6 

 32 14 6 6 

 33 27 6 6 

 34 44 6 6 

 35 0 14 6 

 36 6 14 6 

 37 14 14 6 

 38 27 14 6 

 39 44 14 6 

 40 0 27 6 

 41 6 27 6 

 42 14 27 6 

 43 27 27 6 

 44 44 27 6 

 45 0 44 6 

 46 6 44 6 

 47 14 44 6 

 48 27 44 6 

 49 44 44 6 

 50 0 0 14 

 51 6 0 14 

 52 14 0 14 

 53 27 0 14 

 54 44 0 14 

 55 0 6 14 

 56 6 6 14 

 57 14 6 14 

 58 27 6 14 8 

59 44 6 14 

 60 0 14 14 9 

61 6 14 14 10 

62 14 14 14 

 63 27 14 14 

 64 44 14 14 11 

65 0 27 14 

 66 6 27 14 

 67 14 27 14 12 

68 27 27 14 

 69 44 27 14 13 

70 0 44 14 
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71 6 44 14 

 72 14 44 14 

 73 27 44 14 14 

74 44 44 14 15 

75 0 0 27 

 76 6 0 27 

 77 14 0 27 

 78 27 0 27 

 79 44 0 27 16 

80 0 6 27 

 81 6 6 27 

 82 14 6 27 17 

83 27 6 27 

 84 44 6 27 

 85 0 14 27 

 86 6 14 27 

 87 14 14 27 18 

88 27 14 27 

 89 44 14 27 19 

90 0 27 27 20 

91 6 27 27 

 92 14 27 27 

 93 27 27 27 

 94 44 27 27 

 95 0 44 27 

 96 6 44 27 

 97 14 44 27 21 

98 27 44 27 

 99 44 44 27 

 100 0 0 44 

 101 6 0 44 

 102 14 0 44 

 103 27 0 44 22 

104 44 0 44 

 105 0 6 44 23 

106 6 6 44 

 107 14 6 44 

 108 27 6 44 

 109 44 6 44 

 110 0 14 44 

 111 6 14 44 
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112 14 14 44 

 113 27 14 44 

 114 44 14 44 

 115 0 27 44 

 116 6 27 44 

 117 14 27 44 

 118 27 27 44 

 119 44 27 44 

 120 0 44 44 24 

121 6 44 44 25 

122 14 44 44 

 123 27 44 44 

 124 44 44 44 
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table S5. Intensity barcode subset (12 of 64). 

 

Barcode-No RED GRN BLU Subset No 

1 6 6 6 

 2 14 6 6 

 3 27 6 6 

 4 44 6 6 

 5 6 14 6 1 

6 14 14 6 

 7 27 14 6 

 8 44 14 6 

 9 6 27 6 

 10 14 27 6 

 11 27 27 6 2 

12 44 27 6 

 13 6 44 6 

 14 14 44 6 3 

15 27 44 6 

 16 44 44 6 

 17 6 6 14 

 18 14 6 14 

 19 27 6 14 4 

20 44 6 14 

 21 6 14 14 

 22 14 14 14 5 

23 27 14 14 

 24 44 14 14 6 

25 6 27 14 

 26 14 27 14 

 27 27 27 14 

 28 44 27 14 

 29 6 44 14 

 30 14 44 14 

 31 27 44 14 

 32 44 44 14 

 33 6 6 27 

 34 14 6 27 

 35 27 6 27 

 36 44 6 27 

 37 6 14 27 

 38 14 14 27 
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39 27 14 27 

 40 44 14 27 

 41 6 27 27 

 42 14 27 27 

 43 27 27 27 7 

44 44 27 27 

 45 6 44 27 8 

46 14 44 27 

 47 27 44 27 

 48 44 44 27 9 

49 6 6 44 

 50 14 6 44 

 51 27 6 44 

 52 44 6 44 

 53 6 14 44 

 54 14 14 44 

 55 27 14 44 

 56 44 14 44 10 

57 6 27 44 

 58 14 27 44 11 

59 27 27 44 

 60 44 27 44 

 61 6 44 44 12 

62 14 44 44 

 63 27 44 44 

 64 44 44 44 
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table S6. Intensity barcode subset (5 of 20). 

 

Barcode-No RED GRN BLU Subset No 

1 44 14 14 

 2 14 44 14 1 

3 14 14 44 

 4 44 44 14 

 5 44 14 44 2 

6 14 44 44 

 7 44 44 44 

 8 14 14 14 

 9 44 44 0 

 10 44 0 44 3 

11 0 44 44 

 12 14 14 0 

 13 14 0 14 

 14 0 14 14 4 

15 44 14 0 

 16 44 0 14 

 17 0 44 14 

 18 14 44 0 5 

19 14 0 44 

 20 0 14 44 

  
 
table S7. DNA detection sequences and corresponding barcodes. 

 

Target Sequence Barcode (RED-GRN-BLU) 
1 5’ – GCAGTTTCCGACCGATATAGT TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

14-44-14 

2 5’ – TAGAGTCCAAGAGTCCTCGTT TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

14-44-44 

3 5’ – GGTTAAGGTCAACATCGTCTC TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

14-14-14 

4 5’ – CATGTCAGGAGATTTTCAGCC TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

14-14-44 

5 5’ – TACCCTATCTGAGTGAGTAGC TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

44-14-14 

6 5’ – CTTCCCGTTATGACAAGATGG TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

44-14-44 

7 5’ – CCCTAGTGCTTTTGGAGAAAC TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

44-44-14 

8 5’ – GGACACGGTATTCCTAATTCG TTT CGGTTGTACTGTGACCGATTC – 3’ 

 

44-44-44 
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table S8. Triggered assembly sequences. 

 

Description Sequence 
Capture 
 

Alexa 647 – CTCCTCGCCCTTGCTCACCAT - Biotin 

Trigger 5’ - ATGGTGAGCAAGGGCGAGGAG … 

CCTCACCTCTACTCCCACCCACACGCACCCTC CCTCACCTCTACTCCCACCCACACGCACCCTC … 

CCTCACCTCTACTCCCACCCACACGCACCCTC CCTCACCTCTACTCCCACCCACACGCACCCTC – 3’ 

 

Hairpin Cy3 - TCCCACCCACACGCACCCTC CCTCACCTCTAC … 

GAGGGTGCGTGTGGGTGGGA GTAGAGGTGAGG – 3’ 
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protocol S1. DNA origami self-assembly. 

Self-assembly was performed in a one-pot reaction with 20 µl total volume containing 10 nM scaffold strand (M13mp18), 100 nM 

folding staples and 150 nM biotinylated strands, 100 nM strands with dye-handle extension and 225 nM fluorescently-labeled anti-

handles in folding buffer (1×TAE Buffer with 12.5 mM MgCl2). The solution was heatshocked at 65 °C for 5 min to remove 

eventual secondary structures and subsequently cooled to 4 °C over the course of 1 h. DNA origami were purified by agarose gel 

electrophoresis (1.5 % agarose, 1×TAE Buffer with 12.5 mM MgCl2) at 4.5 V/cm for 1.5 h, on ice. Gel bands were cut, crushed 

and filled into a ‘Freeze ‘N Squeeze’ column and spun for 5 min at 1000×g at 4 °C. 

 

 

protocol S2. Microscopy sample preparation. 

Clean coverslip (No. 1.5, 18×18 mm2, ≈0.17 mm thick) and microscopy slide (3×1 inch2, 1 mm thick) with Isopropanol. 

Build flow chamber by sandwiching two strips of sticky tape between coverslip and glass slide, ~ 20 µl volume. 

 

Incubate 2 min with 20 µl 1 mg/ml BSA-Biotin in Buffer A (see Materials). 

Rinse with 40 µl Buffer A. 

Incubate 2 min with 20 µl 0.5 mg/ml Streptavidin in Buffer A. 

Rinse with 40 µl Buffer A. 

Rinse with 40 µl Buffer B (see Materials). 

Incubate for 2 min with 20 µl ~300 pM DNA origami based metafluorophores. 

Rinse with 40 µl Buffer B. 

 

Seal chamber with epoxy. 

 

 

protocol S3. Triggered assembly on surface. 

Capture (CAP) and trigger (T) strands were annealed in a thermocycler directly before adding to the sample at 1 µM in 1x TAE 

with 12.5 mM MgCl2 with 0.05% Tween20 (85 °C for 5 min, gradient from 85 °C to 10 °C in 15 min). 

Hairpin (HP) strands were annealed in a thermocycler directly before adding to the sample at 1 µM in 1x TAE with 12.5 mM 

MgCl2 (85 °C for 5 min, gradient from 85 °C to 10 °C in 15 min). 

 

Build flow chamber with 3x sticky tape height, ~ 60 µl volume. 

Incubate 2 min with 60 µl 1 mg/ml BSA-Biotin in Buffer A. 

Rinse with 120 µl Buffer A. 

Incubate 2 min with 60 µl 0.5 mg/ml Streptavidin in Buffer A. 

Rinse with 120 µl Buffer A. 

Rinse with 120 µl 1x TAE with 12.5mM MgCl2 with 0.05% Tween-20. 

Incubate 1 min with 60 µl 25 pM annealed CAP-T duplexes in 12.5mM MgCl2 with 0.05% Tween-20. 

Rinse with 120 µl 1x TAE with 12.5mM MgCl2 with 0.05% Tween-20. 

Incubate for 2 min with 60 µl 100 pM DNA origami standards. 

Rinse with 120 µl 1x TAE with 12.5mM MgCl2 with 0.05% Tween-20. 
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Incubate for 20 min with 60 µl 30 nM annealed HP. 

Rinse with 120 µl 1x TAE with 12.5mM MgCl2 with 0.05% Tween-20. 

Repeat HP incubation 3 times. 

 

Seal chamber. 

 

 

protocol S4. Triggered assembly in solution and gel assay. 

Triggered assembly of triangles for the gel assay was performed in a one-pot reaction. Capture strands (CAP), trigger strands (T) 

and fluorescently labeled hairpins (HP) were added in varying stoichiometric ratios to a total volume of 40 µl. CAP strands were at 

a final concentration of 100 nM, T strands at 110 nM and HP strands at 550 nM (5x), 1.325 µM (12x) or 2.2 µM (20x). Strands 

were diluted in 1x TAE with 12.5 mM MgCl2. HP strands were annealed in a thermocycler directly before adding to the triggered 

assembly reaction at 10 µM in 1x TAE with 12.5 mM MgCl2 (85 C for 5 min, gradient from 85 C to 10 C in 15 min). The control 

sample did not contain the T strand but HP strands at 1.325 µM (12x). Assembly was performed in low retention PCR tubes at 

either 30 C or at 24 C for 2 h each. 

Gel electrophoresis was performed using a 2% agarose gel in 1x TAE with 12.5 mM MgCl2, with 4.5 V/cm for 3 h on ice. 

Gel was scanned with a Typhoon scanner. 
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Materials 

Unmodified DNA oligonucleotides were purchased from Integrated DNA Technologies. Fluorescently modified DNA 

oligonucleotides were purchased from Biosynthesis. Streptavidin was purchased from Invitrogen (Catalog number: S-888). 

Albumin, biotin labeled bovine (BSA-biotin) was obtained from Sigma Aldrich (Catalog Number: A8549). Glass slides and 

coverslips were purchased from VWR. M13mp18 scaffold was obtained from New England Biolabs. ‘Freeze N Squeeze’ columns 

were ordered from Bio-Rad. 

Two buffers were used for sample preparation and imaging: 

Buffer A (10 mM Tris-HCl, 100 mM NaCl, 0.05 % Tween-20, pH 8). 

Buffer B (5 mM Tris-HCl, 10 mM MgCl2, 1 mM EDTA, 0.05 % Tween-20, pH 8). 

 

Optical setup 

DNA origami-based metafluorophore imaging was performed on a Zeiss Axio Observer Z1 Inverted Fluorescence Microscope 

with Definite Focus and a Zeiss Colibri LED illumination system (ATTO 488: 470 nm, Cy3: 555 nm, ATTO 647N: 625 nm). We 

used a Zeiss Plan-apochromat (63x/1.40 Oil) oil-immersion objective and a Hamamatsu Orca-Flash 4.0 sCMOS camera. 

ATTO 488: Zeiss filter set 38: (BP 470/40, FT 495, BP 525/50). 

Cy3: Zeiss Filter Set 43 (BP 545/25, FT 570, BP 605/70). 

ATTO 647N: Zeiss filter set 50 (BP 640/30, FT 660, BP 690/50). 

 

Triggered assembly imaging was carried out on an inverted Nikon Eclipse Ti microscope using a Nikon TIRF illuminator with an 

oil-immersion objective (CFI Apo TIRF 100×, numerical aperture (NA) 1.49, oil). 

Lasers: 488 nm (200 mW nominal, Coherent Sapphire), 561 nm (200 mW nominal, Coherent Sapphire) and 647 nm (300 mW 

nominal, MBP Communications). 

Camera: iXon X3 DU-897 EMCCD (Andor Technologies) 

Excitation filters: (ZT488/10, ZET561/10 and ZET640/20, Chroma Technology) 

Multiband beam splitter: (ZT488rdc/ZT561rdc/ZT640rdc, Chroma Technology) 

Emission filters: (ET525/50m, ET600/50m and ET700/75m, Chroma Technology) 

 

Multiplexed nucleic acid detection was performed on a Zeiss LSM 780 confocal laser scanning microscope equipped with a ZEISS 

Plan-APO 63x/NA1.46 oil immersion objective and a GaAsP array for detection. 

Lasers: 458 nm (Argon), 561 nm (DPSS), 647 nm (HeNe). 

 

 

Software section 

 

Spot detection, intensity analysis 

After image acquisition, spot-detection was performed using a custom LabVIEW script. Here, 2D Gaussians were fitted within a 

10x10 px2 area around the center of the spots. The volume of the 2D Gaussian is proportional to the photon count and is thereby 

defined as intensity. Finally, one obtains a molecule-list with both, spatial coordinates and corresponding intensity values. 

 

Barcode identification 
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All intensity values were plotted as a histogram and the local maxima (peaks) were fitted with Gaussians. Based on the 

intersections of these fits, the distinct intensity-level intervals could be determined. 

Non-overlapping regions in between two peaks had to be identified and barcodes with a corresponding intensity had to be 

classified as qualified. To identify the overlapping interval between two peaks, the height of the intersection (x counts) of the 

corresponding fits was determined. By determining the intersections of the two Gaussians with half the height of their intersection 

(x/2 counts), the overlapping interval and boundaries for barcode levels were defined. Additionally, spots that did not meet the 

criteria of the robust subsets were removed (e.g. removal of barcodes that do not have three colors for the 64-subset.). 

 

After removing the spots that did not qualify, the intensity values in the molecule-list were replaced with barcode-level indicators. 

Individual barcodes were identified by combining spots from the three molecule-lists (corresponding to the three recorded colors), 

which are in close proximity (i.e. < 500 nm).  

 

Triggered assembly 

Triggered assembly evaluation was performed by determining spot coordinates and spot intensities as described above. 

Colocalizations of red (Alexa 647) and green (Cy3) spots were grouped as triangles and blue (Atto 488) and green (Cy3) 

colocalizations as DNA origamis. Plotting the two groups together resulted in Figure 6c of the main test. 
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Supplementary Information 

Quantifying Absolute Addressability in DNA origami with Molecular Resolution 
 

Maximilian T. Strauss, Florian Schueder, Daniel Haas, Philipp C. Nickels, and Ralf Jungmann 

 
Supplementary Figure 1 20-nm DNA origami grid structure 

Supplementary Figure 2 caDNAno overview of the rectangular origami structure 

Supplementary Figure 3 Overview of alignment procedure 

Supplementary Figure 4 Interface of analysis software 

Supplementary Figure 5 Overview image for Fig. 2 

Supplementary Figure 6 Influence of Magnesium in folding buffer on staple detection 

Supplementary Figure 7 Influence of storage conditions on detection values 

Supplementary Figure 8 ‘Arrow’-shaped DNA origami grid with 10 binding sites used in Fig. 3c 

Supplementary Figure 9 Overview of DNA-PAINT images used for quantification in Fig. 3d 

Supplementary Figure 10 Overview of DNA-PAINT images used for quantification in Fig. 3d 

Supplementary Figure 11 Overview of 18 DNA origami structures used for the heatmap in Fig. 4 

Supplementary Figure 12 Overview of DNA-PAINT images used for quantification in Fig. 4, Dataset 1 

Supplementary Figure 13 Overview of DNA-PAINT images used for quantification in Fig. 4, Dataset 2 

Supplementary Figure 14 Detection and incorporation heatmap 

Supplementary Figure 15 CanDo simulation of RMS fluctuations 

Supplementary Figure 16 Scaffold and staple detection experiments 

Supplementary Table 1 Fit of Michaelis-Menten saturation curve 

Supplementary Table 2 Overview of related studies and their incorporation values 

Supplementary Table 3 Super-resolution data properties  

Supplementary Table 4 Imaging conditions 

Supplementary Table 5 Used DNA-PAINT sequences 

Supplementary Table 6 List of core staples 

Supplementary Table 7 List of biotinylated staples 
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2 

 
Supplementary Figure 1 | 20-nm DNA origami grid structure. Each hexagon represents a single staple, colored hexagons indicate a 
single staple extension at the 3’-end for DNA-PAINT probing. 

 
 
 
 

 
 
Supplementary Figure 2 | caDNAno overview of the rectangular origami structure. Blue: scaffold, black: unmodified staples, orange: 
biotinylated staples. For strand modification details see Supplementary Table 6.  
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TGCGTGGGCGATGGTTGTT GTCATTGTCGGCGCAACTATCGGTATCAAGCTGTTTAAGAAATTCAC CTCGAAAGCAAGCTGATAAACCGATACAATTAAAGGCTCCTTTTGGA GCCTTTTTTTTGGAGATTTTCAACGTGA AGGGTGGCGGTTCTGAGGG TGGCGGTACTAAACCTCCTGAGTACGGTGATACACCTATTCCGGGCT ATACTTATATCAACCCTCTCGACGGCACTTATCCGCCTGGTACTGAG CAAAACCCCGCTAATCCTAATCCTTCTC

C A T G A A A A A G T C T T T A G T C C T C A A A G C C  T C T G T A G C C G T T G C T A C C C T C G T T C C G A T G C T G T C T T T C G C T G C T G A  G G G T G A C G A T C C C G C A A A A G C G G C C T T T A A C T C C C T G C A A G C C T C A G  C G A C C G A A T A T A T C G G T T A T T G A G G A G T C T C A G C C T C T T A A T A C T T T  C A T G T T T C A G A A T A A T A G G T T C C G A A A T A G G C A G G G G G C A T T A A C T G  T T T A T A C G G G C A C T G T T A C T C A A G G C A C T G A C C C C G T T A A A A C T T A T  T A C C A G T A C A C T C C T G T A T

TCCGTTGTACTTTGTTTCG CGCTTGGTATAATCGCTGGGGGTCAAAGATGAGTGTTTTAGTGTATT CTTTTGCCTCTTTCGTTTTAGGTTGGTGCCTTCGTAGTGGCATTACG TATTTTACCCGTTTAATGGAAACTTCCT CATCAAAAGCCATGTATGA CGCTTACTGGAACGGTAAATTCAGAGACTGCGCTTTCCATTCTGGCT TTAATGAGGATTTATTTGTTTGTGAATATCAAGGCCAATCGTCTGAC CTGCCTCAACCTCCTGTCAATGCTGGCG
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AATTTACTACTCGTTCTGG TGTTTCTCGTCAGGGCAAGCCTTATTCACTGAATGAGCAGCTTTGTT ACGTTGATTTGGGTAATGAATATCCGGTTCTTGTCAAGATTACTCTT GATGAAGGTCAGCCAGCCTATGCGCCTG CTAATAAGGGGGCTATGAC CGAAAATGCCGATGAAAACGCGCTACAGTCTGACGCTAAAGGCAAAC TTGATTCTGTCGCTACTGATTACGGTGCTGCTATCGATGGTTTCATT GGTGACGTTTCCGGCCTTGCTAATGGTA

T G T A A T A A T G T T G T T C C G T T A G T T C G T T  T T A T T A A C G T A G A T T T T T C T T C C C A A C G T C C T G A C T G G T A T A A T G A G  C C A G T T C T T A A A A T C G C A T A A G G T A A T T C A C A A T G A T T A A A G T T G A A  A T T A A A C C A T C T C A A G C C C A T G G T G C T A C T G G T G A T T T T G C T G G C T C  T A A T T C C C A A A T G G C T C A A G T C G G T G A C G G T G A T A A T T C A C C T T T A A  T G A A T A A T T T C C G T C A A T A T T T A C C T T C C C T C C C T C A A T C G G T T G A A  T G T C G C C C T T T T G T C T T T G

TATTTTGGTTTTTATCGTC GTCTGGTAAACGAGGGTTATGATAGTGTTGCTCTTACTATGCCTCGT AATTCCTTTTGGCGTTATGTATCTGCATTAGTTGAATGTGGTATTCC TAAATCTCAACTGATGAATCTTTCTACC GCGCTGGTAAACCATATGA ATTTTCTATTGATTGTGACAAAATAAACTTATTCCGTGGTGTCTTTG CGTTTCTTTTATATGTTGCCACCTTTATGTATGTATTTTCTACGTTT GCTAACATACTGCGTAATAAGGAGTCTT

T T C T C G T T T T C T G A A C T G T T T A A A G C A T  T T G A G G G G G A T T C A A T G A A T A T T T A T G A C G A T T C C G C A G T A T T G G A C  G C T A T C C A G T C T A A A C A T T T T A C T A T T A C C C C C T C T G G C A A A A C T T C  T T T T G C A A A A G C C T C T C G C A A T C A T G C C A G T T C T T T T G G G T A T T C C G  T T A T T A T T G C G T T T C C T C G G T T T C C T T C T G G T A A C T T T G T T C G G C T A  T C T G C T T A C T T T T C T T A A A A A G G G C T T C G G T A A G A T A G C T A T T G C T A  T T T C A T T G T T T C T T G C T C T

TCCGGTCTGGTTCGCTTTG AAGCTCGAATTAAAACGCGATATTTGAAGTCTTTCGGGCTTCCTCTT AATCTTTTTGATGCAATCCGCTTTGCTTCTGACTATAATAGTCAGGG TAAAGACCTGATTTTTGATTTATGGTCA TATTATTGGGCTTAACTCA ATTCTTGTGGGTTATCTCTCTGATATTAGCGCTCAATTACCCTCTGA CTTTGTTCAGGGTGTTCAGTTAATTCTCCCGTCTAATGCGCTTCCCT GTTTTTATGTTATTCTCTCTGTAAAGGC

C G T A C T T T A G T T G C A T A T T T A A A A C A T G  T T G A G C T A C A G C A T T A T A T T C A G C A A T T A A G C T C T A A G C C A T C C G C A  A A A A T G A C C T C T T A T C A A A A G G A G C A A T T A A A G G T A C T C T C T A A T C C  T G A C C T G T T G G A G T T T G C T T G C T A T T T T C A T T T T T G A C G T T A A A C A A  A A A A T C G T T T C T T A T T T G G A T T G G G A T A A A T A A T A T G G C T G T T T A T T  T T G T A A C T G G C A A A T T A G G C T C T G G A A A G A C G C T C G T T A G C G T T G G T  A A G A T T C A G G A T A A A A T T G

ACCTTTTCAGCTCGCGCCC CAAATGAAAATATAGCTAAACAGGTTATTGACCATTTGCGAAATGTA TCTAATGGTCAAACTAAATCTACTCGTTCGCAGAATTGGGAATCAAC TGTTATATGGAATGAAACTTCCAGACAC TAGCTGGGTGCAAAATAGC AACTAATCTTGATTTAAGGCTTCAAAACCTCCCGCAAGTCGGGAGGT TCGCTAAAACGCCTCGCGTTCTTAGAATACCGGATAAGCCTTCTATA TCTGATTTGCTTGCTATTGGGCGCGGTA

G T A T T A C A G G G T C A T A A T G T T T T T G G T A  C A A C C G A T T T A G C T T T A T G C T C T G A G G C T T T A T T G C T T A A T T T T G C T  A A T T C T T T G C C T T G C C T G T A T G A T T T A T T G G A T G T T A A T G C T A C T A C  T A T T A G T A G A A T T G A T G C C A T G A T T C C T A C G A T G A A A A T A A A A A C G G  C T T G C T T G T T C T C G A T G A G T G C G G T A C T T G G T T T A A T A C C C G T T C T T  G G A A T G A T A A G G A A A G A C A G C C G A T T A T T G A T T G G T T T C T A C A T G C T  C G T A A A T T A G G A T G G G A T A

ATTGATGGTGATTTGACTG TCTCCGGCCTTTCTCACCCTTTTGAATCTTTACCTACACATTACTCA GGCATTGCATTTAAAATATATGAGGGTTCTAAAAATTTTTATCCTTG CGTTGAAATAAAGGCTTCTCCCGCAAAA TTATTTTTCTTGTTCAGGA CTTATCTATTGTTGATAAACAGGCGCGTTCTGCATTAGCTGAACATG TTGTTTATTGTCGTCGTCTGGACAGAATTACTTTACCTTTTGTCGGT ACTTTATATTCTCTTATTACTGGCTCGA

A T G C T A G T T T T A C G A T T A C C G T T C A T C G  A T T C T C T T G T T T G C T C C A G A C T C T C A G G C A A T G A C C T G A T A G C C T T T  G T A G A T C T C T C A A A A A T A G C T A C C C T C T C C G G C A T T A A T T T A T C A G C  T A G A A C G G T T G A A T A T C A T A A A T G C C T C T G C C T A A A T T A C A T G T T G G  C G T T G T T A A A T A T G G C G A T T C T C A A T T A A G C C C T A C T G T T G A G C G T T  G G C T T T A T A C T G G T A A G A A T T T G T A T A A C G C A T A T G A T A C T A A A C A G  G C T T T T T C T A G T A A T T A T G

TGGTTAAAAAATGAGCTGA TTTAACAAAAATTTAATGCGAATTTTAACAAAATATTAACGTTTACA ATTTAAATATTTGCTTATACAATCTTCCTGTTTTTGGGGCTTTTCTG ATTATCAACCGGGGTACATATGATTGAC ATTCCGGTGTTTATTCTTA TTTAACGCCTTATTTATCACACGGTCGGTATTTCAAACCATTAAATT TAGGTCAGAAGATGAAATTAACTAAAATATATTTGAAAAAGTTTTCT CGCGTTCTTTGTCTTGCGATTGGATTTG

C A A C G T G A C C T A T C C C A T T A C G G T C A A T  C C G C C G T T T G T T C C C A C G G A G A A T C C G A C G G G T T G T T A C T C G C T C A C  A T T T A A T G T T G A T G A A A G C T G G C T A C A G G A A G G C C A G A C G C G A A T T A  T T T T T G A T G G C G T T C C T A T C A T C A G C A T T T A C A T A T A G T T A T A T A A C  C C A A C C T A A G C C G G A G G T T A A A A A G G T A G T C T C T C A G A C C T A T G A T T  T T G A T A A A T T C A C T A T T G A C T C T T C T C A G C G T C T T A A T C T A A G C T A T  C G C T A T G T T T T C A A G G A T T

GAATGGCGAATGGCGCTTT GCCTGGTTTCCGGCACCAGAAGCGGTGCCGGAAAGCTGGCTGGAGTG CGATCTTCCTGAGGCCGATACTGTCGTCGTCCCCTCAAACTGGCAGA TGCACGGTTACGATGCGCCCATCTACAC CTAAGGGAAAATTAATTAA TAGCGACGATTTACAGAAGCAAGGTTATTCACTCACATATATTGATT TATGTACTGTTTCCATTAAAAAAGGTAATTCAAATGAAATTGTTAAA TGTAATTAATTTTGTTTTCTTGATGTTT

G G C C G T C G T T T T A C A A C G T C G T G A C T G G  G A A A A C C C T G G C G T T A C C C A A C T T A A T C G C C T T G C A G C A C A T C C C C C  T T T C G C C A G C T G G C G T A A T A G C G A A G A G G C C C G C A C C G A T C G C C C T T  C C C A A C A G T T G C G C A G C C T G T T T C A T C A T C T T C T T T T G C T C A G G T A A  T T G A A A T G A A T A A T T C G C C T C T G C G C G A T T T T G T A A C T T G G T A T T C A  A A G C A A T C A G G C G A A T C C G T T A T T G T T T C T C C C G A T G T A A A A G G T A C  T G T T A C T G T A T A T T C A T C T

ATGCTTCCGGCTCGTATGT TGTGTGGAATTGTGAGCGGATAACAATTTCACACAGGAAACAGCTAT GACCATGATTACGAATTCGAGCTCGGTACCCGGGGATCCTCTAGAGT CGACCTGCAGGCATGCAAGCTTGGCACT GACGTTAAACCTGAAAATC TACGCAATTTCTTTATTTCTGTTTTACGTGCAAATAATTTTGATATG GTAGGTTCTAACCCTTCCATTATTCAGAAGTATAATCCAAACAATCA GGATTATATTGATGAATTGCCATCATCT

C G C A A A C C G C C T C T C C C C G C G C G T T G G C  C G A T T C A T T A A T G C A G C T G G C A C G A C A G G T T T C C C G A C T G G A A A G C G  G G C A G T G A G C G C A A C G C A A T T A A T G T G A G T T A G C T C A C T C A T T A G G C  A C C C C A G G C T T T A C A C T T T G A T A A T C A G G A A T A T G A T G A T A A T T C C G  C T C C T T C T G G T G G T T T C T T T G T T C C G C A A A A T G A T A A T G T T A C T C A A  A C T T T T A A A A T T A A T A A C G T T C G G G C A A A G G A T T T A A T A C G A G T T G T  C G A A T T G T T T G T A A A G T C T

CCACCATCAAACAGGATTT TCGCCTGCTGGGGCAAACCAGCGTGGACCGCTTGCTGCAACTCTCTC AGGGCCAGGCGGTGAAGGGCAATCAGCTGTTGCCCGTCTCACTGGTG AAAAGAAAAACCACCCTGGCGCCCAATA AATACTTCTAAATCCTCAA ATGTATTATCTATTGACGGCTCTAATCTATTAGTTGTTAGTGCTCCT AAAGATATTTTAGATAACCTTCCTCAATTCCTTTCAACTGTTGATTT GCCAACTGACCAGATATTGATTGAGGGT

T C G C C C T G A T A G A C G G T T T T T C G C C C T T  T G A C G T T G G A G T C C A C G T T C T T T A A T A G T G G A C T C T T G T T C C A A A C T  G G A A C A A C A C T C A A C C C T A T C T C G G G C T A T T C T T T T G A T T T A T A A G G  G A T T T T G C C G A T T T C G G A A T T G A T A T T T G A G G T T C A G C A A G G T G A T G  C T T T A G A T T T T T C A T T T G C T G C T G G C T C T C A G C G T G G C A C T G T T G C A  G G C G G T G T T A A T A C T G A C C G C C T C A C C T C T G T T T T A T C T T C T G C T G G  T G G T T C G T T C G G T A T T T T T

TTCCCTTCCTTTCTCGCCA CGTTCGCCGGCTTTCCCCGTCAAGCTCTAAATCGGGGGCTCCCTTTA GGGTTCCGATTTAGTGCTTTACGGCACCTCGACCCCAAAAAACTTGA TTTGGGTGATGGTTCACGTAGTGGGCCA AATGGCGATGTTTTAGGGC TATCAGTTCGCGCATTAAAGACTAATAGCCATTCAAAAATATTGTCT GTGCCACGTATTCTTACGCTTTCAGGTCAGAAGGGTTCTATCTCTGT TGGCCAGAATGTCCCTTTTATTACTGGT

ACTAAAGGAATT AGAAAGGAACA GTGAGAAT ACAACTTTCAACAGTTTCAGCGGA CTAA TTG TAAATGAATTTTCTGTATGGGATT GACGTTAG GTCGTCTTTCCA TCTAAAGTTTT TCCACAGACAGCCCTCATAGTTAGCGTAACGA GCAT GTA TCACCAGTACAAACTACAACGCCT GAGTTTCG TACCGTAACACT AGGAACCCATG AGCCCAAT CCACCCTCATTTTCAGGGATAGCA GCCA AGA

C A A A A A A A A G G C T C C A A A A G G A G C C T T T A A T T G T A T C G G T T T A T C A G C T T G C T T T C G A G G T G A A T T T C T T A A A C A G C T T G A T A C C G A T A G T T G C G C C G A C A A T G A C A A C A A C C A T C G C C C A C G C A G A G A A G G A T T A G G A T T A G C G G G G T T T T G C T C A G T A C C A G G C G G A T A A G T G C C G T C G A G A G G G T T G A T A T A A G T A T A G C C C G G A A T A G G T G T A T C A C C G T A C T C A G G A G G T T T A G T A C C G C C A C C C

GGCTTTGAGGAC AGA ACGGCTAC GGGTAGCA GACAGCATCGGAACGA CAGCGAAA TCAG CCC TTTTGCGGGATCGTCA AAGGCCGC GGGAGTTA CTGAGGCTTGCA TCG ATATTCGG GGCTGAGACTCCTCAATAACCGAT TATTAAGA AAAG ATG CCTATTATTCTGAAAC TTTCGGAA CCTGCCTA CAGTTAATGCCC AAA GCCCGTAT GTAACAGT GGGGTCAGTGCCTTGA GTTTTAAC ATAA GTA

A C G G G T A A A A T A C G T A A T G C C A C T A C G A A G G C A C C A A C C T A A A A C G A A A G A G G C A A A A G A A T A C A C T A A A A C A C T C A T C T T T G A C C C C C A G C G A T T A T A C C A A G C G C G A A A C A A A G T A C A A C G G A C G C C A G C A T T G A C A G G A G G T T G A G G C A G G T C A G A C G A T T G G C C T T G A T A T T C A C A A A C A A A T A A A T C C T C A T T A A A G C C A G A A T G G A A A G C G C A G T C T C T G A A T T T A C C G T T C C A G T A A G C G T C A
AAAGAGGACAGA TTG GACCAACT ACCGAACT ATAAGGGA GGTCAATC GCGCAGAC CGAG GAA CCATGTTACTTAGCCG GACCTGCT AAATCCGC TTGTGTCG TAAA TGA TCATCGCC CCACCACCAGAGCCGCGATTTGTA CACCAGAA CCGC GAG CACCCTCA AGAGCCAC CCACCCTC CAGAACCG AGCCGCCACCCT CAG GCCTCCCT CCGGAACC AGCCACCA GGAACCAG AAATCACC ATCA ATA

C T G A C C T T C A T C A A G A G T A A T C T T G A C A A G A A C C G G A T A T T C A T T A C C C A A A T C A A C G T A A C A A A G C T G C T C A T T C A G T G A A T A A G G C T T G C C C T G A C G A G A A A C A C C A G A A C G A G T A G T A A A T T T A C C A T T A G C A A G G C C G G A A A C G T C A C C A A T G A A A C C A T C G A T A G C A G C A C C G T A A T C A G T A G C G A C A G A A T C A A G T T T G C C T T T A G C G T C A G A C T G T A G C G C G T T T T C A T C G G C A T T T T C G G T C

AACGAACTAACG TAA TACGTTAA GAAAAATC GTCAGGACGTTGGGAA TTATACCA CTCA TGG ATGCGATTTTAAGAAC ATTACCTT CATTGTGA TTCAACTTTAAT AAT GATGGTTT TCACCAGTAGCACCATGGGCTTGA CAGCAAAA GAGC TTA TTGAGCCATTTGGGAA TCACCGAC TATCACCG TTAAAGGTGAAT TCA GAAATTAT TATTGACG AGGGAGGGAAGGTAAA ACCGATTG TTCA ACA

A G T T G A G A T T T A G G A A T A C C A C A T T C A A C T A A T G C A G A T A C A T A A C G C C A A A A G G A A T T A C G A G G C A T A G T A A G A G C A A C A C T A T C A T A A C C C T C G T T T A C C A G A C G A C G A T A A A A A C C A A A A T A A A G A C T C C T T A T T A C G C A G T A T G T T A G C A A A C G T A G A A A A T A C A T A C A T A A A G G T G G C A A C A T A T A A A A G A A A C G C A A A G A C A C C A C G G A A T A A G T T T A T T T T G T C A C A A T C A A T A G A A A A T T C A

ATGCTTTAAACA CAA ATCCCCCT TTCATTGA GGAATCGTCATAAATA AATACTGC GTCC AGC AATGTTTAGACTGGAT AATAGTAA GAGGGGGT GAAGTTTTGCCA AAA CTTTTGCA AAGAACTGGCATGATTGCGAGAGG ATACCCAA CGGA TAA CGAGGAAACGCAATAA AAGGAAAC GTTACCAG TAGCCGAACAAA AGA AAGTAAGC TTTAAGAA TCTTACCGAAGCCCTT AATAGCTA TAGC AAA

A T C A G G T C T T T A C C C T G A C T A T T A T A G T C A G A A G C A A A G C G G A T T G C A T C A A A A A G A T T A A G A G G A A G C C C G A A A G A C T T C A A A T A T C G C G T T T T A A T T C G A G C T T C A A A G C G A A C C A G A C C G G A G C C T T T A C A G A G A G A A T A A C A T A A A A A C A G G G A A G C G C A T T A G A C G G G A G A A T T A A C T G A A C A C C C T G A A C A A A G T C A G A G G G T A A T T G A G C G C T A A T A T C A G A G A G A T A A C C C A C A A G A A T T G A

CATGTTTTAAAT CAA CTGTAGCT ATATAATG AGAGCTTAATTGCTGA GATGGCTT TGCG TTT TTTGATAAGAGGTCAT TTGCTCCT ACCTTTAA GGATTAGAGAGT TCA CCAACAGG AAAAATGAAAATAGCAAGCAAACT TTAACGTC TTGT TTT CCAAATAAGAAACGAT ATCCCAAT TATTATTT AATAAACAGCCA CAA GCCAGTTA CCTAATTT GAGCGTCTTTCCAGAG ACGCTAAC ACCA CTT

T T C C A T A T A A C A G T T G A T T C C C A A T T C T G C G A A C G A G T A G A T T T A G T T T G A C C A T T A G A T A C A T T T C G C A A A T G G T C A A T A A C C T G T T T A G C T A T A T T T T C A T T T G G G G C G C G A G C T G A A A A G G T T A C C G C G C C C A A T A G C A A G C A A A T C A G A T A T A G A A G G C T T A T C C G G T A T T C T A A G A A C G C G A G G C G T T T T A G C G A A C C T C C C G A C T T G C G G G A G G T T T T G A A G C C T T A A A T C A A G A T T A G T T G C T

TACCAAAAACAT TTG TAAATCGG CATAAAGC CAATAAAGCCTCAGAG AAATTAAG AGCA ATT ACAGGCAAGGCAAAGA TAAATCAT ACATCCAA GTAGTAGCATTA ATA TTCTACTA TCATCGTAGGAATCATGGCATCAA TTTTATTT CCGT AAG CTCATCGAGAACAAGC GTACCGCA TAAACCAA AAGAACGGGTAT TCC CTTATCAT TGTCTTTC CCAATCAATAATCGGC TGTAGAAA AGCA ACG

T T T A T T T C A A C G C A A G G A T A A A A A T T T T T A G A A C C C T C A T A T A T T T T A A A T G C A A T G C C T G A G T A A T G T G T A G G T A A A G A T T C A A A A G G G T G A G A A A G G C C G G A G A C A G T C A A A T C A C C A T C A A T T C G A G C C A G T A A T A A G A G A A T A T A A A G T A C C G A C A A A A G G T A A A G T A A T T C T G T C C A G A C G A C G A C A A T A A A C A A C A T G T T C A G C T A A T G C A G A A C G C G C C T G T T T A T C A A C A A T A G A T A A G T C C

CGATGAACGGTA AAT AACAAGAG CTGGAGCA GTCATTGCCTGAGAGT GCTATCAG AAAG TAC CTATTTTTGAGAGATC GAGGGTAG ATGCCGGA GCTGATAAATTA CTA CAACCGTT TTAGGCAGAGGCATTTATGATATT CATGTAAT CCAA ACG ATCGCCATATTTAACA AATTGAGA TAGGGCTT AACGCTCAACAG GCC AGTATAAA TTCTTACC ATATGCGTTATACAAA TTAGTATC CTGT AGC

C C G G T T G A T A A T C A G A A A A G C C C C A A A A A C A G G A A G A T T G T A T A A G C A A A T A T T T A A A T T G T A A A C G T T A A T A T T T T G T T A A A A T T C G C A T T A A A T T T T T G T T A A A T C A G C T C A T T T T T T A A C C A C A A A T C C A A T C G C A A G A C A A A G A A C G C G A G A A A A C T T T T T C A A A T A T A T T T T A G T T A A T T T C A T C T T C T G A C C T A A A T T T A A T G G T T T G A A A T A C C G A C C G T G T G A T A A A T A A G G C G T T A A A T A A

ATTGACCGTAAT CGG ACAAACGG CCGTGGGA CAACCCGTCGGATTCT GCGAGTAA GTGA AAT GCTTTCATCAACATTA TGTAGCCA GGCCTTCC TAATTCGCGTCT AAA GCCATCAA TATGTAAATGCTGATGATAGGAAC TATAACTA GTTA TGG AACCTCCGGCTTAGGT ACCTTTTT GAGAGACT AATCATAGGTCT CAA GAATTTAT TCAATAGT AAGACGCTGAGAAGAG CTTAGATT ATAG GCG

C G T A A C C G T G C A T C T G C C A G T T T G A G G G G A C G A C G A C A G T A T C G G C C T C A G G A A G A T C G C A C T C C A G C C A G C T T T C C G G C A C C G C T T C T G G T G C C G G A A A C C A G G C A A A G C G C C A T T C G C C A T T C A A A C A T C A A G A A A A C A A A A T T A A T T A C A T T T A A C A A T T T C A T T T G A A T T A C C T T T T T T A A T G G A A A C A G T A C A T A A A T C A A T A T A T G T G A G T G A A T A A C C T T G C T T C T G T A A A T C G T C G C T A T T A

CCAGTCACGACG TTC CCAGGGTT GGGTAACG ATTAAGTT GCAAGGCG GATGTGCT GGGG AAA ATTACGCCAGCTGGCG TCTTCGCT TGCGGGCC GCGATCGG AAGG GGG CAACTGTT AAGAAGATGATGAAACAGGCTGCG CTGAGCAA TTAC CAA ATTCATTT GGCGAATT CGCGCAGA TACAAAAT TGAATACCAAGT CTT CCTGATTG CGGATTCG AACAATAA TCGGGAGA CTTTTACA GTAC ACA

G C C T G C A G G T C G A C T C T A G A G G A T C C C C G G G T A C C G A G C T C G A A T T C G T A A T C A T G G T C A T A G C T G T T T C C T G T G T G A A A T T G T T A T C C G C T C A C A A T T C C A C A C A A C A T A C G A G C C G G A A G C A T A G A T G A T G G C A A T T C A T C A A T A T A A T C C T G A T T G T T T G G A T T A T A C T T C T G A A T A A T G G A A G G G T T A G A A C C T A C C A T A T C A A A A T T A T T T G C A C G T A A A A C A G A A A T A A A G A A A T T G C G T A G A T

GCCAACGCGCGG TCG TTAATGAA CAGCTGCA GGGAAACCTGTCGTGC TTCCAGTC CGCT GCC TTGCGTTGCGCTCACT CACATTAA AGCTAACT GCCTAATGAGTG GGT AAGCCTGG CATATTCCTGATTATCAAAGTGTA ATTATCAT CGGA GAG AAGAAACCACCAGAAG GCGGAACA ATCATTTT TTGAGTAACATT AGT ATTTTAAA CGTTATTA AAATCCTTTGCCCGAA CTCGTATT ACAA TCG

G G T T T T T C T T T T C A C C A G T G A G A C G G G C A A C A G C T G A T T G C C C T T C A C C G C C T G G C C C T G A G A G A G T T G C A G C A A G C G G T C C A C G C T G G T T T G C C C C A G C A G G C G A A A A T C C T G T T T G A T G G T G G A C C C T C A A T C A A T A T C T G G T C A G T T G G C A A A T C A A C A G T T G A A A G G A A T T G A G G A A G G T T A T C T A A A A T A T C T T T A G G A G C A C T A A C A A C T A A T A G A T T A G A G C C G T C A A T A G A T A A T A C A T T T G
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Supplementary Figure 3 | Overview of alignment procedure. a, DNA origami nanostructures are selected from the reconstructed 

DNA-PAINT super-resolution image. All selected structures are randomly orientated. A template is generated from the structure design. 

The selected structure is rotated stepwise and cross-correlated to the template. By selecting the angle where the correlation is 
maximised, the correct rotation angle can be obtained. The localisation data is rotated by the determined angle and corresponding shift, 

and the structure is aligned. b, Several aligned structures are stacked on top of each other to create a sum image which can be used 

for detection analysis. 

 
 
 
 

TemplateSelected structure Aligned structureAlignment

a

b

Sum image
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Supplementary Figure 4 | Interface of analysis software. a, Structure selection dialog. The analysis software features an interface 

where a structural template for the rectangular origami can be defined by clicking on hexagons. The software distinguishes between 

evaluation handles which will be evaluated and orientation handles which will be used in the template generation for the cross-
correlation but not in the evaluation b, Main window. The main window features a display of the template, the sum image and detection 

statistics for the loaded dataset. Parameters for cross-correlation and thresholding can be set.  

 
 

 

a

b
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Supplementary Figure 5 | Overview image for Fig. 2. The two channels, red (Atto647N - 3’) and blue (Cy3b - 5’) are shifted to each 

other to allow better identification. Scale bar, 500 nm. 
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Supplementary Figure 6 | Influence of Magnesium in folding buffer on staple detection. DNA origami structures were folded at 

different Magnesium concentrations with a 3h folding ramp (60 to 4 °C). Modified staples had a 100´ excess over Scaffold. Average 

detection (dashed line): 85.2% 

 
 

 

 

 
 
Supplementary Figure 7 | Influence of storage conditions on detection values. DNA origami structures were folded, PEG-purified 
and kept at room temperature and -25 °C for 58 days. 
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Supplementary Figure 8 | ‘Arrow’-shaped DNA origami grid with 10 binding sites used in Fig. 3c Each hexagon represents a 

single staple, colored hexagons indicate a single staple extension at the 3’-end for DNA-PAINT probing. 
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Supplementary Figure 9 | Overview of DNA-PAINT images used for quantification in Fig. 3d. 348 3BS structures are shown. 

Scale bar, 500 nm  
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Supplementary Figure 10 | Overview of DNA-PAINT images used for quantification in Fig. 3d. 662 6BS structures are shown. 

Scale bar: 500 nm 
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Supplementary Figure 11 | Overview of 18 DNA origami structures used for the heatmap in Fig. 4. The origami is divided into two 

sides, containing an orientation marker (arrow pattern) and staple positions to be probed. 
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Supplementary Figure 12 | Overview of DNA-PAINT images used for quantification in Fig. 4, Dataset 1. 1186 structures are 

shown. The measurement contains all 18 origami structures.  Scale bar: 500 nm   
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Supplementary Figure 13 | Overview of DNA-PAINT images used for quantification in Fig. 4, Dataset 2. 750 structures are 

shown. The measurement contains all 18 origami structures. Scale bar, 500 nm. 
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Supplementary Figure 14 | Detection and incorporation heatmap. a, The heatmap shows detection values for each probed position. 

b, The detection values can be translated to incorporation values by adding an offset of 7 % (as determined to be the 3’-error (see 
Figure 2) to generate an incorporation heatmap.  

 
 
 
 

a

b
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Supplementary Figure 15 | CanDo simulation of RMS fluctuations. a, Top view. The CanDo simulations show little thermal 
fluctuations in the center of the rectangular structure. Fluctuations with the highest magnitude can be found at the corners and edges. 

b, Side view. The side view shows the twisting of the DNA origami structure. 

  

a
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b
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Supplementary Figure 16 | Scaffold and staple detection experiments. a, Probing the scaffold loop close to the surface yields a 

90% detection efficiency. b, Probing a scaffold stretch (49 nt, similar to the loop of the flat origami) away from the surface yields a 91% 
detection efficiency. c, Probing a shorter scaffold stretch (21 nt, more ideally accessible) away from the surface yields a 97% detection 

efficiency d, Probing a staple extension away from the surface yields a 94% detection efficiency. 

  

a Probing scaffold loop

5 nm

90% scaffold detected 

10% not detected

SR

20  nm

c Probing scaffold away from surface 

97% scaffold detected 

3% not detected
20 nm

SR

d Probing staple extension away from surface

94% staple detected 

6% not detected

20 nm

SR

21nt

b Probing scaffold loop away from surface

91% scaffold detected 

9% not detected
20 nm

SR
49nt

32nt
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Supplementary Table 1 | Fit of Michaelis-Menten saturation curve 

Name Value Standard Error 

Formula y = Vmax * x / (Km + x)  

Adj. R-Square 0.9805  

Vmax 83.13349 0.39929 

Km 1.47056 0.11358 

 
Supplementary Table 2 | Overview of related studies and their incorporation values. For (1) and (2) we 

estimated the incorporated for a single staple by considering the decay in 6 steps. For (1) this was from 100% 

to 74%, for (2) to 42%. For (3) we estimated the incorporation with the given probability of 98.7% that a particle 

is present being bound to three strands and backcalculation to one strand. 

Reference Structure and attachment Incorporation 

Jungmann et al. 2010 Streptavidin/Biotin 83% 

Derr et al. 2012 Motor Protein 80% 

Tomov et al. 2013 Hairpin Walker 95% (1) 

Voigt et al. 2010 Streptavidin/Biotin 84% 

Liber et al. 2015 Walker 86.50% (2) 

Guer et al. 2016 Gold Nanoparticle Attachment 76.50% (3) 

Jungmann et al. 2016 qPAINT 85% 

Chatterjee et al. 2017 DNA Computing 92.5%/83%  
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Supplementary Table 3 | Super-resolution data properties  

Measurement NeNA 

Fig 2: Atto647N 2.256 nm 

Fig 2: Cy3b 1.616 nm 

Fig 3: Annealing 

10min: 1.573 nm 

1h: 1.508 nm 

3h: 1.664 nm 

12h: 1.534 nm 

3d: 1.768 nm  

Fig 3: Excess  

10x: 2.752 nm 

20x: 2.144 nm 

50x: 2.112 nm 

100x: 2.72 nm  

523x: 2.096 nm  

Fig 3: 3 BS  4.017 nm  

Fig 3: 6 BS 1.365 nm  

Fig 4: Heatmap 1.495 nm / 1.469 nm  
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Supplementary Table 4 | Imaging conditions  

Figure Name Origami Excess Folding 
Buffer 

Folding 
Ramp Purification c(Origami) Buffer Imager c(Img)-

nM Laserpower Power density 
(kW/cm-2) 

Int 
(ms) Frames Camera ROI 

(px) 

1 d Simulations 20nm - - - - 50 
structures 

- - 5   1.5 200 15000 160nm 
Px 

128 

2 5' - 3' 
Experiment 

20nm 100 1x FB 80-4, 
10min 

Gel 17/100 B+/PPT P1* 1   561 nm @ ~1.37 300 15000 EMCCD 256 

2 5' - 3' 
Experiment 20nm 100 1x FB 80-4, 

10min Gel 17/100 B+/PPT P9 1   640 nm @ ~1.97 300 15000 EMCCD 256 

3 Folding Ramps Arrow 

100 1x FB 
80-4, 
10min none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 1x FB 80-4, 1h none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 1x FB 80-4, 3h none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 1x FB 80-4, 
12h 

none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 1x FB 80-4, 3d none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

3 Excess 20nm 

10 1x FB 

60to4,3h 

PEG 3/100 O+ P1 5 70 561 nm @ ~2.9 300 7500 EMCCD 256 

20 1x FB PEG 3/100 O+ P1 5 70 561 nm @ ~2.9 300 7500 EMCCD 256 

50 1x FB PEG 2/100 O+ P1 5 70 561 nm @ ~2.9 300 7500 EMCCD 256 

100 1x FB PEG 2/100 O+ P1 5 70 561 nm @ ~2.9 300 7500 EMCCD 256 

523.3 1x FB PEG 2/100 O+ P1 5 70 561 nm @ ~2.9 300 7500 EMCCD 256 

 3d  Simulations 20nm - - - - 50 
structures 

- - 5   1.5 200 15000 160nm 
Px 

128 

4 Heatmap 

1_1_1 100 1x FB 

60to4,3h 

none 

18x 
0.2/100 

O+/PPT P1 2 100 561 nm @ ~4.2 ### ## CMOS ### 

1_1_2 100 1x FB none 

1_1_3 100 1x FB none 

1_2_1 100 1x FB none 

1_2_2 100 1x FB none 

1_2_3 100 1x FB none 

1_3_1 100 1x FB none 

1_3_2 100 1x FB none 

1_3_3 100 1x FB none 

2_1_1 100 1x FB none 

2_1_2 100 1x FB none 

2_1_3 100 1x FB none 

2_2_1 100 1x FB none 

2_2_2 100 1x FB none 

2_2_3 100 1x FB none 

2_3_1 100 1x FB none 

2_3_2 100 1x FB none 

2_3_3 100 1x FB none 

SI Magnesium Arrow 

100 
1x FB (8mM 
MgCl2) 

60to4,3h 

none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 
1x FB (10mM 
MgCl2) 

none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 
1x FB (12mM 
MgCl2) 

none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 1x FB (14mM 
MgCl2) 

none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

100 1x FB (16mM 
MgCl2) 

none 2/100 O+/PPT P1 5 100 561 nm ~4.2 200 15000 sCMOS 512 

SI 16 

Scaffold Loop 
(a) 20nm 100 1x FB 80-4, 

10min Gel 17/100 B+/PPT P9 1   640 nm @ ~1.97 300 15000 EMCCD 256 

Force Clamp 
(b,c,d) 

Force 
Clamp 100 1x FB 

Refer to 
Paper Gel 500pM B+/PPT P1 5 70 561 nm @ ~2.9 200 15000 sCMOS 512 

 

Supplementary Table 5 | Used DNA-PAINT sequences 

Shortname Docking sequence Imager sequence Experiment 

P1  TT ATACATCTA CTAGATGTAT-Cy3b Fig 3/4 

P1* TT ATACATCTA Cy3b-CATCCTAATT  Fig 2 

P9 TT AATTAGGAT CATCCTAATT-Atto647N Fig 2 

 
Supplementary Table 6 | List of core staples 

Position Name Sequence 

A1 21[32]23[31]BLK TTTTCACTCAAAGGGCGAAAAACCATCACC 

B1 23[32]22[48]BLK CAAATCAAGTTTTTTGGGGTCGAAACGTGGA 

C1 21[56]23[63]BLK AGCTGATTGCCCTTCAGAGTCCACTATTAAAGGGTGCCGT 

D1 23[64]22[80]BLK AAAGCACTAAATCGGAACCCTAATCCAGTT 

E1 21[96]23[95]BLK AGCAAGCGTAGGGTTGAGTGTTGTAGGGAGCC 
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F1 23[96]22[112]BLK CCCGATTTAGAGCTTGACGGGGAAAAAGAATA 

G1 21[120]23[127]BLK CCCAGCAGGCGAAAAATCCCTTATAAATCAAGCCGGCG 

H1 21[160]22[144]BLK TCAATATCGAACCTCAAATATCAATTCCGAAA 

I1 23[128]23[159]BLK AACGTGGCGAGAAAGGAAGGGAAACCAGTAA 

J1 23[160]22[176]BLK TAAAAGGGACATTCTGGCCAACAAAGCATC 

K1 21[184]23[191]BLK TCAACAGTTGAAAGGAGCAAATGAAAAATCTAGAGATAGA 

L1 23[192]22[208]BLK ACCCTTCTGACCTGAAAGCGTAAGACGCTGAG 

M1 21[224]23[223]BLK CTTTAGGGCCTGCAACAGTGCCAATACGTG 

N1 23[224]22[240]BLK GCACAGACAATATTTTTGAATGGGGTCAGTA 

O1 21[248]23[255]BLK AGATTAGAGCCGTCAAAAAACAGAGGTGAGGCCTATTAGT 

P1 23[256]22[272]BLK CTTTAATGCGCGAACTGATAGCCCCACCAG 

A2 19[32]21[31]BLK GTCGACTTCGGCCAACGCGCGGGGTTTTTC 

B2 22[47]20[48]BLK CTCCAACGCAGTGAGACGGGCAACCAGCTGCA 

D2 22[79]20[80]BLK TGGAACAACCGCCTGGCCCTGAGGCCCGCT 

E2 19[96]21[95]BLK CTGTGTGATTGCGTTGCGCTCACTAGAGTTGC 

F2 22[111]20[112]BLK GCCCGAGAGTCCACGCTGGTTTGCAGCTAACT 

H2 19[160]20[144]BLK GCAATTCACATATTCCTGATTATCAAAGTGTA 

I2 22[143]21[159]BLK TCGGCAAATCCTGTTTGATGGTGGACCCTCAA 

J2 22[175]20[176]BLK ACCTTGCTTGGTCAGTTGGCAAAGAGCGGA 

L2 22[207]20[208]BLK AGCCAGCAATTGAGGAAGGTTATCATCATTTT 

M2 19[224]21[223]BLK CTACCATAGTTTGAGTAACATTTAAAATAT 

N2 22[239]20[240]BLK TTAACACCAGCACTAACAACTAATCGTTATTA 

P2 22[271]20[272]BLK CAGAAGATTAGATAATACATTTGTCGACAA 

A3 17[32]19[31]BLK TGCATCTTTCCCAGTCACGACGGCCTGCAG 

B3 20[47]18[48]BLK TTAATGAACTAGAGGATCCCCGGGGGGTAACG 

D3 20[79]18[80]BLK TTCCAGTCGTAATCATGGTCATAAAAGGGG 

E3 17[96]19[95]BLK GCTTTCCGATTACGCCAGCTGGCGGCTGTTTC 

F3 20[111]18[112]BLK CACATTAAAATTGTTATCCGCTCATGCGGGCC 

H3 17[160]18[144]BLK AGAAAACAAAGAAGATGATGAAACAGGCTGCG 

I3 20[143]19[159]BLK AAGCCTGGTACGAGCCGGAAGCATAGATGATG 

J3 20[175]18[176]BLK ATTATCATTCAATATAATCCTGACAATTAC 

L3 20[207]18[208]BLK GCGGAACATCTGAATAATGGAAGGTACAAAAT 

M3 17[224]19[223]BLK CATAAATCTTTGAATACCAAGTGTTAGAAC 

N3 20[239]18[240]BLK ATTTTAAAATCAAAATTATTTGCACGGATTCG 

P3 20[271]18[272]BLK CTCGTATTAGAAATTGCGTAGATACAGTAC 

A4 15[32]17[31]BLK TAATCAGCGGATTGACCGTAATCGTAACCG 

B4 18[47]16[48]BLK CCAGGGTTGCCAGTTTGAGGGGACCCGTGGGA 

C4 15[64]18[64]BLK GTATAAGCCAACCCGTCGGATTCTGACGACAGTATCGGCCGCAAGGCG 
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D4 18[79]16[80]BLK GATGTGCTTCAGGAAGATCGCACAATGTGA 

E4 15[96]17[95]BLK ATATTTTGGCTTTCATCAACATTATCCAGCCA 

F4 18[111]16[112]BLK TCTTCGCTGCACCGCTTCTGGTGCGGCCTTCC 

G4 15[128]18[128]BLK TAAATCAAAATAATTCGCGTCTCGGAAACCAGGCAAAGGGAAGG 

H4 15[160]16[144]BLK ATCGCAAGTATGTAAATGCTGATGATAGGAAC 

I4 18[143]17[159]BLK CAACTGTTGCGCCATTCGCCATTCAAACATCA 

J4 18[175]16[176]BLK CTGAGCAAAAATTAATTACATTTTGGGTTA 

K4 15[192]18[192]BLK TCAAATATAACCTCCGGCTTAGGTAACAATTTCATTTGAAGGCGAATT 

L4 18[207]16[208]BLK CGCGCAGATTACCTTTTTTAATGGGAGAGACT 

M4 15[224]17[223]BLK CCTAAATCAAAATCATAGGTCTAAACAGTA 

N4 18[239]16[240]BLK CCTGATTGCAATATATGTGAGTGATCAATAGT 

O4 15[256]18[256]BLK GTGATAAAAAGACGCTGAGAAGAGATAACCTTGCTTCTGTTCGGGAGA 

P4 18[271]16[272]BLK CTTTTACAAAATCGTCGCTATTAGCGATAG 

A5 13[32]15[31]BLK AACGCAAAATCGATGAACGGTACCGGTTGA 

B5 16[47]14[48]BLK ACAAACGGAAAAGCCCCAAAAACACTGGAGCA 

C5 13[64]15[63]BLK TATATTTTGTCATTGCCTGAGAGTGGAAGATT 

D5 16[79]14[80]BLK GCGAGTAAAAATATTTAAATTGTTACAAAG 

E5 13[96]15[95]BLK TAGGTAAACTATTTTTGAGAGATCAAACGTTA 

F5 16[111]14[112]BLK TGTAGCCATTAAAATTCGCATTAAATGCCGGA 

G5 13[128]15[127]BLK GAGACAGCTAGCTGATAAATTAATTTTTGT 

H5 13[160]14[144]BLK GTAATAAGTTAGGCAGAGGCATTTATGATATT 

I5 16[143]15[159]BLK GCCATCAAGCTCATTTTTTAACCACAAATCCA 

J5 16[175]14[176]BLK TATAACTAACAAAGAACGCGAGAACGCCAA 

K5 13[192]15[191]BLK GTAAAGTAATCGCCATATTTAACAAAACTTTT 

L5 16[207]14[208]BLK ACCTTTTTATTTTAGTTAATTTCATAGGGCTT 

M5 13[224]15[223]BLK ACAACATGCCAACGCTCAACAGTCTTCTGA 

N5 16[239]14[240]BLK GAATTTATTTAATGGTTTGAAATATTCTTACC 

O5 13[256]15[255]BLK GTTTATCAATATGCGTTATACAAACCGACCGT 

P5 16[271]14[272]BLK CTTAGATTTAAGGCGTTAAATAAAGCCTGT 

A6 11[32]13[31]BLK AACAGTTTTGTACCAAAAACATTTTATTTC 

B6 14[47]12[48]BLK AACAAGAGGGATAAAAATTTTTAGCATAAAGC 

C6 11[64]13[63]BLK GATTTAGTCAATAAAGCCTCAGAGAACCCTCA 

D6 14[79]12[80]BLK GCTATCAGAAATGCAATGCCTGAATTAGCA 

E6 11[96]13[95]BLK AATGGTCAACAGGCAAGGCAAAGAGTAATGTG 

F6 14[111]12[112]BLK GAGGGTAGGATTCAAAAGGGTGAGACATCCAA 

G6 11[128]13[127]BLK TTTGGGGATAGTAGTAGCATTAAAAGGCCG 

H6 11[160]12[144]BLK CCAATAGCTCATCGTAGGAATCATGGCATCAA 

I6 14[143]13[159]BLK CAACCGTTTCAAATCACCATCAATTCGAGCCA 
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J6 14[175]12[176]BLK CATGTAATAGAATATAAAGTACCAAGCCGT 

K6 11[192]13[191]BLK TATCCGGTCTCATCGAGAACAAGCGACAAAAG 

L6 14[207]12[208]BLK AATTGAGAATTCTGTCCAGACGACTAAACCAA 

M6 11[224]13[223]BLK GCGAACCTCCAAGAACGGGTATGACAATAA 

N6 14[239]12[240]BLK AGTATAAAGTTCAGCTAATGCAGATGTCTTTC 

O6 11[256]13[255]BLK GCCTTAAACCAATCAATAATCGGCACGCGCCT 

P6 14[271]12[272]BLK TTAGTATCACAATAGATAAGTCCACGAGCA 

A7 9[32]11[31]BLK TTTACCCCAACATGTTTTAAATTTCCATAT 

B7 12[47]10[48]BLK TAAATCGGGATTCCCAATTCTGCGATATAATG 

C7 9[64]11[63]BLK CGGATTGCAGAGCTTAATTGCTGAAACGAGTA 

D7 12[79]10[80]BLK AAATTAAGTTGACCATTAGATACTTTTGCG 

E7 9[96]11[95]BLK CGAAAGACTTTGATAAGAGGTCATATTTCGCA 

F7 12[111]10[112]BLK TAAATCATATAACCTGTTTAGCTAACCTTTAA 

G7 9[128]11[127]BLK GCTTCAATCAGGATTAGAGAGTTATTTTCA 

H7 9[160]10[144]BLK AGAGAGAAAAAAATGAAAATAGCAAGCAAACT 

I7 12[143]11[159]BLK TTCTACTACGCGAGCTGAAAAGGTTACCGCGC 

J7 12[175]10[176]BLK TTTTATTTAAGCAAATCAGATATTTTTTGT 

K7 9[192]11[191]BLK TTAGACGGCCAAATAAGAAACGATAGAAGGCT 

L7 12[207]10[208]BLK GTACCGCAATTCTAAGAACGCGAGTATTATTT 

M7 9[224]11[223]BLK AAAGTCACAAAATAAACAGCCAGCGTTTTA 

N7 12[239]10[240]BLK CTTATCATTCCCGACTTGCGGGAGCCTAATTT 

O7 9[256]11[255]BLK GAGAGATAGAGCGTCTTTCCAGAGGTTTTGAA 

P7 12[271]10[272]BLK TGTAGAAATCAAGATTAGTTGCTCTTACCA 

A8 7[32]9[31]BLK TTTAGGACAAATGCTTTAAACAATCAGGTC 

B8 10[47]8[48]BLK CTGTAGCTTGACTATTATAGTCAGTTCATTGA 

C8 7[56]9[63]BLK ATGCAGATACATAACGGGAATCGTCATAAATAAAGCAAAG 

D8 10[79]8[80]BLK GATGGCTTATCAAAAAGATTAAGAGCGTCC 

E8 7[96]9[95]BLK TAAGAGCAAATGTTTAGACTGGATAGGAAGCC 

F8 10[111]8[112]BLK TTGCTCCTTTCAAATATCGCGTTTGAGGGGGT 

G8 7[120]9[127]BLK CGTTTACCAGACGACAAAGAAGTTTTGCCATAATTCGA 

H8 7[160]8[144]BLK TTATTACGAAGAACTGGCATGATTGCGAGAGG 

I8 10[143]9[159]BLK CCAACAGGAGCGAACCAGACCGGAGCCTTTAC 

J8 10[175]8[176]BLK TTAACGTCTAACATAAAAACAGGTAACGGA 

K8 7[184]9[191]BLK CGTAGAAAATACATACCGAGGAAACGCAATAAGAAGCGCA 

L8 10[207]8[208]BLK ATCCCAATGAGAATTAACTGAACAGTTACCAG 

M8 7[224]9[223]BLK AACGCAAAGATAGCCGAACAAACCCTGAAC 

N8 10[239]8[240]BLK GCCAGTTAGAGGGTAATTGAGCGCTTTAAGAA 

O8 7[248]9[255]BLK GTTTATTTTGTCACAATCTTACCGAAGCCCTTTAATATCA 
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P8 10[271]8[272]BLK ACGCTAACACCCACAAGAATTGAAAATAGC 

A9 5[32]7[31]BLK CATCAAGTAAAACGAACTAACGAGTTGAGA 

B9 8[47]6[48]BLK ATCCCCCTATACCACATTCAACTAGAAAAATC 

D9 8[79]6[80]BLK AATACTGCCCAAAAGGAATTACGTGGCTCA 

E9 5[96]7[95]BLK TCATTCAGATGCGATTTTAAGAACAGGCATAG 

F9 8[111]6[112]BLK AATAGTAAACACTATCATAACCCTCATTGTGA 

H9 5[160]6[144]BLK GCAAGGCCTCACCAGTAGCACCATGGGCTTGA 

I9 8[143]7[159]BLK CTTTTGCAGATAAAAACCAAAATAAAGACTCC 

J9 8[175]6[176]BLK ATACCCAACAGTATGTTAGCAAATTAGAGC 

L9 8[207]6[208]BLK AAGGAAACATAAAGGTGGCAACATTATCACCG 

M9 5[224]7[223]BLK TCAAGTTTCATTAAAGGTGAATATAAAAGA 

N9 8[239]6[240]BLK AAGTAAGCAGACACCACGGAATAATATTGACG 

P9 8[271]6[272]BLK AATAGCTATCAATAGAAAATTCAACATTCA 

A10 3[32]5[31]BLK AATACGTTTGAAAGAGGACAGACTGACCTT 

B10 6[47]4[48]BLK TACGTTAAAGTAATCTTGACAAGAACCGAACT 

D10 6[79]4[80]BLK TTATACCACCAAATCAACGTAACGAACGAG 

E10 3[96]5[95]BLK ACACTCATCCATGTTACTTAGCCGAAAGCTGC 

F10 6[111]4[112]BLK ATTACCTTTGAATAAGGCTTGCCCAAATCCGC 

H10 3[160]4[144]BLK TTGACAGGCCACCACCAGAGCCGCGATTTGTA 

I10 6[143]5[159]BLK GATGGTTTGAACGAGTAGTAAATTTACCATTA 

J10 6[175]4[176]BLK CAGCAAAAGGAAACGTCACCAATGAGCCGC 

L10 6[207]4[208]BLK TCACCGACGCACCGTAATCAGTAGCAGAACCG 

M10 3[224]5[223]BLK TTAAAGCCAGAGCCGCCACCCTCGACAGAA 

N10 6[239]4[240]BLK GAAATTATTGCCTTTAGCGTCAGACCGGAACC 

P10 6[271]4[272]BLK ACCGATTGTCGGCATTTTCGGTCATAATCA 

A11 1[32]3[31]BLK AGGCTCCAGAGGCTTTGAGGACACGGGTAA 

B11 4[47]2[48]BLK GACCAACTAATGCCACTACGAAGGGGGTAGCA 

C11 1[64]4[64]BLK TTTATCAGGACAGCATCGGAACGACACCAACCTAAAACGAGGTCAATC 

D11 4[79]2[80]BLK GCGCAGACAAGAGGCAAAAGAATCCCTCAG 

E11 1[96]3[95]BLK AAACAGCTTTTTGCGGGATCGTCAACACTAAA 

F11 4[111]2[112]BLK GACCTGCTCTTTGACCCCCAGCGAGGGAGTTA 

G11 1[128]4[128]BLK TGACAACTCGCTGAGGCTTGCATTATACCAAGCGCGATGATAAA 

H11 1[160]2[144]BLK TTAGGATTGGCTGAGACTCCTCAATAACCGAT 

I11 4[143]3[159]BLK TCATCGCCAACAAAGTACAACGGACGCCAGCA 

J11 4[175]2[176]BLK CACCAGAAAGGTTGAGGCAGGTCATGAAAG 

K11 1[192]4[192]BLK GCGGATAACCTATTATTCTGAAACAGACGATTGGCCTTGAAGAGCCAC 

L11 4[207]2[208]BLK CCACCCTCTATTCACAAACAAATACCTGCCTA 

M11 1[224]3[223]BLK GTATAGCAAACAGTTAATGCCCAATCCTCA 
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N11 4[239]2[240]BLK GCCTCCCTCAGAATGGAAAGCGCAGTAACAGT 

O11 1[256]4[256]BLK CAGGAGGTGGGGTCAGTGCCTTGAGTCTCTGAATTTACCGGGAACCAG 

P11 4[271]2[272]BLK AAATCACCTTCCAGTAAGCGTCAGTAATAA 

A12 0[47]1[31]BLK AGAAAGGAACAACTAAAGGAATTCAAAAAAA 

B12 2[47]0[48]BLK ACGGCTACAAAAGGAGCCTTTAATGTGAGAAT 

C12 0[79]1[63]BLK ACAACTTTCAACAGTTTCAGCGGATGTATCGG 

D12 2[79]0[80]BLK CAGCGAAACTTGCTTTCGAGGTGTTGCTAA 

E12 0[111]1[95]BLK TAAATGAATTTTCTGTATGGGATTAATTTCTT 

F12 2[111]0[112]BLK AAGGCCGCTGATACCGATAGTTGCGACGTTAG 

G12 0[143]1[127]BLK TCTAAAGTTTTGTCGTCTTTCCAGCCGACAA 

H12 0[175]0[144]BLK TCCACAGACAGCCCTCATAGTTAGCGTAACGA 

I12 2[143]1[159]BLK ATATTCGGAACCATCGCCCACGCAGAGAAGGA 

J12 2[175]0[176]BLK TATTAAGAAGCGGGGTTTTGCTCGTAGCAT 

K12 0[207]1[191]BLK TCACCAGTACAAACTACAACGCCTAGTACCAG 

L12 2[207]0[208]BLK TTTCGGAAGTGCCGTCGAGAGGGTGAGTTTCG 

M12 0[239]1[223]BLK AGGAACCCATGTACCGTAACACTTGATATAA 

N12 2[239]0[240]BLK GCCCGTATCCGGAATAGGTGTATCAGCCCAAT 

O12 0[271]1[255]BLK CCACCCTCATTTTCAGGGATAGCAACCGTACT 

P12 2[271]0[272]BLK GTTTTAACTTAGTACCGCCACCCAGAGCCA 

 

 

 

 

Supplementary Table 7 | List of biotinylated staples 

No Pos Name Sequence Mod 

1 C02 18[63]20[56]BIOTIN ATTAAGTTTACCGAGCTCGAATTCGGGAAACCTGTCGTGC 5'-BT 

2 C09 4[63]6[56]BIOTIN ATAAGGGAACCGGATATTCATTACGTCAGGACGTTGGGAA 5'-BT 

3 G02 18[127]20[120]BIOTIN GCGATCGGCAATTCCACACAACAGGTGCCTAATGAGTG 5'-BT 

4 G09 4[127]6[120]BIOTIN TTGTGTCGTGACGAGAAACACCAAATTTCAACTTTAAT 5'-BT 

5 K02 18[191]20[184]BIOTIN ATTCATTTTTGTTTGGATTATACTAAGAAACCACCAGAAG 5'-BT 

6 K09 4[191]6[184]BIOTIN CACCCTCAGAAACCATCGATAGCATTGAGCCATTTGGGAA 5'-BT 

7 O02 18[255]20[248]BIOTIN AACAATAACGTAAAACAGAAATAAAAATCCTTTGCCCGAA 5'-BT 

8 O09 4[255]6[248]BIOTIN AGCCACCACTGTAGCGCGTTTTCAAGGGAGGGAAGGTAAA 5'-BT 
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Supplementary Figure 1 

Overview of “Picasso: Design” 

(a) The main window showing the origami canvas with the hexagonal tiles. (b) Extensions dialog to set extensions corresponding to 
each selected color. (c) Plate export dialog to specify the export format of the plates. (d) Pipetting dialog to select a folder with *.csv 
files to generate a list of sequences that need to be pipetted and to create a visual pipetting aid. (e) Folding table to calculate volumes 

that are needed for pipetting. 
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Supplementary Figure 2 

Overview of “Picasso: Simulate” 

The main window has two preview windows, the left one to display the positions of structures in the full frame, the right one to display 
an individual structure. Structural parameters such as number and structure definition can be set in the group box “Structure”. All 
PAINT-related parameters, i.e. mean dark and bright times are set with the “PAINT parameters” group box. The group box “Imager 

parameters” is used to define properties of the simulated imaging probe. 
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Supplementary Figure 3 

Overview of “Picasso: Localize” 

(a) The main window after the analysis of a movie file. Yellow boxes indicate the identification of a spot, green crosses show the fitted 
subpixel coordinate. (b) The contrast setting dialog. (c) The parameters setting dialog. 

Nature Protocols: doi:10.1038/nprot.2017.024

170 appendix



 
 

 

Supplementary Figure 4 

Overview of “Picasso: Render” 

(a) The main window with two picked regions of interest (yellow circles). (b) The display settings dialog for the render scene in (a). (c) 
The info dialog for the picked regions in (a). (d) The tools settings dialog. 
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Supplementary Figure 5 

Overview of “Picasso: Filter” 

(a) The main window showing properties (columns) of localizations (rows). (b) Filtering in a histogram of a property column. (c) Filtering 
in a two-dimensional histogram of two property columns. The green areas in (b) and (c) have been selected with a pressed left mouse 

button. After releasing the mouse button, any localization with property values outside the green range will be removed. 
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Supplementary Figure 6 

20 nm DNA origami grid 
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Supplementary Figure 7 

10 nm DNA origami grid 
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Supplementary Figure 8 

LMU Logo 
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Supplementary Figure 9 

MPI Logo 
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Supplementary Figure 10 

Custom-made flow chamber 

(a) Two stripes of double-sided sticky tape are placed on a 76x26 mm microscopy slide with a distance of ~ 8mm. A coverglass is 
placed on top of the sticky tape stripes. After pressing the coverglass thoroughly against the sticky tape, overlapping tape can be 
removed. (b) To immobilize DNA nanostructures, fluids are pipetted from one side while simultaneously being sucked out with a lab 
wiper from the other side. (c) The coverglass is sealed with epoxy glue and can be used with the coverglass facing towards the 
objective in a microscope stage once the glue is hardened. 
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Supplementary Manual 
This manual describes details about the Picasso program. 

File Format and Name Conventions 

Movie Files 

Picasso accepts two type of raw movie files: TIFF (preferably from μManager, https://www.micro-manager.org) 

and raw binary data (file extension “.raw”). 

When loading raw binary files, the user will be prompted for movie metadata such as the number of frames, 

number of pixels, etc. Alternatively, this metadata can be supplied by an accompanying metadata file with the 

same filename as the raw binary file, but with the extension “.yaml”. See “YAML Metadata Files” for more 

details. 

HDF5 Files 

HDF5 is a generic and efficient binary file format for storing data (https://support.hdfgroup.org/HDF5/). In 

Picasso, HDF5 files are used for storing tabular data of localization properties with the file extension “.hdf5”. 

Furthermore, Picasso saves statistical properties of groups of localizations in an HDF5 file. 

Generally, several datasets can be stored within an HDF5 file. These datasets are accessible by specifying a 

path within the HDF5 file, similar to a path of an operating system. When saving localizations, Picasso stores 

tabular data under the path “/locs”. When saving statistical properties of groups of localizations, Picasso saves 

the table under the path “/groups”. 

Importing HDF5 files in MATLAB and Origin 

In MATLAB, execute the command “locs = h5read(filename, dataset)”. Replace dataset with ‘/locs’ for 

localization files and with ‘/groups’ for pick property files. 

In Origin, select “File > Import > HDF5” or drag and drop the file into the main window. 

Localization HDF5 Files 

Localization HDF5 files must always be accompanied by a YAML metadata file with the same filename, but 

with the extension ‘.yaml’. See “YAML Metadata File” for more details. The localization table is stored as a 

dataset of the HDF5 file in the path “/locs”. This table can be visualized by opening the HDF5 file with “Picasso: 

Filter”. The localization table can have an unlimited number of columns. Table 1 describes the meaning of 

Picasso’s main column names. 
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Column Name Description C Data Type 

frame The frame in which the localization occurred, starting with zero for the 
first frame. 

unsigned long 

x The subpixel x coordinate in camera pixels float 

y The subpixel y coordinate in camera pixels float 

photons The total number of detected photons from this event, not including 
background or camera offset 

float 

sx The Point Spread Function width in camera pixels float 

sy The Point Spread Function height in camera pixels float 

bg The number of background photons per pixel, not including the camera 
offset 

float 

lpx The localization precision in x direction, in camera pixels, as estimated 
by the Cramer-Rao Lower Bound of the Maximum Likelihood fit. 

float 

lpy The localization precision in y direction, in camera pixels, as estimated 
by the Cramer-Rao Lower Bound of the Maximum Likelihood fit. 

float 

net_gradient The net gradient of this spot which is defined by the sum of gradient 
vector magnitudes within the fix box, projected to the spot center. 

float 

likelihood The log-likelihood of the fit float 

iterations The number of iterations of the fit procedure long 

group (Optional) An identifier to assign multiple localizations to groups, for 
example by picking regions of interest 

long 

len (Optional) The length of the event, if localizations from consecutive 
frames have been linked 

long 

n (Optional) The number of localizations in this event, if localizations from 
consecutive frames have been linked, potentially diverging from the “len” 
column due to a transient dark time tolerance 

long 

photon_rate (Optional) The mean number of photons per frame, if localizations from 
consecutive frames have been linked. The total number of photons is set 
in the “photons” column. 

float 

Table 1 | Name, description and data type for the main columns used in Picasso. 

HDF5 Pick Property Files 

When selecting “File > Save pick properties” in “Picasso: Render”, the properties of picked regions are stored 

in an HDF5 file. Within the HDF5 file, the data table is stored in the path “/groups”. 

Each row in the “groups” table corresponds to one picked region. For each localization property (see Table 1), 

two columns are generated in the “groups” table: the mean and standard deviation of the respective column 
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over the localizations in a pick region. For example, if the localization table contains a column “len”, the 

“groups” table will contain a column “len_mean” and “len_std”. 

Furthermore, the following columns are included: “group” (the group identifier), “n_events” (the number of 

localizations in the region) and “n_units” (the number of units from a qPAINT measurement). 

YAML Metadata Files 

YAML files are document-oriented text files that can be opened and changed with any text editor 

(http://www.yaml.org). In Picasso, YAML files are used to store metadata of movie or localization files. 

Each localization HDF5 file must always be accompanied with a YAML file of the same filename, except for the 

extension, which is “.yaml”. Deleting this YAML metadata file will result in failure of the Picasso software! 

Raw binary files may be accompanied by a YAML metadata file to store data about the movie dimensions, etc. 

While the metadata file in this case is not required, it reduces the effort of typing in this metadata each time the 

movie is loaded with “Picasso: Localize”. To generate such a YAML metadata file, load the raw movie into 

“Picasso: Localize”, then enter all required information in the appearing dialog. Check the checkbox “Save info 

to yaml file” and click ok. The movie will be loaded and the metadata saved in a YAML file. This file will be 

detected the next time this raw movie is loaded and the metadata does not need to be entered again. 

 

Supplementary Table 1: Laser power conversion table 

Set Power (mW) Power at sample (mW) Power density at sample (kW/cm2) 

20 13.7 0.82 

30 20.8 1.24 

40 28 1.67 

50 34.8 2.07 

60 42.2 2.52 

70 48.5 2.89 

 

Power was set at the driver unit of the Coherent Sapphire Laser, 200 mW nominal power, 561 nm. Laser 

power was measured with a digital power meter (THORLABS, PM100D) by placing a microscopy slide thermal 

power sensor (THORLABS, S170C) with immersion oil in the sample holder. The power density was calculated 

as an average of the the gaussian illumination with an area of 256 px2 with pixel size of 160 nm. 
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Supplementary Table 2: DNA-PAINT sequences 
Shortname Docking sequence Imager sequence 
P1 TTATACATCTA CTAGATGTAT-Dye 
P2 TTATCTACATA TATGTAGATC-Dye 
P3 TTTCTTCATTA GTAATGAAGA-Dye 
P4 TTATGAATCTA GTAGATTCAT-Dye 
P5 TTTCAATGTAT CATACATTGA-Dye 
P6 TTTTAGGTAAA CTTTACCTAA-Dye 
P7 TTAATTGAGTA GTACTCAATT-Dye 
P8 TTATGTTAATG CCATTAACAT-Dye 
P9 TTAATTAGGAT CATCCTAATT-Dye 
P10 TTATAATGGAT GATCCATTAT-Dye 

 

Supplementary Table 3: List of core staples 

Position Name Sequence 

A1 21[32]23[31]BLK TTTTCACTCAAAGGGCGAAAAACCATCACC 

B1 23[32]22[48]BLK CAAATCAAGTTTTTTGGGGTCGAAACGTGGA 

C1 21[56]23[63]BLK AGCTGATTGCCCTTCAGAGTCCACTATTAAAGGGTGCCGT 

D1 23[64]22[80]BLK AAAGCACTAAATCGGAACCCTAATCCAGTT 

E1 21[96]23[95]BLK AGCAAGCGTAGGGTTGAGTGTTGTAGGGAGCC 

F1 23[96]22[112]BLK CCCGATTTAGAGCTTGACGGGGAAAAAGAATA 

G1 21[120]23[127]BLK CCCAGCAGGCGAAAAATCCCTTATAAATCAAGCCGGCG 

H1 21[160]22[144]BLK TCAATATCGAACCTCAAATATCAATTCCGAAA 

I1 23[128]23[159]BLK AACGTGGCGAGAAAGGAAGGGAAACCAGTAA 

J1 23[160]22[176]BLK TAAAAGGGACATTCTGGCCAACAAAGCATC 

K1 21[184]23[191]BLK TCAACAGTTGAAAGGAGCAAATGAAAAATCTAGAGATAGA 

L1 23[192]22[208]BLK ACCCTTCTGACCTGAAAGCGTAAGACGCTGAG 

M1 21[224]23[223]BLK CTTTAGGGCCTGCAACAGTGCCAATACGTG 

N1 23[224]22[240]BLK GCACAGACAATATTTTTGAATGGGGTCAGTA 

O1 21[248]23[255]BLK AGATTAGAGCCGTCAAAAAACAGAGGTGAGGCCTATTAGT 

P1 23[256]22[272]BLK CTTTAATGCGCGAACTGATAGCCCCACCAG 

A2 19[32]21[31]BLK GTCGACTTCGGCCAACGCGCGGGGTTTTTC 

B2 22[47]20[48]BLK CTCCAACGCAGTGAGACGGGCAACCAGCTGCA 
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D2 22[79]20[80]BLK TGGAACAACCGCCTGGCCCTGAGGCCCGCT 

E2 19[96]21[95]BLK CTGTGTGATTGCGTTGCGCTCACTAGAGTTGC 

F2 22[111]20[112]BLK GCCCGAGAGTCCACGCTGGTTTGCAGCTAACT 

H2 19[160]20[144]BLK GCAATTCACATATTCCTGATTATCAAAGTGTA 

I2 22[143]21[159]BLK TCGGCAAATCCTGTTTGATGGTGGACCCTCAA 

J2 22[175]20[176]BLK ACCTTGCTTGGTCAGTTGGCAAAGAGCGGA 

L2 22[207]20[208]BLK AGCCAGCAATTGAGGAAGGTTATCATCATTTT 

M2 19[224]21[223]BLK CTACCATAGTTTGAGTAACATTTAAAATAT 

N2 22[239]20[240]BLK TTAACACCAGCACTAACAACTAATCGTTATTA 

P2 22[271]20[272]BLK CAGAAGATTAGATAATACATTTGTCGACAA 

A3 17[32]19[31]BLK TGCATCTTTCCCAGTCACGACGGCCTGCAG 

B3 20[47]18[48]BLK TTAATGAACTAGAGGATCCCCGGGGGGTAACG 

D3 20[79]18[80]BLK TTCCAGTCGTAATCATGGTCATAAAAGGGG 

E3 17[96]19[95]BLK GCTTTCCGATTACGCCAGCTGGCGGCTGTTTC 

F3 20[111]18[112]BLK CACATTAAAATTGTTATCCGCTCATGCGGGCC 

H3 17[160]18[144]BLK AGAAAACAAAGAAGATGATGAAACAGGCTGCG 

I3 20[143]19[159]BLK AAGCCTGGTACGAGCCGGAAGCATAGATGATG 

J3 20[175]18[176]BLK ATTATCATTCAATATAATCCTGACAATTAC 

L3 20[207]18[208]BLK GCGGAACATCTGAATAATGGAAGGTACAAAAT 

M3 17[224]19[223]BLK CATAAATCTTTGAATACCAAGTGTTAGAAC 

N3 20[239]18[240]BLK ATTTTAAAATCAAAATTATTTGCACGGATTCG 

P3 20[271]18[272]BLK CTCGTATTAGAAATTGCGTAGATACAGTAC 

A4 15[32]17[31]BLK TAATCAGCGGATTGACCGTAATCGTAACCG 

B4 18[47]16[48]BLK CCAGGGTTGCCAGTTTGAGGGGACCCGTGGGA 

C4 15[64]18[64]BLK GTATAAGCCAACCCGTCGGATTCTGACGACAGTATCGGCCGCAAGGCG 

D4 18[79]16[80]BLK GATGTGCTTCAGGAAGATCGCACAATGTGA 

E4 15[96]17[95]BLK ATATTTTGGCTTTCATCAACATTATCCAGCCA 

F4 18[111]16[112]BLK TCTTCGCTGCACCGCTTCTGGTGCGGCCTTCC 

G4 15[128]18[128]BLK TAAATCAAAATAATTCGCGTCTCGGAAACCAGGCAAAGGGAAGG 

H4 15[160]16[144]BLK ATCGCAAGTATGTAAATGCTGATGATAGGAAC 

I4 18[143]17[159]BLK CAACTGTTGCGCCATTCGCCATTCAAACATCA 

J4 18[175]16[176]BLK CTGAGCAAAAATTAATTACATTTTGGGTTA 

K4 15[192]18[192]BLK TCAAATATAACCTCCGGCTTAGGTAACAATTTCATTTGAAGGCGAATT 
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L4 18[207]16[208]BLK CGCGCAGATTACCTTTTTTAATGGGAGAGACT 

M4 15[224]17[223]BLK CCTAAATCAAAATCATAGGTCTAAACAGTA 

N4 18[239]16[240]BLK CCTGATTGCAATATATGTGAGTGATCAATAGT 

O4 15[256]18[256]BLK GTGATAAAAAGACGCTGAGAAGAGATAACCTTGCTTCTGTTCGGGAGA 

P4 18[271]16[272]BLK CTTTTACAAAATCGTCGCTATTAGCGATAG 

A5 13[32]15[31]BLK AACGCAAAATCGATGAACGGTACCGGTTGA 

B5 16[47]14[48]BLK ACAAACGGAAAAGCCCCAAAAACACTGGAGCA 

C5 13[64]15[63]BLK TATATTTTGTCATTGCCTGAGAGTGGAAGATT 

D5 16[79]14[80]BLK GCGAGTAAAAATATTTAAATTGTTACAAAG 

E5 13[96]15[95]BLK TAGGTAAACTATTTTTGAGAGATCAAACGTTA 

F5 16[111]14[112]BLK TGTAGCCATTAAAATTCGCATTAAATGCCGGA 

G5 13[128]15[127]BLK GAGACAGCTAGCTGATAAATTAATTTTTGT 

H5 13[160]14[144]BLK GTAATAAGTTAGGCAGAGGCATTTATGATATT 

I5 16[143]15[159]BLK GCCATCAAGCTCATTTTTTAACCACAAATCCA 

J5 16[175]14[176]BLK TATAACTAACAAAGAACGCGAGAACGCCAA 

K5 13[192]15[191]BLK GTAAAGTAATCGCCATATTTAACAAAACTTTT 

L5 16[207]14[208]BLK ACCTTTTTATTTTAGTTAATTTCATAGGGCTT 

M5 13[224]15[223]BLK ACAACATGCCAACGCTCAACAGTCTTCTGA 

N5 16[239]14[240]BLK GAATTTATTTAATGGTTTGAAATATTCTTACC 

O5 13[256]15[255]BLK GTTTATCAATATGCGTTATACAAACCGACCGT 

P5 16[271]14[272]BLK CTTAGATTTAAGGCGTTAAATAAAGCCTGT 

A6 11[32]13[31]BLK AACAGTTTTGTACCAAAAACATTTTATTTC 

B6 14[47]12[48]BLK AACAAGAGGGATAAAAATTTTTAGCATAAAGC 

C6 11[64]13[63]BLK GATTTAGTCAATAAAGCCTCAGAGAACCCTCA 

D6 14[79]12[80]BLK GCTATCAGAAATGCAATGCCTGAATTAGCA 

E6 11[96]13[95]BLK AATGGTCAACAGGCAAGGCAAAGAGTAATGTG 

F6 14[111]12[112]BLK GAGGGTAGGATTCAAAAGGGTGAGACATCCAA 

G6 11[128]13[127]BLK TTTGGGGATAGTAGTAGCATTAAAAGGCCG 

H6 11[160]12[144]BLK CCAATAGCTCATCGTAGGAATCATGGCATCAA 

I6 14[143]13[159]BLK CAACCGTTTCAAATCACCATCAATTCGAGCCA 

J6 14[175]12[176]BLK CATGTAATAGAATATAAAGTACCAAGCCGT 

K6 11[192]13[191]BLK TATCCGGTCTCATCGAGAACAAGCGACAAAAG 

L6 14[207]12[208]BLK AATTGAGAATTCTGTCCAGACGACTAAACCAA 
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M6 11[224]13[223]BLK GCGAACCTCCAAGAACGGGTATGACAATAA 

N6 14[239]12[240]BLK AGTATAAAGTTCAGCTAATGCAGATGTCTTTC 

O6 11[256]13[255]BLK GCCTTAAACCAATCAATAATCGGCACGCGCCT 

P6 14[271]12[272]BLK TTAGTATCACAATAGATAAGTCCACGAGCA 

A7 9[32]11[31]BLK TTTACCCCAACATGTTTTAAATTTCCATAT 

B7 12[47]10[48]BLK TAAATCGGGATTCCCAATTCTGCGATATAATG 

C7 9[64]11[63]BLK CGGATTGCAGAGCTTAATTGCTGAAACGAGTA 

D7 12[79]10[80]BLK AAATTAAGTTGACCATTAGATACTTTTGCG 

E7 9[96]11[95]BLK CGAAAGACTTTGATAAGAGGTCATATTTCGCA 

F7 12[111]10[112]BLK TAAATCATATAACCTGTTTAGCTAACCTTTAA 

G7 9[128]11[127]BLK GCTTCAATCAGGATTAGAGAGTTATTTTCA 

H7 9[160]10[144]BLK AGAGAGAAAAAAATGAAAATAGCAAGCAAACT 

I7 12[143]11[159]BLK TTCTACTACGCGAGCTGAAAAGGTTACCGCGC 

J7 12[175]10[176]BLK TTTTATTTAAGCAAATCAGATATTTTTTGT 

K7 9[192]11[191]BLK TTAGACGGCCAAATAAGAAACGATAGAAGGCT 

L7 12[207]10[208]BLK GTACCGCAATTCTAAGAACGCGAGTATTATTT 

M7 9[224]11[223]BLK AAAGTCACAAAATAAACAGCCAGCGTTTTA 

N7 12[239]10[240]BLK CTTATCATTCCCGACTTGCGGGAGCCTAATTT 

O7 9[256]11[255]BLK GAGAGATAGAGCGTCTTTCCAGAGGTTTTGAA 

P7 12[271]10[272]BLK TGTAGAAATCAAGATTAGTTGCTCTTACCA 

A8 7[32]9[31]BLK TTTAGGACAAATGCTTTAAACAATCAGGTC 

B8 10[47]8[48]BLK CTGTAGCTTGACTATTATAGTCAGTTCATTGA 

C8 7[56]9[63]BLK ATGCAGATACATAACGGGAATCGTCATAAATAAAGCAAAG 

D8 10[79]8[80]BLK GATGGCTTATCAAAAAGATTAAGAGCGTCC 

E8 7[96]9[95]BLK TAAGAGCAAATGTTTAGACTGGATAGGAAGCC 

F8 10[111]8[112]BLK TTGCTCCTTTCAAATATCGCGTTTGAGGGGGT 

G8 7[120]9[127]BLK CGTTTACCAGACGACAAAGAAGTTTTGCCATAATTCGA 

H8 7[160]8[144]BLK TTATTACGAAGAACTGGCATGATTGCGAGAGG 

I8 10[143]9[159]BLK CCAACAGGAGCGAACCAGACCGGAGCCTTTAC 

J8 10[175]8[176]BLK TTAACGTCTAACATAAAAACAGGTAACGGA 

K8 7[184]9[191]BLK CGTAGAAAATACATACCGAGGAAACGCAATAAGAAGCGCA 

L8 10[207]8[208]BLK ATCCCAATGAGAATTAACTGAACAGTTACCAG 

M8 7[224]9[223]BLK AACGCAAAGATAGCCGAACAAACCCTGAAC 
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N8 10[239]8[240]BLK GCCAGTTAGAGGGTAATTGAGCGCTTTAAGAA 

O8 7[248]9[255]BLK GTTTATTTTGTCACAATCTTACCGAAGCCCTTTAATATCA 

P8 10[271]8[272]BLK ACGCTAACACCCACAAGAATTGAAAATAGC 

A9 5[32]7[31]BLK CATCAAGTAAAACGAACTAACGAGTTGAGA 

B9 8[47]6[48]BLK ATCCCCCTATACCACATTCAACTAGAAAAATC 

D9 8[79]6[80]BLK AATACTGCCCAAAAGGAATTACGTGGCTCA 

E9 5[96]7[95]BLK TCATTCAGATGCGATTTTAAGAACAGGCATAG 

F9 8[111]6[112]BLK AATAGTAAACACTATCATAACCCTCATTGTGA 

H9 5[160]6[144]BLK GCAAGGCCTCACCAGTAGCACCATGGGCTTGA 

I9 8[143]7[159]BLK CTTTTGCAGATAAAAACCAAAATAAAGACTCC 

J9 8[175]6[176]BLK ATACCCAACAGTATGTTAGCAAATTAGAGC 

L9 8[207]6[208]BLK AAGGAAACATAAAGGTGGCAACATTATCACCG 

M9 5[224]7[223]BLK TCAAGTTTCATTAAAGGTGAATATAAAAGA 

N9 8[239]6[240]BLK AAGTAAGCAGACACCACGGAATAATATTGACG 

P9 8[271]6[272]BLK AATAGCTATCAATAGAAAATTCAACATTCA 

A10 3[32]5[31]BLK AATACGTTTGAAAGAGGACAGACTGACCTT 

B10 6[47]4[48]BLK TACGTTAAAGTAATCTTGACAAGAACCGAACT 

D10 6[79]4[80]BLK TTATACCACCAAATCAACGTAACGAACGAG 

E10 3[96]5[95]BLK ACACTCATCCATGTTACTTAGCCGAAAGCTGC 

F10 6[111]4[112]BLK ATTACCTTTGAATAAGGCTTGCCCAAATCCGC 

H10 3[160]4[144]BLK TTGACAGGCCACCACCAGAGCCGCGATTTGTA 

I10 6[143]5[159]BLK GATGGTTTGAACGAGTAGTAAATTTACCATTA 

J10 6[175]4[176]BLK CAGCAAAAGGAAACGTCACCAATGAGCCGC 

L10 6[207]4[208]BLK TCACCGACGCACCGTAATCAGTAGCAGAACCG 

M10 3[224]5[223]BLK TTAAAGCCAGAGCCGCCACCCTCGACAGAA 

N10 6[239]4[240]BLK GAAATTATTGCCTTTAGCGTCAGACCGGAACC 

P10 6[271]4[272]BLK ACCGATTGTCGGCATTTTCGGTCATAATCA 

A11 1[32]3[31]BLK AGGCTCCAGAGGCTTTGAGGACACGGGTAA 

B11 4[47]2[48]BLK GACCAACTAATGCCACTACGAAGGGGGTAGCA 

C11 1[64]4[64]BLK TTTATCAGGACAGCATCGGAACGACACCAACCTAAAACGAGGTCAATC 

D11 4[79]2[80]BLK GCGCAGACAAGAGGCAAAAGAATCCCTCAG 

E11 1[96]3[95]BLK AAACAGCTTTTTGCGGGATCGTCAACACTAAA 

F11 4[111]2[112]BLK GACCTGCTCTTTGACCCCCAGCGAGGGAGTTA 

Nature Protocols: doi:10.1038/nprot.2017.024

A.3 supporting information for associated publication p3 185



9 

G11 1[128]4[128]BLK TGACAACTCGCTGAGGCTTGCATTATACCAAGCGCGATGATAAA 

H11 1[160]2[144]BLK TTAGGATTGGCTGAGACTCCTCAATAACCGAT 

I11 4[143]3[159]BLK TCATCGCCAACAAAGTACAACGGACGCCAGCA 

J11 4[175]2[176]BLK CACCAGAAAGGTTGAGGCAGGTCATGAAAG 

K11 1[192]4[192]BLK GCGGATAACCTATTATTCTGAAACAGACGATTGGCCTTGAAGAGCCAC 

L11 4[207]2[208]BLK CCACCCTCTATTCACAAACAAATACCTGCCTA 

M11 1[224]3[223]BLK GTATAGCAAACAGTTAATGCCCAATCCTCA 

N11 4[239]2[240]BLK GCCTCCCTCAGAATGGAAAGCGCAGTAACAGT 

O11 1[256]4[256]BLK CAGGAGGTGGGGTCAGTGCCTTGAGTCTCTGAATTTACCGGGAACCAG 

P11 4[271]2[272]BLK AAATCACCTTCCAGTAAGCGTCAGTAATAA 

A12 0[47]1[31]BLK AGAAAGGAACAACTAAAGGAATTCAAAAAAA 

B12 2[47]0[48]BLK ACGGCTACAAAAGGAGCCTTTAATGTGAGAAT 

C12 0[79]1[63]BLK ACAACTTTCAACAGTTTCAGCGGATGTATCGG 

D12 2[79]0[80]BLK CAGCGAAACTTGCTTTCGAGGTGTTGCTAA 

E12 0[111]1[95]BLK TAAATGAATTTTCTGTATGGGATTAATTTCTT 

F12 2[111]0[112]BLK AAGGCCGCTGATACCGATAGTTGCGACGTTAG 

G12 0[143]1[127]BLK TCTAAAGTTTTGTCGTCTTTCCAGCCGACAA 

H12 0[175]0[144]BLK TCCACAGACAGCCCTCATAGTTAGCGTAACGA 

I12 2[143]1[159]BLK ATATTCGGAACCATCGCCCACGCAGAGAAGGA 

J12 2[175]0[176]BLK TATTAAGAAGCGGGGTTTTGCTCGTAGCAT 

K12 0[207]1[191]BLK TCACCAGTACAAACTACAACGCCTAGTACCAG 

L12 2[207]0[208]BLK TTTCGGAAGTGCCGTCGAGAGGGTGAGTTTCG 

M12 0[239]1[223]BLK AGGAACCCATGTACCGTAACACTTGATATAA 

N12 2[239]0[240]BLK GCCCGTATCCGGAATAGGTGTATCAGCCCAAT 

O12 0[271]1[255]BLK CCACCCTCATTTTCAGGGATAGCAACCGTACT 

P12 2[271]0[272]BLK GTTTTAACTTAGTACCGCCACCCAGAGCCA 

  

Supplementary Table 4: List of biotinylated staples 

No 
Posi

tion Name Sequence Mod 
1 C02 18[63]20[56]BIOTIN ATTAAGTTTACCGAGCTCGAATTCGGGAAACCTGTCGTGC 5'-BT 
2 C09 4[63]6[56]BIOTIN ATAAGGGAACCGGATATTCATTACGTCAGGACGTTGGGAA 5'-BT 
3 G02 18[127]20[120]BIOTIN GCGATCGGCAATTCCACACAACAGGTGCCTAATGAGTG 5'-BT 
4 G09 4[127]6[120]BIOTIN TTGTGTCGTGACGAGAAACACCAAATTTCAACTTTAAT 5'-BT 
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5 K02 18[191]20[184]BIOTIN ATTCATTTTTGTTTGGATTATACTAAGAAACCACCAGAAG 5'-BT 
6 K09 4[191]6[184]BIOTIN CACCCTCAGAAACCATCGATAGCATTGAGCCATTTGGGAA 5'-BT 
7 O02 18[255]20[248]BIOTIN AACAATAACGTAAAACAGAAATAAAAATCCTTTGCCCGAA 5'-BT 
8 O09 4[255]6[248]BIOTIN AGCCACCACTGTAGCGCGTTTTCAAGGGAGGGAAGGTAAA 5'-BT 

 

Supplementary Table 5: Exemplary folding table 

Component Initial conc. (µM) Parts Pool conc. (nM) Target conc. (nM) Volume (µl) Excess 

Scaffold 0.1 1 100 10 4 1 

Core Mix 100 164 609.7560976 100 6.56 10 

P1 Mix 100 12 8333.333333 1000 4.8 100 

Biotin 1:10 100 80 1250 10 0.32 1 

H2O     20.32  

10x Folding 
Buffer 

    4  

Total Volume     40  

 

 

 

Supplementary Table 6: Experimental conditions 

Figure Type Sample Imager Buffer Frames 𝒕𝒊𝒏𝒕 𝒄𝒊 Power PPT Camera 

1b, 7c in vitro 20 nm grids P1 B+ 7500 300 ms 5 nM 1.5 kW/cm2 Yes EMCCD 

1d, e in situ Microtubules P3 C 50000 100 ms 2 nM 2.5 kW/cm2 No EMCCD 

2d–f in vitro Exchange 
rectangle 

P1,P3 B+ 7500 300 ms 10 nM 6 kW/cm2 Yes EMCCD 

2g in situ Microtubules / 
Mitochondria 

P1,P3 C 20000 150 ms 0.8 nM 2 kW/cm2 
 

No EMCCD 

3d–f  
4d, f 

in vitro 10 and 20 nm 
grids, LMU logo 

P1 B+ 80000 350 ms 0.7 nM 4.5 kW/cm2 Yes sCMOS 

4b, c, e in vitro 10  and 20 nm 
grids, MPI logo 

P1 B+ 80000 350 ms 1 nM 4.5 kW/cm2 Yes sCMOS 
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For full details on acquisition settings see corresponding YAML files. 

 

Supplementary Table 7: Dye recommendations 
Excitation Rank Excitation wavelength (nm) Dye Compatible with PCA/PCD/Trolox System 
Red 1 640 Atto647N  Yes 
 2 640 Cy5 Yes 

 3 640 Atto655 No 

Green 1 561 Cy3b Yes 
 2 561 Atto565 Yes 

 3 561 Cy3 Yes 

Blue 1 488 Atto488 Yes 
 2 488 Alexa488 Yes 
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